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Important safety information

This manual contains information and warnings that must be followed by the user
for safe operation and to keep the product in a safe condition.

To safely perform service on this product, additional information is provided at
the end of this section. (See page xiii, Service safety summary.)

General safety summary

Use the product only as specified. Review the following safety precautions to
avoid injury and prevent damage to this product or any products connected to it.
Carefully read all instructions. Retain these instructions for future reference.

Comply with local and national safety codes.

For correct and safe operation of the product, it is essential that you follow
generally accepted safety procedures in addition to the safety precautions specified
in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove
the cover for repair, maintenance, or adjustment.

Before use, always check the product with a known source to be sure it is
operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where
hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system.
Read the safety sections of the other component manuals for warnings and
cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the
responsibility of the assembler of the system.
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Important safety information

To avoid fire or personal  Use proper power cord. Use only the power cord specified for this product and
injury certified for the country of use. Do not use the provided power cord for other
products.

Ground the product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, make sure that the product is properly grounded. Do not
disable the power cord grounding connection.

Power disconnect. The power switch disconnects the product from the power
source. See instructions for the location. Do not position the equipment so that it
is difficult to disconnect the power switch; it must remain accessible to the user at
all times to allow for quick disconnection if needed.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that
exceeds the maximum rating of that terminal.

The measuring terminals on this product are not rated for connection to mains or
Category 11, III, or IV circuits.

Do not operate without covers. Do not operate this product with covers or panels
removed, or with the case open. Hazardous voltage exposure is possible.

Avoid exposed circuitry. Do not touch exposed connections and components
when power is present.

Do not operate with suspected failures. If you suspect that there is damage to this
product, have it inspected by qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged
or operates incorrectly. If in doubt about safety of the product, turn it off and
disconnect the power cord. Clearly mark the product to prevent its further
operation.

Examine the exterior of the product before you use it. Look for cracks or missing
pieces.

Use only specified replacement parts.
Use proper fuse. Use only the fuse type and rating specified for this product.

Wear eye protection. Wear eye protection if exposure to high-intensity rays or
laser radiation exists.

Do not operate in wet/damp conditions. Be aware that condensation may occur if
a unit is moved from a cold to a warm environment.
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Important safety information

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry. Remove the input signals before you clean
the product.

Provide proper ventilation. Refer to the installation instructions in the manual for
details on installing the product so it has proper ventilation.

Slots and openings are provided for ventilation and should never be covered or
otherwise obstructed. Do not push objects into any of the openings.

Provide a safe working environment. Always place the product in a location
convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads.
Improper or prolonged keyboard or pointer use may result in serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an
ergonomics professional to avoid stress injuries.

Use care when lifting and carrying the product. This product is provided with
handles for lifting and carrying.

Service safety summary

The Service safety summary section contains additional information required to
safely perform service on the product. Only qualified personnel should perform
service procedures. Read this Service safety summary and the General safety
summary before performing any service procedures.

To avoid electric shock. Do not touch exposed connections.

Do not service alone. Do not perform internal service or adjustments of this
product unless another person capable of rendering first aid and resuscitation is
present.

Disconnect power. To avoid electric shock, switch off the product power and
disconnect the power cord from the mains power before removing any covers or
panels, or opening the case for servicing.

Use care when servicing with power on. Dangerous voltages or currents may exist
in this product. Disconnect power, remove battery (if applicable), and disconnect

test leads before removing protective panels, soldering, or replacing components.

Verify safety after repair. Always recheck ground continuity and mains dielectric
strength after performing a repair.
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Important safety information

Terms in this manual

These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Symbols and terms on the product

These terms may appear on the product:

®  DANGER indicates an injury hazard immediately accessible as you read
the marking.

B WARNING indicates an injury hazard not immediately accessible as you
read the marking.

B CAUTION indicates a hazard to property including the product.

When this symbol is marked on the product, be sure to consult the manual

A to find out the nature of the potential hazards and any actions which have to
be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

The following symbol(s) may appear on the product:

A @ O | ¢

CAUTION Protective Ground Mains Disconnected Mains Connected

Referto Manual ~ (Earth) Terminal OFF ({Power) ON {Powen) Standby
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Preface

The MTS4000 MPEG system applications are described in three user manuals:

B Analyzer applications
®  Generator applications

m  Carousel applications

The full list of applications can be found in the MTS4000 Quick Start User
Manual. This manual describes the analysis related applications. All applications

are available on the MTS4000 and MTS4SAV3 products:

Table i: Overview of the MTS4000 analyzer applications
Application

Desktop Icon

Transport Stream Compliance Analyzer (TSCA) — Real-time and deferred transport stream analysis with
user-selectable MPEG-2, DVB, ATSC and ISDB conformance tests. Shows transport structure, header
contents, hexadecimal packet contents, PCR timing /transport rate graphs and error message logs.

%

T3 Compliance
Analyser

Packetized Elementary Stream (PES) Analyzer — PES analysis with selectable test options. Shows PES
program structure, header contents, packet contents, PTS/DTS timing graphs and analysis reports.

PES Analyser

Transport Stream - System Target Decoder (T-STD) Buffer Analyzer — Analyzes program streams
modeling their behavior in, and their conformance to, the MPEG-2 T-STD Buffer Model. Includes a
trace facility.

2

Buffer
Analyser

Elementary Stream Analyzer — Elementary Stream analysis at video picture and audio level. This
includes vector graphs and macroblock picture quality.

A,
ES Analyser
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Preface

Product documentation

The following table lists the documentation available for your MTS4000 or
MTS4SAV3 product:

Document (Tektronix part number)

Purpose

Location

MTS4000 and MTS4SAV3 Quick Start User

Manual

(071-2970-xx English,
077-0665-xx Simplified Chinese,
077-0666-xx Japanese,
077-0657-xx Russian)

Describes how to install and get
started using the test systems.

@;++

www. Tektronix.com

MTS4000 and MTS4SAV3 Analyzer

Describes the operation of the

Applications User Manual following analyzer applications: @> + B ;
(077-0622-xx) TSCA, PES Analyzer, T-STD Buffer o e Ktronx com
Analyzer, and ES Analyzer.
MTS4000 and MTS4SAV3 Generator Describes the operation of the S
Applications User Manual following generator applications: @> + - Ex '
(077-0623-xx) Multiplexer, MPEG Player, TS www Tekironix.com
Editor, ISDB-T Remux, Make
Seamless Wizard, Transport
Stream Cutter, and Script Pad.
MTS4000 and MTS4SAV3 Carousel Optional manual supporting @> +

Applications User Manual
(077-0624-xx)

module-level servicing of the
instrument.

www. Tektronix.com

MTS4000 and MTS4SAV3 Release Notes
(077-0627-xx)

Describes known issues with the
test systems.

MTS4EAV7 HEVC / AVC Video and
Compressed Audio Analyzer User Manual
(071-3228-xx)

Describes the operation of the
MTS4EAV7 application software.

MTS4CC Elementary Stream Compliance
Checker User Manual
(071-2075-xx)

Describes the operation of the
MTS4CC application software.

=

www. Tektronix.com

PQAG00B and PQASW Picture Quality
Analyzer User Manual
(071-3280-xx)

Describes the operation of the PQA
application software.

—

= E

www.Tektronix.com

VQS1000 Video Quality Software Quick

Describes the operation of the

Start User Manual VQS1000 application software. —Ea
(077-0489-xx) . Tekiorix com
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Transport Stream Compliance Analyzer
(TSCA)






TSCA - Getting started

The MTS4000 MPEG Transport Stream Compliance Analyzer (TSCA) enables
you to monitor and interpret the contents of real-time, previously recorded, or
synthesized transport streams using the latest MPEG, DVB, ATSC, and ISDB
standards.

The TSCA is specifically designed to enable you to quickly locate and identify
problems within a transport stream using a minimum number of clicks. By
quickly identifying the problem areas, the TSCA software helps you save time
during the development and test of equipment, networks, and services. You can
configure the TSCA software to display stream information in user-selected fonts.
This feature enables you to view stream information in your local language or to
use custom fonts.

The TSCA software will run stand-alone on computers with Microsoft
Windows XP and Windows 7 operating systems.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser 0EX

Analysis View Navigation Settings CaptureVu™ Help

Programs \Tests‘ SIfPSI | PIDs || Packets| [ summry ‘Thumbnalls‘ MPE Sessions |

Acions v @ [F [
4@ Transpert Stream: Id 4103, Netwaork Name: Sandy =
=@ Program 4167 (0x1047) BEC ONE ‘& E Igl= Transport Stream: Id 4103, Networ -
@ P 500 (0x258) '@ ® Humber of Programs 6
@ PID 601 (0x259) A
8 P 02 (0x258) B
@ P 503 (25

Current TS bit rate 24.128 Mbps
Current TS bit rate excluding Null PID 22.116 Mbps

Program Bit Rate Occupancy (Current] 3| ~Programs: Current Bit Rates
® 4167 BBCONE 6.096 Mbp
® 4231 BBCTWO  6.109 Mbp:
B ® 4351 BBC CHOICE 6.108 M

® 4415BBCNEWS24 5989
@ PuT PD 4187 (0x1047) B S e
=@ Program 4231 (0x1087) BBC TWO &0 o B L P
@ PD 610 (0x282) = E : ; 4543BBC PARLINT  0.993
@ P 611 (0x263) A ® P 5191 2.012 Mbps
@ PID 812 (0x284) A
@ P 613 (m2ss) B

8 P 1010 (0x3F2)

@ PuT PD 4231 (0x1087) B

* Priority 1(44) * Priority 3 (89)

@ 11Sync @ 2.1 Transport @ 3.1.aNIT Actual (2) A~
@) Program 4351 (0x10FF) BBC CHOICE & @ 125meByte @ 22crC O 3.1b NIT Other
g E’”W'" x;; (E"m? ::E:E;ﬁ;‘{ - @ L3.aPaT @ 2.3.2 PCR Repetition @ 3.25TRepetiion (17)
@ mem4=43 EU"NBF" G e @ 1.4 Continuity @ 2.3.b PCR Discontinuity Indicator @ 342 UnrefPD
YOOrE; o SO = @ L5aPMT () 2.4PCR Accuracy @ 3.5.3 50T Acual (14)
@ L6PD (44) @ 25PT5 @ 3.5b SDT Other =
@ 26car @ 3.6.3EIT Actual (56)
@ 3.6.bEIT Oter v

< | >

75 Avaiabity @)|syme Q| 24 128335 vbps @ 188204 511,350 Packets| | DVB| Mo Extensions| | Il

Figure 1-1: TSCA Program view - deferred analysis
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TSCA - Getting started

TSCA features

Industry's fastest analysis engine enables reduced analysis time, rapid
development, evaluation, deployment, and diagnostics of next generation
DTV and IPTV systems and services

Support for a wide range of DTV standards, including MPEG, DVB, DVB-S2,
ATSC, including A78 and SCTE 142, and ISDB. Specific service information
(SI) for terrestrial, cable, and satellite, plus regional variations of these
standards are also supported

A range of interfaces and analysis capabilities provide the necessary
connectivity to diagnose problems anywhere in the network environment,
whether that is in transmission links (RF or IP layer) or content processing
(TS layer)

Connection to both IP version 4 and 6 networks, including those using IGMP
and MLD multicast protocols respectively (IP version 6 is only available with
the IP Video Gigabit Ethernet interface)

Constant bit rate stream analysis (CBR)

CaptureVu technology captures and analyzes system events in real time and
deferred time to debug the intermittent and complex problems that traditional
analyzers miss

Multi input monitoring

Innovative program-centric user interface brings expert power to the novice
user

File analysis and Real-Time modes

1-2

The TSCA can be run in offline (or deferred) File Analysis or Real-Time Analysis
mode.

The offline File Analysis mode is available on any recommended platform
(including the your own PC). In offline File Analysis mode, a static stream can be
analyzed and displayed; the content can then be inspected at leisure.
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Technical background

User interface

Program view

TSCA - Getting started

The analyzer has a client-server architecture. Every time the analyzer opens, it
starts two processes: tsca.exe, which is the client, and MpegCore.exe, which is the
MPEG analysis engine. Additionally, when the analyzer opens for the first time,
another single process, CoreManager.exe, is started. CoreManager.exe forms an
intermediary between TSCA clients and MPEG cores.

The tsca.exe, MpegCore.exe, and CoreManager.exe processes use SNMP (Simple
Network Management Protocol) and HTTP (Hypertext Transfer Protocol) to
communicate. The port numbers used for communication are read from a
configuration file, Corelnfo.xml. In a default installation, the path to the file is
C:\program files (x86)\tektronix\mpeg\mts4000\apps\tsca\xml\.
The default port range is 15700-15800. You can change these values if they
conflict with other applications.

You must have local administrator rights to be able to use IP analysis. If you need
to change your rights, please consult your system administrator.

The TSCA software displays two primary views selected using tabs: FlexVuPlus
and Analysis.

Using the FlexVuPlus window, you can assemble up to four views that you select
from the Analysis window. This allows you to customize the view by selecting
the views that are most relevant to the analysis task. The Flex/uPlus window is
described in detail in the MTS4000 Quick Start User Manual.

The Analysis window uses a single main program summary window with different
context sensitive views contained within tabbed frames. This provides the
maximum amount of useful information, while keeping the screen from appearing
cluttered. From the main window, you can access the following views: Program,
Tests, Tables, PID, Packets, and Interface.

The Program view provides a fast overview of the transport stream contents

in terms of program content, bit rate use by each program, and TR 101 290

test results. Red, amber, and green LEDs highlight errors associated with each
program, or element of a program, within the transport stream. Red LEDs indicate
that there are current errors in the stream, amber LEDs indicate that errors have
occurred but are now clear, and green LEDs indicate that no errors have been
detected.

Errors that are detected at lower levels in the program stream hierarchy propagate
up to the highest level. This allows you to monitor all of the programs in the
stream at a high level and then quickly go to lower levels as necessary to locate a
problem.
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TSCA - Getting started

14

Tests view

SIIPSI (Tables) view

PID view

Packets view

The Tests view enables you to isolate errors to the specific tests that have been
applied to the transport stream. The error log is automatically filtered by the
selected test, and can also be filtered by Packet Identifier (PID). In addition to the
standard first, second, and third priority tests included in TR 101 290 standard,
tests are available for Program Clock Reference (PCR) jitter and program/PID bit
rate. A variability test enables you to test the changes in the bit rate of a specific
PID, and there are many tests that are specific to ISDB-T and ISDB-S streams.

The SI/PSI (Tables) view displays the service information tables that have
occurred in the analyzed stream that comply with the selected digital video
standard. This includes MPEG-specific program information, DVB service
information, and ATSC, ISDB program, and system protocol information. The
tables are grouped together by function and hyperlinks enable you to quickly
access related information within other tables.

The PID view displays information about all of the PIDs found in the transport
stream. When you select the transport stream, the associated summary view
provides a PID-oriented overview of the transport stream, displaying the relative
data rates of all of the PIDs contained within the stream. The information can be
displayed as either a bar chart or as a pie chart. Pop-up menus enable fast limit
selection and links.

Each PID is associated with a number of tests. When one or more tests fail, each
failed test will be listed under the relevant PID. Select a specific PID to display
a summary of all the associated tests. Select a specific test to display the Event
Log and Parameters for only that test.

The Packets view displays information about all of the packets found in the
transport stream grouped according to content. These groups include PID value,
SFN mega-initialization packets (MIPs) (DVB only), and ISDB-T and ISDB-TB
information packets (IIPs). When you select a specific PID or MIP, only packets
carrying that particular PID or MIP are displayed. A section view is also available.
Deferred analysis of PCAP files allows you to see the ethernet packets.

The Packets view is not available in real-time mode. However, you can examine
packets in a real-time stream by using the CaptureVu feature.
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TSCA - Getting started

Interface view  The Interface view provides a central location for information related to the RF
and IP interface cards (where installed):

B Test results
m  Graphical representation of specific RF and IP readings
B RF and IP readings and control settings

The graphical views display a selection of graphs of instantaneous measurements
and measurement trends. Also available is an Event Log.

The Interface tab is displayed only when an interface is installed.

CaptureVu feature

The CaptureVu feature captures a snapshot of system events in real and deferred
time, and allows you to debug the intermittent and complex problems that
traditional analyzers miss. You can initiate CaptureVu either manually or
automatically by associating a CaptureVu Breakpoint with any test event. When a
breakpoint is detected, either manual or automatic, the stream is paused and an
in-depth deferred time analysis can be performed on stored data. This powerful
debug mode enables fast debugging of troublesome intermittent problems.

Triggered recording

During real-time analysis, stream information can only be held for a finite time
- eventually it will be overwritten by more up-to-date information. Triggered
recording allows a portion of a stream to be recorded and subsequently analyzed
in detail.

The following trigger sources and conditions apply:
E  Any test event

B Date and time

B Recorded file size can be specified

B Pretrigger buffer size can be specified as a percentage of the overall file size
range from 0 - 100%
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Starting the TSCA software

Opening the TSCA

The TSCA can analyze transport streams in either real-time or file analysis mode.

From the Windows Desktop, select Start > All Programs > Tektronix MTS4000
> Analyzer > TS Compliance Analyzer.

The TSCA is opened, initially overlaid with either the Open File Analysis or the
Select Real-time Interface dialog box as shown in the following figures. The
application opens the dialog box that was last opened.

&2 to File - MPEG TS Compliance Analyzer
Analysis Yiew Mavigation Settings Capturefu™ Help

P FlexvuPlus| [£9 open File Analysis

standard

Programs | Tests

() NaPAT

I
s
Recent ltems

Desktop

My Documents
LY
Computer
H
w

Network

Base Standard DB, Region No Extensions
Using default scripts, Scripted validations are not enabled,

Lookin: | Hew Wolume (D) =

¥ @a

==

B

[4] dvb_§25_meped

Advanced Settings | Eavarite Files

Stream Bit Rate

The stream bit rate is used 25 2 basis
for timing measurements during
analysis, Please select how the bit rate
iz caleulated:

@) Prescan first | 100 FCRs
() Prescan all PCRs in file

() Manually set |0 Wbps
Timestamp Settings

() Do net use Timestamps

@) Use Arrival Timestamps (ff pres...

File name:

Files of type:

MPEG Transport Stream Files (* mpg, *.mp

Capl Settings [+
[] Pause snalysis st packet indes
o

WMean(ibps)

Shaw filter &
Taxllbps)

Min(vbps)

() 1.4 Continuity
Q 1.5.apMT
Q L&PID

() 2.1 Transport

Qz2z2arC

(D 2.3.3 PCR Repetition

() 2.3.b PCR Discantinuity Indicator
(D 2.4 PCR Accuracy

() 3.1.a NIT actual
() 3.1b MIT Other
() 3.2 51 Repetition
() 3.4.a Unref PID
) 3.5.2 50T Actual
() 3.5b 50T Other
() 3.6.2 EIT Actual
(4 3AKFTT Other

75 fvailablity Q|| Syne ()| 0.000000 Mbps @ 16| 0| DVB | Mo Extensions | | [l 61

Figure 1-2: TSCA start-up - offline file analysis
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Source Address 192,168.1.222
Dastination Addrass 239,11 s
Destination Port 16294

Use RTP ¥ otrue -

(&=

() 3.1.a NIT Actual .

() 3.1k NIT Cther
O 52 snapatten

o T Coramey T 2. 3.5 PLR DECONmaty Inadicarar () 3.4.a Unref PID
() 1.5.aPMT () 2.4 PCR Accuracy () 3.5.5 50T Actual L
O 16PID D 25pTS () 3.5b 50T Qther
Q26CAT (D 3.6.a EIT Actusl
(3 3.A.hFIT Other i

75 Availabiity Q|| Sync ()| 0.000000 Mbps @ 168 |0 |DWE| No Extensions | [l B

Figure 1-3: TSCA start-up - real-time analysis
The opening dialog boxes allow you to:

®  Select the interpretation standard to be used for analysis. See step 2 in the
Interpreting a Stream section. You should always set the stream interpretation
standard before starting analysis.

and

m  Identify a stream file for off-line analysis. See step 1 in the Off-Line File
Analysis section. Files can be selected either directly from the disk drive or
using shortcuts that you have defined.

or

®  ]dentify an input (IP, RF, ASI) receiving a stream and start real-time analysis.
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1-8

Interpreting a stream

You can set up the stream interpretation standard in the following way:

1. Click Change in the opening dialog box to open the Standard dialog box.

NOTE. The TSCA software analyzes streams in strict accordance with the
standards defined by the digital television authorities: DVB (Digital Video
Broadcasting), ATSC (Advanced Television Systems Committee), and ISDB
(Integrated Services Digital Broadcasting).

The TSCA software uses preloaded scripts that establish the expected content and
syntax of the analyzed stream. The analyzer is supplied with a comprehensive
range of scripts, which, in different combinations, can interpret the full range

of digital television standards.

2. Select the Base Standards and then (if available) select the Region. The
analysis scripts that will be used are displayed in the Script Files pane.

REEERE -, o, ==

H .
B3 Open File &naly Standard and Region =]
standard Select a standard and region bo use For analysis

Base Standard DY

Using default script Base Standard \DYE - | Region | No Extensions -

Scripks
Lockin: [ Use Custom Scripts
== [ Enable scripted section validations during analysis (slower) Eavorite Files
-
Recent Items Scripts Directory | Z:\Program Files (286 TektronixmpeghMTS40004 Scripks ised as 2 basis for
= - during analysis.
! #'\] tektronix.scp E bit rate iz
F"\] Ethernet.scp
Rechiop B 1PEG_Packet. scp & s
= ) DvE_SFN_MIP scp (il
4 f'\] MpeE. scp ]
S Mbps
My Documents *-‘] dvb.scp
= £
[ L *'1 rnhp.s-:p G tarnps
L. #\] mpe.scp , i .
= arnps L Fesenl
Computer *F'\] dsmce.scp A 4 ps LiFp
F"\] int.scp bs ﬂ
A ) rmpeg_pat.scp . packet index
R ) DF1_SCTE3S scp >

] (o]

Gk Cancel

Figure 1-4: Stream Interpretation dialog box
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3. Select OK.

4. The stream interpretation is now set. Select OK to close the Standard dialog
box and return to the opening dialog box. (See page 1-142, Script files.)

NOTE. The selected stream interpretation standard is not implemented until
stream analysis is started. If the Open Transport Stream dialog box is closed
without starting analysis, the stream interpretation settings are lost, they revert to
the settings that were in effect when the application was last closed.
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Off-line file analysis

Perform the following steps to start analyzing a transport stream file:

1. In the Open File Analysis dialog box, browse to a transport stream file.

If necessary, select a file type from the Files of type drop-down list. Currently,
two types are available: MPEG Transport Stream files and PCAP files.

MPEG transport stream files contain interlinked tables and coded

identifiers, which separate the programs and the elementary streams
within the programs.

PCAP files contain raw packets of network data. A PCAP may contain

more than one session. You will need to select a session using the Browse
dialog box.

When you select a stream, the stream name appears in the File Name field at
the bottom of the window.

¥ Open File Analysis

Standard

Base Standard DVB, Region No Extensions
Using default scripts. Scripted validations are not enabled.

Look in: |b Streams v‘ ? __"’I|E ﬁ
. |2) Golddemos Advanced Settings | Favourite Files
’J I7) samples
= 5E5 Stream Bit Rate
Working.ilcab l/ﬂ The stream bit rate is used as a basis for timing
I Sym measurements during analysis. Plese sslact how
[j-ﬂTEkStrEamer the bit rate is calculzted:
i =
4] BBC 18UG27.mpg (3) Prascan first |100 PCRs
Control Panel | (2] EchoStaré 1-5\West-TP2.mpg () Prescan all PCRs in file
w SmallSports2_SMbpsSeamless. TRP O My =t |7| Mbps
2, Timestamp Settings
,J (%) Do not use Timestamps
My Documents

() Use Arrival Timestamps (if present)

() Use TTS Timestamps (if present)

@,‘

CaptureVu™ Settings =
My R t
D;cu;C;nm D Pause analysis at packet indsx
=
L
Desktop

Flename:  [8BC1AUG27.mpq| |

Files of type: iMPEG Transport Stream Files (*.mpa, *.mpeg, *.trp, *.ts, *.r... |™ ‘

Figure 1-5: TSCA Open File Analysis (Offline) dialog box
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3. Calculating the stream bit rate: To analyze a transport stream correctly,
you must do one of the following:

= Calculate the bit rate from PCRs (Program Clock Reference) carried in
the stream

NOTE. When the TSCA software analyzes a transport stream, it compares the
bit rate of the stream to the expected rate. Errors are reported based on the
expected rate of the stream. To analyze a stream correctly, it is necessary to
know the original bit rate of the stream or to calculate the bit rate from PCRs
(Program Clock Reference) carried in the stream. PCRs are generated as a
stable clock reference and are added to the stream during its generation.
During analysis, the PCRs are extracted and synchronized with a local clock
reference.

= Know the original bit rate and enter it manually

= Use timestamps included with the stream

Advanced Settings | Eavourite Files

Stream Bit Rate

The stream bit rate & used =5 2 beasis for timing
messuraments during anahwsis. Please sslect how
the bit rate is calculated:

{*) Prescan first ‘1‘0.’." ‘ PCRs
O Prescan zll PCRs in file

{:) Manuzaly st ‘ ‘ Mbps
Timestamp Settings
@ Do not use Timestamps

() Use Arrival Timestamps (if present)

() Use TTS Timestamps (i present)
CaptureVu™ Settings (e
|:| Pause anaiysis at packet indiee
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4. After you select the desired stream, select one of the following methods for
calculating the rate of the transport stream:

= Prescan first nnn PCRs. The TSCA software calculates the rate of the
stream by prescanning the stream for embedded PCRs. The entry box lists
the number of PCRs that the TSCA software recommends are necessary
to determine the stream rate. You can use the entry box to enter a different
number.

= Prescan all PCRs in a file. The TSCA software calculates the rate of the
stream by prescanning the stream for all of the embedded PCRs.

= Manually set nnnn Mbps. The TSCA software uses the absolute value (in
Mbps) that you enter as the expected stream rate.

NOTE. If either the 'Use Arrival Timestamps' or the 'Use TTS Timestamps' check
box is selected, timestamps, which may have been added when the stream was
generated, will be used, in the analysis of the stream.

Using timestamps will override the PCR options ("Prescan first nnn PCRs' and
'"Prescan all PCR in file').

A manually entered bit rate will override both PCRs and timestamps in the stream.

5. Ifthe TSCA software cannot calculate the bit rate from the embedded PCRs,
or timestamps, a message box is displayed. You must enter an estimated bit
rate before the TSCA software can analyze the stream.

6. If the CaptureVu feature is to be used, the whole file can be captured or
analysis can be paused either by a previously set CaptureVu breakpoint or at a
specific packet.

7. To pause analysis at a specific packet, enable Pause Analysis at Packet
Index and enter a packet number.

With a file selected and the transport rate calculation set up, you can start the
analysis. (See page 1-26, Starting analysis.)
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Real-time analysis  To start analyzing a transport stream received through an IP or a hardware (RF)
interface, select Real-time from the toolbar and, in the Select Real-time Interface
dialog box, select an interface from the Interfaces drop-down list.

Only installed interfaces will be shown in the drop-down list. For stand-alone
installations, only the IP interface is available.

¥ Select Real-time Interface

Standard

Base Standard DVEB, Region No Extensions
Using default scripts, Scripted validations are not enabled. g9e- -
Interfaces

Select from the available interfaces

Interface Settings
Presets Selected Preset
These are the settings for the currently selected preset.

To browse the network for a stream, select the Srosvse.. . button,

] b4
(& ][ =

[ oK J[ Apply ][ Cancel ]

Figure 1-6: TSCA Real-time Interface dialog box

Real-time analysis will not be available if the appropriate software key
permissions are not found. A warning message is displayed when real-time
analysis is not available.

Make any necessary interface settings. Either select and apply a preset (a
predefined set of interface settings) or modify the individual interface settings.
During analysis, the interface selected will be shown in the status bar. (See
page 1-17, Setting up the IP interface.)
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Interface card overview

This section describes the configuration and interpretation of results of the RF and
IP Video interface cards that you can install in an MTS4000 MPEG test system.
The cards all use a common interface protocol for data handling and firmware
upgrading.

The interface settings described are as follows:

®  QAM B (Quadrature Amplitude Modulation) (Annex B II) (See page 1-74,
RF interface - QAM (Annex B).)

B 8VSB (Vestigial Side Band) (See page 1-77, RF interface - 8VSB.)

®  DVB-S2 supporting QPSK, 8PSK, 16APSK, and 32APSK demodulation (See
page 1-79, RF interface - DVB-S2.)

B [P Video Gigabit Ethernet (See page 1-81, IP video Gigabit Ethernet
interface.)

Refer to the MTS4000 Specification and Performance Verification Technical
Reference, 077-0626-xx for the interface technical specifications.

The RF interface measurements and graphs include a constellation diagram with
EVM, SNR, and BER measurements. A constellation diagram with MER rings is
also available with the QAM B and 8VSB interface cards. The installed interface
can be used simultaneously with a GbE interface and the internal NIC (network
interface card) input. All interfaces have dual-level warning and failure alarms,
and graphs for long term trend monitoring.

The input card screen and configuration of the card depend on which interface
card is installed. (See the following pages.)
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The interface card configuration is set up when analysis is started using the Open
Transport Stream dialog box. The settings can subsequently be changed during
analysis from the Interface view.

When real-time analysis is selected and an interface is selected from the Interfaces
drop-down list. The Firmware Version and the current Interface Settings of the
card are displayed.

.
¥ GigE > ASE1 - MPEG TS Compliance Analyzer ==

Analysis View Mavigation Settings CaptureVu™ Record Help

&

Open File... | Resl Standard... | Configuration... | Restart |4

P Flexvuplus™ £ Analysis

q
Programs Tes >|| 1P Tables | pi | |
iagnostics | Graphs | =@ Interface Event Log | —4& All Session Event Log
PIDs Packets Interface 5
Select Real-time Interface
A:ﬁnnsv|shaw:a O & Q‘E]Ei @
= Standard
= o___g”:ﬂcf i"ﬂrs ) Base Standard DVE, Region o Extensions el
pEx () Using default scripts. Scripted validations are not enabled. cnkithiei
}-1J) Bit Rate Error
o Packet Interarrival Time Error Interfaces
o IP Errored Packet Error _ 3 — N
@) RTP Lost Packet Error Select from the available interfaces  |GigE > ASI-1 R
i ) RTP Out of Order Error Gl
() Interface Warnings Firmware Version
Current Firmware Version: 8.9
Firmware is up-to-date
Interface Settings
Presets Selected Preset
These are the settings for the currently selected preset.
Value (0 —
Defauit - .
- b
Auto 10/100/1000 (Cop... i
02:00:11:0A:08:0C i)
Passve {1Pvd and IPvE) | s
152,168,133 3 = R
A sng (Stateless only ':‘k’h
IPv6 Address & &
AST Output s received B
tuficast Kesp-siv o =
T e % Pk
Q = Configure Multicast... Gl
TS Availabiity @ |Sync @)|| 2.505817 [ oK } [ Apply J | Cancel ]

Figure 1-7: Open Transport Stream dialog box

If the firmware version is incorrect, the Update Firmware button is enabled, and
you will not be able to proceed with the setup and analysis until the firmware is
updated. (See page 1-16, Interface card firmware update.)

1. In the Open Transport Stream dialog box, select Real-time Analysis.
2. Select the interface from the Interfaces drop-down list.

3. Enter the interface settings required. for Descriptions of the settings for each
interface card. (See page 1-74, RF interface views.)

4. Select OK to start the analysis.

The name of the selected interface is displayed in the TSCA status bar.
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Interface card firmware
update

If the interface card firmware needs to be updated, a message will be displayed
when real-time analysis is selected. The Update Firmware button will also be

Update the interface card firmware as follows:
Select Update Firmware.

In the Update Firmware dialog box, select Start.

o Intevfaces

Salact from the avalisbls interfacss v
Fimmiare Veesion
Current Himwvare Yersion: 4.8
Ay upedate for thee frrmeare i avadable, the uodate st be appled before ths nterf ace con be used Update Firmware. .
To begn the update sehet Update Firmmare... -

Updale Firmware FE

Select start ta begin the firmsare update.
Whila the update is In proqress the devics must not be powared-dawn.

Figure 1-8: Firmware update

3. The dialog box will display progress of the update. The box will close when
the update is complete.

CAUTION. Removing power from the MTS4000 while the firmware upgrade is in
progress can cause fatal corruption of the firmware files.
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Two Ethernet interfaces are standard on the network interface cards installed in an
MTS4000 system; one 10/100 Base-T and one 10/100/1000 Base-T GigE.

Two high performance Gigabit Ethernet interfaces can be acquired as options;
only one can be installed at a time.

The following table lists important comparisons between the IP interfaces.

Table 1-1: MTS4000 IP interface comparisons

IP video Gigabit Ethernet
interface: (IP Video

Network interface card

10 GBase-SR Dual Optical

Feature Interface) (NIC) MTS4000/MTS4SAV3 card

Bitrate 1 Gbps (maximum) <120 Mbps (total) <700 Mbps (total)

Interface type 10/100/1000 Base-T; 1000 10/100/1000 Base-T GigE 10 G SFP+
Base-T, -SX, -LX, -ZX

Number of ports (SFP - small 1 x optical SFP; 1 x RJ45 2x RJ45 1 SFP

format pluggable)

Supported IP version Version 4 and 6 Version 4 Version 4

Communications protocols IGMP v2 & v3 and MLD v2 IGMP v2 & v3 IGMP v2 & v3

Sessions (maximum) 500 Multiple 2

Variable bit rate (VBR) Yes Yes Yes

PIT histograms and instantaneous Yes No No

PIT measurements

PIT measurement (average) Yes Yes Yes

IP packet inspection view No Yes Yes

Recording TS TS TS

PCR_0OJ, _DR, _FO Yes - selected session only Yes Yes

PCR_AC Yes - selected session only Yes Yes

TR 101 290 Yes - selected session only Yes Yes
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IP video interface setup

Preset name

In the Select Real-time Interface dialog box with GigE selected in the Interfaces
drop-down menu, the current settings for the selected configuration are shown.

Standard

Base Standard DVB, Region No Extensions

Using default scripts. Scripted validations are not enabled.

Interfaces
Select from the avai

Firmware Yersion

Current Firmware Version: 8.9

Firmware is up-to-date

Interface Settings

Presets Selected Preset
These are the settings for the currently selected preset.

ilable interfaces | GigE -» ASI-1 -

Field

Auto 10/100/1000 (Copper)
(0E200:11:04:0B:0C

Passive (IPv4 and IPVE)
192,168.1.33

Stateless only

(00:03: 2D:03: 2C: F9

(01:00:5E:01:01201

ENELN

[ o [ sy ][ cancel |

Figure 1-9: GigE Configure Interface dialog box

The following configuration settings are available for the IP Video interface card.

(See Figure 1-9.)

The name allocated to a preset interface configuration setup.
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Interface card  These settings deal with the physical and network settings:

configuration Connection Type: Select the line speed and type of the physical connection

from the drop-down list: Force 10 (Copper), Force 100 (Copper), Force 1000
(Copper), Force 1000 (Optical), Force 1000 (Optical Rx), Auto 10/100/1000
(Copper), and Auto 1000 (Optical).

The term Force means that the IP Video interface card will not negotiate a line
speed; the linked device will have to be set in the specified forced speed mode for
this to work. For the Auto 10/100/1000 (Copper) mode, the IP Video interface
card will attempt to negotiate with the linked device for the fastest available speed
denoted by the number following the word Auto.

Two types of interface are available on the IP Video interface card: copper and
optical. The copper interface supports speed settings at 10 Mbps, 100 Mbps, and
1000 Mbps. The optical interface supports 1000 Mbps only.

The Force 1000 (Optical Rx) mode is a special mode that can work in conjunction
with a network splitter. In this mode, the receive laser needs to be connected into a
valid optical link between two other devices using an optical splitter. This enables
the IP Video interface card to monitor the communication between other devices.

®m  MAC Address: Enter the MAC address of the IP Video interface card, for
example, 01-0a-02-0b-03-0c-04. The card is set with a unique MAC address
in the factory; do not change this. The MAC address of your instrument can
be found on a label affixed to the cover of the instrument.

= Network Interaction: Select the way that the instrument interacts with
the connected network: Passive is equivalent to listening, where no
interaction with the network is required. If you require interaction with the
network to receive traffic, such as identifying specific sources or pinging
other instrument, select Active. Selecting IPv4 and/or IPv6 in active mode
will depend on your intended data sources.

The following selections are available:

= Passive (IPv4 and IPv6) - If you select this option, [Pv6 Addressing fields
are not used.

= Active IPv4 only - If you select this option, complete only the
IPv4 Address field.

= Active IPv6 only - If you select this option, complete only the
IPv6 Addressing fields.

= Active (IPv4 and IPv6) - If you select this option, complete all of the
IPv4 Address and IPv6 Addressing fields.
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IPv4 Address: Enter the IP address of the IP Video interface card. This
address will be allocated by your network administrator. The null value is
0.0.0.0.

IPv4 addresses are normally written as four octets in decimal separated by periods,
for example, 192.0.2.235.

IPv6 Addressing: If you have selected the active IPv6 network
administration, use this field to select the means by which the IP address of
the instrument can be discovered by the network.

Stateless only - The interface card will use its MAC address and an address
prefix used in periodic advertisement messages generated by the local router
to automatically calculate an IPv6 address (RFC 4862).

Manual - Enter an address that has been assigned by your network
administrator in the IPv6 Address field.

DHCPv6 (Dynamic Host Configuration Protocol version 6) - The interface
card will attempt to contact a DHCPv6 server on the network, which will
supply an IPv6 address for the card (RFC 3315).

If you selected manual IPv6 addressing, enter the address in the IPv6 Address
field.

IPv6 addresses are normally written as eight groups of four hexadecimal
digits, where each group is separated by a colon (:). For example,
2001:0db8:85a3:0000:0000:8a2¢:0370:7334. To shorten the writing and
presentation of addresses, several simplifications to the notation are permitted.
Your network administrator will be able to advise you.

A Link Local address is automatically assigned to allow your instrument to
communicate with the nearest network router or switch.

ASI Output - Set the output format:

As Received - The IP data is supplied in bursts as they are received directly
to the ASI output port. The data can then be looped to the processor card
for analysis.

Smoothed - The incoming IP data is buffered in an attempt to smooth the bit
rate before supplying it to the ASI output port.

VBR to CBR (Variable bit rate to Constant bit rate) - The incoming IP data
is received at a varying bit rate. Null packets are inserted into the stream to
achieve a constant bit rate output. The result can be recorded and played
back with the timing preserved.

VBR Detection - Enhances VBR detection.

Multicast Keep-alive - If a query is not received in X seconds, then
re-subscribe.
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Session selection criteria ~ These settings target which stream is sent for analysis. Typically these settings are
extracted from the session that is selected in the IP traffic screen. Not all fields
need be completed; just enough to uniquely identify a session.

m  VLAN Selection: (Virtual Local Area Network) A logical grouping of two
or more network nodes, which are not necessarily on the same physical
network segment, but which share the same network number. With the VLAN
Selection turned on, if the packet carrying the transport stream contains a
VLAN identity, the system will attempt to extract the transport stream from
the first IP stream that fits the current control settings.

®  Tag: The desired VLAN ID in hex number format.

NOTE. There may be more than one network session on the monitored networks.
Using the following MAC, IP, and Port selections, a single session can be
identified. If all selections are set to Off, no stream will be received.

m  MAC Selection: Select the MAC Selection filter: None, Source, Destination,
or All. When a value other than None is selected, the system will extract the
transport stream from the first IP stream that fits the Source and/or Destination
settings.

= Source: Enter the source MAC address to filter.
= Destination: Enter the destination MAC address to filter.
Example MAC address: 01-0a-02-0b-03-0c-04.
m IP Selection:
= Source: Enter the source IP address to filter.
= Destination: Enter the destination IP address to filter.
Example IP address: 128.181.39.3.
m  Port Selection:
= Source: Enter the source port address to filter.
= Destination: Enter the destination port address to filter.
Input port number in integers between 0 and 65535.

®  Protocol: Select the session protocol: Don't Care, UDP (User Datagram
Protocol), or RTP (Real-time Transport Protocol).
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Multicast configuration

1-22

Multicasting allows you to subscribe to and monitor single or multiple streams on
the network. To configure the use of multicasting, click the Configure Multicast
button on the Configure Interface dialog box. The content and layout of the
Configure Multicast dialog box will depend on the multicast subscription mode
selected. The subscription mode also affects the layout of the [P Tables tab of the
interface analysis view. The three modes are Off, Single, and Multicast Database:

Subscription Mode - Off No subscription information will be used for the
current preset.

Subscription Mode - Single The single subscription mode allows you to
enter a single subscription for the current preset. The subscription's multicast
address and optional source address is displayed along with an Edit button.
Clicking the edit button will display the Edit Current Subscription dialog.

Subscription Mode - Multicast Database The multicast subscription mode
allows entry and management of multiple subscriptions. The subscriptions
are displayed in the form of a table - the Multicast Database. This allows
you to add, remove, join and leave multicasts as well as import and export
subscriptions. This database is common to all presets but each preset can
choose whether to use it for GigE traffic or use Single or Off.

In all modes the IP Traffic table will be displayed showing all the traffic that
is visible to the network card.

@ Configure Multicast gl

Multicast Options

Subscription Mode: ]7Sir|gla

Current Subscription: ::FFFF:224.0.0.1

aw

il

IP Traffic: 1 UDP flow

Sessi e
| M|UNDEFINED | FFOI

Duuizla-
|

Figure 1-10: Single subscription mode
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Selecting the single subscription option, displays the Edit Current Subscription
edit button. Use the settings in the Edit Current Subscription dialog box to identify
the multicast protocol to be used, IGMP (IPv4) (Internet Group Management
Protocol) or MLD (IPv6) (Multicast Listener Discovery), and the specific
multicast source address required.

Use the Set Supported Protocols button to select the multicast protocol version
that is to be supported. The version labeled as auto-fallback allows the card to
automatically switch to the version actually detected on the network.

Subscription mode - multicast.

The multicast subscription mode displays all of the multicast subscriptions that
are currently added to the multicast database and allows you to add, remove,
join and leave multicasts.

¥ Configure Multicast E|
Multicast Options
Subscription Made: | Mulkicast Database w |
Multicast Database: Active IPvE only Actions ¥
lker &)
Multicast Address
hedl224.0.0.1 Jaoined
[224.1.2.4 Joined
pel224.1.2.5 Joined
pdl224.1.2.6 Joined
pell224.1.2.7 Joinzd
avw
IP Traffic: 1 UDP flow detected (total rate 8.396 Mbps) Actions w

Session Alias |Dest, IP | Dest. Port | Has TS | TS Sync Emor | TS CC Enor |Packet E... | MDI:DF | PIT Emor |Bit rate (Kbps) | MDIMLR | Bit rat o
#|UNDEFINED | FFOE:Z 4354 v - 1000000 0| 17.201 - 8395 1166 - uDp

Figure 1-11: Multicast subscription mode

If the multicast database subscription mode is selected, two tables are displayed:
Multicast Database and IP Traffic.

The multicast database lists the sources of traffic sessions that are available on
the network.

The IP traffic table lists the sessions available from the sources that have been
joined.
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Edit current subscription
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The Edit Current Subscription dialog box allows you to edit the subscription that
is used in Single Subscription mode. The parameters for a subscription are its
multicast protocol (IGMP or MLD), its multicast address, and its optional source
specific address if you are using Source Specific Mode. To automatically join
the subscription upon closure of the dialog box, enable the Join this multicast
checkbox. Also accessible on this dialog box is the Set Supported Protocols
button, which allows you to change the supported protocol version for either MLD
or IGMP. Usually these can be left at the default setting, but there may be times
when you want to force the use of a particular version.

Multicast Database Table. The Multicast Database Table displays the contents of
the multicast database stored in the MTM400A. The entries in the database are
color-coded according to the state of the subscription; the states are as follows:

Not Joined No request to join this subscription has been sent, or a Leave
request has been sent for a previously joined subscription.

Processing The Join or Leave request is currently being sent to the network.

Join Requested A Join request has been sent out on the network but no matching

traffic has been detected.

Joined Traffic matching the subscription has been detected on the
network. A session will only cause a match if the destination IP
address is the same as the subscription's multicast address. If
the subscription also specifies a Source Specific address, this
must match the session's source IP address.

The Actions button on the right of the Multicast Database table, lists all the
available actions. These include joining, leaving, subscription management,

and setting the supported protocols. It is also possible to populate the database
automatically according to the detected traffic using the Mimic Current Sessions
option; this will not overwrite the current subscriptions but will add to them.
Additionally, the context menu for the table includes the option to copy the table
or selected row contents in CSV format to the clipboard. Double-clicking a row in
the table is equivalent to clicking its Join/Leave button. Double-clicking on the
empty space at the bottom of the table will open the Add Subscription dialog box.

The current Network Interaction setting is displayed above the table. This setting
dictates whether the network card will send outgoing traffic, for example, IGMP
Join messages. Consequently if IPv4 (or IPv6) is set to passive, no IGMP (or
MLD) or Ping messages will be sent by the interface card, and actions that would
produce outgoing traffic will be disabled on the context menus.

In Multicast Database mode, editing an existing subscription is not supported. The
Add Current Subscription dialog box must be used to create a new subscription;
this can then be edited. The Add dialog box is identical in contents to the Edit
Current Subscription dialog box.
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IP Traffic Table. This table shows the sessions or "flows" detected by the network
card.

The number of sessions and the total bitrate are displayed above the table. The
currently selected session being routed for deeper analysis is shown highlighted
(and is marked in the Active column, if visible). Additionally, the context menu
for the traffic table includes the option to copy the table or row contents in CSV
format to the clipboard.

Double clicking on a row in the table is the equivalent of selecting that session
for deeper analysis. Double clicking on the empty space at the bottom of the
table will open the Add/Update Session Alias dialog box. Note that selecting a
session will automatically set the Session Selection Criteria parameters on the
Configure Interface dialog box.

Aliases. To better distinguish the sessions in the traffic table, it is possible to
create a list of "aliases", which are names up to 32 characters in length.

An alias will be assigned to a session if it matches the specified destination
address, the optional destination port, and the optional source address. Aliases
will be displayed in the Session Alias column. For adding multiple aliases, it is
recommended to download the Session Aliases list for manual editing in a text or
XML editor. This list can then be uploaded to overwrite the previous list.
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Starting analysis

1-26

To start the analysis, follow these steps:

1. After you have selected the file for analysis or set up the real-time interface,
click OK to continue.

The TSCA software starts analyzing the selected stream. During deferred
analysis, a progress bar is displayed. The TSCA starts reporting analysis
results. (See Figure 1-12.)
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Figure 1-12: TSCA window showing analysis progress

2. When sufficient data has been gathered and the display has stabilized, you can
start using the TSCA to view the analysis.

3. To restart analysis of a stream, select Analysis > Restart Analysis.

4. To analyze another stream, open the Open File Analysis dialog box or to select
another real-time interface, open the Select Real-time Interface dialog box.
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Setting the stream content font

Selecting the display font

You can configure the TSCA software to display stream content information in a
user-defined font style or language, such as Japanese or Chinese.

NOTE. How the TSCA displays the text strings carried in the stream itself is
dictated by the TSCA font setting and by the interpretation standard that is used
during the analysis.

How the TSCA displays entries in the Event Log is dictated by the TSCA font
setting and fonts used by a your local computer. For example, if the default
language of the TSCA computer is Japanese, the event log will be displayed
in Japanese characters. You must choose a suitable font for the characters to
display correctly.

Perform the following steps to set the font that will be used by the TSCA software
to display stream content. You can configure the TSCA software to display stream
content using any font that is installed on your computer.

1. Select Settings > Configuration to open the Configuration dialog box.

2. Seclect Preferences > Font in the configuration navigation tree to display the
Font pane. (See Figure 1-13.)

3. The dialog box lists the default font that is used by your computer for the Log
Entries and Stream Content displays on the TSCA UI. Use the Font Name and
Font Size drop-down boxes to select a desired font style and size.

4. Click OK to accept and save any changes.
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¥ Configuration

|=%| Font @
Use this page to change the fonts used throughout the application. For instance, when displaying
stream content in a language different from the operating system default, select a font that
supports the language's character set. Additionally, the font sizes may be increased to provide
better readability on small screens.
More information on what each font is wsed for is displayed by hovering the mouse cursor o ver the font row.

Faont Flzme Loczhe Defauit Font
Standard < <default=> Normal Tahoma
Log Entries wsgefaults» Narmal Sansserif
Stream Content ==adefault== Normal Sansserif

Set to Default sets all the fonts to the name shown in the Locale
Set to Default

Default Font column and sets the sizes to Normal.

Copy Standard sets the Log Entries and Stream Content fonts

to the currently selected Standard font mname and size, Eooystandad

Click Apply to immediately see effect of new font settings.

Figure 1-13: Selecting a display font from the Configuration dialog box

Installing Asian language =~ Computers that are using local versions of MS Windows (such as Japanese or
fonts  Chinese), should have the Asian language fonts already installed on their systems.

If your computer or MPEG test system does not have Asian fonts installed,
perform the following steps to install the Asian fonts:

1. Insert the MS Windows OS CD-ROM, which was supplied with your
computer or MPEG test system, into the CD-ROM drive.

2. Locate the LangPack directory on the CD-ROM. This directory contains a
number of *.inf files for various languages. For example, you may want to
install japanese.inf and tchinese.inf, for Japanese and Traditional Chinese
language fonts.

3. To install new fonts, right-click on each desired font file in the LangPack
directory and select Install.

4. The new fonts you installed should now appear as possible font selections
in the Configuration dialog box. You must select the new font in the
Configuration dialog box before the new font will be used to display stream
content.
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Loading a custom  The ARIB specifications for the ISDB standards use private extensions to the
extension font  standard Unicode character set [0xE000-OxF8FF]. These extensions allow you to
add additional characters and nonstandard proprietary characters to an existing
font. The extension sets are provided as TrueType Extension files (*.tte). Any
extension sets should be installed using the Private Character Editor, supplied as
part of the standard MS Windows installation.

To install a font extension set on your computer:
1. Open the MS Windows Private Character Editor.
a. Select Run from the Start menu.
b. Enter eudcedit in the Run dialog box and click OK.
2. After the Private Character Editor opens, close the Select Code dialog box.
3. Select Font Links... from the File menu.

4. In the Font Links dialog box, select Link with Selected Fonts.

NOTE. If you select Link with All Fonts, the following actions will overwrite
any existing font extension sets.

5. In the Select Fonts box, find and highlight the font to which you are adding
the extension. This font should be the one you selected in the TSCA font
preferences dialog box.

6. After you select the font to which you are adding the extension, click Save As.

7. In the Modify Private Character Filename dialog box, browse to the TrueType
extension file that you are adding (*.tte) and click Save.

8. In the Font Links dialog box, click OK.
9. Close the Private Character Editor window.

10. To verify that the font extension has been successfully installed, open the
Character Map application.

a. Select Run from the Start menu.
b. Enter charmap in the Run dialog box and click OK.

11. Browse through the font list for the name of the font to which you added the
extension. The term "Private Characters" should follow the font name. When
you select the font name in the list, you can view the extended character set.

12. Close the Character Map application.

The new font extension you installed should now appear as a font selection in the
Configuration dialog box. You must select the new font in the Configuration
dialog box before the new font will be used to display stream content.
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TSCA - Understanding the TSCA window

On start up, you can immediately open and analyze a transport stream. (See
page 1-6, Starting the TSCA software.)

¥ C:\est streams\Sym3.mpg - MPEG TS Compliance Analyzer

Analysis Wew Davigation Settings Capturs¥u™ Help

‘ E FlexWuPlus™

p Analy:

Enable Thumbnails Display Format:

|E |4 & Transport Stream: Id 1, Network Name:
Nurmber of Programs z
Mean TS bit rate 16.000 Mbps
Mean T5 bit rate excluding Null PID 3.051 Mbps.

#® Adherent|

Shaw Fler &)

29. TABLE
TENNIS

Adherent Il

Test Failures (new additions shown shaded)

@ 16PD(3 @ 1.1 3ync (@)

@ 2.6 CAT (Scrambling) (26) @ 1.2 5yncByte (2)

@ 3.1 MIT (Table ID) (8} @ 1.3PAT (Table 1D} (3)
@ NIT Actual Timer (1) @ 1.3PAT (Scrambling) (1)
@ 5.4.aUnref PID (3) @ 1.4 Continuity (17}

@ EIT Ackual PF Min Any Section Reptn Ink (32) () 2.2 CRC (2)

@ EIT Ackual F Timer (1) @ 75 Availability (2)

@ EIT PF Presence (2)

-

i) This device can perform faster

This USB device can perform Faster if you connect it to 5
H-Speed USB 2,0 pork.
For alist of avallable potts, cick here.

[ untitled - Paint

+4 start

Figure 1-14: FlexVuPlus window
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The analyzer window as shown in the following figure will be displayed when
the Analyzer tab is selected.
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Figure 1-15: Analyzer window

TSCA top level displays

The TSCA has two top level tabs: FlexVuPlus and Analysis.

The FlexVuPlus display enables the TSCA to perform like a 4-in-1 monitor on a
single incoming stream. The display allows you to select up to four concurrent
views of a monitored stream and provides the ability to configure each of the
four views independently. Setting up and configuring the FlexVuPlus display is
described in the MTS4000 Quick Start User Manual.

The remainder of this section describes elements in the Analyzer window.
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TSCA window components

The TSCA window contains the following components:

Menu bar  The Menu bar provides access to a selection of system options using drop-down
menus. (See page 1-135, Menu bar and options.)

Toolbar  The buttons displayed on the toolbar provide shortcuts to often-used menu
options. Additional buttons displayed during real-time analysis are shown in
the following table:

Table 1-2: Toolbar icons

Deferred and Real-time Analysis

IE Opens the Open Transport Stream dialog box.
Restart lysis.
'@ Restart Lnalysis estarts analysis
Q F 4 User actions are recorded during a session. The forward and
- arwar back buttons allow you to step through the actions in order to
|Q Back review or repeat them.

& Preferences Opens the Preferences dialog box from which you can set your

preferences.
CaptureVu
View CaptureVu status.
HD Resume file analysis.
IIi Stop and capture analysis.
Real-time analysis
y View record setting.
© sm Arm record feature.
B Start Start recording.
B stop Stop recording.
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Progress bar  The progress bar indicates the progress of processing during deferred analysis
of a stream.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis Wiew MNavigation Settings CaptureVu™ Help

co - > i1 ® | A @ I

OpenFile... | Real-time... | Standard... | Configuration... | Restart | Complet= IEEIEIEEIEEIRE 100%

To stop the analysis process, click the Stop button on the toolbar.

Navigation view The left side pane in the main window is the navigation view and provides
the main analysis information for the transport stream in a number of forms:
Programs, Tests, SI/PSI, PID, Packets and Interface. Views are selected using
the tabs at the top of the pane. The background of each view is color-coded to
aid identification.

Detail view/panes(s)  The right side pane in the main window is the detail view and provides details
related to the selection made in the current navigation view. The overall view
may be subdivided into one or more panes; you can access individual views in
multiple pane views using tabs.

Status bar  The status bar, when not hidden, is displayed at the bottom of the main window
and shows a summary of stream statistics.

T5 Availabiity @) |Sync )| 19.392589 Mbps @ 183||?| |ATSC | |MNo Extensions || Interface: 4513 | | [l &

Table 1-3: Field descriptions, from left to right

Field Description

TS Availability Indicates either that the stream bit rate has fallen below the
minimum value or that synchronization has been lost. (See
page 1-33.) The minimum stream bit rate is set using the "Min
stream bit rate for processing" parameter.

(See page 1-111, Parameter edit.)

Sync Shows the status of the MPEG sync loss test. Loss of sync
during analysis of a stream may mean that analysis of the
complete stream was not possible.

Bit rate Total bit rate of the transport stream. The packet value (188 or
204) is set using the Preferences feature.

(See page 1-117, Bit rates.)

Packet Size Packets in a stream can be either 188 or 204 bytes long. This is
detected automatically.

Stream Interpretation, This is the set of tests that is being used to analyze the stream.
Base Standard
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Table 1-3: Field descriptions, from left to right (cont.)

Field Description
Stream Interpretation, This subset of tests modifies the base standard; it may add
Region tests or modify existing ones.
Physical Interface The current interface for real-time analysis.
Partial Reception (Available only for ISDB-T streams.) This icon indicates the
- E presence of partial reception data in the stream. The colors
Availability indicate the status as follows:
Gray: Partial reception availability is unknown.
Green: Partial reception data is available.
Gray + red cross: Partial reception data is not available.
Processing Throttle This icon consists of three adjacent LED indicators which
. o show the status of the TSCA processing engine. The left
Indicator

indicator shows the "strained" status (whether throttling is being
applied to cut down on the information being processed). The
central indicator shows the "overwhelmed" status (whether the
processing engine is able to cope with the amount of information
in the stream even after throttling). The right indicator shows
the status of the processing of Sl tables even after throttling.
The colors indicate the status as follows:

(See page 1-36, Error status LEDs.)

Green: OK

Amber: Processing was strained/overwhelmed,
but is currently OK

Red: Processing is currently
strained/overwhelmed

White: Processor state is unknown

Gray: Test disabled

E Shows the status of the system log, which records system-wide
System Log Status events, for example, scripting errors. The color of the LED (in

the body of the icon) indicates the most serious event state in
the log. When the top surface of the icon is gray, it indicates

that all entries in the log have been viewed. Double-click the

icon to view the log.

Gray: The log is empty

Amber: There are entries in the log, but none
since the log was last viewed

Red: There are new entries in the log
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If you choose not to select and analyze a stream, the screen will appear as shown in
the following figure. The analysis structure is present, but with no stream content.
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Figure 1-16: Analyzer window - no file
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Error status LEDs

Test management context

1-36

menu options

Error status LEDs are used throughout the TSCA interface to represent the status
of the tests applied to associated items, such as programs, tests, and PIDs. Colors
used are as follows:

(Red) Error; test failed

(Yellow) Transient error (error not currently being detected but has been seen
since last reset)

(Green) No error; test passed

(Dark Blue) Warning (Interface tab only)

¢ e

(Light Blue) Transient warning (warning not current, but has been detected
since last reset) (Interface tab only)

(Gray): Test disabled

(White) Test not applicable or unknown state

(Red) PID referenced but not found in the stream

8% L€

(Green) PID referenced but not found in the stream. Applicable test disabled.

When an LED represents a parent node in a tree (for example, a program node is
the parent of elementary stream nodes), the color represents the worst case of all
of'its tests and the worst case of all of the tests represented by its child nodes.

Similarly, when an LED representing a parent node in a tree is disabled or
enabled, all subsidiary (or child) nodes are also disabled or enabled to reflect the
state of the parent node. When an LED representing a parent node is reset, all
the child nodes are also reset.

NOTE. The color scheme described here is used throughout the TSCA interface,
for example, the bit rate bars in the navigation views.

Tests can be disabled and enabled as required using the context menu associated
with the LED icon. However, it is important to note that the extent of the action
depends on the hierarchical level of the icon chosen. For example, choosing

Disable from a program node context menu will disable all tests in the program

group.

NOTE. In offline file analysis, if any disabled events are reenabled at the end of
analysis, the LEDs will become green. You will have to restart the analysis if you
want to see the status of the test when the test is enabled.
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Context menus provide an important way of navigating around the TSCA
application. They are available on most displayed objects, for example, program
tree nodes. These menus provide options relevant to the selected object. For
example, after failure, all tests associated with a node can be reset, by selecting
the context menu option Reset All Tests. The context menu options provide both
actions (for example, enable and disable a function) and quick links to associated
objects in other views.

Navigation view tabs

Program | Tests || SIfPSI || PID | Packets : SURMERY | Mo
==
E & E
Nodes @ Transport Streat: 1d 4103, Metwwork Mame: Sandy H A
. =-4@) Frogram 4167,FRC OkE iem Proararm
Context menu (title bar) 0 Qgpu:; = ER Program 4167 BEC ONE
..... .O FiD &0 1 Reset Bit R.ate Limits F
------ a PIDEDZ (0  SekGit Rate Limits. .. T
""" @ P03 Reset Bit Rakes (all programs)
----- Q) PID E50 (1
______ R PID 851 ¢ Shaw Mean Yalues
Context menu options ————— £ s Quick Links:

----- {QPE10051 PR view PMTPID 4167 (051047 in PID kres
""" PIL» 1006 | ‘iew this program's PMT in 51 Tree

------ PIC 1007 §
_____ g PMT PID 4 Qq Go ko next red LED in current bree F3

T

o

Figure 1-17: Context menu (example)

To view context menus, right-click an object. The menus are associated with node
types (for example, a PID node). Node types can be displayed in more than one
view; for example, PID nodes are displayed in the Program view and the PID
view. All context menus have a title bar that indicates the selected node.
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TSCA - Using the Program view
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The Program view is displayed when the Program tab is selected in the navigation
tabbed pane. The navigation view initially displays the top node of the program
tree, which represents the analyzed transport stream from a program perspective.
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Figure 1-18: Program view

The detail view shows details of the node highlighted in the navigation view.
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TSCA - Using the Program view

With the tree expanded, the navigation view shows the makeup of the stream.
(See Figure 1-18.) The stream display consists of the nodes as shown in the
following figure.
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Figure 1-19: Program view nodes

The following table shows which information is available for each node.

Summary
/
Tabs / Now IP MPE Associated Graph - Graph - Event
Node Summary Playing Graphs Sessions  Tests Bit Rate Timing Log Parameters
Transport I I v P - - P
Stream
Program s 4 - P~ e - P P
Elementary - - s 4 4 i< 4
Stream

In DVB analysis mode, the MPE tab is always present. However, the MPE view
will be populated only when MPE data is present in the stream. (See page 1-126,
MPE views.)

Pressing the F3 key on the keyboard (or selecting Go to the next red LED in
current tree from one of the shortcut menus) will highlight the next red LED in
the current view. Only the lowest level nodes will be considered and highlighted in
the search since the parent nodes simply reflect the state of the lowest level nodes.
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TSCA — Using the Program view

Program navigation - transport stream node

1-40

The transport stream node represents the entire transport stream in terms of the
programs that it contains. The adjacent LED icon represents the status of the entire
transport stream; any status error in the stream will be represented by this LED.
When this node is selected, the detail view displays the transport stream summary.

The associated detail view provides a program-orientated overview of the
transport stream, allowing you to see the relative data rates of all of the programs
contained within the transport. A summary of the overall stream is also displayed.
The information can be displayed as either a bar chart or as a pie chart.
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The data rate of a program is the cumulative data rate of all the PIDs that are
associated with that particular program, including PCR and ECM PIDs.

NOTE. Components can be shared between programs, so the overall data rate
of all of the programs may appear to be greater than the total data rate of the
transport stream as shown in the status bar.
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TSCA - Using the Program view

Bar chart  You can display the transport stream bar chart by selecting the bar chart icon.

summary | Thumbriaiss | MPE Sessions |

MNumber of Programs
Current TS bit rate

6
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Current T5 bit rate exduding Mull PID 22.116 Mbps

F « <

Cusrent Bit Rate Cumrent{Mb... Min{ Mbps) )
BBC TEXT 4479 (0x117F) e 0.899 0,594 0,902 3.15%
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Each program identified in the stream is allocated one row of the table. Related
information includes the overall program status (icon), the program name,
program number, and the maximum, minimum and average bit rates.

In addition to the basic display, you can associate a maximum and minimum
threshold value with each program in the bar chart. (See page 1-117, Bar charts.)
For deferred analysis, where these values are set after analysis, the stream must
be reanalyzed for the new values to be applied. In real-time analysis, the new
values will take effect immediately. The color of the bit rate bar indicates that the
program has stayed within the bit rate limits (green) or exceeded the limits (red).

Pie chart  You can display the transport stream pie chart by selecting the pie chart icon.
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TSCA — Using the Program view

Historical multiplex graph

1-42

The pie chart view is divided into two panes. The left pane shows the pie chart,
and the legend on the right provides a list of the component programs. Each
program is color-coded. The overall program status (icon), the program name
and number, and the bit rate are also provided. The values given in the pie chart
labels are bit rates expressed as percentages of the overall bit rate. The Null PID
is shown in this view.

The color of the bit rate labels (and the bit rate values in the legend) reflects
the status of the bit rate measurement, for example, green indicates that the
program has stayed within the bit rate limits, and red indicates that the bit rate
has exceeded the limits.

Click and hold one of the pie chart segments to temporarily display an information
label. Double-click anywhere in the pie chart to toggle the display of all of the
segment labels.

The historical multiplex view is divided into two panes. The left pane shows
the historical multiplex graph, and the legend on the right provides a list of the
component programs. Each program is color-coded. Related information given
includes the overall program status, the program name and number.

‘¥ GigE - Summary | Transport Streamn: Id 1, Network Name: ADHERENT NETWORK

Mumber of Programs 5
Current TS bit rate 41.471 Mbps
Current T3 bit rate excluding Mull PID 39.195 Mbps

Last 1 minute {1 second period) by Programs

[ 5(0x0005) Adherent
B 4 (Dx0004) Acherent 1Y
W 3(0x0003) Adherent I
B 2(0x0002) Adherent I
B 1 (0x0001) Acherent |

Figure 1-20: Historical Multiplex Graph

The Time Period drop-down list allows you to select a range of X-axis time
periods.
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TSCA - Using the Program view

Test status panes The lower view pane allows you to see a summary of the states of all the associated
tests as well as the event log for the entire transport stream (an unfiltered event
log). The test tabs that are available will depend on the interpretation standard that
you choose. For example, with the DVB interpretation standard, the available tabs
are TR 101 209 and Other. Other interpretation standards will generate different
tabs and different sets of tests. (See page 1-160, 7SCA — SI/PSI nodes.)

When any test in the transport stream has failed (and has not been reset), you can
identify which individual tests have failed by observing the red LEDs.

You can use the shortcut menus to reset and disable tests, to set alarms, CaptureVu
Breakpoints and record flags, and to jump to associated tests.

Eventlog  The Event Log screen displays the log entries as shown in the following figure
for the whole transport stream. In deferred mode, the packet generating the error
report can be inspected by highlighting the error and selecting Go to packet
from the shortcut menu. Similarly, in real-time analysis mode, and where an
event concerns a PID carrying a PCR, you can use the shortcut menu to jump to
the relevant PCR graph. Deferred PCAP file analysis enables a shortcut that
allows Ethernet packets to be viewed.

@ R 101290 (133) | @ Other | Q) 5PN Error | = EventLog |

Transport Stream: Id 4103, Network Name: Sandy Heath
Time w | Desoiption
d 00:00:31.778 |TR 104 280 error : mini any section repetition error (ld: DVB EM, Interval: 80ms) end, durati... |5
° 00:00:31.687 |TR 104 2580 error 1.6 PID_error pid 603 [0x25k6] timeout: start ? =
3 00:00:31.652 |TR 101 280 error : mini any section repetition error (ld: DVB EM, Interval: Oms) start 508431
Q 00:00:30.800 |SDT Timer error end, duration 2017ms 454124
3 00:00:30.797 |TR 101 280 error 1.6 PID_error pid 643 [0x2&3] timeout: start 7
i 00:00:30.784 |SDT Timer error start ?
3 00:00:30.714 |TR 101 230 error . mini any section repetition error (id: OVE EM, Interval: 31ms) end, durati... |432752
i 00:00:30.671 |TR 101 280 error . mini any =ection repetition error (id: 0VE EM, Interval: Gme ) start 452055
@ 00:00:30 885 |TR 101 Z80 error : mini any 2ection repetition error (id: DVE EIT, Interval: 130ma) end, dura... |481853
3 00:00:30.608 |TR 101 250 error 1.6 PID_error pid 603 [0x25b] timeout: end, duration 3908ms 491043
i 00:00:30.58% |TR 101 280 error 1.8 PID_error pid 623 [0x261] timeout: start ?
3 00:00:30.523 |TR 104 280 error : mini any section repetition error {ld: 0VE ET, Interval: 8mes ) start 438673
Q 00:00:30.164 |TR 101 290 error : minimum any s=ction repetition error (ld: DVB EMT, Interval: 482ms) end, dura... (483915 .

Figure 1-21: Event log

Three buttons are available in the Error Log toolbar: (See page 1-113, Event log.)
Table 1-5: Event log buttons

Icon Description

_P / g Pin log / Log is pinned

@ Export log

X Clear log
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TSCA — Using the Program view

IP graphs  The IP graphs, where available, are as follows:
B Packet Interarrival Time (PIT): Shows the mean interarrival time of IP packets.

B PIT histogram: Shows the distribution of packet arrival intervals. The X
axis contains accumulators where interval times are collected. The Y axis
corresponds to number of intervals that collect in each accumulator. (PIT
histogram graphs are only available when analyzing PCAP files.)

B Ethernet flow rate: Bit rate of the Ethernet flow being analyzed.

The available graphs vary, depending on which IP interface option is being used.
Unavailable graph names will be grayed out in the selection menu.

| Summary IThurnbnaiIs IP Graphs | g

AddEraphE‘.| Y :EE mEE

Available Graphs
Packet Interarrival Time (PIT)

v
v Ethernet Flow Rate

|
! Add All Graphs

Remove Other Graphs
Femove All Graphs

T

NOTE. Graph management and timing graphs are described in more detail in the
Common User Interface Concepts section of this manual. (See page 1-97, Graph
management.) (See page 1-103, Timing graphs.)
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TSCA - Using the Program view

Program navigation - program nodes

Each of the program nodes in the transport stream represents a single program
referenced within the stream. When a program node is selected in the navigation
view, the detail pane displays the details of the program. The LED adjacent to the
program node represents the status of its child nodes (elementary streams) and
the related tests.
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[§8 852 (0x280) %0B) (DSM-CC U-N messages 0.000 0| 103 (0x67)
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@ 4167 (0x1047) 0.250 0

< | >

TS Avaisbiity | |Sync )|| 24.128335 Mbps @ 188|| 204 | 511,360 Packets | DVB || Mo Extensions| | [l

The program detail view provides you with an overview of the selected program,
allowing you to see the relative data rates and stream types of all of the PIDs that
are associated with the program (including PCR and ECM PIDs). If the program
contains an MPEG?2 or H.264 video stream, it is decoded to produce a thumbnail
picture of the content; this is updated during real time analysis. Similarly, where
EPG information is associated with the program, a summary (Now and Next
program) is displayed. PID content is indicated using icons. (See page 1-94,
Icons.) Bar chart and pie chart views are available.
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VLC Media Player

PID related information is available under the Summary tab.

The Thumbnails tab displays thumbnails and details of the streams for each of the
programs (where available). (See page 1-109, Thumbnail views.)

The Program Tests tab shows tests related to the program. Similarly, the Bit rate
Graphs tab displays the program bit rate in graph form.

Many tests have associated parameters; these parameters are set by the selected
standard, but you can modify the settings. (See page 1-111, Parameter edit.)

The Event Log shows the errors for the highlighted test. When no tests are
selected, the event log will show the events related to all tests associated with the
elementary stream selected in the program tree.

The VLC Media Player is a portable multimedia player for various audio and
video formats. The player allows program content displayed in the TSCA
thumbnails to be played in a larger window. The media player is automatically
accessed from the TSCA when you choose to view or listen to the video and audio
content of program streams.

NOTE. The VLC Media Player is not installed as part of the MTS4000 system.
Installation of the player is described in the MTS4000 Quick Start User Manual
(Tektronix part number: 071-2970-xx). You can find full documentation of VLC
on the Videolan Web site, http://www.videolan.org.

To start the media player, click the start button (below the thumbnail) in the
Program Summary view.

% H® @ PID 600 (0x258)

The VLC Media Player opens and the selected program content (video and/or
audio) plays. To close the player, click the stop button (below the thumbnail).

NOTE. The VLC Media Player may open behind the TSCA window. Use the
Windows controls to bring it forward.
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Elementary stream
analysis

TSCA - Using the Program view

The elementary streams in the selected program can be examined in more detail
using the MTS4CC Elementary Stream Compliance Checker or the MTS4EAV7
HEVC / AVC Video and Compressed Audio Analyzer. Select the ES icon below
each thumbnail picture.

Pl % @ PID 600 (0x258)

Program navigation - elementary stream node

MTS4000 and MTS4SAV3 Analyzer Applications User Manual

Each of the elementary stream nodes in the program tree represents a single
elementary stream referenced by the parent program. When this node is selected,
the view pane displays the Elementary Stream summary view.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
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() PID Eit Rate Variability

Q Discontinuity

88 pD 1007 (0x3EF) i1
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O Program 4543 (0x11BF) BBC PARLMNT /3 aw

—j EventLog |

1.6 PID PID 603 (0x258) Bx+
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When you hold the cursor over the elementary stream node, a tooltip provides the
stream type and description.

a Transport Strearmn: 1d 4103, Network Mame: Sandy Hes

=I-4g Program 4167 BEC ONE 'Sk —
S ® 3P D E0D e 3

L PID A0 (0x253) A % 1.4 Conkin

-$8 PID 502 (0x258) A Prreambype: 2 (0r0D2) (MPEG-2 ¥ideo)
0 FID A03 (x256) (=) FID carries a PCR.

-{) FID 530 (0x284) 151t @ 23bPkR
- §8 PiD 631 (0x286) Wi (D 24PCRA
-8 PID 552 (0x28C) 14 @ 25FTS
N DIm A NNE fReTEr SEe W ad 5 hre

An LED associated with each elementary stream node indicates the status of the
tests relating to the elementary stream.

When the selected elementary stream PID contains timing information, PCR
trend analysis views are also available, allowing you to display graphs of PCR
accuracy and PCR interval data. When the transport stream contains timestamped
data, the PCR overall jitter, PCR frequency offset, PCR arrival time, and PCR
drift rate graphs are also available.

NOTE. Graph management and timing graphs are described in more detail in the
Common User Interface Concepts section of this manual. (See page 1-97, Graph
management.) (See page 1-103, Timing graphs.)
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@ |P - MPEG TS Compliance Analyser EEX]
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Program | Tests | sypst | Po | packets| || @ ssocisted Tests | Tiving Graphs | Bit rate Graphs|

Graph:
- Transpert Strean 1d 20, etwork Hame: TEK BEE ) AEEE B
Program 1 TEKT &1 Data at Cursor
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8l I Ii'
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Figure 1-22: PCR Graphs view
The Associated Tests tab shows tests related to the elementary stream node.

Many tests have associated parameters; these parameters are set by the selected
standard, but you can modify the settings. (See page 1-111, Parameter edit.)

Similarly, the Event Log shows the errors for the highlighted test. When no tests
are selected, the event log will show the events related to all tests associated with
the elementary stream that is selected in the program tree.
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TSCA - Using the Tests view

The Tests view displays test information that is relevant to the transport stream

being analyzed. The view is displayed when the Tests tab is selected in the
Navigation tabbed pane. (See Figure 1-23.)

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis Wiew Mavigation GSettngs CaptureVu™ Help
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) & @ Other e @ 1.4 Continuity @ 2.3.b PCR Discontinuity Indicator @ 3.4.aUnref PID
! @ sFNEmor @ L5aPMT (D 2.4PCR Accuracy (@ 3.5.2SDT Actual (14)
@ Informational Events @ 16PD (43) g 2.58Ts gm; SOT Other
2.6CAT 3.6.3EIT Actual (56)
@ 3.6.bEIT Other
@ 3.6.CEITPF
@ 3.7RsT
@ 38107

¢|| TestFaiures | 4 Event Log|

@ NIT Actual Max Section Reptn Int (1)

@ NIT Actual Max Subtable Reptn Int (1)

@ 50T Actual Max Section Reptn Int (2)

@ 5DT Actual Max Subtable Reptn Int (2)

@ SDT Other Max Subtable Repin Int ()

@ EIT Actual PF Max Subtasle Reptn Int (6)
@ EIT Actual PF Min Any Section Reptn Int (56

@ SDT Actual Timer (14)

!T‘S Availsbility QHsync Q@)|| 24128335 Mbps @ mﬂj\znq‘[sn,:ﬁn Packets|| DvB| | Mo Extensions| ‘i =]

Figure 1-23: Tests Navigation view
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The view displays a test tree, which represents all the tests that have been applied
to the analyzed transport stream. The following figure shows the nodes available
in the navigation view.

Program | Tests | SUPSI| PID || Packets

ests All Tests
= @ TR0 280 Group
= Priority 1 Priority
= ) Priority 2
QD 21 Transport < Test
Q 220CRE

Q) 2.3 a PCR Repetition
Q) 23 b PCR Discortinuity Indicator
Q) 24 PCR Accuracy
= Q25PTS
() PID 210 (0xD2) «—————  Associated PIDs
) PID 220 (0xDC)
O PID 3100 (0x136)
) PID 410 (0x194)
) PID 510 (0xX1FE)
= Q2scat
() 26 CAT (Table D) <————  Sybset
@ 25 CAT (Serambling)
() CAT man: subtable Rl
= G Priority 3
2 (D Other = Group “Other”
# () SFM Error

Figure 1-24: Test view nodes
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Test structure

The test tree structure represents all of the tests that can be applied to a transport

stream complying with a particular digital video standard: MPEG, DVB, ATSC,

and ISDB. The standard must be selected before beginning analysis. The test tree
contains nodes for each test that the analyzer can implement.

An example of a tree structure for a selected standard is the TR 101 290 group of
tests for DVB transport streams. (See Figure 1-24.) The Group node is split into
priority groups: First Priority, Second Priority, and Third Priority. Each of these
priority groups contains a number of individual tests.
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@ SDT Other Max Subtable Repin Int ()

@ EIT Actual PF Max Subtasle Reptn Int (6)
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Test grouping differs between digital video standards. However, all of the
currently implemented standards contain a subset of the relevant TR 101 290 tests.
Note that in standards other than DVB, the tests are not numbered.

Where relevant, PIDs will be associated with a test in the test tree when the test
has either been disabled, or when it has failed.

The LED associated with each node indicates the status of the node and its child
node tests. (See page 1-36, Error status LEDs.) Total entries in the Event Log
for each group of tests and for each test are indicated in parenthesis; resetting a
group of tests or a test restarts the count in parenthesis.
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TSCA — Using the Tests view

Test filtering  Interpreting the display of tests can be made easier using the three filter buttons at
the top of the Tests navigation view.

Show: ) ) & q [l

Grey White Green

Figure 1-25: Test filtering buttons

When a button is selected, it hides a category of tests in the test tree display, as
follows:

B QGrey - hides disabled tests
B White - hides tests with unknown or not applicable status

m  QGreen - hides tests with OK status
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TSCA — Using the Tests view

Tests navigation - all tests

The detail view when the All Tests node is selected. (See Figure 1-23.) In addition
to a summary of all tests, the event log shows the most recent 10000 events that
have occurred during analysis of the stream.
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TR 101290 (123
@ Friorty 1 (44)
@ Priorty 2

! 5@ priomy 3 (89) @ 13.aPaT (@ 2.3.2 PCR Repetition @ 3.2 5IRepetition (17)
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Figure 1-26: Test Failures screen

The Test Failures view provides an overview of the tests that have failed during
stream analysis. The view is divided into two panes. The left panes shows those
tests that have failed in the last second. The right pane shows those tests that have
failed, not including those that have failed in the last second, and are displayed on
the left side.

If a test fails, it will be displayed on the left side. When it no longer fails, it will be
removed from the left side and listed on the right side as a test that has previously
failed. If the test fails again, it will be removed from the left side and redisplayed
on the right side until it no longer fails.

Additionally, tests that have been listed (in either pane) in the last second are
displayed at the top of the list and shaded.
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Test navigation - test nodes

TSCA — Using the Tests view

When you select a test node, the Associated PIDs pane displays a summary of
all of the PIDs and an event log listing all events that are associated with the
test. Where parameters are applicable to the test, you can modify them under

the Parameters tab.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
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@ FID 523 (0x25F)
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@ PID 641 (0x281)

in this test:

|

—}4 Event Log |

[, i < >
®

! 00:00:31 697 ITR 101 280 error 1.6 PID_error pid 603 [0x25b] timeout: start

[ 00:00:30.797 [TR 101 280 &rror 1.6 PID_error pid 643 [0x253)] timeout: start
[*] 00:00:30.608 [TR 101 280 error 1.6 PID_error pid 603 [0x25b] timeout: end, duratio
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[*] 00:00:29.755 [TR 101 280 &rror 1.6 PID_error pid 643 [0%263] timeout: nd, duratio
[*] 00:00:29.239 [TR 101280 error 1.6 PD_error pid 623 [0x261] timeout: end, duratio.
2 00:00:28.187 [TR 101 250 error 1.6 PID_error pid 613 [0x265] timeout: end, duratio.

|T5 Avallabiity QHsync Q|| 24128335 Mbps @ 188 | 204) [ 511,360 Packets| DVB| Mo Extensions| \E@‘
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TSCA — Using the Tests view

Test navigation - PID nodes

Where tests have failed, the PIDs affected are listed under the test node in the Tests
navigation view. Selecting a PID will display the Event Log in the detail view.

Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
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P12 Vigw PID 623 (0x267) in PID Ty Set Al to Neminal_| | | [ Cancel

!T‘S Availsbility QHsync Q@)|| 24128335 Mbps @ mﬂj\znq‘[sn,:ﬁn Packets|| DvB| | Mo Extensions| ‘i =]

NOTE. The screenshot also shows the Edit Parameters dialog box, which is
available from the PID node context menu. (See page 1-111, Parameter edit.)
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TSCA — Using the Tables view

The Tables view (SI/PSI tab) displays service information in tree form, as in the
other navigation views. The tree represents the service information tables that
have occurred in the analyzed stream and which comply with the selected digital
video standard. This includes MPEG program specific information, DVB service
information, ATSC and ISDB program information, and system information
protocol. The tree contains nodes for each table that is found; tables/nodes are
grouped together by functionality. The following figure shows an example of the
Table navigation view with DVB stream interpretation selected.
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Figure 1-27: Tables view

Every node within the service information tree has a corresponding summary
view. Nodes that represent tables will also provide you with access to the table
structure and hex data. (See page 1-59, Tables detail view - Section view.) (See
page 1-61, Tables detail view - SI repetition graphs.)

Some of the nodes that represent less common tables or table groups may not
have specific summary views available in the analyzer. In these cases, a generic
summary view is used.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual 1-57



TSCA — Using the Tables view

Table summary pane

EPG views

1-58

The table summary view provides a summary of the table related information for
the analyzed transport stream. There is a table summary view for every node of
the service information. The content is dictated by the selected node.

All summary views for nodes that represent an individual table or subtable

will display the table identity and version number of the table from which the
information is extracted. Where relevant, links (underlined text) are provided to
associated objects, for example, in the programs summary, links are provided to
the individual program summary views. Similarly, arrow icons provide links to
the electronic program guide (EPG) tables. (See Figure 1-28.) Where the section
is carried on a PID, a link is also provided to the PID view.

The following shows an example of the summary pane with the PMT PIDs node
selected in the navigation view.
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Figure 1-28: Tables view - Programs (example)

A specific departure from the Table Summary view described previously is the
EPG view that is displayed when a section of the EPG table is highlighted. For a
description of the general presentation of the EPG view. (See page 1-122, EPG
view.)

MTS4000 and MTS4SAV3 Analyzer Applications User Manual



TSCA — Using the Tables view

Tables detail view - Section view

The detailed section view is available when the selected node in the service
information tree represents a table or subtable in the transport stream. During
real-time analysis, the view is continually updated.

The subtable identity, version, and section are displayed at the top of the table
pane.

NOTE. In deferred mode, where two or more subtables, versions or sections are
found in the stream, the relevant field is active, and an alternative selection can be
made from the drop-down list.

In real-time mode, only the latest version and section can be viewed.
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The table pane shows all fields that make up a section (for example, PMT). The
fields are arranged in a hierarchical order. The presence of subordinate fields is
indicated using { } bracket symbols adjacent to the container field. The container
can be expanded or collapsed by clicking the + or - icon.
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1-60

Below the table pane, the data source is displayed. The data pane shows the data
bytes (in both hexadecimal number format and ASCII character format) for the
selected table, version, and section. When a node is selected in the table pane,
the bytes that make up the selected node (including the subordinate nodes) are

highlighted in the hexadecimal data pane as shown in the following figure.
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-{} STD_descriptor

s

0z

EO
OC 52 0
FO 08
04 04
05 58
52 01
oo oo
ol 70
0l &6

10 47 DS 00 00

02 0& 04 &85
67 03 52 01
gE &7 10 00
05 00 00 o0
EE FO 03 52
84 FO 03 52
8C FO 03 52

ol
GE
65
13
E3
Ez
Ez

06
ol
ol
ol
ol
ol

06
ulu]
ulu]
&F
65
67

FO
E3
ol
[Ei
o)z
e

5a
FO
ol
03
03

ol
1z
ol
5a
52 slocoocloBoooon

Figure 1-29: Section payload

If the section is corrupt or empty, the hexadecimal view background is red instead

of blue.

The pause button in the detail window title bar allows real time section data to be
paused (or frozen), so that it can be examined in detail. The play button resumes
the real time display of section data.
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Tables detail view - Sl repetition graphs

The section graph view is available when the selected node in the service
information tree represents a table or subtable in the transport stream. You can
view graphs of the following data:

m  Section repetition interval: This graph displays the interval between two
sections of a table on a particular PID.

m  Subtable intersection gap: This graph displays the interval between sections
in a particular subtable.

B Subtable repetition interval: This graph displays the time between receiving
one complete subtable and receiving the next complete subtable.

NOTE. Not all of the above graph types are relevant to all table types. (See
page 1-97, Graph management.)

Export SI/PSI as XML

The export control in the top left corner of the SI/PSI navigation pane opens the
Export SI/PSI as XML dialog box. Enter an output file name (and path) and
select the required options.

¥ Export SI/PSI as XML

Output File

|c: \temp\test, xmi| |@

Options

Indude 51 tree structure Incude subtable information

Labest version only [] Include section data

& File 'c:\temp\test, xml' already exists and will be overvwritten,

0K l [ Cancel
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TSCA - Using the PID view

1-62

The PID view displays information about all of the PIDs found in the transport
stream being analyzed. The navigation view contains the PID tree structure
representing all of the PIDs that have occurred within the transport stream.

\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser

jew Navigation Settings Captureyu™ Help
| = FIexNuPIus"" pAﬂa'VS'E|
[ Programs | Tests | st/pst| PIDs | Packets| N
Actions v | @ B
[BRC- J 21 PDs (47): Nework Name: Sandy Heath [
@ Reservad PiD= (6)
@ Referenced PiDs in stream (41) 5
@ P 800 inx2se) ER D 1 o
@ PO 601 (1x258) A @ |16 (0x10) 5 K 0.000 0 ~
8 Po 60z in2sa) A [§8 502 (0x258) AN 0.000 0 B
@ r 603 iesE) B (88 651 (0x288) | 0.000 0
() PID E10 (0x282) ' [§8 [e52 (0x250) g1t 0.000 0
@) PDE11 (0x263) A [§8 652 (0x238) N 0.000 0
@ PD 612 i0x264) A |98 |63 (0x297) N 0.000 0
@ P 613 (x285) 2 [§8 [1008 (0x3EE) N 0.000 0
@ PID 620 i0x28C) ' ® [$8 [1007 (0x3ER) N 0.000 0
(@ PD 621 0x26D) A [$8 1008 Ox3F 1) N 0.000 0
@ P 622 joxzsE) A [§8 [1010 (0xF D) N 0.000 0
@ P 623 itxzeF) 2 ||| (881012 (ox3F D) [ 0.000 0
@ P 620 (0x280) =3 T} S| |88 101z xzFs) W 0.000 0
@ PID 641 0x281) A -|[| |[$8 1015 ©@x3F 7 W 0.000 0
@ P ez ioxesy 2 2|l |[$8 1016 (ox578) N 0.000 0
@ PD 650 i0x284) i 620 (0x26C) (5] e |y 0.004 0
8 P 651 i0x288) 610 (1x262) D] e 0.005 0
$8 P 852 inx2ac) 1§10 640 (0x230) [C] e Y 0,006 [1] |
- PID 653 (0x28D) 04¢ 650 (0x28A) L 0.006 [
@ PG50 (0x204) A D o /600 (0x258) O e 0.007 0
Q P 661 (0x285) 611 (0x263) AN 0.019 0
$8 P es2 ix208) 641 (0x281) AN 0.019 0
88 P es3 inx207) 601 (0x2585) AN 0.037 0
@ PID 1005 (0x3ED, 621 (0x26D) AN 0.037 0
$8 P 1005 (0x32E 660 (0x294) D AN 0.045 0
8 P 1007 (c3EF) 1810 612 (0x264) ] 0.071 0
@) PID 1008 (0x2FD) 622 (0x26E) A 0.071 0
88 P 1003 (0x3F1 653 (0x28D) Wil 0.100 0
& P 1010 (0x3F2, 1005 {0x3ED) 0.100 0 e
@ PD 1011 (0x3F3] 3 < =
-
|T5 Availability Q“sync Q|| 24128335 Mbps @ 188 | 204|511, 360 Packets | 08| |10 Extensons| | [ 6

In DVB analysis mode, the MPE tab is always present. However, the MPE view
will only be populated when MPE data is present in the stream. (See page 1-126,
MPE views.)
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PID view - all PIDs

In the navigation view, PIDs are grouped under the following subordinate nodes:
B Reserved PIDs

m  Referenced PIDs

®  Unreferenced PIDs

®m  SI/PSI PIDs

m  User PIDs

B Obsolete PIDs (deferred analysis only)

The number of PIDs in each group is shown adjacent to the node. The root node
label shows the total number of PIDs found and the Network Name.

When highlighted, the All PIDs node displays in the detail pane all of the PIDs
that are found in the analyzed stream.

Each of these subordinate nodes contains PIDs belonging to that group. PIDs are
allocated during analysis, and the number of PIDs is identified for each node. You
can also allocate PID numbers to the User PID node, although User PIDs may not
necessarily have been found in the stream. This feature allows you to compare the
properties of one or more PIDs more easily.

The associated summary view provides a PID-oriented overview of the transport
stream, allowing you to see the relative data rates of all of the PIDs contained
within the transport stream. The information can be displayed as either a bar chart,
or as a pie chart. Columns in the summary views can be sorted in ascending or
descending order by clicking on the column header. PID related information is
available under the PID Information tab.

Each PID is associated with a number of tests. If one or more tests fail, they will
be listed under the relevant PID node in the navigation view. Selecting the PID
node will display a summary, in the detail view, of all associated tests that have
been found. Selecting a specific test in the Associated Tests pane will display the
Event Log and Parameters for only that test.
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PID view - detail view (All PID and PID Group)

1-64

The All PID and PID Group detail view provides you with a PID-oriented
overview of the transport stream. This view is displayed when any of the
main nodes is selected in the navigation pane: All PIDs, Referenced PIDs,
Unreferenced PIDs, or User PIDs.

The view shows the relative data rates of all of the PIDs contained within the
selected node. You can display the information in either a bar chart or a pie
format. The associated test states are shown in all views.
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Figure 1-30: PID Summary view

The PID Information view provides PID related information, for example, PID
type stream type, scrambled status and the presence of PCRs. Layer information is
also shown when analyzing ISDB streams. (See Figure 1-31.) The icons provide
an indication of the PID content. (See page 1-94, Icons.)

Where a PID carries video or audio, thumbnails are displayed under the Now
Playing tab.
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In deferred mode (or during CaptureVu analysis), you can view the packets
carrying a PID by highlighting the PID, and selecting the Go To Packets view from
the shortcut menu. The packet will be added to the PIDs list (in the Packets view).
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Figure 1-31: PID Information view

PID view - detail view (PIDs)

The individual PID detail view provides you with information about the selected
PID. This view will be visible when you select an individual PID node in the
PID tree. If a PID has failed a test, one or more test nodes are displayed as child
nodes of the PID.

The combination and detail of the views vary depending on the selected PID
type and node.

During deferred or captured analysis, the packets carrying the PID can be
examined in more detail by highlighting a PID, and selecting the Go to Packets
view from the shortcut menu.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual 1-65



TSCA — Using the PID view

Ordinary PID selected

PCR PID selected

1-66

When a PID does not contain PCRs, the main view in the PID pane is the
Associated Tests view. This view lists the tests associated with the selected PID.
The status of the individual tests is indicated with LED icons. Also available are
Bit rate Graphs, which show the bit rate of the selected PID in graphical form.

Also on the Associated Tests tab is an event log and a parameters pane. The
event log shows all PID related events. If a test is selected in the PID pane, only
the events associated with that test on that PID are shown. Similarly, when a
test is selected, the Parameters pane shows the parameters associated with that
test (when applicable).

When the selected PID contains PCR information, PCR inaccuracy and PCR
interval data graphs will be displayed in addition to a bit rate graph. When
the transport stream contains time stamped data, the PCR overall jitter, the
PCR frequency offset, and the PCR drift rate graphs will also be available. For
real-time IP analysis, the Packet Interval Timing (PIT) graph is also available.
(See page 1-106, PIT graph.)
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A Presentation Time Stamp (PTS) graph may also be available on PIDs carrying
audio and video information. And a PTS-PCR graph showing the variation
between the PTS and PCR values; this can help detect buffering issues.

(See page 1-97, Graph management.) (See page 1-103, Timing graphs.)
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TSCA - Using the Packets view

NOTE. The Packets view is available only during deferred analysis and CaptureVu
analysis.

Data in the stream is carried in 188- or 204-byte packets. The Packets view allows
you to examine the contents of each packet in the analyzed stream.
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The packet navigation view shows a tree structure which represents the packets
within a stream grouped according to content, including PID value, SFN
mega-initialization packets (MIPs) (DVB only), and ISDB-T information packets
(IIPs).

The All Packets, MIP and IIP nodes do not have any child nodes. The All Packets
node represents all of the packets in the transport stream. The MIP node represents
all of the DVB SFN MIPs in the transport stream. The IIP node represents all of
the ISDB-T information packets in the transport stream.

The PIDs node represents all of the PIDs that are of interest. You can add PIDs
in the transport stream to this node, and to PIDs that are contained within the
user PID list.
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Packet navigation bar
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Selecting any leaf node in the packet tree will apply a packet filter to the associated
packets. For example, selecting a PID node will only allow packets carrying

that particular PID to be displayed in the associated summary view. Similarly,
selecting the MIP node will only allow MIP information to be displayed in the
associated summary view.

Double-clicking the Custom Packet Search node opens a dialog box in which
you can specify strings to search for.

In the packet summary view, you can use the top bar to navigate the packets
in the stream.

Current packet position

The navigation bar functionality depends on the selection in the packet navigation
view. If you select All Packets, the controls will operate on all packets. If you
select a single PID, a filter is in operation, and the controls will work only for
those packets carrying that PID.

Selects the first available packet (in the stream or carrying the
selected PID)

Selects the previous available packet (in the stream or carrying
the selected PID)

Selects the next available packet (in the stream or carrying the
selected PID)

Selects the last available packet (in the stream or carrying the
selected PID)

Opens the Go To Packet dialog box

o) (=] (]| o =]

You can also use the packet position bar to navigate through the stream. To do so,
use the cursor to point to and click the next packet to be displayed. Double-click
the packet number in the bar to open the Go To Packet dialog box. Enter the
required packet number and select OK. For both methods, remember that the
destination packet is dependent on the node selected in the navigation view.
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Packet navigation - filter nodes

The packet filters allow you to view packets carrying PID.

To inspect the sequence of packets carrying a particular PID, you must add the PID
to the PID Filters node in the Packet Navigation view. PIDs carrying sections can
also be viewed. You can add as many PIDs as are required. There are a number of
ways to add a PID to the node, as described in the following paragraphs.

—

Adding a PID in the Packet
view

In the Packet view, expand the PIDs node by doing one of the following:
= Double-click the child node (double-click to add a PID).
= Select Add PID... from the PIDs node shortcut menu.

2. Inthe Add PID... dialog box, expand the nodes, locate and select the required
PID.

3. Click OK.

The selected PID is added to the PIDs node, and the first occurrence of a packet
carrying the selected PID is displayed in the summary view.

Added PIDs will be stored when the application is closed. They will be reinstated
when the application is reopened. However, if a different stream is analyzed, the
stored PIDs may not be used.

Removing PIDs  All PIDs previously added to the PID node can be removed by selecting Remove
All from the PIDs node shortcut menu.
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Packet Detail view
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The detail view shows the fields and data that are contained in a packet. The
fields are arranged in a hierarchical order. The presence of subordinate fields is
indicated using { } bracket symbols adjacent to the container field. To expand or
collapse the container, click the + or - icon.

Below the table pane, the data source is displayed. The data pane shows the data
bytes (in both hexadecimal number format and ASCII character format) for the
selected packet. When you select a node in the table pane, the bytes that make
up the selected node (including the subordinate nodes) are highlighted in the
hexadecimal data pane.
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The packet transport header bytes are displayed in red. Similarly, bytes greater
than 188 are displayed in gray. The adaptation field, where present, is displayed
in blue.

If the section is corrupted or empty, the background of the hex view is red instead
of blue.
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ISDB streams  The following figure shows an example of the packet detail view with an analyzed
ISDB-T stream. Note the IIP tab and the additional TMCC and IIP nodes.
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Figure 1-32: Packet view - ISDB detail -lIP
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TSCA - Using the Interface view

If real time analysis using an interface card is invoked, the Interface tab is
displayed in the Navigation view of the TSCA window.

NOTE. The Interface view is available only if an interface card is selected for
real-time analysis.

Analysis View Navigation Setings Capture¥u™ Record Help

Open File...

B rovupisr £ s
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Q Power
@ Fhase Noise.
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@ BVl Warming
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{* JciR Warning

5 valabitty @) sync @[ 35.576577Mbps @ 153|185 |08 o Extensions| | nterface: DVB-52 Pk > Ast-2|

= e

Figure 1-33: Interface view - example

Two interface card test nodes are displayed in the navigation view: Interface
Errors and Interface Warnings. Each collection contains a range of tests. (See
Figure 1-33.)

The detail of the interface view is different for each interface type.
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Detail view tabs

The detail view contains two tabs: Graphs and Interface Event Log. This section
describes the tabs in general terms. The following sections describe in detail the
tabs associated with each interface type.

Graphs  The Graphs tab contains instantaneous graphs and trend graphs.

The instantaneous graphs display instantaneous measurements in graphical form.
The trend graphs display trends in measurements in graphical form.

Interface event log  The interface event log displays a history of the events related to the item selected
in the navigation view.

Readings and controls

The right panel contains Readings and Controls. The Readings area displays
values received from the card itself.

The RF Lock LED conveys different types of information. If full lock onto the
channel is acquired and it is receiving the signal correctly, the LED will light up
green. When a signal is present but no lock is achieved, the indicator is red. When
no signal is found, the indicator is gray.

In the Readings area, the LED colors are as follows:

Green On
Red Out of range or failed test
Gray Off or not applicable

The Readings background colors are as follows:

White In range

Red Out of range; for example, too much or too little power or out of
order packets per second being greater than zero

Yellow Not recently updated

Gray Not applicable; for example, out of order packets not being

available when the UDP protocol is selected

The Controls area contains user controls. Values entered here will be applied to
the card and will affect its performance. These controls correspond exactly with
those on the Open Transport Stream dialog box.
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RF interface views

This section describes the settings and displays associated with the RF interface
cards.

RF interface - QAM (Annex  The settings and displays of the QAM (Annex B) RF interface card are as follows:
B) QAM(B) Interface Settings, QAM(B) Instantaneous Graphs, and QAM(B) Trend
Graphs.

== =

Analysis View Navigation Setiings Captur Record Help

o
Programs. [ tests =
sipst | pps | padets | Interface

actons v | show: @ & @ | 9, 5 =)

@ Lock LIS

@

Figure 1-34: Interface view - RF - QAM (Annex B)
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Field

TSCA - Using the Interface view

The following QAM (Annex B) settings are available on the Open Transport
Stream - Real Time Analysis dialog box, and also in the Interface tab - Controls
area

Description

QAM(B) - Tuner
controls Frequency
(kHz)

This value, set in kHz units, is the center frequency of the channel to be received. Any
frequency can be entered. There is no need to follow a channel plan. The frequency resolution
is determined by the tuner step size of 62.5 kHz.

Modulation
Format

This drop down list allows 64 QAM or 256 QAM operation to be selected. Note that SCTEQ7
and ITU-Tj83 annex B specify exact symbol rates for the two modulation formats, so there is
no dialog box to enter the symbol rate separately.

Interleaving
Mode

Interleaving assists in the correction of burst noise induced errors. All interleaving modes
mentioned in SCTE 07 are supported, including all Level [l modes up to | = 128 J = 6.

Carrier Lock

This allows the carrier lock range to be increased from the normal +150 kHz to approximately
1500 kHz. This is useful if you are attempting to lock on to badly mistuned or wandering
carriers.

Tuner Phase
Noise

This control modifies the carrier loop bandwidth to allow the acquisition of noisy carriers.
Normal mode is recommended for general use.

Equalization
Range

The channel equalizer can be configured to give a long equalization range, at the expense of
equalizer resolution, or, in normal mode, optimized for typical cable environments. Normal
mode is recommended for general use.
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Table 1-6: QAM(B) Settings (cont.)

Field Description

QAM(B) - RF I and Q data are collected from the QAM front end and displayed as a conventional
Instantaneous Constellation constellation of 256 points by 256 points. The samples collected are not real time, so there is
graphs some dwell (delay) before a complete constellation is displayed. The persistence of the display

can be varied using the Persist slider control at the bottom of the graph.

MER (Modulation Error Ratio) and EVM (Error Vector Magnitude) calculations are performed
on the constellation data according to the formulas in TR 101 290.

SNR after This graph represents the signal-to-noise ratio over time, typically over 256 seconds. It is

equalizer useful for examining signal-to-noise trends, for example, if an alarm condition has been
breached, the graph can be used to examine trends in the signal-to-noise performance before
the alarm occurred.

MER This graph gives a time record of MER over the last 255 seconds.

Equalizer This graph shows the status of the equalizer taps, and gives an estimate of the channel state.
If there are echoes or other time related distortions on the signal, the Equalizer display will
display the amplitude of the corresponding tap correction values versus time.

NOTE. The Equalizer graph amplitude values are approximate.

Trend Graphs. The trend graphs extend the principle of the instantaneous graphs by graphing measurements
over longer periods.

Each graph is associated with a measurement that is also displayed in the Readings panel on
the right side of the display. The measurements have status LEDs associated with them.

Individual trend graphs can be opened by making a selection from the drop-down menu of the
Trend graph or from the context menu of the measurement in the Readings panel.

The following trend graphs are available for the QAM B interface card:
®  RF Lock

® MER

= EVM

®m  Pre-RS BER

E  Input Level

E  SNR after Equalizer

B Carrier Offset
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RF interface - 8VSB  The settings and displays of the 8VSB RF interface card are as follows: 8VSB
Interface Settings, 8VSB Instantaneous Graphs, and 8VSB Trend Graphs.

=l
View Navigation Settings Capt

B FexvuPlus™ | §° Analysis
Programe| Tests | SUPSL | Pibs  Pacets] ntefece |
actors v | show: @ w @ | & B D
ERC Jrieiace trrors 2|
Q Lock (1)
Q uer
Qe
@ BER (Pre Recd-Solomon/BCH)
= @ Power (1)
@ High Power Limk (1)
Q@ Low Power Limit
{Q Power Drift Limt
Q@ sr
@ Carrier Offset
=@ nterface Warnings (1)
@ MER warning
@ EVM Warning
Q@ BER (Pre Recd-Solomon/BCH) Warming
@ Power waming (1)
@ stR warning
@ carrier Offset Warning

q
Graphs | a1

Add Graoh £ | | BB

svss > ast-1] il B

5 vaisbity Q)| sync Q|| 19.382670 Mops @ 188 | 188 [v8 Mo ]

Figure 1-35: Interface view - RF - 8VSB
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Table 1-7: 8VSB settings

8VSB interface settings. The following 8VSB settings are available on the Open
Transport Stream - Real Time Analysis dialog box, and also in the Interface tab -
Controls area.

Field Description
8VSB controls Tuner Enter the required tuned (channel) frequency. Remember to enter the center channel
Frequency frequency, not the "pilot" frequency.
(kHz)
IF Spectrum This can be set to Normal or Inverse, to allow for frequency conversions in the signal chain.
Conversions that use difference frequencies invert the spectrum; additive conversions do not.
Channel State Available options are auto, static, dynamic and fast dynamic. Using these options you can
match the receiver equalizer to the expected channel conditions. The recommended default
setting is auto.
NTSC This setting gives you control over the integrated cochannel NTSC reject filter. Options are
Rejection Filter ~ On, Off and Auto. The recommended default setting is Auto.
Carrier Lock This setting allows you to control the carrier lock range. The Normal setting allows lock over
a £150 kHz range; Wide extends the range to £500 kHz. The recommended default setting
is Normal.
Tuner Phase This control modifies the carrier loop bandwidth to allow the acquisition of noisy carriers.
Noise (Normal Normal mode is recommended for general use.
and High)
Signal NTSC (National Television Standards Committee) and VSB (Vestigial Side Band).
Detection
8VSB Symbol This graph shows the samples received over time in a falling vertical line display. In a noise
Instantaneous Distribution free system, all samples would fall on one of the eight vertical lines. However, in normal
Graphs systems, the samples will be displayed distributed around the vertical lines. At the bottom of

the graph display, the sample values are accumulated into a distribution histogram. The
histogram can be displayed in a linear or logarithmic format.

Signal to Noise
(SNR) (after

The SNR values are plotted in a pen-trace style, giving a brief history of the collected values.

equalizer)

Equivalent An MER (Modulation Error Ratio) calculation is performed on the in-phase (1) data samples.
MER The quadrature data samples are ignored in this calculation.

Equalizer The equalizer coefficients are plotted across the graph display. The display illustrates the

presence of multi-path echoes by indicating how the equalizer is adjusting to cancel them out.

NOTE. The Equalizer graph amplitude values are only approximate.

Trend Graphs

The trend graphs extend the principle of the instantaneous graphs by graphing measurements
over longer periods

Each graph is associated with a measurement that is also displayed in the Readings panel on
the right side of the display. The measurements have status LEDs associated with them.

Individual trend graphs can be opened by making a selection from the drop-down menu of the
Trend graph or from the context menu of the measurement in the Readings panel.

The following trend graphs are available for the 8VSB interface card: RF Lock, Equiv, MER,
EVM, Pre-RS BER, Input Level, SNR after Equalizer, and Carrier Offset.
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RF interface - DVB-S2  The settings and displays of the DVB-S2 RF interface card are as follows:
DVB-S2 Interface Settings, DVB-S2 Instantaneous Graphs, and DVB-S2 Trend
Graphs.

TE¥ DVB-52PSK > ASI-2 - MPEG TS Compliance Analyzer == ==

Analysis View Navigation Settings CaptureVu™ Record Help

P FlexvuPlus™ | §° Analysis

[ rograms [ Test [ stpst [pios [ pageets | iterface
actons v | show: @ & @D | ¥ {1 E)

5@ nnterface Errors.

@ BER (Pre Reed-Solomon/BCH)

Power

Q@ rnase oise

Qowr

Q@ interface Warnings

@ MER warning

@ EVM Warning

@ BER (Pre Reed-Solomon/BCH) Warning
Q@ rower waming

@ Phase Noise Warning

[* JCh viarning

[

75 avabity @[Sy @] 35.576577 Mops @ 159) 199 o8 o T ovesapK > 512

Sl B %)
Figure 1-36: Interface view - RF - DVB-S2
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Table 1-8: DVB-S2 settings

Field

DVB-S2 interface settings. The following DVB-S2 settings are available on the
Open Transport Stream - Real Time Analysis dialog box, and also in the Interface
tab - Controls area

Description

DVB-S2 PSK
controls

Tuner
Frequency
(GHz)

This value is the center frequency of the IF channel to be received (after down conversion in
the LNB where applicable). Any frequency can be entered; there is no need to follow a channel
plan. The frequency resolution is determined by the tuner step size of 1 MHz.

Use LNB
Frequency

Enables/disables the LNB frequency selection.

LNB Frequency (tone off): (GHz) LNB mixer frequency when the LNB 22kHz tone is switched
off.

LNB Frequency (tone on): (GHz) LNB mixer frequency when the LNB 22kHz tone is switched
on.

LNB Power

The interface card incorporates a regulated power supply for control of an LNB (Low Noise
Block) or similar equipment. The supply voltage, using the drop down dialog box, is selectable
between Off (default), 13 V and 18 V.

LNB 22 kHz
Tone

A 22 kHz tone is provided for control of an LNB (Low Noise Block) or similar equipment. The
tone, using the drop down dialog box, is selectable between Off (default) or On.

S2 Stream
Filter

When enabled, you can select one stream from multiple stream that may be encoded in the
RF signals using the input stream identity (Input Stream ID).

S2 Input Sync

For slow RF signals carrying multiple streams, this setting enables a stream synchronization
and smoothing function.

PL Scrambling
ID

Physical layer scrambling is used to spread the spectrum of the transmitted signal to reduce
interference. You can select a specific Gold code to descramble the RF signal or Auto to
cycle around up to 10 possible codes. Individual codes can be selected; these will act as a
conditional access system or, in auto mode, increase priority.

DVB-S2 PSK
Instantaneous
Graphs

Constellation

I and Q data are collected from the QAM front end and displayed as a conventional
constellation of 256 points by 256 points. The collected samples are not real time, so there is
some dwell (delay) before a complete constellation is displayed. The persistence of the display
can be varied using the Persist slider control at the bottom of the graph.

MER and EVM calculations are performed on the constellation data according to the formulas
given in TR 101 290.

DVB-S2 PSK Trend Graphs

The trend graphs extend the principle of the instantaneous graphs by graphing measurements
over longer periods

Each graph is associated with a measurement that is also displayed in the Readings panel on
the right side of the display. The measurements have status LEDs associated with them.

Individual trend graphs can be opened by making a selection from the drop-down menu of the
Trend graph or from the context menu of the measurement in the Readings panel.

The following trend graphs are available for the DVB-S2 PSK interface card: RF Lock, MER,
EVM, Phase Noise, RF Lock, Input Power, CNR, Pre-RS/BCH BER, and Hocquenghen BCH
BER..
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IP video Gigabit Ethernet interface

The IP Video Interface tree view contains two primary nodes: IF Error Collection
and IF Warnings Collection as shown in the following figure. The secondary
nodes are specific to the IP Video interface. The detail views are contained under
five tabs: IP Tables, Diagnostics, Graphs, Interface Event Log, and All Session
Event Log.

¥ GigE - MPEG TS Compliance Analyzer
Analysis Yiew Mavigation  Sett

BB Flexvuplus™ £ Analysis
| Programs Tests | supst |

| FIDs Packets Interface
Aciors w | Show: W v @ @ [F 5

@ Intertacs Errors

Lock Multicast Database: Passive (P4 and [Pve) actiansw | | Preset |Default
- () Bit Rete Error Show fiter @
- @ Packet Interarival Tine Error st e e e T
© @ P Errored Packet Error felz24.0.0.1 Disablzd
@ RTP Lost Packet Error
(@) RTP Out of Order Error

(D Intertace Warnings

IP Traffic: 2 LGP flows detected (total rate 86,299 Mbps) Actions

Shaw frer &

Sezzion Aliaz ot |H:

Undefined 239.1.1.1 16385

ITS Awailability Q‘ Syne @) | #1.471039 Mbps @ 168 @\Nn Extensions | Interface: cige| | [ (6

Figure 1-37: Interface view - IP Video
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IP Tables tab

The IP tables view contains the Multicast Database table, the IP Traffic table,
and the IP card readings panel.

Multicast database. This table shows the multicast addresses that have been
added by the user. (See Figure 1-38.)

This table will be shown only when multicast subscription mode has been selected.

The table shows the status of the current multicast sessions: Join Requested,
Joined, Not Joined, Shadowed, Leave Pending, and Join Pending. Join Requested
is displayed when Join has been clicked and a message has been transmitted on
the network, but no traffic has yet been seen. As soon as traffic is detected, the
status will be updated to Join.

IP traffic. The Traffic view as shown in the following figure displays all traffic,
including, for example, FTP (File Transfer Protocol) traffic and available IP
sessions with rates higher than five network packets per second on the currently
selected interface (copper or optical)

The currently selected traffic is highlighted in this table. You cannot select
network streams that do not carry a transport stream. The column display can
be shown/hidden by selecting/deselecting headings from the column heading
context menu. The individual columns are described in the following table. If
a single subscription mode is selected, all sessions will be suspended except the
one currently subscribed.

@ Stream (192.158.201.116) - Tables Only | IF Error Collection

IF Error Collection > Tables Only
Multicast Database: Active [Pv4 and Pve Actions w
Aiter @
Multicast Address Source Address
224.1.2.2 Joined Leave
bAll224.1.2.3 Joined Leave
lz24.1.2.4 Joined Leave
ll224.1.2.5 Nat Joined Join
Beall224.1.2.6 Joined Leave
|eljz24.1.2.7 Joined Leave
I Joined Leave
Joingd Leave
Joined Leave
IP Traffic: 3 UDP flows detected (total rate 31,765 Mbps) Actions w

Has TS | T5 Sync Emor | TS €C Eror |Packet E...
B'CAST 5D
BEC HD
}|B'CAST SD

Figure 1-38: IP Traffic view (tear-off view)
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Table 1-9: IP Traffic view column descriptions

Field Description

Active Indicates the selected stream. The row is also bolded

Session Alias User allocated name

Source MAC Session source MAC address

Destination MAC Session target MAC address

Source IP Session source IP address

Destination IP Session target IP address

Source Port Session source IP port

Destination Port Session target IP port

VLAN Tag VLAN (Virtual Local Area Network) tag; "-" where not applicable.

Includes all parts of the VLAN information not just the identity

Transport RTP (Real Time Protocol) or UDP (User Datagram Protocol)
(Others, such as FTP, are possible if there is a sustained flow of
another kind on the network)

Has TS Yes (check mark), if sync has been detected in this session. No,
if sync has not been detected in this session

Multicast Yes (check mark), if it is a multicast address

TTS (Time Stamp Transport Stream) Yes (check mark), if the session
is time-stamped.

TS Sync Error Yes (green), if no sync byte or sync loss errors have been
detected in the session since reset or startup

TS CC Errors MPEG CC (continuity count) error count in each session since
reset or startup

Pkt Error Total count of IP corrupted, lost packets, and out-of-order
packets in each session since reset or startup

PIT Error Yes (green), if the PIT (packet inter-arrival time) in each session
has not exceeded the user defined limit at any time since reset
or startup

Bit Rate (Kbps) Session bitrate (not the same as the stream bitrate, this includes

IP wrappers)

At the top of each of the IP tables (Multicast Database and IP Traffic) is a Show
filter option. You can use these to filter and limit the displayed items.
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Readings. In this section, the IP Video interface readings are described. (See
Figure 1-39.) (See Table 1-10.)

Previously configured setups are available in the Preset drop-down menu.
Selecting from the drop-down menu is equivalent to applying a configuration
in the Configure Interface dialog box. Use the Edit button to open the Edit
Interface Settings. (See page 1-19, Interface card configuration.)

¥ Stream (192.158.201.116) - Readings | Interface Errors |Z||E||E|

E = w

Preset |Preset3 ,Vl [ Edit... J

B T B T tnia
=

100 FOX

FEBD:: ADD: 11FF: FEAS:F34E
2001:20%:: A0 1LFF FEAT: F4E

Figure 1-39: IP Video interface Readings view (tear-off view)
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Table 1-10: IP Video interface readings

Field title Description Units
Link Information
Line Speed Shows the speed and type of the current physical connection to the Mbps
network. Line speed; 10, 100, 1000, 1000 (Optical), N/A. FDX - Full-duplex;
HDX - Half-duplex
NOTE. The IP Video interface card allows active network participation on
half-duplex connections. However, if there are issues with active traffic,
such as IGMP dropout, a full-duplex connection will be needed.
Manual/DHCPv6 Address ~ Manually entered address or address supplied by DHCPV6 server. -
Local Link Address The local link address is used for network address autoconfiguration where -
no external source of network addressing information is available.
Stateless Address Unique IPv6 autoconfigured address. -
All Session Information
The All Session readings provide cumulative readings for the current multicast sessions.
Total Bit Rate Total bit rate on the currently selected copper/optical port including network Kbps
headers.
Session Count The number of sessions present on the link. -
All Session IP Error Indicates the worst case packet error from all sessions. (Error LED)
NOTE. The All Session IP/PIT/TS error LEDs will turn red only when the
related limits defined on the Information screen are exceeded.
All Session PIT Error Indicates the worst case PIT Error from all sessions. (Error LED)
All Session TS Error Indicates compliance checking and sync errors for all sessions. (Error LED)
All Bit Rate Error Indicates bit rate errors for all sessions. (Error LED)
Selected Session Statistics
The Selected Session readings provide readings for the current session.
Lock The LED icon is green when the signal is in sync and is being received (LED)
normally. When a signal is present but no lock is achieved, the indicator is
red. When no signal is found, the indicator is gray.
Session Bit Rate Bit rate of currently selected stream including network headers. Kbps
Min Packet Interarrival Minimum packet interarrival time (PIT) of the currently selected stream. ns
Time
Mean Packet Interarrival Mean packet interarrival time (PIT) of the currently selected stream. ns
Time
Max Packet Interarrival Maximum packet interarrival time (PIT) of the currently selected stream. ns
Time
IP Errored Packet Rate The calculation is maintained per session on the interface card. The field pkt/min

displays a red background if the rate is greater than zero.
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Table 1-10: IP Video interface readings (cont.)

Field title Description Units

IP Errored Packet Count Total IP packet error count since the last reset. The count is maintained pkts
per session on the interface card, so that the count that is presented when
a stream is selected is since reset or startup, not since the session was
selected. The field displays a red background if the count is greater than
zero.

RTP Lost Packet Rate The calculation is maintained per session on the interface card. The field pkt/min
displays a red background if the rate is greater than zero. This field is not
applicable (gray) if protocol is set to UDP.

RTP Lost Packet Count Total lost RTP packets since the last reset. The count is maintained per pkts
session on the interface card, so the count that is presented when a stream
is selected is since reset or startup, and not since the session was selected.
The field displays a red background if the count is greater than zero. This
field is not applicable (gray) if the protocol is set to UDP.

RTP Out of Order Rate The calculation is maintained per session on the interface card. The field pkt/min
displays a red background if the rate is greater than zero. This field is not
applicable (gray) if protocol is set to UDP.

RTP Out of Order Count RTP out of order packet total count (since last reset). Count is maintained pkts
per session on the interface card, so the count that is presented when a
stream is selected is since reset or startup, and not since the session was
selected. The field displays a red background if the count is greater than
zero. This field is not applicable (gray) if protocol is set to UDP.

TS CC Error Total MPEG CC errors on this session since reset or startup. The field -
displays a red background if the count is greater than zero.

NOTE. The TS CC Error count may not equal the count shown in the
Analysis Tests view, for example TR101 290, test 1.4, Continuity. The
interface card starts counting before the MTM400 processor card, and will
continue to count per session, while the MTM400 monitors other sessions.

Locked Session Information

Source IP IP address of the currently monitored transport stream. -
Source Port Port that is currently receiving the transport stream. -
Destination IP IP address to which the transport stream is being sent. -
Destination Port Port to which the transport stream is being sent. -
Type of Service Type of service field of the transport stream IP packets. -
Datagram Size Datagram size of the transport stream IP packets. bytes
VLAN Tag Virtual Local Area Network (VLAN) tag displayed in hex format. This is a -

two byte value containing priority bit, canonical format indicator (CFI), and

VLAN ID (VID).
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This tab displays ping results in the same format as the DOS ping program. The
results include round trip time, TTL, and time-out messages. The results will be
shown in this table after the Ping button is clicked. The address format, [Pv4 or
IPv6, should be selected in accord with the address format used.

IP Tables ‘ Diagnastics | Graphs | — Interface EventLog | —j& All Session Event Log

IPVersion (&) IPwd (O IPve

Target [192.168.204,201 | [jn%

Subnet Mask |255.255.255.0 |

Gateway [182.168.204.201 |

Ping Results

ing complete 192,163, 204,201
Mo reply
Ma reply
Ma reply
Ma reply
ing skatiskics:
Packets: Sent = 4, Received =0, Lost = 4(1009%)

Figure 1-40: IP Video interface - Diagnostics

MTS4000 and MTS4SAV3 Analyzer Applications User Manual

1-87



TSCA — Using the Interface view
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Graphs tab

Interface event log

All Session event log

This tab allows a range of measurements to be displayed in graphical form.
Readings are also displayed. (See page 1-84, Readings.)

¥ GigE - MPEG TS Compliance Analyzer
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i @ TP Ot of Order Error RTP Lost Packet Rate Trend
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Lock Trend
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RTP Out of Order Rate Trend
Session Bit Rate Trend
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Remove Other Graphs
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Figure 1-41: IP Video interface graphs (tear-off view)

The following trend graphs are available: Lock, Corrupt Packet Rate, Dropped
Packet Rate, Packet Inter-Arrival Time (Peak and Average), and Out-of-Order
Packet Rate. The period over which the trend values are displayed can be selected
from the Trend Timescale drop-down menu or from the graph context menus.

On some trend graphs, peak readings are shown in gray; the average readings
are shown a single line.

Also available are graphs of the selected session bit rate and session cumulative
bit rate (the sum of bit rates of all sessions).

This log collects all of the interface errors in a single log file. The log can be saved
for detailed examination and manipulation.

This log collects all events. Apart from displaying all events, two other subsets of
all events can be selected from a drop-down list and displayed, that is Selected
Stream Events and All IP Session Events.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual



TSCA - Using the Interface view

IP Video interface notes  The following notes are included to assist with the setup and operation of the
IP Video interface card. Click the Interface button in the toolbar to access the
interface setup.

Before connecting to the network under test, enter a valid Input Card IP
address on the interface configuration dialog box, otherwise any router or
switch that is connected may add an invalid IP address to its own ARP table
(which may have a long time-out).

If the Input Card IP is 0.0.0.0, you cannot be active on the network. Similarly,
if the Input Card MAC is 00-00-00-00-00-00, you cannot be active on the
network. In the latter case, the [P Video card may have been incorrectly
configured.

A MAC address is allocated to the IP Video interface card during manufacture.
If required, you can change it using the Configure Interface dialog box.

The MAC and IP addresses of the IP Video interface card must be configured
before any of the other IP Video interface settings.

The Network Interaction setting must be one of the active options when you
are trying to send or receive pings on the network or when you are acting as
an end point for unicast and multicast traffic.

IGMP (Internet Group Management Protocol) join and ping commands cannot
be sent when the Network Interaction mode is set to passive.

An SFP (Small Format Pluggable) module is used to facilitate the Ethernet
Optical interconnection feature. The IP Video interface card has been tested
with SFP module(s) ordered from Tektronix. SFP modules purchased from a
supplier other than Tektronix are not warranted to work.

Only optical SFPs are supported; copper SFPs are not supported.
Only full duplex operation is supported by the IP Video interface card.

Traffic flows are displayed in the Traffic screen only if they have a total packet
rate of > 5 network packets per second.

The Traffic screen will show all traffic, for example, FTP. For non-transport
streams, the MTS4000 instrument will perform IP level tests only.

Only transport streams can be selected for monitoring; transport streams are
indicated by a check mark in the TS column.
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10 Gb/s NIC interface  The optional 10 Gb/s interface card provides dual SFP plus short wavelength
optical port with LC connector for 10 Gb ethernet interface. The 10 Gb/s interface
is selected via the IP Device Name from the Real-time IP interface dialog screen.

Standard

Base Standard MPEG, Region No Extensions
Using default scripts, Scripted validations are not enabled.

Interfaces

Select from the available interfaces | IP -

Interface Settings

Presets Selected Preset
These are the settings for the currently selected preset.

To browse the network for a stream, select the Sronse. .. button.

IP Device Nams

{[\Device\WPF_{COAS5735- ?083—4CC
|Intel{R) 82583V Gigabit Networ
[\Device \NPF_{4B8DF 7B5-2B0D-48C

L ]| = |

Figure 1-42: 10 Gb/s interface selection
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[[E¥ - MPES TS Compliance Analyzer

P Flexvuplus™ | 2 Analysis

Analysis View Navigation Settings CaptureVu™ Record Help

Programs | Tests | s1/PST | PIDs | Packets|

i/ Summary | Trumbnais| 17 Graphs | RTP Losses|

Actions ¥ \ QEE
(= - Transport Stream: Id 0, Network Name:
(=@ Program 1 (0x01) &
@ PD 32 (0x20) ‘2T
@ PD 33 (0x21) A
@) PuT PID 50 (0x32) B

BddGroph O | & & B EH O | @

Data at Cursor

uTC
Ethernet Flow Rate
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TSCA - Common user interface concepts

1-92

Many user interface concepts are used throughout the analyzer. The following
common elements are described in this section:

Windows management

Icons

Graph management

Timing graphs

Bit Rate graphs

PIT graph

Now Playing views

Parameter edit

Event logs
Bit rates
EPG view
MPE views

CaptureVu features

Triggered recording

Menu bar and options

Preferences

Script files
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Windows management

NOTE. For basic Windows operations, such as minimizing windows or using the
scroll bars, refer to the MS Windows documentation.

In addition to the standard windows management methods, the following controls
are added which allow the windows panes to be resized.

Horizontal and vertical = Horizontal and vertical control icons are placed between adjacent panes. Clicking
controls  on an icon will expand the adjacent pane in the direction shown by the icon.

AW
@ TR sat hIL[

Figure 1-44: Window size adjustments

The size of panes can also be controlled by placing the cursor over the horizontal
or vertical dividing bar so that it changes to a bidirectional arrow. The dividing
bar can then be dragged to the required position as shown in the following figure.

4
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(=] ° Transport Stream: Id 1, Netvwark MName: |—F_|E Transport Stream: Id 1, Net
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# () Program 2 Adhersnt Il s - Matn= Rlutnizer

® () Program 3 Adnerect Il = acherent | 1

@ Q) Prograr 4 Adnersmt IV Ex O R — 2

£ O Program & Adherert ' g O acdherent I 3
D Adherent IV 4
QD Adherent 5
@ MULL PID 5191 0x...

Wb

Program | Tests | SUPSI | PID | Packets Summsry | MPE Sessions

= G Transpart Stream: Id 1, Metwork Name: ADHEREMT METVWORK |E|gI Transpnrt t
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& Q) Program 2 Adherent || -I

& () Program 3 Adherert Il ' A8 Q Adherert |
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QD Adnerert v 5

Q) MULL PID 8191 C...
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Icons

1-94

Table manipulation

The

following activities are available for data displayed in tabular form:

Click a column header label to sort the section in ascending or descending
order

Drag a column header label divider bar to adjust the column width

Select Resize All Columns to Fit from the context menu to adjust all columns
to fit the available display width

Columns can be hidden or shown by selecting them in the header label
context menu

Icons are used in the TSCA to convey information about a node or function.

In this section, the icons used in the TSCA and the icons used in the quick link
section of context menus are described. (See Table 1-11.) (See Table 1-12.) (See
Table 1-13.)

NOTE. The display of all icons is context-dependent. Not all icons will be visible
in all views.

Table 1-11: Object identification icons

Icon

Description

Application Information Table (MHP)

Audio

Conditional Access PID

Data stream

& 0|2 |f| B

Packet

PCR

Program
=)= Programs
)

Sl table
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Table 1-11: Object identification icons (cont.)

Icon Description

{} Sl table container
= Sl tables

a Stream scrambled
= Subtitles

@ Teletext

_ Video

ha'; Video + audio

Closed caption - CC-EIA608

TOH

Closed caption - CC-EIA708

Table 1-12: Interface management icons

Icon

Description

Open transport stream

View CaptureVu settings

Capture analysis

Bar chart

Pie chart

Stacked graph chart

Link to

Preferences

Audible alarm

B B e e & WG X

CaptureVu breakpoint
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1-96

Table 1-12: Interface management icons (cont.)

Icon Description

Graph management

BT Graph selection

@, Zoom in

@, Zoom out

Nz Show full dataset

| Hide/show limits

£ Hide/show settling time indicators

= Rotate graph view

Packet management

Remove all PID packets

Remove PID packet

® | o

]Ifﬁ Add PID packet
o | PID packet group
F— PID packet placeholder

LA L

Go to first packet

Go to previous packet

Go to next packet

Go to last packet

Open Go To Packet dialog box

)| (= | ) )] =

Action control

: Go to previous view
'0 Eack

la Go to next view
Forvard
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Table 1-13: Quick link icons

Icon

Description

Go to next red LED in current tree

View this PID in PID tree

View packets with this PID

View packets in Packet tree

View PCR graphs

View this program's PMT in Sl tree

View this test in Tests tree

Graph management

A number of screens displaying graphs are available in the analyzer. The graphs
are described in the relevant sections of this manual. This section describes the
management of the graphs user interface.

Four categories of graph are available: PCR measurements, section timing, bit
rates, and PTS (Presentation Time Stamps).

PCR measurement graphs include:

PCR Drift

PCR Inaccuracy

PCR Arrival Interval
PCR Frequency Offset
PCR Overall Jitter
PTS - PCR Variation
DTS - PCR Variation

PTS interval graphs include:

PTS value interval

PTS arrival interval
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Measurement background

1-98

Section timing graphs include:

®  Section Repetition Interval

B Subtable Inter Section Gap

m  Subtable Repetition Interval

For streams received over IP, the PIT (packet interarrival time) graph is available.

The graphs that can be displayed depend on the selection made in the navigation
view. However, the menus and options for the graphs are similar and as described
in the following pages.

Measurement points (2048 maximum) are held in a circular buffer.

NOTE. A circular buffer is an area of memory used to store a continuous stream
of data by starting again at the beginning of the buffer after reaching the end.

A graph set for full display will show the current measurement points. During
real-time analysis, the graph is constantly being filled (from the right to left), and
measurements moving off the left side of the display are lost. The time scale
(Y-axis) is started from zero each time that the node is accessed.

For some of the graphs, sufficient data must be gathered before meaningful results
can be displayed. The phrase "Settling Time" will be displayed briefly in the
graph area while the necessary data is gathered.
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The following figure shows a typical timing graph display. In this example, a
PID carrying PCR has been selected, and two graphs are displayed: PTS Arrival
Interval and PCR Arrival Interval.

EEX

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
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L |
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- PD 850 0x284) Wi
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88 PD 652 i0x28C) §
(@ PID 1005 (0x3ED)
- §8 PID 1006 (0x3EE) 1B
. §8 PID 1007 (0x3EF) B

@) PMT PD 4167 (0x1047) B3

@ Program £231 (0x1087) BEC TWO '&

@ Program 4351 (0x10FF) BBC CHOICE| |-

Program 4415 (0x113F) BEC NEWS 2 |-

£ @ Program 4479 (0x117F} BBC TEXT i

@ Program £543 (0x11BF) BBC PARLM

addeaph B & & = B @ &
Data at Cursor
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Inaccuracy - PCR Arrival Interval
PTS-PCR Variation 315
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Figure 1-45: Timing graphs

Within the category, the X axis is common to all graphs. A horizontal scroll
bar allows you to select an area for inspection when the graph extends beyond
the display area.

A cursor can be displayed on the graphs, allowing you to see accurate
measurements in the adjacent data panel. You can place the cursor by clicking
any data point on one of the graphs. Note that the cursor is displayed at the same
point on all of the visible graphs. (See Figure 1-45.)

The cursor can be moved either by clicking a new position on the graph, or one
point at a time by using the left or right controls on the keyboard. When you
select a point, a tooltip provides the X and Y coordinates of the point; the values
of these will vary depending on the graph.

Data associated with the selected point is displayed in the statistics panel (above
the graphs). The displayed values (maximum, minimum, mean and standard
deviation) are calculated for all of the data that is received while the navigator
node is highlighted.

Similarly, data for all graphs is displayed in the Data at Cursor panel. A link to the
associated packet is provided in the context menu.
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Graph menu and toolbar ~ The Graph Toolbar allows you to select and control the available graphs. (See
Figure 1-46.) The graphs listed will depend on the interface in use.

Timing Graphs ‘ Bit rate

g Moaldijdli g ll_-_‘Ls

available Graphs

o

| v PCR Overall Jitter D:

x| PCR Inaccuracy P

9| o PR arrival Inkerval P
PR, Drift

T PCR Frequency OFFset 4

=  PTS Arrival Interval N

['E

=

=+ Packet Interarrival Time (PIT)

]

E Add all Graphs

a_ P &

Figure 1-46: Graph toolbar

At the left end of the toolbar, a drop-down menu allows you to select which
graphs are to be displayed. Only graphs for which data is available are listed. (See
page 1-103, Timing graphs.)

The remaining graph controls are as follows:

Icon Description

&, Zoom in

a, Zoom out

Nz Return graphs to full scale display (All graphs can be returned
to full display by double-clicking anywhere in the graph display
area.)

| Hide/show out-of-range indicators

£ Hide/show settling time

=y Rotate graph layout
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The graph context menu can be displayed by right-clicking anywhere in a graph
display area. The options on the menu are applicable to only the graph from
which the menu was selected.

PID 600 (Dx258): PTS Arrival Interval

B add/Remove Graph PCR Crverall Jikker
B Show Limits PCR Inaccuracy
PCR Arrival Inkeryal
H .
PCR Dwift
&, zoam In PCR Frequency Offset
9, Zoom Cut v PT3 Arrival Inkerval
iz add All Graphs |‘
Quick Links: CLALRERL A UL LLLTERA L | |
IR view Packet 310,311 in Packets Tree
)P 10T 0 P01 OO A 1 O

Figure 1-47: Graph context menu

The title bar displayed at the top of the menu shows which object the graph
applies to (for example, PID 600).

Adding and removing  Graphs can be added by selecting them from the context menu or from the
graphs  drop-down menu either in the toolbar or from the top right corner of any displayed
graph. All graphs can be opened by selecting Add All Graphs from the same
menu. Each graph type can only be displayed once.

Graphs can be removed by clearing them from the context menu or by clicking the
close icon in the top right corner of the graph to be closed.

Out of range indicators ~ Each graphed measurement has limits set by default (derived from the stream
interpretation standard) or that you modify. (See page 1-111, Parameter edit.)

Limits imposed by the test parameters can be displayed on a graph by clicking the
Out of Range indicator icon. (See Figure 1-48.)In this example, the PTS Arrival
Interval has been set at 700 ms. The area outside the limits is shaded (red). The Y
axis is rescaled to show the maximum and minimum data points.

Settling time ~ Some of the graphs in the TSCA require a number of samples to be available
before meaningful results can be displayed. The period during which sufficient
samples are being gathered is referred to as the settling time. During this settling
time, the graph is grayed out and displays the phrase "Settling Time".

Zoom feature  You can zoom graphs in and out using the controls on the menu bar or from the
Graph Menu. An area of a graph can also be expanded by holding the right mouse
button and dragging a rectangle around the area of interest.
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Zooming (in or out) is centered on the middle point of the graph, irrespective

of the cursor position. Both axes are expanded/contracted to accommodate the
revised display. The graph is expanded or contracted by 25% of the displayed area
each time that the control is used. Double-clicking on a graph rescales the axes
to show the complete plotted data set.

If you hold the shift key while you click the zoom control, the Y axis is locked
while the X axis is expanded or contracted.

If you hold the control key while you click the zoom control, the X axis locked
while the Y axis is expanded or contracted.

During real-time analysis, expanding (zooming in) an area of a graph generates a
static snapshot of the graph. Because of the way that the measurements are stored
in the circular buffer, the display will eventually clear. The only way to redisplay
the graph is to return to full-scale display.

(D Associated Tests | Timing Graphs | Bit rate Graphs|

R e e WEO

Data at Cursor

Quick Links L

Packet
0. Jitter

how the out of range indicators,

The minirurn and maximunn limits For the displayed graph e 0:00:07 718

lare showen. The limits can be changed using the Parameters diglog,[ival Inte... 5
3 TET —FIS R

Drift

TTival Inte... 100

va

(D Assoriated Tests | Timing Graphs | Bit rate Graphs|

StiEs E oa a '_}B: %E =il Quick Links | b
Datast ol Hide the aut of range indicators|

Packet 12377z OTC 7.715.122 Date/Time 0:00:07 715
0. Jitter - Inaccuracy - PCR Arrival Inte... -
Drift - Freq Offset - PTS Arrival Inte... 100

Figure 1-48: Out of range indicator
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PCR Inaccuracy (PCR_AC)

PCR Arrival Interval

TSCA — Common user interface concepts

The following table shows the timing graphs that are available for PIDs carrying
PCRs. If a PCR PID is also carrying time stamp information, the full set of graphs
will be available. (See page 1-97, Graph management.)

Table 1-14: Timing measurement graphs

Graph Type PID + PCR PID + PCR + Timestamps
PCR Inaccuracy V I
PCR Arrival Interval V vV
PCR Drift Rate I
PCR Frequency Offset I
PCR Overall Jitter I

Descriptions follow of each of the measurements. Adjustments can be made to
each of the measurement parameters.

If the interval exceeds the limits displayed on the screen, the scale is adjusted
automatically as necessary to include the maximum displayed values.

NOTE. As with other parameter value adjustments, it is important to note where
the adjustment is being made from. If the adjustment is made with a test node
highlighted, all PIDs will be measured against that value. If the adjustment is
made with a PID highlighted, only that PID will be measured against the modified
value.

The PCR Inaccuracy graph shows the difference between the actual and expected
values for each PCR on the Y-axis. Expected PCR values are calculated from the
byte index of the PCR.

The default limits are set to £500 ns.

The Maximum PCR Accuracy Error limit can be adjusted by modifying the Max
PCR accuracy error.

The PCR Arrival Interval graph provides a display of the time interval between
successive PCRs, during the last 256 PCRs. The interval is displayed on the
Y-axis. The default limit (Maximum Repetition Period set in TR 101 290 test
2.3) is 40 ms.

The PCR Maximum Repetition Interval limit can be adjusted by modifying the
PCR max repetition interval.
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PCR Drift Rate (PCR_DR)

PCR frequency Offset

1-104

(PCR_FO)

PCR Overall Jitter
(PCR_0J)

PTS and DTS graphs

This Drift Rate graph shows the rate of change of PCR Frequency Offset, which is
often very small. It is calculated using PCR Frequency Offset measurements.

The maximum PCR Drift Rate limit can be adjusted by modifying the Max PCR
frequency drift rate parameter.

The Frequency Offset graph shows the difference between the program clock
frequency and the nominal clock frequency (measured against a reference that is
not PCR or transport stream derived).

PCR Frequency Offset is a measurement of the error in the PCR frequency from
the specified 27 MHz; the MPEG specification sets the limits at+=810 Hz.

The Maximum PCR Frequency Offset limit can be adjusted by modifying the
"Max PCR frequency offset" parameter.

The PCR Overall Jitter graph shows the time interval between the actual value of
the PCR and its expected value based on its arrival time.

The Maximum PCR Accuracy Error limit can be adjusted by modifying the Max
PCR overall jitter parameter.

Decode Time Stamps (DTS) and Presentation Time Stamps (PTS) indicate the
exact moment at which a video or audio frame has to be decoded or presented
to the user. The values of these time stamps are references to the program time
base, as indicated by the program’s associated PCR.

The decoding and presentation times for a frame will be different if the frames are
not transmitted in the order that they should be presented, that is, in video streams.
In streams which are not reordered, for example, audio streams, the PTS and
DTS values for a frame are identical.

The following PTS/DTS graphs are available for non-encrypted elementary
streams carrying PTS data:

PTS Value Interval. The PTS Value Interval graph plots the difference in value
between each PTS and the prior PTS. The time stamp value difference is displayed
in terms of time.

PTS Arrival Interval. The PTS Arrival Interval graph shows the difference in
arrival time between each PTS and the prior PTS.

PTS-PCR Variation. The PTS-PCR Variation graph plots the difference between
each PTS value and the value of the program time base at the moment the PTS
arrived. The program time base value at that point is interpolated from the
associated PCR values. The measurement is displayed in terms of time, and gives
an indication of how long after receiving the frame the decoder must wait before
presenting it to the user.
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DTS-PCR Variation. The DTS-PCR Variation graph shows the difference between
each DTS value and the value of the program time base at the moment the DTS
arrived. The program time base value is calculated in the same way as for the
PTS-PCR Variation graph. For video streams this graph is likely to differ from the
PTS-PCR graph, but for non-reordered streams it will display the same values.

The PTS-PCR and DTS-PCR graphs can be useful for detecting encoder timing
issues that are likely to cause receiver T-STD problems.

PTS processing for PES  The default behavior of the TSCA is to perform PTS, and DTS, where applicable,
Private stream types =~ measurements on audio and video PIDs. For PES Private (stream type 6) PIDs,
these measurements are only carried out for PIDs that are recognized as carrying
subtitle/closed caption information.

A parameter has been added that can override this automatic detection of
PES Private PIDs. The behavior can be changed for all PIDs by opening the
configuration dialog: Settings > Configuration... > Test Parameters. Locate
and set the parameter Process PTS for PES Private streams.

B Set the value to 0 to select the default automatic behavior.
PIDs with stream type 6 will be processed only for PTS/DTS measurements if
the TSCA recognizes them as carrying subtitles and/or teletext.

B Set the value to 1 to force the TSCA to perform PTS/DTS measurements for
all PIDs with stream type 6.

®  Set the value to 2 to disable the PTS/DTS measurements for those PIDs with
stream type 6.

This parameter can also be adjusted for a specific PID. Highlight the required PID
in the PID view, and select Edit Parameters from the 2.5 PTS context menu in
the Associated Tests tab. This method affects the behavior of the selected PID
only, and will only take effect if the PID is marked as stream type 6 in a PMT.
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Bit rate graphs

Bit rate graphs are available on program and PID nodes. (See page 1-97, Graph
management.)

& C:\Streams\BBC1AUG27. mpg - MPEG TS Compliance Analyser [[=1 3]
Analysis View Davigation Settings Captureyu™
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PID 851 (0x28f
PID 652 (028
PID 1005 (0x3ED)

uTC 15,400,028 Date/Time 0:00:16.400 Bit rate
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Figure 1-49: Bit rate graph

PIT graph

The PIT Graph displays the mean interarrival time of IP packets. This can be
viewed from the Transport Stream node in the Program view. It can also be
viewed alongside other timing graphs for PIDs with PTS, DTS, and/or PCR
information. This can help you coordinate apparent problems with PCR, PTS,
and DTS timing with IP packet timing.
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RTP Loss distribution graph

The RTP Loss distribution graph is available when analyzing transport streams
carried using RTP in real-time, using the internal NIC or in file based analysis
(PCAP). The graph shows the distribution of RTP packet losses by plotting
loss duration (the number of consecutive packets lost) against loss distance (the
distance between one block of lost packets and the previous block). The color
of each point represents the count of occurrences of losses with a particular loss
duration and distance.

To access the graph while analyzing an RTP stream, select the transport stream
node in the Programs tree, and select the RTP Losses tab in the detail view.
Note that any losses that occur outside of the range of the graph are captured and
displayed in aggregate form at the top and on the right side of the graph. The
limits can be changed by selecting the Edit Parameters... button.
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The Edit Parameters dialog box allows you to alter the loss duration and loss
distance values which will increase or decrease the X and Y axis ranges.

@ Edit Parameters...

RTP Loss Distribution
The parameters for this test are listed below

RTP lass distribution rmax loss distance axis (100 Intzger... 1 100 1000000
RTP lass distribution max loss duration axis |10 [teger..| 1| 100 | 1000000

& Analysis has completed. Parameter changes will only take effect when analysis is restarted,

[ Set all to Mominal ][ oK H Cancel ]
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The Thumbnails tab displays video content at the transport stream and program
node levels. Icons at the top right of the now playing screen provide three levels
of detail and layout of the thumbnails: Thumbnails only, Brief Details, and Full
Summary. The following figures in this section illustrate the level of detail
provided by each icon.

The content of each program node can be viewed in more detail by clicking
the play button. This assumes that a suitable player application is installed, for
example, VLC Media Player.

In file analysis mode only, the program node content can be further analyzed
using the MTS4CC Elementary Stream Compliance Analyzer or the MTS4EAV7
HEVC / AVC Video and Compressed Audio Analyzer (ESA). Select the ES
button to open the analyzer. The ES button will be hidden if either of the ESA
applications is not detected when the TSCA starts.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis View Navigation Settngs Captursyu™ Help
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Oty
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Figure 1-50: Thumbnail view - Thumbnail view
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Figure 1-51: Now Playing - Summary view
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Figure 1-52: Now Playing - Detail view
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TSCA — Common user interface concepts

Each of the error states displayed on the user interface are the result of making one
or more measurements or tests on the analyzed transport stream. The displayed
tests are derived from the selected interpretation standard. Additional proprietary
tests are also included.

Some measurements and tests translate directly to an error state, and others are the
result of a combination of tests. For many of the tests, you can affect the result
by varying parameters that influence the test result, for example, maximum and
minimum bit rate values, although the test result may not then conform to the
chosen interpretation standard.

The Edit Parameters window is available from test and PID context menus. The
following figure shows the parameters that are available for the TR 101 290 test
2.5. The PID test parameters dialog box shows the subset of parameters that are
available for a single PID under TR 101 290 test 2.5. (See Figure 1-54.) Not
all parameters applied to a test are necessarily applied to a PID, and not all test
have configurable parameters.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis View Mavigation Settings CaptureVu™ Help

.z} FIe*KVuPIus"" £ Analysis

Programs | Tests | s1/pst | PIDs | Packets | Assocated PIDs |
Adions v | Show: W ¥ W@ W 3

=@ Stream Tests (134)

TR 101 290 (133)
@ Priority 1 (44)

riority 2

@ 2.1 Transport @ P> 601 (0x259)
@ 22CRC @ PID 602 (0x254)
@ 2.3.a PCR Repetiion Q PD 610 (0x252)
@ 2.3.b PCR Discontinuity Indicator Q PD 611 (0x253)
(D 2.4 PCR Accuracy Q P 612 (0x254)

PID 621 (0%26D)
Edit Parameters... PHEZR RN
& @ Other (1)
() SFN Error Reset
@ Informational Events Disable

Enable

@ Edit Parameters..._ 3]

2.5PTS
The parameters for this test are listed below
Feld Value @ [ Min Nominal Max

Disable All Tests
Enable All Tests

[ setaitonominal | [ ] [ cancel ]

Audible Alarm
CaptureVu™ Breskpoint |

Desaipton
Clear All Trigger Actions ] |Ho log entries were found
f

Desc

< | >

|75 Avaiiabiity @ [sync @|[ 24.128335Mbps @ 188 204 511,350 Packets| | DvB| | o Extensions, [E ﬁ‘

Figure 1-53: Test parameters
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¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis Wiew Mavigation GSettings CaptureVu™ Help

| FIex\'uPIus“" £ Analys
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Actions ¥ | Show: i o @ | % [ 5
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=+ Priority 2 @ PID 600 (0%258)
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. ~@z22cRc D

@ 2 3.2 PCR Repetition @ PID 610 (0x25)

2 3.b PCR Discontinuity Indicator Q PID 611 (0x25;

24 PCR Accuracy Q@ PID 612 (0x284

@ 25pTS @ PID 620 (0x26( dit Paramete
@ 26 CAT @ PID 621 (Dx28l
Priority 3 (89) @ PID 622 (0x28% AR

& @ other (1) O PID 640 (32l | The parameters for this testare fisted below

er

- SFN Error @ FID 641 (0x28
@ informational Events (Q FID 660 (0x25{

{700 ms 100 700 5000

Setltonomnal | [ ok ][ cancel ]

e ', View PID 602 (0x254) in PID Tree
—ja Event Log |

EEE

Show fiter @)
Q o log entries were found

< | %

[ | | | ] [ =
|7 Avaiabiity 915\#«: Qr! 24.123335 Mbps @ ]88;\&![511,%0 Packets| | DVB| No Extensions| ‘i ‘

Figure 1-54: PID test parameters

Each test parameter entry includes the following fields:

Description of the parameter.

Value - the current setting. If the setting is the same as the nominal value, an
icon will also be displayed in this field.

Units in which the measurement is made.

Maximum and minimum values. These are the maximum and minimum
values recommended by the selected standard.

Nominal value. This is the value or setting recommended by the selected
interpretation standard.

It is important to understand the difference between default and nominal values.
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If a parameter value is set for a test, it becomes the default value for the test and
for all PIDs subject to that test. PIDs using the default value will have a bullet
icon displayed in the Value field as shown in the following figure.

“Tiaue s

700 #® IS

Figure 1-55: Parameter value - default icon

However, you can also set individual PID parameter values. The value set is
applied to only that PID, not to the other PIDs using the same test or the test
default value.

The nominal value is provided by the interpretation standard; it cannot be changed
using the user interface.

Changing a test parameter ~ To change the value of a test parameter:
value 1 Click in the Value field.
2. Enter the required value.

3. Press Enter.

NOTE. For a new value to take effect during offline analysis, the stream must be
closed. Select Restart Analysis to open and reanalyze the stream.

Access to all parameters  (See page 1-136, Configuration.)

Event log

The event log displays a history of events related to a selected item. When no log
is available, the message "No log entries were found" is displayed. In a log, events
are placed in chronological order (with the most recent at the top).

Event log displays are context-dependent; the view and object that is currently
selected will dictate the content of the associated log. For example, with the
transport stream node selected in the Programs navigation view, the associated
event log displays all events. Similarly, with a single PID selected, the associated
event log only displays events relevant to that PID. Exported logs are similarly
context-dependent; only currently displayed events are exported.
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Event log control

Event log pinning

Exporting the event log

1-114

The event log normally displays the most recent event at the top of the log. Past
events are scrolled down the screen; not all of these event entries can be viewed
on a single screen, even in a maximized Log view window.

If events are constantly being generated, an event entry may pass out of view
before you have a chance to examine it.

However, if you scroll down to view a past event, the viewing window will
remain fixed on that entry, even though events entries are still being added at the
top of the log view. This is evidenced by the scroll box continuing to advance
toward the bottom of the screen.

The event entry being viewed will eventually move to the bottom of the event log.
At this point the entry will be lost, the view will return to the most recent entries
at the top of the screen, and automatic scrolling will restart.

Another way of viewing a single event in a stream of log events is by pinning the
log. By pinning the log, you are taking a snapshot of the log at a particular moment
in time; you can move up and down the pinned log as required. Newly generated
events continue to be generated, but are not displayed until the log is unpinned.

You can pin the log by selecting the Pin icon or Pin Log from the context menu.

_Fi Shows that the log is not pinned
Select to pin the log
—5- Shows that the log is pinned

Select to unpin the log

When the log is pinned, it displays against a blue background and the pin icon
changes.

Pinning the log may take a few seconds. The whole log is saved, up to 10000
entries.

The log will remain pinned until you select the Pin icon or display another TSCA
view.

You can export the log (pinned or unpinned) in either XML or CSV format.

You can export the log by selecting the Export icon or Export Log from the
context menu.

o

Select the format in which the log file is to be saved, either xml or csv, and
a location for the file.
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Color-coding events
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You can clear all events from the event log by selecting the X icon or Clear Log
from the context menu.

Specific event types can be color-coded in the display to allow them to be
identified more easily as shown in the following figure. Color-coding can be
done from any event log display. The color-coding dialog box is available from
the event log context menu.

@ TR 101 280 | @ Other | () SFN Error | Event Log |

Transport Stream: Id 1, Network Name: ADHERENT NETWORK
Packet Descrition
28-Feb-2005  14:42:49.784 14607347 TR 101 280 error 2.5 (PTS_errar) : Timer pid 220 end, durstion 48ms
28-Feb-2005  14:42:49736 14606523 TRAM 230 error 2.5 (PTS_error) : Timer pid 220 start
0 28-Feb-2005  14:41:50.376 12089738 TRAM 290 error 2.5 (PTS_error) : Tirmer pid 310 end, duration 40ms
O— 28-Feb-2005  14:41:50.336 12965636 TR 101 290 error 2.5 (PTS_errar) : Timer pid 310 start
° 28-Feb-2005  14:41:50.261 12966369 TR 101 280 error 2.5 (PTS_errar) : Timer pid 410 end, durstion 40ms
° 28-Feb-2005  14:41:50.251 12086204 TRAM 290 error 2.5 (PTS_error) : Tirmer pid 210 end, duration 40ms
O— 28-Feb-2005  14:41:50.221 12965466 TR A0 290 error 2.5 (PTS_error) © Tirmer pid 410 start
°— 28-Feb-2005  14:41:50.211 12965192 TR 01 290 error 2.5 (PTS_error) @ Tirmer pid 210 start
° 28-Feb-2005  14:41:50146 12953399 TR0 290 error 2.5 (PTS_error) @ Titner pid 510 end, durstion 40ms
(a Feh 2NNS  14-41-5010F 4 79R779R TR AMM 200N areor 2 S5 (PTS arraet - Timer nid 540 start

Figure 1-56: Event log - color coding

1. Highlight the event type and select Color from the context menu as shown in
the following figure. The following figure shows the Color dialog box.

@ TR 101 250 (248) | (@ Other | () 5PN Errorl — Event Log |

Transport Stream: Id 4103, Network Name: Sandy Heath

" EventID: 14679

@ Export Log...

TR 101 290 error 1.6 PID_error pid 603 [0:250] timeout: sta

S05431

TR 101 230 error : minimum any =ection repetition error (ld:
494124 SOT Timer error end, durstion 201 7ms —4 PinLog
TR A0 280 error 1.6 PID_error pid 643 [0x253] timeout: sta
492752 TR 101 290 error . minirmum any section repetition error (id: Gt LOOLE
492055 TR 101 230 error : minimum any =ection repetition error (ld: Reset Al Colours iz
A A T AN T mosm s i E s s et mm mkimn mim bk mn Quick Links: -
— 10 Wiew Packek 509,515 in Packets Tree | —
Figure 1-57: Event log - context menu - color
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D Sample Text Sample Text

I K l[ Cancel ][ Reset ]

Figure 1-58: Event log - color dialog boxes

2. Select the primary display color.

The color can be specified from the Swatches tab. It can also be specified
in HSB (Hue, Saturation, Brightness) or RGB (Red, Green, Blue) terms by
selecting the appropriate tab and entering the required values.

3. Select OK. All events of the same type are now highlighted in the selected
color.

The color-coding on a single event type can be removed by selecting Reset Color
from the Event Log context menu. Color-coding can be removed from all event
types by selecting Reset All Colors from the context menu.
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Bit rates

In a stream, bit rates are calculated and displayed for the following:
®  Transport stream

B Programs

= PIDs

The bit rates can be displayed in graphical form as a bar chart or a pie chart. The
management is similar for each graph type. In addition, a historical multiplex
graph can be displayed at the transport stream level.

Select the appropriate icon to switch charts:

Historical
Bar chart — F & =<— mu|tip|ex
T graph

Pie chart

Figure 1-59: Bit Rate display selection

Bar charts  The following information is included with the bit rate bar charts:
m  Error status (LED)
B Object name (Program or PID name)
B Stream type (PIDs only)
B Bit rate bar including change bars and limit markers, where relevant

B Bit rate statistics (including the current bit rate, the bit rate expressed as a
percentage of the overall bit rate, and the maximum and minimum values
reached during analysis).
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Error indication

Range bar

Summary | Mow Playing | MPE Sessions |

|_ Q Transport Stream: |d 4103, Network Name: Sandy Heath

Mbmber of Programs: 6

lMean TS bit rate: 24.128 Mbps

Mean TS bit rate excluding Null PID: 22.126 Mbps

Mame Mumber Mean Bit Rate Mean

Q) MULL PID 191 (0%1FFF) | 2.002Mbps  8.30%  1.395Mbps 2.324 Mbps
@ EEC ONE 4167 N 5.079 Mbps  21.35%  5.790 Mbps 6.115 Mbps
@ BEC TWo 4231 | 5.102 Mbps  21.43%  5.805 Mbps 6,169 Mbps
@ BEC CHOICE 4351 ] 5,101 Mbps 21.43% 5.804 Mbps 6.166 Mbps
@ EEC NEWS 24 4415 | 5.989 Mbps  20.96%  5.679 Mbps 5.996 Mbps
@ EEBC TEXT 4479 | T 0.8353Mbps  3.10%  0.594 Mbps 0.902 Mbps
@ BEC PARLMNT 4543 - 0.975Mbps  3.42%  0.686 Mbps 0.994 Mbps

Figure 1-60: Bar chart

The bit rate bars are scaled so that all bars are displayed relative to the one with
the highest bit rate.

Column widths can be adjusted by dragging the line dividing the title bar to the
left or right with the mouse.

Two levels of error status are displayed in each row. The error status LED shows
the test status of the element, for example, a program. The color of the bit rate
bar indicates the bit rate status and whether the rate has exceeded the limits that
were set.

A range bar indicates the variation of bit rate in each program or PID. The ends of
the bar show the maximum and minimum values of the bit rate since monitoring
started.

Range bar

& 503 (02EE) = |
@ 550 (0x284) iy
@ 631 (0xzEmE)
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Bit rate limits  Bit rate limits can be set on a program or PID bar. An error will be indicated
when the bit rate exceeds the limits set.

You can highlight the program or PID and select Set Bit Rate Limits from the
context menu.

- U LUl B8 FLUURIUL, 101 D0 | Sl b
QD B00(0x2.., || w2 (0x02) (MPEG-2 Y., | I 49724, 09¢
@ 501 (0xz.,, PID 600 (0x258) 269,216 |
a 602 (0x2..| R &ll Tests 0,000 K
@ c=03(0x2,,| Disable Al Tests 0,000 K
() 610(0x2..] Enable Al Tests B 4575965
@ BLUDAZ. Rt Bk Rates Limits 20020 |
Q@ 612 (0x2.., 67,680 K
Q@ B30z, 0.000 K
Q) B20(0x2.., : 4871.45¢
) 521 (0x2..,  Show Mean values 266.208 |
Q 627 (0x2.., Quick Links: £9, 154 K
@ 523 (0x2... PID ey this PID in PID Tree 0.000 K
@ B0 (0x2..| L, Yiew PCR. Graphs I (4523326
Q) 641 (02, 266.208 |
@ 543 (02 B, View Bit Rate Graph 0000 K
0 50 (0x2,., i% “Wienw packets with this PID 249,760
8 50| Mview sections on this PID 0.000 K
e B52 (0x2. 4 q; a0 ko nesct red LED incurrent kree F3 LS
Q) 653 (0x2... TR ] 40,652 K

The Set Bit Rate Limits dialog box opens:

Number Cument Bit Rate Cument{Mbps) Min{Mbp=)

MULL PID 8191 (0...
BEC ON

P

4167 (0x1047) K 6.096 5.790

Set Bit Rate Limits for "Program 4167 BBC ONE’
This dialog allows you to set the minimum andjor maximum bit rate limits for Program 4167 BEC ONE.
Note: the colour of the bar indicates whether the cument value is within the entered limits

Minimum Bit Rate Maximum Bit Rate i
; 4 Enable Limit
4,575.000| Kbps | 14,500.000 | Kbps i
3
Current Bit Rate: 6,095.712 Kbps
”
T T WO NLLTECY TR el

You can enable the limits by selecting the Enable Limit checkboxes and entering
the required values. The cursor in the bar indicates the current bit rate. The limits
can also be changed by dragging the limit icons in the dialog box to the required
positions. The color of the overall bar in the limits dialog box indicates whether
the current bit rate is within the proposed limits. Select OK to close the dialog
box. The limit icons will now be displayed on the bit rate bar. The scaling of all
bars is recalculated to ensure that the maximum limit is displayed.
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During file analysis, you must close and reopen the file to reanalyze it and view
the effects of the limits. Real-time limits take effect immediately. Limit values
are retained when the application is closed. Limits set for specific PIDs will be
applied (to a PID with the same number) irrespective of the stream being analyzed.

Setting (and resetting) the bit rate limits for programs and PIDs will automatically
update the Program Occupancy and PID Occupancy tests. To change the transport
stream bit rate limits, the parameters must be altered directly in the Transport
Stream Occupancy test. This can be found under the Other tab in the Tests view.

The Bit Rate Limits of al/ programs in a stream can be disabled and reset by
selecting the Clear Limits button at the top of the Programs screen.

Pie charts = The information shown in the pie chart is similar to the information shown in
the bar chart.

Summary | Mawe Plaving | MPE Sessions

E |_ Transport Stream: Id 4103, Network Name: Sandy Heath
Mumlbier of Programs: 6
lMean TS hit rate: 24.128 Mbps
Mean TS hit rate excluding Mull PID: 22.126 Mbps

: Programs: Mean Bit Rates

Figure 1-61: Pie chart

The pie chart view is divided into two panes. The left pane shows the pie chart,
and the right pane provides a list of the component programs. Each program is
color-coded. Related information given includes the overall program status (icon),
the program name and number, and the bit rate (bps). The bit rate expressed as a
percentage of the overall bit rate is displayed in the segment labels. The maximum
and minimum values are not shown.

Labels for individual segments can be displayed by holding the mouse button
down over the segment. All labels can be displayed by double-clicking anywhere
on the pie chart. If a segment label is hidden at the edge of the window, click on
a segment to display the label in full.
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Historical multiplex graph  This graph shows the bit rates for all programs in stacked area format. You can
select the time period over which the graph is calculated from the Time period
drop-down list.

¥ GigE - Summary | Transport Stream: Id 1, Network Name: ADHERENT NETWORK
Tr

Mumber of Programs 5
Current T3 bit rate 41.471 Mbps

Current T3 bit rate excluding Null PID 39.195 Mbps

Last 1 minute {1 second period) Programs

[ 5 (0x0005) Adherert v
W 4 (0x0004) Adherert v
W 3 (0x0003) Adherent Il
W 2 (0x0002) Adherent I
W 1 (0x0001) Adherent |
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EPG view

An electronic program guide (EPG), where present, is a schedule of events and
programs that are or will be available on each service. A short summary or
commentary for each event may also be included. Events for services that are
actually carried in the stream are referred to as "actual" and as "present" or as
"following" (labeled as "EIT actual p/f" in the navigation view).

A transport stream may also carry EPG information for other network services,
referred to as "other" (labeled as "EIT other p/f" in the navigation view).

NOTE. The examples shown in the figures in this section are of DVB transport
streams. The construction of SI and node names in ATSC and ISDB streams differ.

The EPG node in the navigation view contains and displays all of the program
information carried in the transport stream.

The content of the Detail view will depend on the currently highlighted EPG table
node. Nodes representing an individual table or subtable will offer the usual
Summary, Section, and SI Repetition graph detail views. However, the higher
nodes will display the programming information graphically as shown in the
following figure.

@ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliancy
Analysis View Navigation Settngs Captursyu™ Help

Title bar  Display time zone  Start time Display range
P ——

Programs | Tests | SUPSI | PIDs || Packets
EQyEwort.. BEE
|5 Tables

B Programs (PAT/PMT/SOT actual)
- Networks (NIT=)

&) Time (TOT/TOT)

= Epc (EMEOTRST)

=+ This Transport Stream (SDTE actual)
B8 SDT actual
- s

Display Time Zone

This Transport Stream {[;DT/EIT actual)

Start Time Display Range

| GBR (GMT+01:00) [Stream]

v| 27 August 2001 15:00 v | [pahours b0 minutes v|

[=He] @ Jump to Now @& Q Q

Time scale

B Service 4231 (BBC TWO) (EIT actu
G- Service 4351 (BBC CHOICE) (EM a

[a 15:00:00

16:00:00 JY17:05:06] 18:00:00

190000 [>)

T e

s
B Service 4479 (BBC TEXT) (ET actu
= Service 4543 (BBC PARLMNT) (EIT

Service/Subtable panel ; ;

T ‘

1= Sound DF Musie
0
360 (0xF208]

Event pane| =
B9 Network 018, Transport Stream 1228/

- Network 8018, Transport Stream 16324

{53 Network 9018, Transport Stream 2048

-3 Network 8018, Transport Stream 24578

£-E5) Al ETs (ungrouped)

I8 All SDTs (ungrouped)

(& psm-cc

The Weakes...
17:15t0 18:00
61396

Ready Steady Cook

~
Source: table_id 78 (0x4E), version 12 @ 00:00:00, section 0 (carried on PID 18 (0x12)) ﬁ

Event time

-

Event detail panel

Channel ID

From 27-Aug-2001 16:30:00 to 27-Aug-2001
17:15:00 (duration 0:45:00)

BBC TWO

orig_net_id 9018 (0x233A), ts_id 4103 (0x1007),

&
< ] s

service_id 4231 (0x1087)

|£

Ts Avaiability || sync @ | 24.128335 Mbps @ 188|204 511,360 Packets || DVE || No Extensions| | [l B

Figure 1-62: EPG Summary view
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EPG node summary £l & Time (TOTAOT)

= EPG (EITASDTARET)
= This Transpart Stream (SDTEIT actual)
Be =0T actual
= B Service 4167 (BEC ONE) (EIT actual)
MovwwMest CEIT actual pif)
T E Service 231 (BEC TWioT (EIT actual)
# B Service 4351 (BEC CHOIWCE) (EIT actual)
+ E Service 4415 (BBC NEAZ 247 (EIT actual)
+ a Service 4473 (BBC TEXT) (EIT actual)
+ B Service 4543 (BEC PARLMNT) (EIT actual)
= Mletweark 9018, Transport Stream 5194 (SDTEIT ather )
Be SOT other
+ E Service 3253 (1TY 1) (EIT other)
¥ Q Service 3384 (Channel 47 (EIT cthet)
+ a Service 3445 (FilmFour) (EIT other)
+ E Service 3573 (ITY Sport) (EIT other)
+ E Service 3640 (E4) (EIT other)
+ Metweark 9018, Tranzport Stream 12290 (SOTEIT other)
+ Metweark 2015, Transport Stream 16334 (SDTEIT ather)

T B Metuenrk O S Tramsnart Strearm 20450 rSTEIT mthee

Figure 1-63: EPG nodes

For each node type, the detail view shows the following information:

EPG node Links to the EPG information for all the transport streams
described in this stream.

Transport stream Graphical view of the events identified in the service(s) belonging

summary nodes to a specific transport stream.

SDT nodes (Service Links to services identified in the Sl for a specific transport

Description Table): stream.

Service summary Graphical view of the events identified in the service.

nodes

EIT nodes Detailed view of event information for a single EIT subtable.
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EPG Summary view  The elements highlighted in the EPG Summary view screen are described in
the following table: (See Figure 1-62.)

Item Description

Title bar Displays the title of the currently highlighted service or transport
stream.

Display Time Zone Select the required time zone from the drop-down list. The time

scale will change accordingly. The time zone may be derived
either from the transport stream, UTC (Co-coordinated Universal
Time), or local time (as set on the host computer).

Start Time Shows the event panel start time and date. Other dates can
be selected from the drop-down calendar, and the display will
scroll to the selected date.

In deferred mode, the initial date and time will be dictated by the
information found in the stream. If the selected date is beyond
that held in the EPG information, the date will be automatically
set to the last date held in the information.

In real-time mode, this information is updated regularly.

Display Shows the extent of the event panel. More detail can be
displayed by choosing a shorter time period. Select the required
range from the drop-down list.

Timescale Shows the start and end time of the current event panel. The
range is dictated by the Display field selection.
Service/Subtable panel When a transport stream EPG is selected, this panel shows the

names of the services currently displayed in the event panel.
The displayed services will vary depending on which node is
selected in the navigation view.

Event panel This panel shows the events for one or more services, depending
on the selected node. Individual events are color-coded and
shown as blocks; each block (and its associated tooltip) displays
event information that is extracted from the EIT. When a block
is selected, the complete event information is shown in the
event detail panel, including a link to the section carrying the
information.

Event detail panel Shows details of the selected event. The details are contained
in the EIT (event information table).

Events are color-coded as follows:
®  Red: Present event

m  Green: Following event

®  Blue: Schedule event

®  Yellow: (ISDB only) After event
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ATSC EPG Rating and closed caption information carried in ATSC EITs is displayed in the
ATSC EPG view. The consistency of closed caption signalling between the PMT,
EIT, and the closed caption content of video streams (Stream Tests > Other >
Miscellaneous > Closed Caption Error) is tested. The presence or absence of
CEA-608 and CEA-708 closed captioning is displayed next to thumbnails for
video streams, along with the current program rating information as signalled in
the EIT. The following thumbnail illustration shows the closed caption presence
indication. Closed caption data (CEA-608 and CEA-708) is signalled in the PMT
and EIT; an inconsistency error is triggered if the presence of signalling and data
do not correspond.

Create [10.3] 1 TV-G

MTS4000 and MTS4SAV3 Analyzer Applications User Manual 1-125



TSCA — Common user interface concepts

MPE views

Multi-Protocol Encapsulation (MPE) provides a mechanism for transporting data
network protocols on top of the MPEG-2 transport streams in DVB networks.
MPE data has been optimized to carry the internet protocol (IP). MPE covers
unicast (datagrams targeted to a single receiver), multicast (datagrams targeted to
a group of receivers), and broadcast (datagrams targeted to all receivers). The 48
bit MAC (Media Access Control) addresses are used for addressing receivers.

The MPE views display the MPE data flow that is available in the stream.

‘¥ localhost - MPEG TS Compliance Analyzer

Fle Navigation Settings Captursvu™ Record Help
B @ rectart sty (Y Back (o B mreterences T @] @ TUURE @ am oo B
4
Program | Tests | SIPS! | PID | Packets | ¥|| Surnmary | MPE Sessions
(=@ Transport Stream: Id 4103, Network Name: Sanc | ‘Number of MPE Sessions: 2
L+ Jrroorain 4167 BEC ONE *=
@ Frogram 4231 BBC TWO n
@ Prograim 4351 BBC CHOICE ‘g 2305 01:00:5E:04:64:64) 1921662310, 225140400100 UDP|  1053) 9000) 33.040) NN 13770 ¥ A
Program 4415 BBC NS 24 2306 01:00.5E.0A64:65 19216825.10) 22510100.101|  UDP| 1054| 9001 31.452] N | 47T v
@ Proorem 4479 BEC TEXT 31
@ Frogram 4543 BEC PARLUNT 73 3
>
- 3 | ||l e
15 avaiatiey @)||Syne @) Bitrate 33791014 Mbps @ 18 | Packet Size - 18|  DVE| Mo Extensions | rterface - DVE paratel| [l m

Figure 1-64: MPE view
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CaptureVu feature

The CaptureVu feature allows you to capture and analyze system events during
deferred or real-time analysis to debug the intermittent and complex problems
that traditional analyzers miss.

The feature can be activated either manually by selecting the Capture button
during analysis or automatically by a CaptureVu breakpoint preset on a test. For
deferred analysis, a packet number can be identified, at which analysis will stop.
Any of these actions freezes the analysis and allows details of the analysis up to
that moment to be examined.

Links to the packet and the test (where applicable) at the point at which the
Capture button was pressed or a designated test failed are displayed in the
CaptureVu Settings dialog box.

NOTE. If a recurring test failure needs to be examined in its true context, it is
advisable to make a triggered recording. With pretriggering set, it is then possible
to examine the events surrounding a test failure. (See page 1-130, Triggered
recording.)
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Setting Up the CaptureVu

1-128

feature

The feature can be activated when a test flagged with a CaptureVu breakpoint
does not fall within the parameters set for the test. Breakpoints can be set at any
time. They will be activated during real-time analysis as soon as the flagged
test fails. To operate successfully in a deferred analysis stream, the stream may
need to be reanalyzed.

You can set a CaptureVu breakpoint as follows:
1. In either the Program or Tests view, locate and highlight the required test.

2. From the context menu, select CaptureVu Breakpoint.

Program | Tests | s1/pst | PID | Packets| | AssodatedPIDs |
= P 2.3.2 PCR Repet
=@ TR101 290

E’O Priority 1 Any PIDs listed below 3

=14 Priority 2 () PID 500 (Ox255)

Lo D 21 Transport @ PID 610 (D:e262)

. @ PID 620 (0xZ60)

(O PID A4N (N 7800

{1 238 PCR Repetition
) 2.3 PCR Discortin.
: Q 24 PCR Accuracy

2.3.a PCR Repetition

, ..... O 25PTS Disablz
[+-{) 25 CAT Trigger Action:
-4 Priority 3 I\ Audible alarm
[+ Cther

E‘x.) =FM Error E Capkurei'u™ Breakpoint
Quick Links:

Qt Go ko next red LED iR current bree F3
T

Note the addition of the breakpoint icon beside the test entry.

Program | Tests | SIfPSI | PID | Packets|

=g &I Tests
=) TR 101 290
IEIO Priarity 1
~ -4 Priority 2
© D) 21 Transport

@ 22 CRe
Qo

-4 2.3.h PCR Discontinuity |n$amr
{_) 2.4 PCR Accuracy

The CaptureVu breakpoint is now set. You can set as many breakpoints as you
require. The next time an error is detected on any breakpoint test, analysis
(real-time or deferred) will stop and the test will be identified.
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The CaptureVu breakpoint will operate during real-time and during deferred
analysis. The CaptureVu Settings dialog box is displayed as soon as a breakpoint
is reached or the CaptureVu feature is activated from the toolbar.

1File. .

pnnalysisl

| Programs | Tests | s1jpst | PIDs | Packets|
Actions v | Show: W o W | O [ 2

E FlexVuPlus™

=@ Stream Tests (62)
=@ TR 101 290 (42)
Q priorty 1
Priority 2 (1)
- @ 24 Transport
i @22cRe
U = D 2.3.2 PCR Repetition
P (@ 2:3.b PCR Discontinity Indicator
. () 24 PCR Accuracy
| m-@a2seTs(

P E-Q2EcaT

(1)
@ 2.1 Transport
@ zzCRC
@ 2.3.a PCR Repetition
@ 2.3.b PCR Discantinuity Indicator
(D 2.4 PCR Accuracy
@ z5PT5(1)
@ 260CAT

@ 1.2 5ync Byte
@ 1.3.apaT
@ 1.4 Continuity

¥ CaptureVu™ Status

Priority 3 (41)

o @ otreri20) dhz Real-time Analysis P
i () SFN Error
@ Informational Events tate
&S captured [ 0 capture ] [ Q) Restart Analysis I
Triggered at packet 935006 by 2.5 PTS

Activate this dialog when Captureyu™ triggers

Close 4

Failed outside the last update (1)

Failed v

@ 25FT5 (1)
@ EIT Actual PF Min Any Secticn Reptn Int (40
@ EITPJF Presence (1)

@ EIT Syntax (200

lazt update (4)

|5 wsitabity @/ sync @[ +1.476526 Mbps @ 166|166 3,573 Facksts :Iﬁ No Extencions | Inkerface: TP (RTR/LIDP)| ‘ﬁ =]}

The State panel in the CaptureVu Status dialog box displays the test and packet in
which the test has failed when a breakpoint has been set. Clicking either the test
or the packet identity will open the related view (Tests or Packets) and highlight
the test or packet.

You can activate this dialog box when the breakpoint triggers. When enabled, the
Capture Vu setting dialog box is opened automatically when a breakpoint occurs.

The CaptureVu Settings dialog box can also be viewed at any time by selecting
the CaptureVu Settings button on the toolbar.

With the CaptureVu feature activated, all of the TSCA tools are available for you
to analyze and inspect the saved information.

NOTE. In Packets view, only the packets contained in the last 200 MB are
available for analysis.
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Resuming analysis

Triggered recording

1-130

You can resume deferred analysis by selecting the Resume Analysis button from
the dialog box or the toolbar.

NOTE. When you select the Resume Analysis button, analysis will continue from
the point at which analysis was paused.

Similarly, you can resume real-time analysis by selecting the Restart Analysis
button from the dialog box or the toolbar.

NOTE. While real-time analysis is paused, further analysis is stopped. When the
Restart Analysis button is pressed, analysis is restarted at the current time.

During real-time analysis, stream information can only be held for a finite time.
Eventually, the stream will be overwritten by more up-to-date information.

To examine events that occur in real-time mode more closely, recordings can be
made manually or automatically. Recordings are saved to hard disk and can be
subsequently analyzed and examined in more detail.

The Triggered Recording setup is accessed using Record > Record Settings on
the menu bar; the Recording Settings dialog box is displayed. The dialog fields
are described in the following illustration and text:
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EP Record Settings
© Armed 10%,
Recording is armed. l @- Arrm ] | [ stop |

Target file

Path |D:\Test.mpg

File Size Pretrigger
k=
150 ME e
] 50 100
45z ak 27.651 Mbps 15MEB (45 ak 27,651 Mbps)
PID Filker

COnly include the Following PIDs in the recording. ..

PIDs

Trigger

(@ Manual Test Failure Tirmed

P start

[¥] Activate this dialog when recording starts Close

Figure 1-65: Record Settings dialog box

Table 1-15: Record settings

Command Function
Source selection Record transport stream packets in an mpeg file (default selection).
Source Transport Record transport stream packets in an mpeg file (default selection).
Selection
Status bar Indicates the trigger status (Ready, Armed, Recording, or Complete) and the pretrigger/recording

progress. The status and progress are also displayed on the toolbar in the main window.

Target file Path Enter the file name and path for the recording or use the browse button to find and select an
existing file name. If this file name already exists, you must approve the overwriting of the
old file when recording is initiated.

File Size Enter the file size required in megabytes. For example, for a stream at 30 Mbps, a file size of
600 MB would record approximately 160 seconds of stream information.
Pretrigger A proportion of a stream can be recorded before a trigger event occurs. (See page 1-133,

Pretrigger recording.) Enter the pretrigger size (as a percentage of file size) that is to be
recorded. (Pretrigger is not available when recording from an IP input.)

PID Filter PID numbers cannot be entered directly into the PIDs field. Use the adjacent browse button to
open the Select PIDs dialog box and select PIDs to be recorded. The resulting recorded stream
will contain only the identified PIDs. (See page 1-134, PID selection.)
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Table 1-15: Record settings (cont.)

Command

Function

Trigger

Manual

The event that triggers the recording can be one of four types, selected from the drop-down list.
In each case, the trigger is set and pretrigger recording starts when Arm is selected. Pretrigger
recording must be complete before triggered recording will start.

Recording will start when the Start button is pressed. IP analysis supports only manual
recording.

Test Failure

Recording will start when an error occurs on a flagged test.

Tests are flagged by highlighting a test in the Program or Tests view and selecting Record from
the context menu. The record icon is displayed next to the test.
g 3.1 .aMIT Act

g 2.1 Transport
(D 3.1k NIT Othe

@ 22¢Re
e WO

Q 2.3.3 PCR Repetitian e
@ 2.3b PCR Discartin, - Cor <r2-@ Epetition

D 2.4 PCR Accuracy Reset
@ 25p18 Disable
@ 2ECaT A Harm

8 Capturevu™ Breakpoint

G0 ko Test

:
@ 22¢CRC
(D 2.3.a PCR Repetition >

O 2.3.h PCR Discontinuity Indicatar
D 2 4PCR Arcuracy

You can set the Record flag on as many tests as you require; recording will be triggered by the
first flagged test that is encountered.

Timed

Recording will start when the time and date set in the Start recording at field is reached.

You can enter the date and time manually (in the format displayed). The date can be selected
from the drop-down calendar.

For all trigger types, except manual, when recording is complete, the starting packet is indicated
in the Record Settings dialog box. Click on the packet number to display it in the Packets view.

Arm button

Places the recording function into an armed state. If a pretrigger value has been specified, the
pretrigger recording will start (as shown by the progress bar). Full recording will start when
any trigger requirements are met.

Stop button

Only active during recording, this button either disarms the previously armed trigger or stops
recording immediately. Any recording made up to the point when the button is pressed will
be lost.

Start button

1-132

For manual recording, this button becomes active after arming and any pretrigger conditions
have been met; when pressed, recording will start immediately.

The Recording Settings dialog can be left open while waiting for a recording to

take place. If, after setting up the recording, the dialog is closed, the recording can
be controlled from the toolbar.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual



TSCA — Common user interface concepts

Pretrigger recording  Setting a pretrigger size allows the condition of the final recording to be examined
both before and after a trigger event. Pretriggering a recording allows a section of
a recording to be recorded before the trigger event. The pretriggered portion of
the file is filled and written over repeatedly until the trigger event occurs.

Pretrigger recording starts when the trigger is armed by pressing Arm. (See
Figure 1-65 on page 1-131.)

CAUTION. Recording may fail if the hard disk is unable to match the data
rate of the stream. This can be caused by a fragmented hard disk. Regular
defragmentation of the hard disk is recommended (refer to your Windows help).

NOTE. No timestamps are stored when performing a recording through an IP

NIC interface
§P Record Settings
€ Armed | | 10%
Recording is armed. [ 9 Bt ] | B stop |
Target file
Path |D:\Test.mpg
File Size Pretrigger
150 ME 10%
1] 50 1oo
45z ak 27.651 Mbps 15MEB (45 ak 27,651 Mbps)
PID Filker

COnly include the Following PIDs in the recording. ..

PIDs

Trigger

(@ Manual Test Failure Tirmed

P start
[¥] Activate this dialog when recording starts

Figure 1-66: Record Settings dialog box - Recording in progress
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PID selection  PIDs can be selected for recording.

To identify PIDs for recording, select the PID Filter browse button in the Record
Settings dialog box to display the Select PIDs to include dialog box.

¥ Select PIDs to include...

Select one or more PIDs.
Chonose PIDs by selecting them from the PID tree or tvping them in to the PID text box below the tree.
‘fou can select multiple PIDs as well as PIDs which are not currently present in the stream.

Using the mouse: Select rultiple PIDs with Skift depressed For cantiguous selections and L&l For non-coantiguous zelections,
Using the keyboard: Enter PIDs between 0 and 8191 in decimal ar hex (using the Ox preficl, e & 3, Svdo-fe 5, f20-35

=) Reserved PIDs (5) %
~(@) PID 0 (0% - PID 0 (PAT) B3

(@) PID 16 (0x10) - PID 16 (T or 5T) B3

- PID 17 (0x117 - FID 17 (SDT, BAT or STy B3

() PID 18 (01 2) - PID 18 (BT or 5T B

- PID 20 (0x147 - PID 20 (TOT, TOT or =T) B

(@) PIDr 8191 (01 FFFY - PID 8191 ¢Null)

EIQ Referenced PIDs in stream (20)

(@) PID 100 (OxE4) - PT B3

(@) PID 110 (0EE) - 2 (D02 (MPEG-2 Yiden) ‘) 3
(@) PID 120 (078D - 4 (004 (MPEG-2 Audia) 7

() PID 130 (0E2) - 4 (004 (MPEG-2 Audin) 7

(@ PID 200 (0xcE) - PMT 3

Q) PID 210 (0D2) - 2 (Ox02) (MPEG-2 Viden) s

~(@) PID 220 (0xDC) - 4 [0x04) (MPEG-2 Sudio)

(g PID 230 (OIEE - 4 (04 (MPEG-2 Awiddio) J3

~(@) PID 300 (0x12C) - PMT B3

() PID 310 (0136 - 2 (0x02) (MPEG-2 iden) ‘2 (E)

(@ PID 320 (0x140) - 4 (0x04) (MPEG-2 Audio)

PID(s) |18, 300, 310, 320, 330 |

W

Ok, H Cancel ]

Figure 1-67: PID selection

PID numbers to be recorded can be entered directly in the PID(s) field or selected
using the mouse pointer in combination with the Shift and Ctrl keys. PIDs that are
not currently present in the stream can also be entered.

If the Only include the following PIDs in the recording check box is selected in
the Record Setting dialog box, the TSCA will record only packets that include
the selected PIDs.
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Menu bar and options

The Menu bar provides access to a selection of major system options using
drop-down menus. The menus and their options are described in tables listed in
this section.

Table 1-16: Analysis menu options

Command Function

File Analysis... Opens the Open File Analysis dialog box

Real-time Analysis... Opens the Select Real-time Interface dialog box

Restart Analysis Restarts the current analysis

Save Captured Stream... Saves the captured stream (200 MB maximum). Only available
in real-time mode

Save TS Packets... Saves the transport packets from a PCAP (packet capture) file
with the current IP filtering. Only available in deferred mode

Recent Files Lists the most recently analyzed files. Select a file name to
reanalyze the file

Close Analysis Stop and close the current analysis, leaving the TSCA open

Exit Exits the TSCA

Table 1-17: View menu options

Command Function

Show Toolbar Show/hide the toolbar

Show Status Bar Show/hide the status bar
Tear-Offs > Lists the open tear-off screens

Table 1-18: Navigation menu options

Command Function

Back Returns to previous view

Forward Goes to next view

FlexVuPlus Goes to the FlexVuPlus screen

Select Tree > Allows selection of a navigation view (Programs, Tests, SI/PS],

PIDs, Packets, Interface)
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Configuration
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Stream

Table 1-19: Settings menu options

Command Function
Configuration... Opens the Configuration dialog box
Standard... Opens the Standard dialog box

Table 1-20: CaptureVu menu options

Command Function

CaptureVu Status... Opens the CaptureVu status dialog box

Capture Pauses the current analysis to allow detailed inspection
Resume Resumes analysis - only available in deferred analysis mode

Table 1-21: Record menu options

Command Function

Record Settings Opens the Record Settings dialog box.
Arm Arms the record function.

Start Starts recording.

Stop Stops recording.

The Record menu is only available during real-time analysis

Table 1-22: Help menu options

Command Function

About... Displays application and system information.

Select Settings > Configuration to display the Configuration dialog box. Two
configuration categories are offered in the Configuration dialog box: Stream and
Preferences. Several sub-categories are also offered.

Use this category to modify stream-related settings.

Item Description

Enable thumbnails Thumbnail views of program content will be displayed when this
option is enabled.

Reset Actions The Factory Default button restores all configuration items to
those set in the factory. All parameters, including the interface
card settings (where installed), will be reset.
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Stream - test parameters  All parameters are accessible from the Settings > Configuration > Stream > Test
Parameters window. Parameters are initially listed in alphabetical order. To
quickly search for a parameter, enter text in the search field, for example ‘BER'.
Only parameters containing the entered text in their description will be displayed.
You can clear search text by selecting the button adjacent to the search field.

¥ Configuration

ier seardh query “u| Test Parameters @
-Stream Use this page to edit the parameters for the tests in the tests tree. Not all tests have editable parameters - those that do are
IR st Parameters listed below.
. _BCRFilters A tests can ko be edited via s right-cick menu,

references
\-Font Use the fiter to restrict the fisted parameters, =g type "PCR” to show PCR related parameters.

“-Decode

Filter: | Enter text to fiter the table |[:

=
0l
linteger ... =
ms 2000 10000 50000
ms 0 3 1w [
linteger ... 5 5 100
I~ ms 100 10000 100000
" linteger.| 5 5 00
CAT max subtable repetition interval |
:alill.:le: 10000 boooo |
nits: ms e |
Min: 100 om0
Nominak 10000 B
Max: 100000 1
=] 0 0 i
Pkts/m [ 100 10000
|Integer. 2 3 &
ms 500 2000 30000
ms ] 5 100
linteger ... B 5 100
ms 2000 10000 120000
ms 0 2 100
fintsger .| 5 25 w |,

Figure 1-68: Configuration - Test Parameters

Parameter values can be changed in the same way as individual parameters. (See
page 1-111, Parameter edit.) Changes made to values in this dialog box are also
applied to the individual PID parameters, since changes made here become the
default value for the parameter.

Select the Set All to Nominal button to return all parameter values to their
factory settings. During file analysis, you will need to restart analysis for the
new parameter settings to take effect.

Stream - PCR filters  The PCR measurements provided by the MTS4000 Transport Stream Compliance
Analyzer are defined by TR 101 290. Appendix I of TR 101 290 describes the
measurements in detail, and also introduces the concept of the "demarcation
frequency" at which PCR errors are separated into drift errors or jitter errors.
Errors below the demarcation frequency are measured as drift, while errors above
that frequency are measured as jitter.

TR 101 290 also defines three standard demarcation frequencies, MGF1 (10 mHz),
MGF2 (100 mHz), and MGF3 (1000 mHz), at which the PCR measurements can
be made, and provides for a user-definable demarcation frequency, MGF4.
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From the menu bar, select Settings > Configuration > Stream > PCR Filters to
open the PCR Filters dialog box. (See Figure 1-70.) Any PCR error below the
low-pass filter cut-off frequency will be measured as drift; any error above the
high-pass filter cut-off will be measured as jitter.

The filters can be set to any of the standard MGF profiles, or a user desired
cut-off frequency, by selecting MGF4 and entering a value between 1 mHz and
10000 mHz (10 Hz).

Alternatively, these filter values can be changed by selecting Settings >
Configuration > Stream > Test Parameters from the menu bar, filtering the
appropriate parameters, and making the required changes.

Test Parameters &
Use this page to edit the parameters for the tests in the tests tree. Not all tests have editable parameters - those that do are
listed below.

A test’s parameters can zlso be edied vis s rightclick mene,

Use the fiter to restrict the listed parameters, eg type "PCR" to show PCR related parameters.

Filter: | -pass filter Ex
mHz 1 10 10000
mHz 1] 100 10000
Figure 1-69: PCR parameters - Filter settings
¥ Configuration E|
|5 PCR Filters @
Use this page to set the PCR drift and jitter cutoff frequencies.
i..Test Parameters Any PCR error below the low pass filter cutoff frequency will be measured as drift, while any error above the high pass filter
S cutoff will be measured as jitter.
ferences For more information sbout these demarcation filters, see ETSI TR 101 290 (5.3.2 and Annex D).
s-Font
+Derode PCR_FO/DR Low Pass Fiter

(3 MGF1 (10mHz) - Default
() MGF2 (100mHz)

() MGF3 (1000mHz)

MGF4 mHz
e

Measurement settling time: 500s

PCR_AC/01 High Pass Filter
() MGF1 (10mHz)

(=) MGF2 (100mHz) - Default
() MGF3 (1000mHz)

Measurement settling time: 50=

Parameter changes will take effect only after analysis is restarted.

Figure 1-70: Configuration - PCR Filters
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Note that the TR 101 290 drift limit of £75 mHz/s is only defined at a demarcation
frequency of 10 mHz. As the low-pass filter frequency is increased above that
value, more of the PCR jitter will be measured as drift, and so the measured drift
values will increase. If you are attempting to check that your source PCR clock
is compliant with the TR 101 290 limits, the low-pass filter cut-off frequency
should be set to 10 mHz.

Settling Time. All of the PCR measurements that depend on demarcation filters
have a settling time.

The measurements will not return valid values before this time elapses. The
settling time is indicated on the PCR graphs in the TSCA.

This settling time is inversely proportional to the cut-off frequency of the
demarcation filter. This means that there is a trade-off between reducing the filter
frequency to improve drift measurement accuracy and increasing the time it takes
to obtain any drift measurements at all.

Filter cut-off Settling time TR101-290 profile Comments

10 mHz 500 s MGF1 TSCA default for PCR_FO/DR low-pass
filter cut-off; drift limit of£75 mHz/s is only
applicable at this level

100 mHz 50s MGF2 TSCA default for PCR_OJ/AC high-pass
filter cut-off.

1000 mHz (1Hz) 5s MGF3

1 mHz - 10,000 mHz 5000s-0.5s MGF4 User-defined profile

For more information about PCR measurements, please read the PCR
Measurements Primer, available on the Tektronix Web site (www.tektronix.com).
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Preferences

Use this category to modify general preferences.

‘¥ Configuration @

[F-Stream Use this page to madify general preferences.
Test Parameters
PCR Filters
A
= Default File Folder ‘C. ‘

Font

f Maximum File History Size | 4 3 ‘
‘--Decode

Timezone for timestamp display ‘ Local v‘
Packet Size used for TSbitrate 188 (%
Optimise for UI performance [

Colour Scheme [aaéuh -

Figure 1-71: Configuration - Preferences

Default File Folder: Set the default folder that will be shown when first
displaying the Open File Analysis dialog box in a session.

NOTE. Navigating away from the set folder within the open dialog box will
change the default folder shown for this session only.

Maximum File History Size: Specify the maximum number of file names to be
shown in the Analysis > Recent Files list.

Timezone for timestamp display: This setting affects the display of timestamps
in the event log.

The available timezones are: Local: The timezone set on the PC running the
client application UTC: Universal Co-ordinated Time Remote: The timezone set
on the system running the analysis engine

Connecting to a remote machine, the Local and Remote settings will produce
different timestamps if the client and device are in different timezones.

When connecting to localhost, the Local and Remote settings will yield the
same displayed timestamp, since the client and remote software are on the same
machine, for example, an MTS4000 instrument.

Packet Size used for TS bit rate: Specify the packet size (188 or 204) to be used
to calculate the transport stream bit rate. This is displayed in the status bar.

Optimize for Ul performance: Under some circumstances when analyzing
large files or using low specification instruments, the user interface may appear
to freeze. Enabling this feature will cause the user interface to refresh at more
regular intervals, thus reassuring you that the analysis is progressing.

Color Scheme: Select the background color for all graphs. When Default is
selected, the graphs are based on a white background. When Instrument is
selected, the graphs are based on a black backgrounds.
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Preferences - font The Font preferences option allows you to specify the display font and size for log
entries and stream content. Place the cursor in the field to be changed and select
the font name or font size required from the displayed drop-down list.

E ) |5 Font @
S-Stream Use this page to change the fonts used throughout the application. For instance, when displaying stream contentin a
i..Test Parameters language different from the operating system default, select a font that supports the language's character set. Additionaly,
i..PCR Filters the font sizes may be increased to provide better readability on small screens.
[=-Preferences More information on what each font is used for is displayed by hovering the mouse cursor over the font row.
“-Decode o Font Name Font Sze
Standard <<default=> Normal Tahoma
|Log Ent <=default=> MNormal SansSerif
|5tream Content <<gefault=> Normal SansSerif

Set to Default sets ll the fonts to the name shown in the Locale

Default Font column and sets the sizes to Normal. SethoDefoult

Copy Standard sets the Log Entries and Stream Content fonts
C Standard

to the currently selected Standard font name and size. opYy StEnoan

Click Apply to immediately see effect of new font settings.

Figure 1-72: Configuration - Preferences - Font

Preferences - decode  The decode preferences relate to the VLC Media Player that can be used to play
elementary stream video and audio content.

r -

ﬁ" Configuration
Filter: | Enter search query =&/ Decode @
[=)-Stream LUse this page to select a player application to decode the video. When analysing a stream in real-time
{ -TestParameters mode, the data can be streamed to a local port. Changing any settings on this page will stop any
\..PCR Filters current decode session.
El-Preferences
LFont Select Player

Tektronix VQS1000 Yes
UDP Network Stream Yes Real-time only
VideoLAN VLC Yes Both

Selected Player: C:\Program Files (x88)\VideoL ANWLC Yvlc.exe

Figure 1-73: Configuration - Preferences - Decode

VideoLAN VLC: Selecting the VLC setting indicates that a stream should be
sent to the VLC Media Player.

UDP Network Stream: The UDP setting, which is only available for real time
systems, is used to designate the port over which streams should be sent to
external players, for example, the MPlayer. The UDP Destination can be set
either automatically or manually.

Tektronix VQS1000: Selecting the VQS1000 setting indicates that a stream
should be sent to the Tektronix VQS1000.
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Script files
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In the TSCA, scripts provide a method of interpreting and displaying standards
during analysis. Scripts provide templates, which determine how the SI
information found during stream analysis will be displayed. The scripts must cater
for all the information that may be found in a stream, including the various table
types found in all of the identified standards. To this end, it has been found that
the best approach is to make the scripts modular; each script module deals with
different aspects of the SI and standards.

For example, when DVB is identified as the standard against which to analyze,
the scripting dialog box displays a list of Script modules. Additionally, when it
is known that tables or descriptors not commonly carried in the identified base
standard and region are likely to be included, extra scripts can be written and
added to the Script Files list to be used for the analysis.

Essential scripts are installed and enabled using the Stream Interpretation dialog
box. In the absence of any enabled scripts, only the PAT table will be analyzed,
and all other data will be presented as private data.

Scripts can be customized or new scripts can be written to analyze private data.
With the Custom Scripts checkbox enabled, if a suitably configured script

is selected and enabled before a stream is analyzed, custom data will also be
analyzed when the stream is opened.

Scripts can be selected and enabled when files are open; analysis will restart
as soon as any changes as accepted.

A script file will not be used for analysis until it is present in the Script Files panel
of the Open Transport Stream dialog box.
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Setting stream  Set the stream interpretation as follows:
interpretation

¥ Standard

Standard and Region
Select a standard and region to use for analysis
Mote: Changing the standard or region and pressing OK will restart the analysis

EBase Standard | ~ | Region |N-:- Extensions ~ |

Scripts

[]Use Custom Scripts

[] Enable scripted section validations during analysis (slower)

Scripts Directory | ‘

LJBL .

FEEEEEEEEEED
N| @« P

LY

[ 0K &J[ Cancel

Figure 1-74: Stream Interpretation dialog box

1. Select Settings > Standard to open the Standard dialog box or select Change
from the opening dialog box.

2. From the Base Standard drop-down list, select the required base standard.

The selected standard will dictate the availability of options that are available
in the Regions drop-down list.

3. From the Region drop-down list, select the required region.

The regions list allows country-specific extensions to be added to the base
standard scripts. If No Extensions is selected, only the standard scripts are
listed in the script list. The remaining country-specific extensions add extra
scripts to the current listing. Scripts that will be used are listed in the main
pane.

Scripts listed by default are resident in the default
installation directory (program files\missing files
(x86)\tektronix\mpeg\mts4000\scripts). Other directory locations
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Custom script selection
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can be specified in the custom script selection mode. All selections will be
retained between TSCA sessions.

4. Select OK to confirm changes.

Scripts are syntactically analyzed when the OK button is selected. A fault in the
syntax of a script will not necessarily prevent a stream from being analyzed, but
it may result in an incomplete analysis of the stream. Errors in the script syntax
will be noted in the stream log.

When the Custom Scripts checkbox is enabled, the buttons beside the script listing
become active and custom scripts can be selected in addition to the standard
scripts. Some script names in the listing are dimmed; these are considered to

be essential and cannot be removed.

¥ Standard

Standard and Region
Select a standard and region to use for analysis
Mote: Changing the standard or region and pressing OK will restart the analysis

L]

Base Standard |D*.fB w | Region |N0 Extensions
Scripts

Use Custom Scripts

[] Enable scripted section validations during analysis {slower)

Scripts Directary ‘C: Program Files\Tektronix\mpeg \MTS400\Scripts

@ tektronix. scp

B Ethernet.scp

3 MPEG Packet.scp
&4 DvB_SFN_MIP.scp
@ mpeg.scp

m mhp, scp

@ mpe, scp

B dsmec.scp

@ mpeg_pat.scp
F4 DPI_SCTE3S.8cn

() (8] [@]®] (n]le] @] (]

[ OK %H Cancel ]
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The buttons operate as follows:

Button Operation
Resets the script list to the default list for the standard and
B region.
Opens the script selection dialog box. You can highlight the
required script and select OK. The script name is added to the

Script Files list.

@ Removes any script name highlighted in the Script Files list.

@ @ Scripts are applied to streams in the order that they are listed
in the Script Files list. Use these buttons to move a highlighted
script up and down in the list.

. Opens the highlighted script in ScriptPad (the Tektronix script

<4 editor).

Verifies the syntax of the scripts listed in the Script Files pane. A
message window lists any errors found.

If the standard script list has been changed and you want to return to the default
list of scripts, highlight the Base Standard and Region required, and select the
default script button. The list will be overwritten with the default list.

More information about ScriptPad can be found in the MTS4000 Generator
Applications User Manual.
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Scripts directory

Script validation

The Scripts Directory field indicates the root directory for scripts named in the
Script Files list when analysis starts. If scripts are not present in the scripts
directory, the interpretation and validation of the SI will be incomplete.

NOTE. If the script list is modified in any way, always use the n button to verify
the changes.

Scripts can be selected from any directory (using the + button). If the directory
is not the same as that identified in the Scripts Directory field, the path (either
relative or absolute) will be displayed with the script name in the Script Files list.

NOTE. The Scripts Directory browse button allows you to specify a default
directory for script selection. The browse window does not display the scripts
available. If you need to see the scripts available, use the Windows Explorer.

If the standard script list has been customized and you want to return to the default
list of scripts, highlight the required Base Standard and Region and select the
default script button. The list will be overwritten with the default list.

NOTE. Each Base Standard and Region combination can be individually
customized.

Validating scripts checks the syntax of the listed scripts.

If the "Enable scripted section validations during analysis" check box is enabled,
the scripts are checked during analysis to ensure that the data as defined by the
scripts is as expected (for example, values are within specified ranges). A fault in
the syntax of a script will not necessarily prevent a stream from being analyzed,
but it may result in incomplete analysis of the stream. Errors in script validation
will be logged in the stream error log. Enabling this check box may have an
impact on real-time analysis.
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TSCA - Task examples

The examples in this section describe how to locate a fault or information using
the analyzer.

To use this section, you should have a basic understanding of the analyzer user
interface and be familiar with the more important aspects of digital television
transport stream structure and interpretation standards.

The MPEG Test System is a tool which allows you to analyze a transport stream
and then examine it in detail. Errors in the content can be identified and examined
to byte level.

Because of the comprehensive nature of the analyzer, there are a number of ways
of achieving your objective. In these examples, one or more ways are described to
achieve the objective.

Error status  LED icons are used throughout the analyzer interface to represent the status of
the tests applied to associated items, for example, programs. Colors used are as
follows:

(Red) Error; test failed

(Yellow) Transient error (error not currently being detected but
has been seen since last reset)

(Green) No error; test passed

(Dark Blue) Warning (Interface tab only)

¢ ¢ L e

(Light Blue) Transient warning (warning not current, but has
been detected since last reset) (Interface tab only)

(Gray): Test disabled

<

L | (White) Test not applicable or unknown state

oo

% (Red) PID referenced but not found in the stream

3 (Green) PID referenced but not found in the stream; applicable

test disabled.

When an LED represents a parent node in a tree (for example, a program node is
the parent of elementary stream nodes) or a navigation tab, the color represents
the worst case of all of its tests and the worst case of all of the tests represented
by its child nodes.

Similarly, when an LED representing a parent node in a tree is disabled or
enabled, all subsidiary (or child) nodes are also disabled or enabled to reflect the
state of the parent node. When an LED representing a parent node is reset, all
the child nodes are also reset.
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Which tests have failed in an analyzed stream

Method

1-148

In this example, the analyzer has just finished analyzing a stream. The Program
navigation view is initially displayed with the transport stream tree collapsed. The
transport stream error LED is red, indicating that one or more tests have failed.
(See page 1-36, Error status LEDs.)

With the Program tab still selected, view the tests summary view (bottom right).

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis Wiew Mavigation GSettings CaptureVu™ Help

EEX

2 0 1]
¢ 5 Restart | Comples EIEEEREERE 100%

M FlexNuPIus"" pAnawsh|
Programs | Tests | 51/Pst | PIDs | Packets| [ summary | Thumbnais | MPE sessions|
actons v | O [{ 5

=@ Transport Stream: Id 4103, Network Name: S
@) Program 4167 (0x1047) BBC ONE '&n
& ' Program 4231 (0x1087) BBC TWO "&®
- @ Program 4251 (0x10FF} BBC CHOICE ‘&%
@) Program £415 (0x113F) BEC NEWS 24 '
(- @) Program 4479 (0x117F) BBC TEXT 3i{
& ‘ Program 4543 (0x11B6F) BBC PARLMNT

E |% <& Transport Stream: 1d 4103, Network Name: Sandy Heath

Number of Programs 6

Current TS bit rate 24.128 Mbps

CurrentT5 bit rate excuding Null PID 22.116 Mbps

Curent Bit Rate: <) | Min{Mbps) Mo

[ ]

4167 (0x1047) I N 6.095| 5,790 6.115 71

4231 (0x1087) | 6.108] 5.805] 6,169 21,

BBC CHOICE 4351 (0x10FF) | 6. mj 5.804 . 166) 2L
BEC NEWS 24 4415 (0x113F) — 5.983 5,679, 5.936 0,
BBC TEXT st xit7r) M 0,895 0.554 0.902 3.
BBC PARLMNT (4543 (0x11BF) [ M 0.993] 0,686 0.994 3.
| b3

@ 1.1Sync @ 2.1Transport @ 3.1aNIT Actual (2) fad

@ 1.2SyncByte @ 22ccRe (2 3.1b NIT Other
@ L3apPAT @ 2.3.2 PCR Repetition @ 3.251 Repetition (17)
@ 1.4 Continity @ 2.3.b PCR Discontinuity Indicator @ 3.4.aUnrefPDD
@ 153PMT (D) 2.4PCR Accuracy @ 3.5.2 50T Actual (14)
@ 167D (44) @ 25FTs @ 3.50 50T Other
@ 26cCAT @ 3.5.2 EIT Actual (56)
@ 3.6.bEIT Other L
@ 36.cETTPF
¢ I 5 @ 3.7RST ]

- ‘, = p— T —
TS Availabiity @) |Sync || 24.128335 Mbps @ 188 || 204|| 511,360 Packets| | DVB || Mo Extensions| | [ill]

Figure 1-75: Failed tests - example

Identify the tests that have failed (red LED). The following tests have failed in the
test summary view (TR 101 290 tab) : (See Figure 1-75.)

®  First Priority: 1.6 PID

B Third Priority: 3.1a NIT Actual; 3.2 SI Repetition; 3.5a SDT Actual; 3.6a
EIT Actual

Remember that the tests may be distributed over more than one tab in the test
summary view; the color of the LED on the tab helps you locate the failed tests.
(See Figure 1-75.)
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You can view a test (and see other PIDs that it has failed on) by highlighting a test
and selecting "View this Test in Tests Tree" from the shortcut menu:

g L@t
1 & PIN (44!

Edit Parameters...
Reget

—_ Digable c

— Ensble r

04

— =

act Dizable All Tests e
Enable All Tests

Audible Alarm
Captureyu™ Breakpoint
Clear All Trigger Actions

View this Testin Tests Tree

You can also display the fault by expanding the tree in the Tests navigation view
until the fault is revealed.

Expanding the test itself reveals the PIDs that have failed the test.

Programs | Tests | SI/PSI | PIDs | Packets
Actions ¥  Show: W ) W | ©

=@ Stream Tests (134)

= @ TR 101 290 (133)

. =@ Priority 1 (44)
0 1.1 Sync

- @ 1.2 Sync Byte
=@ 1.3.aPAT
(@ 1.4 Continuity
=@ 15aPNT
EX" J16PD (44
@) PID 602" 0x254)

@) PID 603 (0%25B)

™ Din =17 TR
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How many PIDs are there in a stream?

How many PIDs are referenced?

How many are unreferenced?
For this task, the PID navigation view is used to view information about
individual PIDs in the transport stream. Under the All PIDs node, which displays
all of the PIDs in the summary view, there are four subgroup nodes: Reserved

PIDs, Referenced PIDs, Unreferenced PIDs, and User PIDs. The number (in
parenthesis) in each node gives the number of PIDs found during analysis.

Method  Select the PID navigation view.

1. Expand the All PIDs node to display the subgroups (and their quantities).

Pragram | Tests | SIPSI| PIQ, | Packets

Al Picls (487 r'-let'-.-'-.-'-:nr'h:.r'-l atme: Sandy Heath

2. Expand the All PIDs node to display the subgroups (and their quantities).

Program | Tests | SIPS!| FID | Packets

° Al Pidz [ d8): Metwork: Mame: Sandy Heath
() Reserved PIDs
° Referenced PIDs in stream (41
O Unreferenced Pl in stream (0]
Q) User Pids: (1)
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What tests have been applied to a program PID?

1. Select the Program navigation view.

1 .
Program | Tests | SWPSI | PID | Packets i| @ sssocisted Tests | pTg Graphs || Bit raf

= 0 Transport Stream: [d 03, Metwork Name: Sancy PID 6803 [0!255] Stream wpe. f
= @ Prooram 4167 BEC OME ‘=m

@ P 600 (0:258) ' B)
Q PO BT (0x258) A () 1.4 Cortinuity
% roe02 (0xz2s8) B Q1&pPD
Q IR = () 2.3.a PCR Repettion
0 PID 650 (03284 j#1i () 2.3 PCR Discontinuity Indicator
¢ PID 651 (0x288) 181 () 2.4 PCR dccuracy
8 FID 652 (0280 151 D 25PT3
Q) PID 1005 (Dx3ED) 331 () 34.aUnrefFD
$¢ PiD 1008 (03EE) B4 @ FID Occupsmey
& PID 1007 (D3R d84t () PCR Overall Jtter (PCR_OJ)
0 PMT PID 4167 (0x1 0477 () PCR Freguency Offset (PCR_FO)
@ FProgram 4231 BBC TWO 'an @ PCR Dritt Rate (PCR_DR)
@ Frogram 4351 BBC CHOICE 'ax Q FID Bt Rete Wariabilty
@ Frogram 4415 BEC NEWS 24 &p @ Discontinuity

= @ Program 4479 BEC TEXT 4t

2. Expand the Transport Stream tree until the required PID can be highlighted.

In the Associated Tests view, note the tests that are enabled. Gray LEDs indicate
tests that have been disabled, and white LEDs indicate tests that are not applicable
to the selected PID.
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Establish the stream type of a PID

Method 1

1. Select the Program navigation view.

Frogram | Tests | SIPSI | PID | Packets

QD Associsted Tests | pTS Graphs | it ra

= @ Program 4167 BBC OME '2p
() PID 600 (0%258) "2 (T
() PIDBO1 (0x259) A
$roo0zoxasm A

= @ Transport Strearm: 1o 4103, Network Name: Sandy

PID 803F (0x25B) Stream type: !

() 1.4 Cortinuity
Q15PD

(J 2.3a PCR Repetition

[®Fi0 603 ( ]
Q) PID 50 (0284 jog1e
$8 riD B51 (0x28E) d01¢

() 2.3.1 PCR Dizcartinuty Indicator
() 2.4 PCR Accuracy

$8 PID 552 (0x28C) 81 Q 25PTS
Q) PID 1005 (0x3ED) 148 (J 3.43 Unref PID
S8 PiD 1005 (0x3EE) 184 @ P Cccupancy

i.-_) PCR Overall Jitter (PCR_CJ)

O PCR Frequency Offzet (PCR_FO)
0 PCR Crift Rate (PCR_DR)

D PID Bit Rate "arisbilty

@ Discortinuity

$% PiD 1007 (0x3EF) 164

D PMT RID 4167 (D:1047)
@ Frooram 4231 BEC TWO
° Program 4351 BBC CHOICE ham
@ Frogram 4415 BEC MEWS 24 e
i @ Program 4470 BBC TEXT 146

2. Expand the Transport Stream tree until the required PID can be highlighted.

3. Keep the cursor over the PID. A tooltip will display the stream type.

$8 P 602 (0x250) A
o =
Q) PID B50 (0x284) 810
“ PID 651 (0x266) igqotream type: & (0x0D6) (PES private data)|f‘ﬁ'1-
$2 0 652 (Dx28C) i | ' “ | “—‘3 ZaRTs

() 2.3.a PCR Repeti
() 2.3h PCR Discot

‘ @ 15FD

The tooltip is available wherever the selected PID node is displayed (for example,
in the PID navigation view).
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Method 2 1. Select the Program navigation view.
2. Select the program node.

3. In the summary view, select the Summary tab.

> T | T T ST | = ™ al
Programs | Tests || SI/PSI || PIDs | Packets| ¥|| Summary |Thumbnai|s | @ Program Tests | Bitrate Graphs|
Actions v | @ 3] [

E|° Transport Stream: id 4103, Metwork Name: S3

- O IR | || [E|® ok

----- @ PID 500 (0x258) ‘e i Program number = 4167 (0x1047)

""" Q@ P 601 (0258) A Service Provider = BBC
----- 8 rD602 (x2sh) R
----- @ riD 503 (x258) 2 Service Type = 1 (0Ox 1) {digital television service)
----- @ PID 650 (0x284) 1 Now/Next

----- $8 riD 551 (0x28E) 11 ok
""" 8 P 652 (0x250) 2 m The Sound Of Music 13:25 - 16:10 UTC

[ 55c News 16:10 - 16:25 UTC D> | @ PID 600 (0x258)

----- 8 P 1007 (0x3eF) B4
----- @ PuT PID 4167 (0x1047) B

- @ Program 2231 (0x1087) BBC TWO ' s : T v oo m

'EJ"O Program 4351 (010FF) BBC CHOICE ‘& 500 (0%258) =10 2 (0x02) (MPEG-2 Videa) 0.007
2 £ s :

i@ Program £415 (0x113F) BBC NEWS 24 "2 [ 601 (ox253) A 3 (0x03) (MPEG-1 Audio) 0.037

- @ Program 4479 (0x117F) BBC TEXT it [$8 602 (0c258) AN 3 [0x03) (MPEG-1 Audio) 0,000

Note the Stream Type column in the display. The stream type is given for each
PID in the selected program.

How many programs are there in the Stream?

1. Select the Program navigation view.

2. Expand the Transport Stream tree and note the number of program nodes.
(See Figure 1-76.)

3. The Summary view (bar chart or pie chart) also displays a program count.

S FlexvuPlus™ &2 Analysis |

Programs |Tests SL/PSI || PIDs || Packets : Summary |Thumbnails MPE Sessions

- | o | |

Bo Tranzport Stream: Id 4103, Network Name: Sa F Q‘ - I 1d 41 N
i@ Program 4167 (0x1047) BBC ONE ‘& ' & <2 Transport Stream: Id 4103, Network N

(@ Program 4231 (0x1087) BBC TWO &k Number of Programs 6

@ Program 4351 (0x10FF) BBC CHOICE '&» Current TS bit rate 24.128 Mbps
-@ Program 4415 (0x113F) BBC NEWS 24 '
=@ Program 4479 (0x117F) BBC TEXT 104

@ Program 4543 (0x11BF) BBC PARLMNT

Current TS bit rate exduding Mull PID 22.116 Mbps

Figure 1-76: Program count
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What are the contents of the Programs?
And what Pids are they on?

1. Select the Program navigation view.

2. Expand the Transport Stream tree and a program node as shown in the
following figure.

3. Note the number of program PIDs. Each PID is accompanied by an icon
indicating the stream type. Hold the cursor over a PID node to display more
information.

4. The Summary and the PID Information views also display the program PIDs.

E FlexVuPlus™ D Anah'si's‘

Programs | Tests || s1/pst | PIDs | Packets|
Actions w Q‘ =

EI° Transgport Stream: Id 4103, Network Name: 53 |§|
= o prErTEEE | || F)e EcoER

LY

Surnmar y | Thumbnails || Q Program Tests " Bit rate

..... o PD 500 (0x253) 'E)ﬂ A Proaram numhbar — d167 leT)

IIIII o PD 801 (0x255) 1 Prugram 4167 (0% 1047) BE!C_ONE o B

..... $8 P 602 (02en) 2 Service Type: 1 (0x 1) (digital television service)

..... @ 0203 (0.2e6) Service Type = 1 (0x 1) (digital telev
----- @ PD 650 (0x284) 11 _
----- $8 FDEs1 (0x28E) il

..... 8 Po 52 (0x28c) hB4 (2270 e Sound Of Music

----- Q PID 1005 (0x3ED) 1341

---- $8 rD 1008 (ox3EE) i m RAC Hews

----- $8 P 1007 (0x3EF) B4

----- @ PUT PID 2167 (0x1047) B3

4@ Program 4231 (0x1087) BEC TWO &
i+ (@) Program 4351 (Dx10FF) BBC CHOICE %k
- Program 4415 (0x113F) BBC NEWS 24 = fnt vz T T

P
D)

@

=]

=1
=

=

e

n

=
@
3¢

Figure 1-77: PID count
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What is the bit rate of each PID in a program?

Bit rates are displayed in the Program and PID summary views. The bit rates
displayed depend on the node highlighted in the navigation view.

Table 1-24: Bit rate views

Bit rates displayed in

Navigation view Node Summary view

Program Transport Stream All programs

Program Program Program PIDs

PID All PIDs All PIDs

PID Secondary nodes PIDs in secondary groups
(Reserved, Referenced, PIDs

Unreferenced, and User)

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser
Analysis Wiew Mavigation GSettings CaptureVu™ Help

FH FlexvuPlus™ £ Anaiysis |
Programs | Tests | 51/Pst | PIDs | Packets|

actons v | O [{ 5

¥|| Summary | Thumbnails | ) Program Tests | Bit rate Graphs

=@

Transport Stream: Id 4103, Network Name: S — N "
Q Program 4167 (0x1047) BEC ONE =2 ‘E‘Q BEC ONE

Q) PD 800 (x258) ' Program number = 4167 (0x1047)
Q) PD 601 (0x259) A

$8 P 502 (02sa) A Service Provider = BBC

i A}

@ PIn 603 (ez5B) (2 Service Type = 1 (0 1) (digital television service)

i PID 650 (0x28A) — .

88 PD &1 (1x288) § Now/Next

B fimireei) [0 e o ornsie e

i S (0x3ED)

88 P 1006 (0x3EE) BBC News 16:10 - 16:25 UTC

L9 v oos ooy =0 >u @ PID 600 (0x258)
@ PUT PID 4187 (0x1047) ED

Show fiter @
@) Program 4231 (0x1087) BBC TWO '8 S e ]
- @) Frogram 4351 (0x10FF) BBC CHOICE ‘@ S0 (0se) D
G
G

Q 2 (0x02) (MPEG-2 Video) 0.007
@ Program 4415 (0x112F) 8BC NEWS 242 | || 01 (3x259) 3 (0%03) (MPEG-1 Audic) 0.037

@ Program 4472 (0x117F) BBC TEXT 151 $8 502 Bx25A) 3 (E%0%) (MPEG—1 Audic) 0.000

@ Program 4543 (0x11BF) BBC PARLMNT '@ 05 ) & (6x0%) (P55 private da) o

Q@ [550 (0x288) 11 (0x0B) (DSM-CC U messages 0.006

(98 [551 (0x288) 11 (0x0B) (DSM-CC U-N messages, 0.000

(88 552 0x2aq) 11 (0x0B) (DSM-CC U messages 0.000

@ [1005 (0x3ED) 11 (9x0B) (DSM-CC U-N messages 0.0

9% [ 1006 ©Ox3eE) 11 (0x0B) (DSM-CC U-N messages 0.000

18 [1007 367 11 (0x0B) (DSM-CC UN messages 0.000

(@ [9167 0x1047) PMT 0.250

< | » £ >

|75 availabiity @ |sync @) | 24.128335 Mbps @ 188|204 511,360 Packets| | V8| Mo Extensions| | [l

Figure 1-78: Program PID bit rate - bar chart

The PID bit rate summaries can be displayed as either bar charts or pie charts by
selecting the appropriate icon at the top left of the Summary view.

Barchat —— & ﬂ. ~ Piechart
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B FIexNuPIus"" pA"ﬂVS'E|

—_— —— -
Programs | Tests || s1/Pt | PIDs | packets| »|| summary | Thumbnails | ) Program Tests | Bit rate Graphs|
actons v | O [{ 5
£ @ Transport Stream: ld 4103, Network Name: S
- ormyETmETTE || || F ¢ B ——
@ PD 800 (0x258) ‘=S Program number = 4167 (0x1047)
- Q Ppeo sy A Service Provider = BBC

88 PD 602 iDx254) A
Service Type = 1 (Ox 1) (digital television service)

[ The Sound Of Music 13:25 - 16:10 UTC

[T sc tews 16:10 - 16:25 UTC >m

@ PID 600 (Dx258)
@) PMT PD 4167 (0x1047) B3 J

@ Frogram 4231 (0x1087) BEC TWO ' PID Bit Rate Occupancy (Current) § (SRS

£ @ Program 4351 (0x10FF) BBC CHOICE | |- cumulative Bit rate: 6.114 Mbps 58) 4926 Mops
@ Program 2415 (0x113F) BBC NEWS 24 ' |- T Kbps

@ Program £479 (0x117F) BBC TEXT i§4{

@ Program 4543 (0x11BF) BBC PARLMNT

49 760 Kbps.

Obps
0bps
PID 1005 (0x3ED) 51.136 Kbps
> PID 1006 (Ox3EE) 0 bps
> PID A 3EF) Obps
PID 4167 (0x1047) 18.048 Kbps

< | >

|T5 Aavallabiity QHsync Q|| 24128335 Mbps @ 188 | 204) 511,360 Packets| DVB| Mo Extensions| ] g‘

Figure 1-79: Program PID bit rate - pie chart

A selection of statistics for each program or PID is shown in the charts. Either
current or mean bit rates can be shown by selecting the Show Mean Values option
from the Summary view shortcut menu. For deferred analysis, the current bit
rate is the final bit rate.
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You can also display a bit rate graph for the highlighted node by selecting the Bit
Rate Graphs tab.

B FlexvuPlus™ pAnaNS'E|
Programs | Tests | SUPS | PIDs | Packets|

Adionsv | & [ F
2, Network Hame: S addeahE] & o K E O 2
S pnooe s Data at Cursar
utC - Date/Time

P——
¥| | summary | Thumbnails | ) Program Tests E\tratEGrEDhS‘

- PID 601 (0x259) A
-8 PD 602 (x258) A
@ P 603 (0x258) =
@) PID 850 (0x28A)
- §8 PID 851 (0x28B)
88 PD 652 (0x28C)
@ PID 1005 (0x3ED)
- §8 PID 1006 (0x3EE) 1B
. §8 PID 1007 (0x3EF) 184
@) PMT PD 4167 (0x1047) B3

- @ Program £231 (0x1087) BBC TWO *&»
i@ Program 4351 (0x10FF) BBC CHOICE '8
@ Program £415 (0x113F) BBC NEWS 24 =
£ @ Program 4479 (0x117F) BBC TEXT 81
@ Program 4543 (0x11BF) BBC PARLINT

< il | > < | >

|TS Availability OHSWC Q” 24.128335 Mbps @ 188 ‘ ‘204” 511,360 Pad(ets‘ ‘ DVE”Nn Exhensmnsl

Figure 1-80: Bit rate graph
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What is the latest version number of the Program Association Table (PAT) in
the SI?

Tables and their versions can be found in the Tables (SI/PSI) view. When a node
representing a table is selected in the navigation view, the table identity and the
version are displayed in summary view (top right) as shown below.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser

Analysic View Mavigation Settings Captureyu™ Help
Open File
B FIexNuPIus"" £ Analysis
Programs | Tests| SUPSI | PIDs | Packets| | Summary | section | s Repetition Graphs
R Export...
=6 Jobics) Table ID 0, Version 12 @ 00:00:00 (carried on PID 0)
=88 Programs (PAT/PIITISDT actual)
PAT
B8 Pu
B Networks (NTs) :
&) Time (TOTAOT) Transport Stream ID = 4103 (0x1007)
(£ EPG (EM/SDTMET) Network_PID = 16 (0x10)
-5 DSm-CC E \
Program Number PMT PID
4167 (0x1047) PID 4167 (0x1047)
4231 (0x1087) PID 4231 (0x1087)
4351 (0x10FF) PID 4351 (0x10FF)
4415 (0x113F) PID 4415 (0X113F)
4479 (0x117F) PID 4479 (0x117F)
4543 (0x11BF) PID 4543 (0x11BF)
]
£ >
|75 Availability jSsync Q< 24,128335 Mbps @ 188 204511, 350 Packets {Dua? o Extensions| lii7]

Figure 1-81: Table Identity and Version (summary view)

The table identity and version can also be seen in the table header using the Tables
(SI/PS]) section view as shown in the following figure.

1-158

I | | | 4 . |
Frogram | Tests| SWPS! | PIC || Packets | F|| Summary | Section | Sl Repetition Graphs |
= (P Tables Subtable |
= Eg Programns (PATFMTIEDT actual) “ersion | :
PATR
PMTE {} PAT

B8 SDT actual
# g Bouguets (BATS)
Metvworks (MTs)
Titme (TDTTOT)
# g EPG (EIT/SDTIRST)

= {} table_header
@ table_id = Q0= Q) (PAT)  «—— Tgple |dent|ty
@ zection_syntax_indicator =1
@ szection_length = 33 [0x21]
@ transport_stream_id =1 [0x1]
@ version_number = 0 [0x0] . Version number
@ currert_next_indicator =1
@ szection_number = 0 [0x0]
@ l=st_=ection_number = 0 [0x0]

=1 {} programs

# {} program_numier = 0 [0x0]

Figure 1-82: Table Identity and Version (section view)
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Examine a transport packet

A transport stream packet is a unit of data that contains a header and a payload.
The Packets view allows individual transport stream packets to be identified and
examined.

Navigating around the = The navigation bar at the top of the Packet summary view is used to move
packets  between packets. How the controls work depends on the selection in the Packets
navigation view. If All Packets are highlighted, the controls will operate on all
packets. If a PID has been identified, added to the PIDs node and highlighted, the
controls will operate only on packets carrying the selected PID.

EIKIERER| o 059659

Current packet position

The packet position bar shows the position of the selected packet in the stream.

The controls work as follows:
Selects the first available packet (in the stream or carrying the
selected PID).

Selects the previous available packet (in the stream or carrying
the selected PID).

Selects the next available packet (in the stream or carrying the
selected PID).

Selects the last available packet (in the stream or carrying the
selected PID).

Opens the Go to packet dialog box.

)| ()] ) L | =

The packet position bar can also be used to navigate through the stream. You can
use the cursor to point to and click the next packet to be displayed. Similarly,
double-click the packet number in the bar and enter the required packet number in
the Go to packet... dialog box.

Looking at the packet ~ When you have identified and selected a packet, the Packets summary view
displays the interpreted code and the raw data in hexadecimal and ASCII format.
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TSCA - SI/PSI nodes

Primary nodes

The Tables view (SI/PSI tab) displays the service information in tree form. The
tree represents all of the service information tables found in the analyzed stream
that comply with the selected digital video standard (including MPEG program
specific information, DVB service information, and ATSC and ISDB program and
system information protocol). The tree contains nodes for each table found; tables
and nodes are grouped together functionally.

This section identifies the nodes that may be present for each standard.

The following figure shows an example of Table navigation view with DVB
stream interpretation selected.

The following tables in this section show the nodes that can be displayed in the
SI/PSI navigation view depending on the selected interpretation standard and the
content of the stream.

¥ C:\Streams\BBC1AUG27.mpg - MPEG TS Compliance Analyser

fnalysis View Navigation Settngs Captureyu™

’

Configuration..

P FexvuPlus™ ‘
[ Programs | Tests| SUPST | pips || Packets i

g Eport...

=3 ~
@8 Programs (PATPWTISDT actual) Tables T

B pat
288 PUTs * Programs (PAT/PMT/SDT actual)

+-8) PMT Program 4167 (BBC ONE) * Networks [NITs)

v g PMT Program 4231 (BBC TW} « Time (TDT/TOT)

+-8) PMT Program 4351 (BBC CHOICE)| $ e gl PR

B PUT Program 4415 (83C NEWS 2 * EPGEVSDIRS])

8 PMT Program 4479 (BBC TEXT) * DSM-CC

- (B PUT Program 4543 (BBC PARLMN
B8 soT actual
(-5 Networks (NITs)
) Time (TOTITOT)
[+ EPG (EMSDTIRST)
=-£9 psu-cc

£ PD 850 (0x284)

= (3 DSM-CC U-H Messages

~ B3 psisy
B ous)

(8 DSM-CC Download Data Messag
9 D 653 (0x28D)

-3 PD 851 (0x295)

£ PD 1005 (0x3ED)
I-£5 PD 1008 (0x3F0)

£ P 1011 (0x3F3)

-5 PD 1014 (0x3F8)

< | = k3 >

TS Avalabilty @ Sync @ | 24.128335 Mbps @ 188| 204| 511,360 Packets || DVB | No Extensions | | Il

Figure 1-83: Primary SI/PSI nodes (DVB example)
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Table 1-25: MPEG SI/PSI

Primary node Subsidiary node
TS info
TSDT
Programs
PAT
PMT PIDs
Conditional access
CAT
Other Tables
Table 1-26: DVB SI/PSI
Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3
TS info
Partial TS
DIT
SIT
BIT
Programs
PAT
PMT PIDs
PMT PID +
SDT
Bouquets
BAT
Conditional
access
CAT
Networks
NIT - This
NIT - Other
Time
TOT
DT
EPG
This TS
SDT Actual
Service (number,
name)
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Table 1-26: DVB SI/PSI (cont.)

Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3
Now/Next (EIT P/F)
Schedule (EIT
schedule)
Other TS
SDT Other
Service (number,
name)
Now/Next (EIT P/F)
RST
MHP apps
Other tables

Table 1-27: ATSC SI/PSI

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4
TS info

MGT
Programs

PAT

PMT PIDs

VCT CIT

ETT-V
Conditional
access

CAT
Ratings

RRT+
Time

STT
EPG

Source/Services

EITO > EIT127

Directed
channel
change

DCCT id +

DCCSCT
Other tables
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Table 1-28: ISDB-S SI/PS| nodes

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4
TS info
Partial TS
DIT
SIT
BIT
Programs
PAT
PMT PIDs
SDT
Conditional
access
CAT
Networks
NIT - This
NIT - Other
Time
TOT
EPG
This TS
SDT Actual
Service
(number,
name)
Now/Next (EIT
P/F)
Basic
Schedule (EIT
schedule)
Extended
Schedule (EIT
schedule)
Other TS
SDT Other
Service
(number,
name)
Now/Next (EIT
P/F)
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Table 1-28: ISDB-S SI/PSI nodes (cont.)

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4
Basic
Schedule (EIT
schedule)
Extended
Schedule (EIT
schedule)
Maker
id/model id +

Other tables

Table 1-29: ISDB-T and -TB SI/PSI nodes

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4
TS info
Partial TS
DIT
SIT
BIT
Programs
PAT
PMT PIDs
SDT
Conditional
access
CAT
Networks
NIT - This
NIT - Other
Time
TOT
EPG
This TS
SDT Actual
H
Service
(number,
name)
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Table 1-29: ISDB-T and -TB SI/PSI nodes (cont.)

Subsidiary Subsidiary Subsidiary Subsidiary
Primary node node 1 node 2 node 3 node 4

Now/Next (EIT
PIF)

Basic
Schedule (EIT
schedule)

Extended
Schedule (EIT
schedule)

Service
(number,
name)

Now/Next (EIT
PIF)

Basic
Schedule (EIT
schedule)

Extended
Schedule (EIT
schedule)

Service
(number,
name)

Now/Next (EIT
PIF)

Basic
Schedule (EIT
schedule)

Extended
Schedule (EIT
schedule)

SDTT

SDTT(H)

Maker
id/model id +

SDTT(L)

Maker
id/model id +

Other tables
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Packetized Elementary Stream Analyzer
(PES)






PES Analyzer - Getting started

The Packetized Elementary Stream (PES) Analyzer performs a series of user
selectable conformance tests on a previously recorded file. Files can be interpreted
according to either the ATSC or DVB standards. Once the file is analyzed, users

can view the results of the selected tests and browse through the content of the
PES packets.

ﬂ!__ Tektronix MPEG-2 PES Analpser - Ad_10s.mpg

Filz  Edit %ew ‘“Window Help
M=l alz| EmdT aal |
@ Ad_10: mpo - Progiam Stuctule 0] =] 0 Ad_10s. mpg - Event Lag - 0] x]
B Program 1 Frog. 3 Audio (PID 107]. PES Packet 80 FTS Enor. PTS difference is greater than 700ms <
Yides, [PID 289.0:0121) Prog. 3 Audio [PID 106]. PES Packet 80 : PTS Enor. PTS difference iz greater than 700ms
MPE[; Audio IP’lD 2900401 22 Fron 3 Audin (PID 1071 PFS Packet 75 PTS Fuor PTS difference i armater than 70
MPEG Audin, (PID £8 ﬁxmse] @ Ad_10s.mpg - PTS/DTS View Prog. 1 Video (PID 289) M= E3
o MPEG Audio, [PID 89,0:0053) EPEFEI BPBEPEPBPEBEPBI BPEBP Diata 3t Cursor IA
MPEG Audio, [PID 30.050054) [ 80ms™™ 3 - - i I TR . o 0 ALY Number
+ Program 2 | ! I —
= Frogam 3 : ; N ; N e
£ Progand i : ] : | PSP e
+ Program 5 i 0
| | ] | ] At
! H L H H L H 41638591
d0ms-| -2 R R R R Rl B B e i I B == R
{ : : : : : : brs
i ! ! ! ! ! ! Not Present _ —
strean | | | | | | | Frame Sate
id | Mok Valid
{ : : : : : : Frams Type
| OO | 0005 widen,_shsam | | I
: : C : : Firofike & Level
Rl i Sl Sl SR s e B S Fieserved & Reserved
PES data 0000 D120 ° 0240 0380 ° 0430 DEO0 0720 0840 [T ChomsFamat
scrambling PES alignment [ *PTS Acoess unit time (3] Ressrved
control | PO indicator | +DTS [um of durations) Polure Sze H sVl
L [[=—= g i g ‘ . i g g i T
afer han T00ms
-
= PTS
[ ¢ [0 ]]| Packet Humbes [0 Gt || [Prog. 1video PID 289) ]
[TS Packet 1083 | ' P

Information can be viewed in graphical and textual formats. To analyze and view
the Transport Stream packets, use the companion program TS Analyzer, which
can be run at the same time as this PES Analyzer.

The functionality provided includes:

B Display of program structure showing the programs contained within the
transport multiplex and the PES streams which make up each program.

m  Display an interpretation of PES packet for individual packets.

®  Hexadecimal representation of PES packet.
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m  Extraction and display of Presentation Time Stamp (PTS) and Decoding Time
Stamp (DTS) information from the PES packet header.

B Display of access unit information for video and audio access units.

NOTE. The examples shown in this chapter are taken from both ATSC and DVB
compliant transport streams. An example of each type is sometimes shown

as a reminder that both standards are supported or where a difference needs
explanation.sds

Starting the program

Start the program by selecting the Tektronix PES Analyzer option from the Start >
Programs menu or by double clicking on the Tektronix PES Analyzer shortcut on
the desktop.

L=, Stamup »
[= [ Tektronix Monitor-R ecorder

@ TokironixPES Analyser

s¥Tektranix Plaper
|#] Tektronix Release Mates

Initial appearance ~ Once the program has started and is ready for use it will open a Main Window.
When the program first starts it looks as follows:

1
@ MPEG-2 PES Analyser M=l B3
File View Seftings Options Help

|| 2 o

Iﬁ‘ Packet Number [ Goto || j‘

PES Analyser [Wot ¥alid P
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The Toolbar (row of buttons above the dark gray area of the empty window) may
be hidden from view, moved to a separate window or moved to either side or the
bottom of the main window.

The Status Line at the very bottom of the window may be hidden from view.
Because no file is open, it is displaying a message that the TS packet number
is Not Valid.

Above the Status line is the Slider bar. This has three groups of controls for
selecting streams and packets within a file. This may be moved to the top of
the window.

Initial menu options ~ PES Analyzer presents different menus and options, depending on whether or
not a file is open for analysis. The menu options available when no file is open,
are as follows:

NOTE. A check mark next to an option indicates that the window or toolbar is
currently visible or enabled, no check mark means that it is hidden or disabled.

File menu options. The File menu contains the options listed in the following
table.

Table 2-1: File menu options

Command Function

Open... Opens an MPEG file for analysis. The
program opens the file selection dialog
allowing the user to choose the required file.

Print Setup... Opens a dialog for selecting which printer
and associated options to use.

1 <filename> A list of the four most recently analyzed files.

2 <filename> If the program has recently been installed the

3 <filename> list may be empty or hold less than four files.

, Selecting a filename opens that file for
4 <filename> analyss,
Exit Finishes running the program.

View menu options. The View menu contains the options listed in the following
table.

Table 2-2: View menu options

Command Function
Toolbar Displays or hides the toolbar.
Status Bar Displays or hides the status bar.
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Options

24

Settings menu options. The Settings menu contains the options listed in the
following table.

Table 2-3: Settings menu options

Command Function

Test Options Opens a dialog for setting the Conformance
Test Options for analyzing and interpreting
the PES information in stream files.

Options menu options. The Options menu contains the options listed in the
following table.

Table 2-4: Options menu options

Command Function

Limit Repeat Errors Lists the first 20 occurrences of each error
type in the event log.

The MPEG and ATSC Conformance Test Options for MPEG and ATSC may not
be modified when a file is open. To change them, all files must be closed, the test
options modified, and the file opened again.

Select Test Options from the Settings menu to open the Conformance Tests dialog.

@&MPEG-2 P nalyser

File Wiew l Options  Help

|3

NOTE. The Settings Menu is only available when there is no file open. It is hidden
when a file is opened and redisplayed when the file is closed.
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Conformance tests  The dialog box contains two tabbed pages containing tests relating to MPEG and
ATSC files, respectively. Note that the MPEG tests are sufficient for DVB streams.

Test of PES header syntax (MPEG). The tests of PES header Syntax are based on
the conformance requirements laid down in the standards document ISO/IEC
13818-4 for Packetized Elementary Streams

Each check box uses the same name for a particular test as the standard. For
example, to test conformance to the standard for the length of PES packets select
the PES packet length option.

Test Settings E I
MPEG | aTSC |
— Test of PES header Syntax
W ipacket start code prefiv V¥ PTS interal <700
v stream_id ¥ rep_chil
¥ PES_packet_length V' wariginal_stuff_length
v PTS_DTS flags [V stuffing_byte
¥ PES_header_data_length v padding_byte
[ CRC
[Mate: this option may add up
to B0% to the analysis time]

| Ok | Cancel HElD

A check mark shows that a test is selected and an empty check box indicates that
the test will not be performed.
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Test of PES header syntax (ATSC). When the ATSC Stream box is checked,
selected streams are interpreted according to the ATSC standards, A/52 and A/53

A check mark shows that a test is selected and an empty check box indicates that
the test will not be performed.

Test Settings ’I
MPEG ATSC |

¥ ATSC Stream

— Test of PES header Spntax

I PES_scrambling_controt ¥ PES_piivate_data_flag

¥ ESCR_flag W pack_header_field flaq

¥ ES_rate_flag W program_pkt_seq counter_flag
¥ PES_CRC_flag I P-3TD_buffer_flag

I¥ data_alignment_indicatar
[video anly]

| ak I Cancel HElm

For streams in a DVB standard stream, leave the ATSC Stream option unchecked.
The ATSC Stream option is disabled (grayed out) if the software license is only
for the DVB standard.
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Opening a file from the
menus and toolbar

PES Analyzer — Getting started

Any file holding a recorded or synthesized sample of a stream can be opened
for PES Analysis by this program. To analyze the Transport Stream packets,
open the file in the TS Analyzer. A file can be opened by both the TS and PES
Analyzers at the same time.

To open a file select the Open... option from the file menu. If the required file is in
the list of recently analyzed files then it can be opened from the list to save using
the Open file dialog. Alternatively, use the Ctrl+O keyboard shortcut.

ﬁ:HPEE-Z PES Analyser

Eiew Settings Help

_ I
Print Setup. ..

1 Ad_10z.mpg
2 4d Bs.mpg

3 4d Tminmpg
4 Ad Bz.mpg

E =it

There is also a shortcut button available on the Toolbar for opening a file, which
has the standard file open symbol:

X|@| 22| ElEm=] @@
&

Once a file is open this button will be disabled, which is shown by being "grayed
out".
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Window layout  Program Structure and Event Log windows are opened as soon as the file is

opened. The layout of the windows will have been saved from the last time the

program was used. If the program has just been installed, the windows will be in
the application default Cascade arrangement, which looks like this:

@ MPEG-2 PES Analyser - Ad_10s.mpg M= B

File Edt View Optiors Window Help

=5 &2 [EEmm| S

@ Ad_10s.mpg - Progiam Stucture I [=]

Bl @ #d_10s.mpg - Event Log [_[O]x]

Category Feference Comment

- | @ Information Starting Analysic

| D Tine 00:01:02 Analysis Complete Interval

i

.

.

B

| | |
| } 4| ‘ Packet Number [ Goto | | [Prog. 1 viden (PID 289] =l
PES Analyser [ [NUM [T5 Packet 1043 [ 4
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Many users rearrange the windows so that the Program Structure and Event Log
windows do not overlap. The examples in this manual often use this arrangement:

i! MPEG-2 PES Analyser - Ad_10s.mpg =] B3
File Edit Yiew Dptions ‘window Help
]| 32| [@Blmm| 2|
i!j_AdJ 0s.mpg - Program Structure J[=] B || & Ad_10s.mpg - Event Log (=] B
EF-— Program 1 Category Rsference Comment
{3, video, (PID 283.0:0121) @ Information Starting Analysis

Budio, (PID 230.040122)
Audio, [PID 88,0:008)

Audio, [PID 83,0:0053)

Audio, [PID 90,040054]

- Program 2

- Program 3

- Program 4

- Program 5

Time

00:01:02

Analysis Complete It

al
D HPackelNumbEr 0

} Goto “Frng 1 Videa [PID 289) =l
FES Analyser [ [NUM [T5 Packet 1043 [ 4

NOTE. The above example is from a transport stream interpreted and labeled
according to the DVB standard. If the ATSC Stream option is set the elementary
streams will be interpreted and labeled according to the ATSC standard. For
example: audio streams would be labeled AC-3 Audio, instead of Audio or AAC

Audio.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual



PES Analyzer — Getting started

PES analysis

The PES Analyzer program now starts to analyze the file for conformance to the
selected tests. Due to the very efficient algorithms used by the program, it will
analyze large files in a few minutes. Other algorithms have been seen to take
much longer. The rightmost pane in the Status bar shows a progress indicator

during Analysis.

As the file is analyzed messages are written in the Event Log and the structure
diagram is drawn in the Program Structure window. When the processing is done
an "Analysis Complete" message is written in the Event Log.

=
Ele Edit View Window Help
=R B ]
Qo omloreey Evenilog | M|
Program 1 Category Reference Comment o
3, Video, [PID 289.0:0121] & Information Starting Analysis J
Audio, [FID 250.0:0122) €3 Ermor Prog. 3 Audia (PID 107). PES Packet 3 PTS Enor. PTS difference is greater than 700ms
Audio. [PID 88.0+1058) €3 Enor Prog. 3 Audio (PID 106], PES Packet 3 PTS Ennor. PTS diference is grester than 700ms
Audie, [PID 63,0x0053) €3 Error Prog. 3 dudio (PID 107). PES Packet 4 PTS Enor. PTS diference is greater than 700ms
Audio. [PID 30.0:0034) Q Error Prog. 3 Awdio (PID 108). PES Packet 4 PTS Enar. PTS difference is greater than 700ms
;;Zg;:zi €3 Enor Prog. 3 Audio (PID 106], PES Packet 5 PTS Enror. PTS diference is grester than 700ms
Program 4 €3 Enmar Prog. 3 Audio (FID 107). PES Packet 5 PTS Enor. PTS difference is greater than 700ms
Frogram 5 Q Error Prog. 3 Audia (PID 107), PES Packet & PTS Emar. PTS difference is greater than 700ms
@ Errar Prog. 3 Audio (PID 108], PES Packet B PTS Enor. PTS difference is greater than 700ms
Q Error Prog. 3 Awdio (PID 108). PES Packet 7 PTS Enar. PTS difference is greater than 700ms
Q Error Prog. 3 Audia (PID 107), PES Packet 7 PTS Emar. PTS difference is greater than 700ms
Q Error Prog. 3 Awdio (PID 108). PES Packet 8 PTS Enar. PTS difference is greater than 700ms
Q Error Prog. 3 Audia (PID 107), PES Packet & PTS Emar. PTS difference is greater than 700ms
@ Errar Prog. 3 Audio (PID 107], PES Packet 3 PTS Enor. PTS difference is greater than 700ms
Q Error Prog. 3 Awdio (PID 108). PES Packet 3 PTS Enar. PTS difference is greater than 700ms
Q Errar Prog. 3 Audio (FID 107], PES Packet 10 PTS Enor. PTS difference is greater than 700ms
Q Error Prog. 3 Awdio [PID 106). PES Packet 10 PTS Enor. PTS difference is greater than 700ms
Q Error Prog. 3 Audia (PID107). PES Packet 11 PTS Emar. PTS difference is greater than 700ms
@ Errar Prog. 3 Audio (PID 108], PES Packet 11 PTS Enor. PTS difference is greater than 700ms
€3 Enor Prog. 3 Audio [PID 1061, PES Packet 12 PTS Enor. PTS difference is areater than 700ms _'LI
] | A
= « | ]| Packet Humber a | [Froa. 1 video (FID 285) i |
[ UM (TS Packeta1l | v
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PES Analyzer — Menus and controls

When a file is open the program presents a different set of menus and options.
They change as soon as the Program Structure and Event Log windows appear.
For example, the Open file commands are replaced by Close file commands.

Toolbar

d=] sl?| |2 mnjn = &l

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

Closes the current file. This button becomes enabled the
moment a file is opened and analysis starts. If the wrong file is
being opened, or the wrong options are selected, clicking on the
button will abandon the analysis and close the file.

Open a file. This button is disabled when a file is open.

|2

Print the contents of the current window.

Opens a dialog which displays the program version number.

Toggles the Event Log window. When the button is in this state
the window is not visible and clicking on the button will open
the Event Log.

Toggles the Packet Hex view window. When the button is in
this state the window is not visible and clicking on the button
will open the Hex view.

Toggles the PTS/DTS view window. When the button is in this
state the window is not visible and clicking on the button will
open the PTS/DTS view.

Toggles the Header Interpretation window. When the button is in
this state the window is not visible and clicking on the button will
open the Header Interpretation.

Zoom In on data in the PTS/DTS view. This button is only
enabled when the PTS/DTS view is the current window.

Zoom Out from the data in the PTS/DTS view. This button is
only enabled when the PTS/DTS view is the current window.

B | |m |

5]

|

& |12
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The Toolbar can be dragged off the edge of the main window into a floating pallet.
To do this click on the background inside the Toolbar, that is, not on one of the
buttons, and drag into the main window area. The result is a self-contained
window which looks like this:

I |
H=| 32| 2laomD| &|a]

To replace the Toolbar on the window border drag it over the border until the
outline changes shape. It can be placed on the top, bottom, left or right edges.

Status bar

View the PTS/DTS Analysis [ |TS Packet 1043 | 4

The Status bar may be hidden from view, but if visible is always at the bottom of
the main window. It displays the following information about the program and
keyboard states:

Message Field
Gives a description of any Keyboard
button or ogtion over which Mode
the curzor iz placed.
Way also showy ather
non-critical messages,

g

TS Payload Unit Start
Displays number of TS

packet in which current
PES packet starts

Anahysis Status
Dizplatys & progress
indicatar wvhile 5 file
iz being loaded.

Indicators

TS Packet 1043

Namal

Actie

[CaP [NUM TS Packet 1043 | 2

ﬂ!; Tektronix MPEG-2 PES Analyser
File Edt [P window Hel

= " o Toolbar =
w Status Bar

The message changes 10
describe the function of the buttan
aF mendU option ower which the

mouze painter is placed.

w Event Log
Hesx
|rterpretation
PTS/DTS Timing

(The des=cription iz =till displayed
if the button or option is unavailakle,
e greyved out )

ier the PTS/DTS Analwsis | | TS Packet 1043 | ‘/f:l
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Slider bar

S | » ”|F‘a-:kel Hurbe [0 Golo HIng.Wideu (PID 263) =

The Analyzer can display the contents of any PES packet in the currently loaded
file. Packets are numbered, within a PID, according to their position in the file; the
first PES packet of each PID being PES packet 0 (zero). The Slider bar displays
the packet number and the PID for the current packet.

The slider bar controls are as follows:

Slider

Slider Move to Move to
Scrolls through packets of previous next
the selected type in the file. packet packet
4
A\ 7l
Start End
of file of file
Packet number Packet Number Goto Button
Shows current packet number. Selects packet shown
New values can be typed in. in Packet Number

Facket Mumber |?3 N 5ot

click in the )
Packet Number then click

Field and type in on the Goto
the new value Button.

To select
a packet by
number
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Packet type - elementary
stream

Selecting packet type

Packet Type
Shows currently selected
Elementary Stream.

||F'ru:ug. 2Wideo [PID 305) j

Like the Toolbar the Slider bar can be dragged from the edge of the main window
into a floating pallet; to do this click on the background inside the Slider bar

and drag it into the main window area. The result is a self contained window
which looks like this:

=
| J ] |PacketNumber [54 |lProg.2Video (PID 305) vl

Drop Down Arrow Button
"Drops down’” the list of
Streams to choose from

To replace the Slider bar on the window border drag it over the border until the
outline changes shape. Unlike the Toolbar it can only be placed on either the top
or bottom edges.

The Slider and Packet Number can only select packets in the currently selected
program stream. The stream is indicated in the Packet Type drop-down list and by
the magnifying glass symbol,

. & Audio [PID 305)
2 Audio [FID 98]
. 2 Audio [FID 7]
. 2 Audio [PID 5]
- 3 Video [PID 150)
3 Audio [FID 104]
. 3 Audia [PID 105)
. 3 Audio (PID 106)
]
]
]
]

Choose an

Elementary Stream
by selecting the Name in
the Program Structure or

. 3 audio [FID 107
.4 Wideo [FID 161
. 4 Audio (PID 112
L4 Audia [PID 113

L

& Ad_10s.mpg - Program Structure =] =
[=]- Program 1
e Hideo, (PID 289.060121)

- Program 3
- Program 4
- Program 5

& i,
- Audia,
e Ao,

- fadio,

e fiudi,
. ALidio,
e i,
e 00,

(

(PID 290,0x01 22)
[PID 88, 0x0055)
(FID 29.040059)
[

from the List in the Slider ' P : PID 50.0:0054]
Bar "List Box”. _E Togram
§‘--Q Yidea, [PID 305.0:0131)

(

[PID 308, 0x1 32]
(FID 96.0+0060)
(PID 97,0006 1)
(PID 95,040062)

a]

2 video [PID 305

=

in the Program Structure window. A new stream may be selected from either the
list box or the window.
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Menus and options

NOTE. A check mark next to an option indicates that the window or toolbar is
currently visible or enabled, no check mark means that it is hidden or disabled.

File menu options  The File menu contains the options listed in the following table.
Table 2-5: File menu options

Command Function

Close Closes the current file. This option is available as soon as
analysis starts. If the wrong file is being opened, or the wrong
Conformance Tests are being run, selecting this option will
abandon the analysis and close the file.

Print Prints contents of the current window.

Print Setup Selects printer and configuration.

Exit Closes any file that is open and terminates execution the
program.

Edit menu options  The Edit menu contains the options listed in the following table.
Table 2-6: Edit menu options

Command Function

Copy Copies the contents of the current window to the MS Windows™
Clipboard, from which it can be pasted into a document in
another application.

Copy TS Packet Allows the user to select an AU (access unit) within the PES
Analyzer, and then copy the TS packet number onto the
Windows clipboard. The Stream Analyzer may then be started
and Paste TS packet selected to go to the packet number
retrieved from the clipboard.

View menu options  The View menu contains the options listed in listed in the following table.

Table 2-7: View menu options

Command Function

Toolbar Shows or hides the Toolbar, which provides a set of convenient
shortcuts for the more frequently used menu options.

Status Bar Shows or hides the Status bar.

Event Log Shows or Hides the Event Log.

Hex Shows or Hides the Hex view.

Interpretation Shows or Hides the Packet Interpretation view.

PTS/DTS Timing Shows or Hides the PTS/DTS Timing Analysis window.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual 2-15



PES Analyzer — Menus and controls

Options menu options ~ The Options menu contains the options listed in the following table.

Table 2-8: Options menu options

Command Function
Limit Repeat Errors Only lists the first 20 occurrences of each error type in the event
log.

Window menu options ~ The Window menu contains the options listed in the following table.

Table 2-9: Window menu options

Command Function

Cascade Arranges all the windows so that they are neatly stacked; only
the title bars show behind the active window.

Tile Reduces and moves windows so that they can all be seen at
once.

Arrange Icons Aligns icons of any minimized windows at the bottom of the
program's main window.

1 <window title> Makes the named window active, putting it on top of any

2 <window title> windows which had been hiding all or part of it.

3.. etc.

Help menu options  The Help menu contains the options listed in the following table.

Table 2-10: Help menu options

Command Function

About PES Analyzer... Opens a dialog that displays the program version number.
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lﬁ Ad_10z.mpg Hex View - Prog. 2 Yideo (PID 305) PES Packet 171

oo0ed D4 1C
noovo 05 CF

00090 55 50
000s0 CE 35
000B0 32 4F
000co 46 32
ooooo 02 32
OO0ED &8 24
000FD 32 81
00100 439 28
00110 0D 40
00120 B7Y 47
00130 E4 B9
o040 30 01

[N = N = |

73 83
70 14

F7 a8
0h D&
4F 4t
Ca 73

o000 E7 03 78 3C C6 A3
00040 35 CO CF 2C A3 55
Oo0s0 21 24 70 AB A 04

38, 7A

4E

00080 04 FD B& As 1B

o3
7E
12
e

JEze
5 DO M
ce o
CC BO
0z D014

4aC 41
2C 05

FC F&

a0

6B AD 1D

FE 02

Qe

a4

rin]

s
EE
ac
a0
03
32
B&
EC

&0
B
44
&D

[ [n}

PES Analyzer — Packet Hex view

00000 00 00 071 B0 00 00 B0 50 05 21 08 17 B4 B3 00 00
oooto 01 00 00 1A 4B DB B& 00 00 01 BS 85 59 57 98 00
00020 00 00 1 01 32 BF

23 20 8B EE 03 EY &D 9B 10 7F
B1 66 51 BF 10 B4 62 C5 A% 52
7B C3 A 81 B6 DC D4
75 03 BE AD 89 D4 27
BE EA 07 20 40 A2 EA
E0 2D DC OB AE
FC C7 07 05 BC
17 &4 BE

a1 C3 70
26 A0 50
51 OE &0
0503 9E
02 Ch 3C
63 4F 4E
E9 D4 EF
Dz a1 E3
34 Ba N
o6 2 M
0B &1 74
oB 91 1A
30 DO BE
05 A3 26
63 59 00
34 EQ FF
cap2m

L[ | ]

&1 EE
Fg 7D
04 CF
52 10
23 GE
a0 44
Ao A7
7F CF
DA o2
Ef B3
14 74
EE 64
98 og
De

20 1D

Cz
o0
20
4E
40
0z
B8
21
2C
o1
96

A

L4 13
B3 1B
50 00
2046
1E B4
ES FF
C4 70
D3 0B
0E 40
ES 05
1F EO

[ -y ]

BY 2
5C ED

F1
0o
Fo
0o
JF
53

13
m

42
C
18
18

04 oo

03
B1

96
a7

CC 74

nh DA

=l

This is the lowest level view of the PES Packet data. It displays the contents of
every byte in hexadecimal. Each byte is represented as a pair of hexadecimal

digits. The window may be resized to display 16, 32, 48,... bytes of information
on each row.

The four digit numbers in the left most column are the addresses of the first (that

is, leftmost) byte in the row. The addresses are shown in hexadecimal.

'ﬂ Ad_10s.mpg Hex View - Prog. 2 Yideo [PID 305) PES Pack

Qoo oo 0o o1 EO0 00 Qo 20 20 05
nooio o1 00 00 1A 4B DB BS 00 00
00020 00 00 01 M 32 BF 23 20 8B

Column of bytes addressed

to the right

Address Column
showing address
of byte immediately
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PES Analyzer — Packet Hex view

Packet header

The Hex view displays the bytes holding PES Packet header information in
magenta color text. For example here is a packet containing a PTS field, from a
video stream:

'ﬂ Ad 10z.mpg Hex Yiew - Prog. 2 Yideo [PID 305] PES Packet 171  [Hj=] E3
00 00 0 EOO0 0D 80 80 058 21 0A 17 B4 B3 00 00
3 :

o

D
0oos0 21 24 70
00060 Cd 1C 73 &
0oo¥n 05 CF 70

et NA Fh |

bytes carrying header
information displayed in
magenta colour text

7 M7 NR P

The most significant two bits of the eighth byte (that is, the byte at address
0x0007) contain the PTS DTS flags. The ninth byte (address 0x0008) contains
the PES header data_length, which specifies how many additional bytes are
present. In the above example:

PTS DTS flag=2
PES header data length =5

These specify that there is a 5 byte Presentation Time Stamp (PTS) field in
the header. The contents of the PTS are 21 0A 17 64 B3 and they follow the
PES header data length.
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The preceding packet, from the same stream, carried both a PTS and DTS field:
PTS DTS flag=3

PES header data length = 10 (shown as 0A in hexadecimal)

'ﬂ Ad 10s_mpg Hex View - Prog. 2 ¥ideo [PID 305] PES Packet 170 [Hi=] E3

o0 o001 EOODD 0020 Cons 31 0A 17 200311 A
17 48 93

23
A2 DB
D154 B4
00 1E && 04
ES A0 45 FF

& N MR 22 P4

00060 Die 30 6D
00070 5F FC 77

19 bytes of header
information including the
DTS and PTS fields

Instead of having to interpret header information from the Hex view, the PES
Analyzer provides the Header Interpretation window. This interprets the header
and displays the contents, in table form, according to the MPEG-2 standards.
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PES Analyzer - Event log

Categary Reference Cormmenk -
ﬂ Imformation Starting Analvsis J
Q Error Prog. 3 Audio [PID 107), PES Packet 3 FT5S Enor. FTS difference i greater than 700mz
EB Error Prog. 3 Audia [PID 108). PES Packet 3 FTS Enrar. PTS difference is greater than 700m:
€3 Error Prog. 3 Audio [PID 107). PES Packet 4 FTS Enor. PTS difference iz greater than 700ms
€3 Enrar Prog. 3 Audio [PID 106), PES Packet 4 PTS Emar, FTS difference i greater than 700ms
Q Error Prog. 3 Audio [PID 108], PES Packet 5 FT5S Enor. FTS difference iz greater than 7 00mz
€3 Errar Prag. 3 Audio [FID 107). PES Packet 5 PTS Emar. PTS differenice is greater than 700ms
€3 Enrar Prog. 2 Audio [PID 107), PES Packet & PTS Emar, FTS difference i greater than 700ms
Q Error Prog. 3 Audio [PID 108], PES Packet £ FT5S Enor. FTS difference i greater than 700mz
EB Error Prog. 3 Audia [PID 108). PES Packet 7 FTS Enrar. PTS difference is greater than 700m:

'E:]' Errar Prog. 3 Audio [PID 107). PES Packet 7 FTS Enor. PTS difference iz greater than 700ms

E:i Error Prog. 3 Audio [PID 108], PES Packet 2 FT5S Enor. FTS difference i greater than 700mz

Q Error Prog. 3 Audio [PID 107). PES Packet 8 FT5S Enor. FTS difference i greater than 7 00mz

€3 Error Prag. 3 Audia [PID 107). FES Packet 3 PTS Enar. PTS difference i greater than 700m:

€3 Enrar Prog. 3 Audio [PID 106), PES Packet 3 PTS Emar, FTS difference i greater than 700ms

f:’ Error Prog. 3 Audio [PID 107), PES Packet 10 PTS Enor. PTS difference iz greater than 700ms

E:’ Error Prog. 3 Audio [PID 108). PES Packet 10 PTS Emor. PTS differance iz greater than 700ms

€3 Enrar Prog. 3 Audio [PID 107), PES Packet 11 PTS Enor, PTS difference is greater than 700ms

Q Error Prog. 3 Audio [PID 108), PES Packet 11 PTS Enor. PTS difference iz greater than 700ms

€3 Error Proa. 3 Audio [PID 1061, PES Packet12 ~ PTS Enor. PTS -Ijifferen-:e i& qreater than 700ms hd
L o

The program always opens the Event Log window when it starts to analyze a
file. As the file is analyzed the program writes the results to the window as they
are produced. When processing finishes an "Analysis Complete" message is
appended to the report.
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Packet selection

If a warning or error message gives a packet number, that packet may be inspected
by selecting the message. For example, here is an extract from a file with PTS
errors on two of the Audio streams:

¥ Erroi Fiog. 34udio [FIL TUB). FES Facket & Fl5 Emon Fi s diterence is gieaker than fUlms
e’ Errar Prag 3 Audia [PID 106), PES Packet 7 PTS Errar. PTS differenice iz greater than F00ms
' Prog. 3 Audio [PID 107]. PES Packet 7 PTS Enror. PTS difference iz greater than 700ms
Q Ermar Prog. 3 Audio [FID 108). PES Packet 8 PTS Error. PTS difference is greater than 700ms
& Brre 2 Andin (PID AT PES Paclet 0 ETE Errmr BTE differamee i+ Armatsr tham T

Clicking on the message for Prog. 3 Audio (PID 106), PES Packet 78 selects both
the program stream and the packet. This is reflected by the Slider bar, in the
Program Structure, Hex view, Header interpretation and PTS/DTS views.

The Slider bar will look like this:

Facket Mumber |? [Efa] {a] | | IF'rn:-g. Jadwdio [PID 107 j

In the program structure view, the magnifying glass icon, Q, appears on the
selected stream:

ﬂ test_seamless.mpg - Program Struct... =] B2

g Pogamtr

............. Video,

o, [PID 280,0:0122)

-« Audia, [PID 88 0R0058)
[
[

FID 283.0x0121)

- Audio, [PID 89.0:0055)
............. Audin, [PID 90, 0:0054]
e [— F'mgram 2
B Frogram 3
............. Yiden, [PID 160, 0x0040)

[
L [FID 104,0=:0082)
- budio, [PID 106,0-00869]
[
{

------------- Audin, [PID 105, 0=006A]
A2, Audia, (FID 107 0<006E)
[ Program 4
e — Program 5

If the Hex view and/or Header Interpretation windows are open they will be
updated to show the contents of the selected packet. If the PTS/DTS view window
is open the cursor is placed on the packet and the panel showing the Data at
Cursor is updated.
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Having selected the packet it can now be inspected with other tools. The
information in the Header Inspection and Hex view windows will look like this:

g test_seamless.mpg Header Interpretation - Prog. 3 Audio [PID 107) PES Packet 7  [H[=] [EY !

T }si=
pack st .
shart sltream zglfet _5 df"
code id i 5 dif
prefix ? 'S dif
0x000007 | 04C3 audic_stream] 0=0BB2 Fs di
1S diff
PEs [ oo | et original [ PT5 | . [ £ ?.5';" addtiorall peg | g [[5 dif
serambling| i slignment ] coppnght]  or DTS i rate "t:j C.E'fpl" crc |exter |[5 di
control | PO indicatar copy | Flags ag flag n;'l‘;; If?a; flag fla |5 diff
00 00 | 0w0 D40 | 040 | OwZ | Ox0 |Oe0| OO | Ow0 JOx0| 0Ox |[[5dN

'ﬂ test_seamless.mpg Hex Yiew - Prog. 3 Audio (PID 107) PES Packet 7

00 0D 07 L3 0B BZ 60 80 05 23 4€ C3 7D oF 20 47
PTS 0010 45 A7 78 F1 17 DAB3J 0B 24 22 6C 24 B2 7C 1& 30
00020 D7 SE CO A2 05 FD 97 21 EC 80 F9 44 CC B1 BD 24
00030 61 DS OC 52 F9 F& B 41 BO 5F 40 9€ 07 BC 5F 2B
1404032073] \nap4n 0C E1 OC 2E 65 CB 03 D2 EB 10 88 63 31 90 DC 25
= 0050 24 B9 43 67 BO 83 52 D1 A8 1F 42 F1 50 CE G4 A8

NO0G0 4C 92 02 GC 0B D5 DE 38 C3 04 B3 24 B4 CC 1 4D

“““ M o AU Mumber
R 36

Woow Stream Type
s u Audio
PRl IR EREEEE Femm e S EaR H PES Packet Mumber
n ?

u PTS
_____ o 1404092079
" |0

H 1 [MPEIGT]
B Layer
----- - 2 [Layerll]
u Bitratelndesx
" 10 [192kbit/s)
" Frequeticy
L e i e e e H n 48000Hz

M tods

" 0 [Stereq)

" tdode E stension
0.000 0840 1.680 2 E.JEI 33&0 4200 & DQEI 5.ai4 0

®PT5 Bccess unit e (3] Coppright

+DTs [sum of durations) = HDEE
riginalCopy hd

H
e

-

4 1 ' 1 ' 1 % 1 ' 1 ' 1 |

This shows all the PES packets for the selected PID. See the section on the
PTS/DTS view for more information on selecting a particular packet.
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PES Analyzer — Packet header interpretation

QE Ad_10z. mpg Header Interpretation - Prog. 2 Video [PID 305] PES Packet 171

packet PES
prefis length
(000007 | Ow00ED video_stream] 0«00

FES data original | FT5 g5 | D3M additionall pec | ppg | PES

scrambling PES; alignment | coppright]  or  |DTS E“SCH rate lrlcc||< ':fc'flj"" cre | extension hsatder
cortiol | PP | indicator copy | flags ags flag I'l;ll;ge If?a; flag flag Ie:g?h

5] i) 5] IR Os0 [ Ox | Ow0 [Ow0f 0a0 IR 5] 00 [Is]

FT=

42316377

PES
packet
data
bytes

This window interprets and displays the header of the currently selected packet.
The above example shows a packet which carries a Presentation Time Stamp
(PTS).

The relationship between the top row of information displayed in the Header
Interpretation, for this packet, and the Hex view is:

pafkf‘ t PES

. lerugth
prefis

Ox000007 | 0=00E 0 video_stream | O=00

= A 1 1 E E O] deo [PID 1 H F 3 e - [Of =
0O000 (00 00 OT{EC{O0 OOfs0 80 05 21 04 17 64 B2 00 00 “
IR BER 00O 0o 01 BR B8R KRR RY 98 00
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The next row completes the compulsory header information. The mapping
between the Header Interpretation and Hex view is:

- DSM | additional FES
PES data original | PTS ES | FES] PES
scrambling D’;El?t}' §Iig_nment coppright| or  |DTS EflsagsH rate nt':nl:ﬁzllfe ?:%J cic | extension hg:td:l
cantrol imdicatar copy | flags flag flag flag flag flag length
0=0 0xz0 0=0 0x0 00 | 0x2 | 0x0 |0x0] 00 0x0 0=0 0x0 05

00000 00 00 07 E0 00 00[80[80]05[21 o0& 17 64 B3 00 00
oot Moo oo 148 4B NDIE BE M BS 8% 5 R7 93 NN

lﬁlAd_l Ds.mpg HexView - Plog. 2 Vided IPiD 305) PES Packet 171 [H[=] E3
rY

The last row is a reminder that after the header comes the packet data. Any other
rows represent additional fields, such as the Presentation Time Stamp (PTS)
carried in this example. The relationship of these rows to the Hex view is:

FES
packet
FTa data
btes
42N 637
B A 1 1 B B Prog deo [PID 1 = = - 4
00000 00 00 01 E0 00 00 80 20 05421 0% 17 B4 B3 {00 00 -

oo |01 00 00 14 4B DB BS 00 00 01 BS 85 55 57 33 00
00020 |00 00 01 01 32 BF 23 200 8B EE 03 E7 AD 9B 10 7F
0oa30 |[EY 03 78 9C Ck A3 61 66 51 BF 10 B4 62 C5 A5 92
00040 |35 CO CF 2C A3 55 41 C3 70 7B C3 &4 81 66 DC 04

RN 2 24 70 AR AR MDA 28 AN RN 7R N2 PE AN 29 1A 27

The size of the header depends on the fields it carries. Here is the Header
Information view of the preceding packet which carries PTS and DTS fields:

& Ad_10s. mpg Header Interpretation - Prog. 2 Video [PID 305) PES Packet 170 = =1 I
e
Pafk?‘ \ PES
! length
prefix
0000001 | 000ED video_stream | 0x00

L DSM | additional FES

FES data original [ FTS ES | PES| FES
scrambling pigﬁty slighment| copyright| or (DTS Eflsags rate rtnrnlj:lke ?:f%'" cre | extension hz:ﬁ:'
contral indicator copy | flags flag flag flag flag flag length
0x0 00 00 0x0 0s0 J0x3 | 040 J0=0] Ow00 0:0 | 0x0 0x0 (1)

PTS DTS

423837 42312777 =
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PES Analyzer - Program structure

The Program Structure window displays a list of all available programs and the
elementary streams that they contain. It shows which stream is currently selected
for inspection and may be used to select a different stream.

The example below shows a program structure from a file conforming to the
ATSC standard.

ﬂ ATSC_10s.mpg - Program Structure [_ 8] =]

| Program 3
Q Wideo, [PID 49,0:0031)

e ATSE Audio, [PID 52 020034)

e TSE Prosgramm [dentifier, [PID 51,040033]

= Program 4

e Widea, [PID B5,0x0047)

e BTSC Audio, (PID 63,0:0044)

e TSE Prosgramm [dentifier, [PID B7,0x0043]

[ P[Dgham 5]

The example below is a program structure from a file that is compliant to the
DVB standard.

ﬁ, DVE_10s.mpg - Program Structure

[=- Program 1
- Video, [PID 289,0x0021)
e i, [PID 2900800 22)
: Audio, (FID 83.0:0058)
- Audio, [PID89.0:0059)
e Audia, (PID90.0x0054)
[3 ~ Program 2

=i B3

(P10 305,0:0131)

Audio,
- dydio,
o dudia,
Audio,
Program 3
Frogram 4
- Program &

(P10 306,001 32)
(P10 96, 0:0060]
(PID 97 .0:00E1]
(P10 38.0=0062)
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The diagram

2-26

The Program Structure is displayed by the program as soon as a file is opened. As
the file is analyzed, the top levels of a structure diagram are drawn in the window:

ﬁ:_.ﬁd_‘l 0s_.mpg - Program Stiuchure Hi=1E
= Program 1
q Video, [FID 289,001 21)

[
e Byadio, (PO 230,0:00 22)
e Badio, [PID B8, 0x0058)
(
[

e fadio, (PO 89, 0x0059)
e Sytdiin, (PID 90, 00054
[#]- Program 2
[ Program 3

An Elementary Stream is selected by default. The Program Structure view shows
the selected stream and other streams in the same program. The first program is
expanded to show the streams in the next level.

Streams in the other programs are initially hidden from view.

The structure is represented by a tree diagram, with the "root node" or highest
level component at the top. Components which contain more information beneath
them in the structure are indicated by a square box.

Components that are connected to a branch of the tree without a square box are
leaf nodes. In this case the Video and Audio elementary streams are leaf nodes.
They display the lowest and finest level of detail.

Nodes can be expanded and contracted by clicking on the square box.
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PES Analyzer — Program structure

When a file is first opened and analyzed a stream will be selected by default. The
type is indicated by the magnifying glass symbol, Q, in the Program Structure. It
is also displayed in the Packet Type "list Box" on the Slider bar. A new stream
may be selected from either the list box or the window.

ﬂE Ad_10s.mpg - Program Structure [_ (O] =]
[ Prrogram 1
Choose an e Widen, (PID 283.0:07127)
Elementary Stream e i, (PID 290,0u0122)
by selecting the Name in zuj!o’ EE:E ggg”gggg%
the Program Structure or Azd:z’ [FID EID’D:DDE-’:«]
from the List in the Slider - Progtam 5 ’
Bar "List Box .3}, Videa, [FID 305.040131]
e Audio, (PID 306,0:0132)
e Adin, (PID 96, 0x0060)
i e i, [PID 37 .00087)
. 2 Swdio [PID 306) k ] Audio, [PID 33,0=0062)
Prog. 2 Audio (FID 36) [ Program 3
Prag. 2 Audia (FID 97) ==
Prag. 2 Awdio (PID 98] Bl Progeam 4
Frog. 3 Yideo [FID 160] B Program &
Prog. 3 Audia (PID 104]
Prog. 3 Audio (FID 108)
Prog. 3 Audio (FID 108]
Prog. 3 Audia (PID 107)
Prog. 4 VYidea (FID 161)
Prog. 4 Audio (FID 112)
| Prog. 4 Audin [PID 113] [ =
ﬂ]| Fiog. 2 ¥ideo [FID 306 =]
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PES Analyzer — PTS/DTS timing analysis

ﬂ!:_ﬁ\dj Os.mpg - PTS/DTS Yiew Prog. 2 Yideo [(PID 305)

[ata at Cursor i -

B0 ¢ 30 00 YO %méafeay AR Y RO AL Mursber
. | | 112
Stream Type
ideg
FES Packet Mumber
112
PTS
42111177
0TS —
42103977
Frame Rate
25 fps
Frame Type

D : : e s -
2400 Z7E0 4120 4480 4840 5200 5560 5920 6280 -
Prafile & Lewel

=PTS Access urt time [3) Mo Mo
+0T3 [zum of durations) Ehranl:'.a F:.:'I:a[ .:j

| e

:
goms H-HHEH B E R

The PTS/DTS view shows timing analysis of the selected stream. The x-axis
shows the duration of the stream in seconds. The y-axis shows the differences
between the expected and actual DTS values. A vertical blue line is used to show
the difference between the PTS and DTS for each Access Unit (AU). Therefore, a
compliant stream will exhibit each DTS on the Oms y-axis. Streams with errors
usually exhibit a "stepped" graphical effect.

Any AU in the stream may be selected to view additional information in the
panel on the right. If the panel is not tall enough to show all of the information a
scroll bar appears.
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When first opened the entire stream is shown. Even a small file may display data
points packed too closely together to be read; for example, here is just under

12 seconds of video:

ﬂ! Ad_10s. mpg PTS/DTS View Prog. 2 Yideo (PID 305])

A0

Orns—sdie

DDDD 1400 2800 4200 5600 7.000 S.QDEI Q_BDD 11.800
HPTS Access unit ime [s)
+0TS [zurm of durations)

Dala at Cursar -

Al Mumber
0

Sheam Type
Yideo

PES Facket Murmnber

0

FTS
41707977

DTS -
41700777

Frame= Rate
Mok Walid

Frame Type
FI

Reserved & Reserved

Profile & Level

Chrama Format -

' ' 3

A longer sample may appear as a solid band of blue.

To see the individual packets or access units click on the Zoom In button on

the Toolbar:

=] &2 = @m | &l

In this example, clicking the on the Zoom In button four times gave a much

clearer view:

ﬂE Ad_10z.mpg - PTS/DTS Yiew Prog. 2 Audio [PID 306)

24ms PR I - PEMIE PR - MR RO MM e M

Ome-
0192 0.720 1248 1776 2304 2832 3380 3.888 © 4800

HPTS Azcess unit ime [=]
+0TS [gum of durahons)

[1ata &t Cursor | -

&L MNumnber
a3

Sheam Type
Ludio

PES Packet Mumber
16

PTS
41861904

ID
1 [MPEG1)

Laper
2 [Laver ) =

Bitratelndex

10 [192kbit 5]

Frequency
4830004z

Made _:l
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The blue # crosses of Presentation Time Stamps and the magenta 1 crosses of
Decoding Time Stamps can now be differentiated.

To Zoom back out click on the Zoom Out button as many times as required:

le| sz Ep/an al

Access unit selection

The triangular cursor above the graph indicates the selected access unit. Extra
information about that access unit is displayed in the Panel on the right of the
Graph.

ﬂE Ad_10z.mpg - PTS/DTS Yiew Prog. 2 Audio [PID 306)

[1ata &t Cursor -
2dinng PR FIENIE - FRE oy e PR - PO OO0 - a1 Number
. . . . . . . . . . a3
Sheam Type
Ludin
PES Packet Mumber
16
PTS
| | | | | | | | | | 41561904
i i i i i i i i o ID
' ' ' ' ' ' ' ' ' ' 1 [MPEG1]
Laper
2 [Laver ) =

Bitratelndex

D - - <-4 O P S VS B R - ]
0192 0720 1248 1776 2304 2837 3360 388 " 48 12};;‘5;‘5531
HPTS Bcoess unit ime [3]
+DTS [sum of durshions) 4830004z

[ —— =
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Scrolling the view

The Slider at the bottom of the window indicates where the displayed packets /
access units are in relation to the rest of the file. It can be used to scroll the display
through the data in the same way as a standard window scroll bar.

Slider Control

Shows position of selected access unit

within the file. Drag the control to move
the View Bar. When released it returns

to show position of selected access unit

View Bar

Shows size and position
of visible area of the
graph within the file.

First
Access unit
inFile

Last
Access unit
inFile

Latest
Access unit
in View

Earliest
Access unit
in View

To scroll the stream through the view drag the Slider Control left or right with
the mouse. After dragging the Slider Control it returns to the previous position
showing the location of the selected access unit.

Click the mouse pointer on the white space either side of the View bar to center
the displayed graph about the currently selected access unit.

When an access unit is selected on the graph, the Slider Control is automatically
repositioned within the View bar. The placement of the Slider Control reflects the
position of the selected packet in the field of view.

Selecting an Access Unit on the graph also changes the selection for all of the
other views to the packet containing that Access Unit.
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Video streams

2-32

& Ad_10s. mpg - PTS/DTS Yiew Prog. 1 Video [PID 289)

Diata & Cursor

151

A1 Mumnber

Sheam Type

151

PES Packet Muriber

E Video

PTS
42249391

DTS
422419

=0 fps

Frame Rate

*. -
"B

Frame Tupe
F!

Profile & Level
Wit & M ain

Chroma Format

[

E P B P B I B PB PPBPUBFP
BUI‘I‘IS:’"?%"'} """ :'"'é"':"v":’"'é"':"':i"":'"'4"
e I O R
LT S A U O O
760 5840 5920 EBO000D BOBD EBI1ED  EB.240
HPTS Access unit time (g)
+DTS [zum of durations)

T ==

The panel on the right shows information about the selected access unit. For video
streams these are always complete packets. Some of the information shown in the
panel is specific to video streams, that is, frame rate and frame type.

The graph shows the frames of video in transmission order analysis and, when

"Zoomed In" close enough, the type of each packet plotted along the x-axis. The
graph scale is drawn in gray dashed lines. It is the equivalent of the scale or
graticule on an oscilloscope or logic analyzer.

Frame Type

display the characters.

Shown when there is space to

y-axis shows any
differences between
the PTS / DTS times
and the calculated
arrival times of the
Access Unit.

It also indicates the
difference between
PTS and DTS times.

l;'EiUmx -

Ams -~

Frames plotted in
Transmission Order
along the x-axis

O - —
000 0080 0160 0.240

®PTS

+DTS

Line colour and
cursor show selected
access unit

Accers unit ime ()
[sum of durationg)
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X-axis The x-axis shows the nominal time of an access unit. The first access unit
displayed is taken to have a nominal time of zero. Each access unit has a nominal
duration, calculated from parameters within the elementary stream. These
parameters include "low_delay" and "repeat_first field", which allow analysis of
effects such as 3:2 pulldown. These effects alter the access unit duration, which is
nominally equal to a video frame period.

Y-axis  The position on the y-axis of a PTS or DTS shows the relative timing of the
timestamps. The first timestamp (PTS, or DTS) is taken to have a y-value of
zero. Each Subsequent timestamp has a y-value given by the difference between
their timestamp and the first timestamp, less the difference in nominal time of
their access unit and the first access unit.

The solid blue vertical lines show the time difference between the PTS and DTS
from the same Access Unit.
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Audio streams

2-34

ﬂ: bt_bbc.mpg - PTS/DTS Yiew Prog. 4167 Video [PID &00)
Feo B 5B P B B AP GBE B LB OCEE PR
oy D.ata at Cursor

120ms == -==---=- flmmmmmm fmmmmme s AT T =il AU Humber
i 324
Stream Type
Yideo
PES Packet Mumber
324
kS
1607345392
DTS
1607834592
Frame Hate
' 25 fps
L niniinieietel Bttt it g Frame Type
i |
Azpect Hatio
9+1E
Profile & Level
bain & Main
Chioma Format
4:2:0
Picture Size [H V]
720 = B7E
Picture Structurs
' Frarme Picture
L e il Eie it i —s WBY Delay
i E5535
WEV Bulfer Size
112
Lo Delay
Falye
Progressive Frame
Falze
Progressive Sequence
Falze
Top Field First
0 L 4o -3 - -3 L e % L
{0 0 o =i e s e by e ey |l et oy S ol i sl A i i
12600 12720 12840 12960 Yo [A—
HPTS Access unit ime (3] TR Ty
+OTS [sum of durations] 16:9(shtpret] 4: Scent)

The panel on the right shows information about the selected access unit. For video
streams, these are always complete packets. The frame rate and frame type shown
in the panel are specific to video streams. The "Picture Size (H x V)" information
is taken from the display horizontal size and display vertical size values in the
sequence display extension. If that is not present, the horizontal size value and
vertical_size values in the sequence header, as modified by the sequence header
extension values horizontal size extension and vertical size extension in the
sequence header extension are used.

Some of the information shown in the panel is specific to audio streams.
AC-3 Audio streams will differ from Audio streams.
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The graph shows timing analysis of the PTS. There are no DTS in an audio
stream. Select an access unit by clicking on it with the mouse. Clicking between
two PTS will select an access unit that does not carry a PTS.

q;hd_1 0z.mpg - PTS/DTS Yiew Prog. 2 Audio [PID 306]

e T --aleaae? G R LE L ELE ;
;;;J : : Solid line and Lo :

Difference cursor show selected
between the . . access unit . FES
PTS and the / : , : - g N

calculated )
arrival time H . ; . . . R
of the : : E : : : Lo -
Access Unit. i i i i ; ; A
— N[
DITI?-"""'-K """ ST i Cia - |"""':""| -H
2286 ZBE4 3072 3480 388 42396 4704 HAT2 BYE0 ———

=PT5 Aocess unit tine [2)

+0TS [0 of durations) —

The graph scale is drawn in gray dashed lines for each value on the axis. In this
example there are only two values on the y-axis, at 0 ms and 24 ms.

AC-3 audio streams

@ ATSC_10s.mpg - PTS/DTS View Prog. 3 AC-3 Audio (PID 52

Data at Cursor | -

32ms roomooo- AL Murber
41
Stream Type
AC-3 Audio
PES Packet Mumnber
41
PTS
412033750
o]
AC-3 audio
Bitratelndex
384khit/s
Frequency
43000Hz

.
'
1
'
'
'
'
1
'
'
'
'
1
'
'
'
'
1
'
'
'
'
1
'
'
'
'
'
'
'

|

e e e e e D B 5 T

o6, e e D e X e e

0,765
®PTS
+DT5

0.928

1088 1248 1408 1868 1728 1.888

Bit Skearn Mode
Complets Main (CM) 7

Azcess unit bme [5)
[zum of durations)

Audio Coding Mode

342 -

The Data at Cursor panel of the PTS/DTS view shows different information for
AC-3 Audio streams. Otherwise the window works in the same way as for Audio
streams.
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AAC audio streams

@ T5020804_cut.mpg - PTS/DTS View Prog. 140 AAC Audio [PID 532) =] I

Data at Curgor I -

21..“8,__.....:.. --—-—-|—-—----v‘v—'—'l—"""""""""_'_"':'----_-': Al Mumber
' ' 1 i LAl
' : : Stream Type
i ' ! AAC Audio [ADTS
! H ! PES Packet Mumber
LAl
PTS
37302608
D
|1 (MPEGL
Layer
0 [pac
Pratection Absent
u]
Prafile
1[LC]
Sarnpling Frequency
48000 Hz
Channel Config
0

Original/Capy
O riginal

1 Copyright |0
i Ma start in frame

! ! ! . . ! ! ! ! Frame Lenath
(s X6 36 56 K 3 Ko KoMK P P 56 3 3 I KK ICICIK S 9 3 96 e e I D06 9 S 5 5 I 384 butes
047 0512 0597 0683 0768 0893 0939 1024 1103 1195 120 Buffer Fulness
=PTS Access unit time (5] 0 [0x0 —
+0T5 [sur o durations) Raw Drata Blocks

nl

==

[ R S ' ' ' ' ' ' [ ' ' ' ' [

The Data at Cursor panel of the PTS/DTS view shows different information for
AAC Audio streams. Otherwise the window works in the same way as for Audio
streams.
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T-STD Buffer Analyzer — Getting started

IM T-STD Buffer Analyser - sample_stream.bmr

Flle Edit Yew Options Process Trace Window Hep

The T-STD Buffer Analyzer models the behavior of the buffers in the hypothetical
Transport Stream System Target Decoder, as specified in ISO/IEC 13818-1. It
can process video, audio, and system control streams. The results of the analysis
are displayed as graphs of the buffer capacity over time and a log of exceptions
and noteworthy events.

~|5{p| & 813 &[S wE |
#'sample_stream.bmr - Stream List

¥, Transport Stream
= Pragram 1
{9 PID 100 (System) Unprocessed
-« PID 110 Stream Type: 2 (0x02) (MPEG-2 Video) Processed
6 PID 32 Stream Type: 27 (0x1b) (H264 Video) Frocessed
-2 PID 35 Stream Type: 4 (0x04) (MPEG-2 Audin) Unprocessed
2 PID 36 Stream Type: 4 (0x04) (MPEG-2 Audin) Pracessed
&+ @ Program 2
@ Program 3
[+ 8 Program 4

ample_stream.bmr - Event Log for PID 32
TS Packet | Event Type Comment

0:11.988 023936 0:36.904 0:47 872 0:59.833
0:59.839

ideo Multiplex Buffer (MB1) - Pid 32

0 Log Started Starting the Video buffer model

General Event Frame Rate = 25.00 fps

General Event B size: 512 bytes, RX rate: 36000000 bytes/s - 100.0%

0
0 Goneral Bvent  Profile: Bascline, Level: 5.1
0
a General Event B size: 160000 bytes, rate: 30000000 bytes/s - i1 A AR ——

o General Event EB size: 30000000 bytes

142518 General Event  Ignoring out of range DTS 39,2802 Seconds - spox | 0°0-000, 0.0
143052 General Event  Ignoring out of range DTS 39,36002 Seconds
143054 General Event  Ignoring out of range DTS 39.40002 Seconds E

e i S i g >l 053833

BYsample_stream.bmr - Trace

T I R

Tirme 110

110
110
110
110

110 18 Picture H

110 MB
110

T 1500% |-

- oox

0:0.000 0:11.968 0:35.904 0:47.872 0:59.833

leo Transport Buffer (TB1) - Pid 32

%

5 0:0.000, 0.0

_ S00%
0.0.000 0:11.968 0:2393 0:35.904 0.47.872 0:5983

0:59.833

Buffir Analysar

| UM 4
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Suitable streams

Table handling

Multiple PAT and PMT
versions

MPEG-2, DVB and ATSC
tables

Starting the program

3-2

Any valid MPEG file, recorded or synthesized, can be processed by this
application. A valid file is one that starts on a transport stream (TS) packet
boundary (the first byte of the file must contain the first byte of a TS packet).

The Buffer Analyzer will process video, audio, and system control streams that
are compliant with the 1996 standard ISO/IEC 13818 parts 1-3.

The Buffer Analyzer is able to analyze the following types of elementary streams:
MPEG]1 Audio and Video, MPEG2 Audio and Video, H.264 Video, MPEG2 AAC
Audio, MPEG4 Audio (Only LC and SBR profiles) and AC3 Audio. It also
supports HEAAC along with the above elementary streams.

The Buffer Analyzer will handle transport streams that contain PCR and/or
PTS/DTS discontinuities. The PTS/DTS and PCR in a stream must, however,
use the same timebase.

The Buffer Analyzer is unable to work on scrambled streams. If it fails to make
sense of a stream, use TS Analyzer to determine if the stream is scrambled.

Buffer Analyzer forms a list of elementary streams that are present in the transport
stream. This is called the Stream List. It creates the Stream List by reading

the first occurrence of the Program Association Table (PAT) and Program Map
Table (PMT).

If more than one version of the PAT and/or PMT are present, TS Cutter can be
used to isolate a particular section for analysis.

Only PIDs carrying MPEG-2 PSI tables are included in the System model. Any
DVB or ATSC tables that are present in the Transport Stream are ignored.

To start the program, select the Tektronix Buffer Analyzer option from the Start
> Programs menu or double click the Tektronix Buffer Analyzer Shortcut on
the desktop.

Adminiztrative Tools [Common]  F
Startup L4
M Tektroniz Buffer Analwse

Tektroniz Monitor-Recorde
@ Tektroniz PES dnalyser
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Initial appearance  Once the program has started and is ready for use, it will open a Main Window.
When the program starts, the Main Window looks like this:

[N 7-STD Buffer Analyser
File View Help

DR | &[] M| zoef=fec] #| w24 ¢

Buffer Analyser R

The Toolbar (row of buttons above the dark gray area of the empty window) can
be hidden from view, moved to a separate window, or moved to either side or the
bottom of the main window.

The Status line at the very bottom of the window can be hidden from view. It
displays information about the application and keyboard status.
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Initial menu options  The application presents different menus and options, depending on whether a
file is open for analysis. The menu options available when Buffer Analyzer has
just been started, or after a file is closed, are: File menu options. The following
table lists the File menu options.

Table 3-1: File menu options

Command Function

New Opens a stream file for analysis and opens or creates a Buffer
Model Results (BMR) file in which to dstore the results.

The application opens a file selection dialog allowing you to
choose the stream file. It then opens another file selector dialog
to specify the BMR file.

Open... Opens an existing BMR file to review results of a previous
analysis. The application opens the file selection dialog allowing
you to choose the required file.

Print Setup... Opens a dialog for selecting which printer and associated
options to use.

1 <filename> A list of the four most recently used BMR files. If Buffer Analyzer

2 <filename> has recently been installed, the list may hold less than four files.

3 <filename> Selecting a filename opens that BMR file for review.

4 <filename>

Exit Finishes running the program.

View menu options. The following table lists the View menu options.

Table 3-2: View menu options

Command Function

Toolbar Displays or hides the toolbar.

Status Bar Displays or hides the status bar.

Settings... Opens the Settings dialog for specifying Video Buffer Sizes and

Video Data Transfer method.

(A check mark next to an option shows that the toolbar is currently visible; no
check mark means that it is hidden.)
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System settings

T-STD Buffer Analyzer — Getting started

Various configuration parameters, including Packet Interpretation, Pre-Scan
Packets, PES Private Interpretation, Video Buffer Sizes, Video Data Transfer
method, and Audio Buffer sizes can be modified before and after opening an
MPEG file. When a file is open, one or more streams can be analyzed, the settings
can be changed, and then other streams can be analyzed with the new settings. If
the settings are changed, to reanalyze streams analyzed with previous settings, the
MPEG file must be closed and opened again.

It is a good idea to check the settings before opening a file to verify the method
with which video streams will be analyzed.

Select Settings... from the View menu to open the Settings dialog.

[T MPEG-2/H.264 T-STD Buffer Analyser

File:

Dy e ple] e

| v Status Bar

This opens the Settings dialog, which has three tabs: System, Video and Audio.

t3

Settings

System | video | Audio |
~ Packet Interpretation ~Pre-Scan Packets

+ MPEGZ v Al Packets

" MPEG2 /ATSC ,7 peckels

MPEG4 Audio ;| FES Frivate Interpretation

AC-3 Audio
L0 Agdio
MPEG2 Audio

MPEG2%ideo
HZ264 Video

Syaterm
] | Cancel ‘

These options can only be set before analyzing a file. They are disabled (grayed
out) while a file is open.

The MPEG2 / ATSC option is available on ATSC or ATSC/DVB dual standard
MPEG Test System products. It is disabled (grayed out) on single standard DVB
systems.
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3-6

Packet interpretation. Specifies which standards will be used for interpreting the
packets in the Transport Stream when a file is opened for analysis

The options are:

MPEG2 Interprets the packets according to the standards for DVB
streams.
MPEG2/ ATSC Interprets the packets according to the ATSC standards. This

option is required if AC-3 audio stream content will be analyzed.

Pre-Scan packets. During the initial processing of an MPEG file, a number of
packets are prescanned for information that will result in a more accurate analysis
of the initial parts of the transport stream

The greater the number of prescanned packets, the greater the chance of locating
all of the information required for accurate analysis. The drawback is increased
processing time. By default, 10000 packets are prescanned, which should be
sufficient for most streams, excluding High Definition Video.

All Packets Select this check box to cause all packets to be prescanned.
If this check box is selected, the packets field will be disabled
(grayed out).

Packets If the All Packets check box is not selected, enter the number
of packets to be prescanned in this field.

PES Private interpretation. This setting specifies the model type to use for streams
signaled as PES Private (stream_type = 6)

The selections available include the following: AC-3 Audio, AAC Audio,
MPEG-2 Audio and Video, MPEG-4 Audio, H264 Video and System. The default
setting is AC-3 Audio.
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Settings

Systen  Yideo lAudiD ]
Buffer Sizes

+ Automatic

" Marual " Leak Mathod

" BV Delap Method (MPEG-2 only)
hdB ,7 Bytes
EB : ,7 Bytes

T-STD Buffer Analyzer — Getting started

3

D ata Tranzfer

% Automatic

Default Frame Rate
|25 ﬂ Framesds

o ]

Cancel ‘

Buffer size. Specifies the sizes that will be used for the Main and Elementary
Buffers, when interpreting the stream. The options are:

Automatic

Manual

Automatically detects the buffer sizes from the Sequence
Headers and Extensions in the elementary stream being
processed. This is the default option when the application is
started.

Enables the size of the Main or Multiplex buffer (MB) and
Elementary Buffer (EB) to be specified manually. The MB and
EB fields are available for editing when this option is enabled.

Data transfer. By default Buffer Analyzer inspects the stream to determine which

transfer method to use

This can be overridden if required. The options are:

Automatic

Leak Method

VBV Delay Method

Examines the stream to determine the transfer method. This is
the default option when the application is started.

Initiates modeling of the stream using the Leak Method.
H.264 streams support only this method but the option can be
kept as Automatic.

Initiates modeling of the stream using the Video Buffer Verifier
(VBV) Delay Method. This option is specific to MPEG-2.

Default frame rate. The frame rate is one of the parameters that is searched for
during the prescan phase of analysis. However, if it is not found, the default value
selected from the drop-down list in the Default Frame Rate field is used.
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Audio settings

Settings E|

Systen  Yideo lAudiD ]

Buffer Sizez D ata Tranzter

& Automatic & Automatic

" Manual " Leak Method

B - ,7 Byles " BV Delap Method (MPEG-2 only)
EB : ,7 Bytes

Default Frame Rate
|25 ﬂ Framesds

Ok | Cancel ‘

Buffer Size. Specifies the size that will be used for the audio buffer when
interpreting the stream. The options are as follows:

Automatic Examines the stream to determine the transfer method. This is
the default option when the application is started.

Manual Enables the size of the buffer (B) to be specified manually. The
B field is available for editing when this option is enabled.

AAC. Select the number of AAC channels required from the drop-down list

Within the ADTS (Audio Data Transfer Stream) fixed header, the channel
configuration field is used to indicate the number of channels required by AAC. If
the number in this field is zero, the value in the AAC Default channels field is used.

NOTE. The associated ADIF (Audio Data Interchange Format) is unsupported.

Refer to Information technology - Generic coding of moving pictures and
associated information, Part 7: Advanced Audio Coding (AAC) ISO/IEC
13818-7:1997

NOTE. Remember that if the settings are modified, the new settings are used for
all video streams that are subsequently processed. The settings are reset to the
default option when the application is started.
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Opening an MPEG file

Any file holding a recorded or synthesized sample of a Transport Stream that
carries video, audio, and/or system control streams can be analyzed. These files
are referred to as MPEG files to distinguish them from Buffer Model Results
(BMR) files. The results of analysis are written to a BMR file.

Opening a file from the  To open a file for analysis, select the New option from the File menu.
menus and toolbar  Alternatively, use the Ctrl+N keyboard shortcut.

[M MPEG-2/H.264 T-STD Buffer Analyser
Y view Help

Opaty. ChrHo

Prink Setup. ..

1 hza4 _with_audio, brar
2 atsc_ba_test.bmr

= hbo_236.bror

4 test_bad.bror

Exit

NOTE. The list of previously used files shows BMR not MPEG files, as can be
seen by their .bmr extension.

There is a shortcut button for the New command on the Toolbar:

| B & S %] %

In response to the New command, the Buffer Analyzer opens a file selection
dialog to choose an MPEG file for processing. When the MPEG file has been
chosen, the MPEG file selector closes and another file selection dialog opens. This
is for choosing a Buffer Model Results File (BMR), which holds the results of any
analysis performed on the MPEG file.

NOTE. Choosing an existing BMR file will erase all results that had previously
been saved in that file.

Buffer Analyzer suggests an output file with the same name as the MPEG file but
a file extension of .bmr to hold the Buffer Model Results. Select OK to accept
the suggested filename. Otherwise, select a different file or type in a different
name, and then select OK.
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Opening a BMR file

Opening a file from the
menus and toolbar

An existing Buffer Model Results (BMR) file can be opened to review the results
saved in it from previous Buffer Model Analysis.

To open a BMR file, select the Open... option from the File menu. Alternatively,
you can use the Ctrl+O keyboard shortcut.

M MPEG-2MH.264 T-STD Buffer Analyser

GIEN “iew  Help

e el
Prink Setup. ..

1 h2ad_with_audio . bmr
2 atsc_ba_test.bmr

3 hbo_236.6mr

4 best_bad b

Exik
If the required file is in the list of recently analyzed BMR files, it can be opened
from the list to save using the open file dialog.

There is a shortcut button available on the Toolbar for opening a file, which has
the standard file open symbol:

(2] 5] S[2] %] el ]| wls]s
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Window layout

The Stream List window opens as soon as either an MPEG or BMR file is

opened. The application inspects the file to find what program streams are present
according to the Packet Interpretation setting. For example:

I T-S1D Buffer Analyser - Sym3.bmr

File Edit VWiew Options Process Trace Window Help

D0 e S| ®| Ml z=|vm|=s|=] 2 | waf] 0| @ (m=] Ql
BE' Sym3.bmr - Stream List

. Transport Stream
Program 1
PID 100 {System) Unprocessed
<= PID 9 Stream Type: 2 (0x02) (MPEG-2 Yideo) Processed
J3 PID 120 Stream Type: 4 (0x04) (MPEG-2 Audiod Unprocessed

JJ PID 130 Stream Type: 4 (0x04) (MPEG-2 Audiod Unprocessed
=& Program 2

PID 200 (System) Unprocessed

< PID 210 Stream Type: 2 (0x02) (MPEG-Z Video) Unprocessed

JJ PID 220 Stream Type: 4 (0x04) (MPEG-2 Audiod Unprocessed

J3 PID 230 Stream Type: 4 (0x04) (MPEG-2 Audiod Unprocessed

= PID 260 Stream Type: 14 (0x0e) (MPEG-2 Auxiliary) Unprocessed

Buffer Analyser UM y
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Initial processing of MPEG files

If an MPEG file is opened, the program performs initial analysis to form the
Stream List and calculate the mean transport rate. All streams in the list are
marked as Unprocessed, because no analysis has been performed on them in
this session.

To build the Stream List, the MPEG file is scanned for the PAT and PMT table
contents. It is assumed that the contents are constant, which is the general case.
If the program changes in a drastic way, such as streams disappearing between
PMTs, the model will give meaningless results.

Only the first occurrence of complete PAT and PMT are read when forming the
Stream List. Use TS Cutter to isolate a section when multiple versions of the
tables occur.

A number of packets in the file are scanned for the Sequence Header and
Extension start codes (containing profile and level) (See page 3-5, Settings.) for
more information. If they are not found the Main Profile and Level setting are
assumed together with the maximum VBV buffer size.

Initial processing of BMR files

If a BMR file is opened, the State column indicates which streams were processed.
The file only holds results for those streams marked as Processed. To obtain
results for unprocessed streams, the original MPEG file will have to be opened
again and analyzed.
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T-STD Buffer Analyzer — Menus and controls

When a file is open, the program presents a different set of menus and options.
They change as soon as the Stream List window appears. For example, the Open
file commands are replaced by Close file commands.

Toolbar

|| 0| | S 2] ] =ewefwelen]+ | ][] |G| Q

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

E

Opens dialogs to select an MPEG file for analysis and a BMR
file for saving the results. This button is disabled (grayed out)
when a file is open.

&

Opens a dialog to select a BMR file to review the results of a
previous analysis session. This button is disabled (grayed out)
when a file is open.

|2

Closes the current file. This button becomes available the
moment a file is opened. If the wrong file is being opened, or the
wrong options are selected, clicking on the button will abandon
the analysis and close the file.

Opens the Settings dialog.

Prints the contents of the current window.

Opens a dialog that displays the program version number.

& = || &

Analyzes the stream(s) from the PID(s) that are currently
selected in the Stream List. This button is only enabled when
one or more PIDs that are marked as unprocessed are selected.

The next group of five buttons open Results views for the selected streams.

Rl

Opens a graph of the Transport Buffer for the selected stream.
This button is only enabled when the PID of a Processed stream
is selected in the Stream List window.

g

Opens a graph of the Multiplexing Buffer of a video stream; Main
Buffer of an audio stream or of a system information stream.
The button is only enabled when the PID of a Processed stream
is selected in the Stream List.

E5|

Opens a graph of the Elementary Stream Buffer for the selected
video stream. This option is only available when a PID carrying
a Processed Video stream is selected in the Stream List.
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E| Opens the Event Log for the selected stream. The button is
only enabled when the PID of a Processed stream is selected in
the Stream List window.

i| Opens all of the relevant graphs and the event log for the
selected stream. This option is only available when a PID
carrying a Processed Video stream is selected in the Stream List.

The remaining buttons control display options for Graphs of buffer analysis

Toggles the graph displays between having all points drawn and
sampling the points for drawing.

Synchronize Graphs toggles the graphs between using the
same position and zoom settings or operating independently.

Auto Scale toggles the selected graph between fixed and auto
scaling of the y axis.

Zoom In increases the magnification along the x-axis (time
scale) of the currently selected graph. All graphs are affected if
Synchronize Graphs is enabled.

Zoom Out reduces the magnification along the x-axis (time
scale) of the currently selected graph. All graphs are affected if
Synchronize Graphs is enabled.

Reset Zoom resets the magnification of the currently selected
graph from zoomed to original state.

=] e R 2

q | Trace analyzes the message logs. You can view the message
log that is produced by the Buffer Analyzer.

The Toolbar can be dragged off the edge of the main window into a floating pallet.
To do this, place the mouse pointer on the background inside the Toolbar, (not
on one of the buttons), hold the left button down, and drag into the main window
area. The result is a self-contained window that looks like this:

o = S| %] =)o - | wil[¢] &S G

To replace the Toolbar on the window border, drag it over the border, until the
outline changes shape, and release it. It can be placed on the top, bottom, left
or right edge.
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Status bar

.Fur Help, press F1

[

The Status bar may be hidden from view, but when visible, the Status bar is
always at the bottom of the main window. It displays the following information

about the program and keyboard states:

Message Field

Gives a description of any
button or option over which
the cursor is placed.

Way alzo show other
non-critical messages,

g

Keyboard
Maode
Indicaters

TS Payload Unit Start
Displays number of TS

packet in which current
PES packet starts

Analysis Status
Displays a progress
indicatar while a file
iz being loaded.

| TS Packet 1043

N al

At

CaP [NUM [TS Packet 1043 |

The messadge changes to
describe the function of the button
oF ment aption aver which the

mouse poirter is placed,

(The description is =till displaywed
if the buttor or option iz unavailable.
e greyed o)

Bnalpser - Ad 53 bmr

Options

Frocess  Window

Drraws &l Points {
Synchroni i

Auto Scale % Axis

View the FTS/DTS &nalvsis

[

[T5 Packet 1043 |
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Menu options

The available menu options are listed in the following tables.

Table 3-3: File menu options

Command Function

Close Closes the current file. This option is available as soon
as analysis starts. If the wrong file is being opened, or
the wrong options are selected, selecting this option
will abandon the analysis and close the file.

Print Prints contents of the current window.

Print Preview Prints contents of the current window.

Print Setup Selects printer and configuration.

Trace Print Font Selects the font to be used for printing text.

Options Colors Not available with Buffer Analyzer.

Exit Closes any file that is open and terminates the
program.

Table 3-4: Edit menu options

Command Function

Cut Moves the currently selected records from the main window to
the clipboard.

Copy Copies the contents of the currently selected records to the
clipboard. They are not removed from the main window.

Delete Deletes the selected records from the main window.

Delete Except Deletes all records except those selected from the main window.

Delete All Deletes all records.

Select Al Selects all records.

Table 3-5: View menu options

Command Function

Toolbar Shows or hides the Toolbar.

Status Bar Shows or hides the Status bar.

Settings... Opens the Settings dialog.

Global Event Log Shows or hides the Global Event Log window.

Transport Buffer Opens a graph of the Transport Buffer for the selected PID.
Main Buffer Opens a graph for the selected PID in the Stream List. The

graph shows results for the Main Buffer of audio and system
streams or the Multiplex Buffer for video streams.

Elementary Buffer Opens a graph of the Elementary Buffer for the selected PID.
PID Event Log Displays the Event Log for the selected PID.
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Table 3-5: View menu options (cont.)

Command Function
All Buffers Opens all graphs and the log for the selected PID.
Trace Generates a detailed trace log.

Table 3-6: Options menu options

Command Function

Draw All Points Toggles between drawing all points on the graphs, drawing
every nth point. ‘n"is calculated from the total number of data
points and the screen space for the graph.

Synchronize Views Toggles the graphs between using the same position and zoom
settings and operating independently.

Auto Scale % Axis Toggles the selected graph between fixed and auto scaling of
the y axis.

Table 3-7: Process menu options

Command Function

Process Streams Applies the stream(s) from the PID(s) selected in the Stream List
to the System Target Decoder Buffer Model.

This option is only enabled when one or more unprocessed PIDs
are selected in the Stream List.

Table 3-8: Trace menu options

Command Function

View

Column Opens the column definition dialog box for selecting the columns
of information that has to be displayed.

Font Selects the font that is used for displaying the text of detail
message log records.

Colors.... Selects background and text colors that are used to display
each type of message.

Newest End Displays the newest record.

Show

Markers Shows markers permanently while using Trace with the Buffer
Analyzer.

General Text Shows or hides general messages. For example, messages
indicating the start of processing for a particular PID.

Fixed Shows or hides information such as transport rates and buffer
sizes.

PCR Timestamp Shows or hides messages about PCRs and associated

instantaneous transport rates.
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Table 3-8: Trace menu options (cont.)

Command Function

System... Selects which types of system messages to show.
Audio... Selects which types of audio messages to show.
Video... Selects which types of video messages to show.

Table 3-9: Window menu options

Command Function
Cascade Cascades the windows.

Tile

Arrange Icons Arranges any minimized windows along the bottom of the main
window. Aligns icons of any minimized windows at the bottom
of the program's main window.

1 <window file> Lists all of the available windows. A check mark indicates the

active window. Select an option to bring that window to the top.

Table 3-10: Help menu options

Command Function

About Buffer Analyzer... Opens a dialog that displays the program version number.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual



T-STD Buffer Analyzer — Stream list

T-STD Buffer Analyzer — Stream list

The Stream List is displayed in the form of a tree view. The tree view is grouped
and sorted by the program numbers with the label for the PIDs, stream types,
and the states displayed. The Stream List displays all the elementary streams in
the file. An unprocessed state is indicated by the black label and the processed
state is indicated by the green label.

The ‘+' symbol displayed to the left of some icons indicates that the item includes
lower-level stream components that are not displayed. The symbol changes to

‘- when the lower level components are displayed. To expand the hierarchy,
click on the ‘+' symbol. Similarly, to collapse the hierarchy, click on the ‘-' of
the selected upper-level icon.

The System, Audio, and Video PIDs of a specific program number are displayed
as leaf nodes of the same level.

# h264_with_audio.bmr - Stream List

YL Transport Stream

= & Program 1
FID 16 (Systern) Processed
< PID 17 Stream Type: 27 (Ox1b) (H264 Yideo) Processed
13 PID 20 Stream Type: 4 (0x04) (MPEG-2 Audio) Processed

Stream Type includes Video, Audio, AC-3 Audio, AAC Audio, System, or
Private. Private streams cannot be processed, but may show more information
about the type, for example ISO/IEC 13818 Auxiliary. The Packet Interpretation
from the System tab of the Settings dialog box sets the standard that is used for
identifying these types.

The preceding example is from a DVB compliant transport stream.

An ATSC stream might look like this:

?f-' atsc_ba_test.bmr - Stream List

SE Transport Stream
—I-5Y Frogram 1
PID 16 (Sysbemn) Unprocessed

w PID 1 Stream Type: 2 (0x02) (MPEG-2 ¥iden) Processed
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Selecting streams

3-20

This tree view lists processed (analyzed in the buffer model) and unprocessed
streams. A stream may be processed only once when the file is open. To process a
stream again, the file must be closed and then opened again.

When an MPEG file is first opened, the program streams are all marked as
Unprocessed. Unprocessed state indicates that no buffer analysis has been so far
performed in this session so far.

If a BMR file is opened, the streams state will be displayed as processed or
unprocessed. The file only holds results for those streams marked as Processed.
To obtain results for unprocessed streams, the original MPEG file must be
reopened and analyzed.

To analyze or open the results views for a stream, or streams, they must first be
selected in the Stream List. To select a stream, click on the PID number.

For example, click on PID 1 Stream Type text to select the Video stream carried
in PID 1.

E h264_with_audio.bmr - Stream List

‘i Transport Stream

=-8) Program 1
PID 16 (System) Unprocessed
S JFID 17 Stream Type: 27 (0xlb) (H264 Yiden) Unprocessed
Jd PID 20 Stream Type: 4 (0x04) (MPEG-2 Audin) Unproressed

By using the Shift and Control key, you can make multiple selections for all the
tree nodes.

You can select the highest level node to process all the descendent nodes. For
example, selecting the highest level transport stream node will process all the
PIDs or selecting a specific program level node will process all the PIDs of that
program.

To select a contiguous range of streams: click on the first streams PID, then hold
the Shift or A key down and click on the last stream's PID number. If the required
streams are not adjacent, hold the Ctrl key down and click on the PID number
for each stream.

All streams can be deselected by clicking the mouse pointer outside the tree view
data. To deselect a particular stream while leaving the others selected, hold the
Ctrl key down, and click the stream's PID number.
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Processing streams

When one or more streams are selected from the Stream List, they can be analyzed
in the buffer model.

To start analysis, select the Process Streams option from the Process menu.

T-5TD Buffer Analyser - atsc_ba

Alternatively, click on the Process button in the toolbar.

I (TR I T R T T

You can also process the highlighted streams by selecting Process Streams from
the shortcut menu.

B8 h264_ with_audio.bmr - Stream List

3t. Transport Stream
-I-f=) Program 1

[@) PID 16 {System) F‘ru:u:essed

PID 17 Skream

JJ FID 20 Stream |

o) Unprocessed
i) Frocessed

Glabal Event Log
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When H.264 streams with SEI (HRD) parameters are processed, a dialog box is
displayed, prompting you to either continue or abort the processing of streams.
If you continue, the STD leak method will be used for analysis. If you abort the
process, the state of that stream will be displayed as aborted.

HRD parameters detected (PID: 35)

HRD Parameters are present, however STD leak method is
used for analysis,
Do yau wank bo continue?

[ Do nok prompt again

Continue | Abort

NOTE. For HRD model analysis, use Tektronix MTS4EAV7 HEVC / AVC Video
and Compressed Audio Analyzer.

Supported profiles and  Buffer Analyzer supports 6 Profiles for MPEG-2 video: Simple, Main, SNR,
levels  Spatial, High, and High4.2.2.

Buffer Analyzer supports 7 Profiles for H.264: Baseline, Main, Extended, High,
High10, High4.2.2, and High4.4.4.

It supports 4 Levels: High, High - 1440, Main, and Low.

Details of valid combinations of profile and level are given in standards document
ISO/IEC 13818 part 2 section 8.5.

Start-up  The hypothetical T-STD specified in ISO/IEC 13818 part 1 section 2.4.2 assumes
a processing steady state. To handle the start-up processing before reaching the
steady state, Buffer Analyzer performs as follows:

B The fraction of the first video frame leading up to the first picture start code
is not passed through the Buffer Analyzer. This is because it is not possible
to determine whether the Leak or VBV Delay method is being used. During
this period, the PES header, Sequence Header, and Extension information are
extracted. This information is used to determine the initial DTS, size of the
MB and EB buffers.

B The Decoding Time Stamp (DTS) for the first frame is assumed to be correct.
It is used as a base for the timing of all subsequent frames. MB underflow
errors are suppressed during the first frame.

If the DTS of the first frame is not correct, use TS Cutter to remove the suspect
frame(s) from the file.
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Approximations ~ The application uses the following approximations to model the behavior of the
hypothetical T-STD:

®  Data is processed one packet (188 bytes) at a time. An underflow/overflow
condition that occurs and clears within the period of one packet will be missed.

B Processing one packet at a time causes the buffers to be emptied in block
fashion, thus giving a stepped graphical output.

m  Slight quantization effects occur because the model is processed at discrete
time intervals, corresponding to a single packet length. This may affect the
VBYV Delay calculations. The timing intervals for transferring frames from
MB to EB are dynamically adjusted to compensate.
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T-STD Buffer Analyzer — Event and message logs

The T-STD Buffer Analyzer allows you to access the Global Event log and the
PID Event log. You can use the Trace to create a log containing a more detailed
analysis of the entire process.

The views can be synchronized by selecting the Synchronize Views option from
the Options menu. While Synchronize Views is enabled, a change to any view is
immediately applied to all the other views.

Global event log

?_ﬁ' atsc_ba_test.bmr - Event Log E@E{
|Euilding Program Table A

Building Program T able

Packet Size = 188 bytes

Seatring PCR'z

Mean Transport Rate = 8.000 Mbit/s
Firished Pre-processing

Freparing Program 1 Spstern Fid for processing
Pracessing selected streams
Pracesang Interval = 0,00:00; 00

Preparing PID 1 for processing

Frocessing selected streams

Pracessing lntereal = 0:00:00: 00

Pracesaing A ate = 79, 999264 Mbit/s e

The Global Event Log displays: reports from the initial analysis, PID independent
information (Transport Stream errors) and high level details for each stream
processed.

For details of events detected during the processing of a stream, open the PID
Event Log for that stream.
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PID event log

B8 atsc_ba_test.bmr - Event Log for PID 16

Tirne: T5 Packet Event Type Commenk
Qoad o0 Log Started Starking the Systems buffer model
oooon 0 General Evert TB size: 512 bytes, R¥ rates 125000 bytes)s
ool o General Evert B size! 1536 bykes, R rabe 16000.000 bykesys (127999,999
o:o0n 3 TB Cverflow Start Stark of TB overflow
Q0007 34 Fatal Error TE i full, Data being discarded
00007 39 T8 Overflow End End of TE awerflow
< >

An Event Log window may be opened for each PID that has been or is currently
being processed. Results are written to the log as they are produced. All time and
packet numbers are given, relative to the start of the file.

Selecting an event row from the Event Log will place a cursor at that time in
each of the Buffer Results graphs. To select an event, click on the row of the
desired event.

Event selection

BB Test2.bmr - Event Log for PID 610
Time TS Packet Event Tupe Camment -
012080 E4254 B/MWB Overflow Start  Start of MB overflow I—
12110 B4413 Gereral Event WBY _DELAY penod exceeds avalable time befare dec
12117 B4450 BB OverflamEnd  End of ME overflow
012118  EB4457 General Event VEY_DELAY peniod excesds avalable time befors dec
0165273 81238 B/MB Overflow Start  Start of MB overflow
115352 B16R General Event WBY DELAY penod exceeds avallable ime before dec
15403 8197 B/MB Overflow End  End of MB averflow
IE (115 697 Jeetks B/ME Qverflowe Start Start of ME averflow
015737 94028 General Event VBY_DELAY penod exceeds avalable time before dec
015802 24052 Feneral Event WBY_DELAY penod exceeds avallable ime before dec
016872 854423 B/MB Overflmm End  End of MB averflow
1E6.095 85614 B/MB Overflow Start  Start of MB overflam -
.| | 2y

To deselect an event, click the mouse pointer outside the data column.
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Trace

User interface

Detailed message records

3-26

The Trace is used for analyzing the message logs produced by the Buffer
Analyzer. The message logs may be useful for in-depth analysis of the internal
processing, particularly for the video stream type. Trace has filtering capabilities
that allow you to focus on message types of particular interest.

Trace record is displayed only for processed streams.

64 _with_audio.bmr - Trace

Description
B occupancy 2072 bytes. Bemoving frame of size [H
576 bytes:
Frame rate= 41.67 1ntDT5= 21374226
Pes Header found at m_B[39898] len= 3464:

PTS 1981261087: Frame decode set to 237.515
{look ahead=0.024)

B occupancy 2048 bytes. Bemoving frame of size
576 bytes:

(=] e Y ] (=]

Frame rate= 41.67 1ntDT5= 21376386

B occupancy 2010 bytes. Bemoving frame of size
576 bytes:

Frame rate= 41.67 intDTS= 21378546:

B occupancy 2132 bytes. Removing frame of size
576 bytes:

Frame rate= 41.67 1intDTS= 21380706

B occupancy 2146 bytes. Removing frame of size
576 bytes:

Frame rate= 41.67 intDTS= 21382866:

B occupancy 2058 bytes. Removing frame size
576 bytes:

Frame rate= 41.67 intDTS= 21386026

= (ol ] (ol ] (=l ()

[7983 Trace records [0 Selected Y

To start Trace, select the Trace option from the View menu.

Alternatively, click the Trace button in the toolbar.

| | B =ikd &l ve|me| Be|eL | A | wa]E| 4] ©

|

Frace window

Trace displays the detailed message log in the main window. It has a Status bar at
the bottom of the window and a scroll bar on the right side.

The Status bar can be hidden from view, but when it is visible, it is always at the
bottom of the main window.

These are displayed in the trace window as a table. Each record is represented
by a single row of the table. The window displays buffer sizes, transfer rates,
profiles, levels, and frame rates that are used for the analysis. The window also
displays the data movements between buffers and their occupancies with respect
to time and packet numbers.

The example shows a log in which a PID (PID 17) carrying video was analyzed
and another PID (PID 20) carrying audio was analyzed.
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The types of messages that are displayed in the trace window is selected from
the Show menu.

To move forward and backward through the log, use the scroll bar on the right
of the window, the Page Up, Page Down, Cursor Up Arrow, and Cursor Down
Arrow Keys.

NOTE. If more than one PID is processed concurrently by the Buffer Analyzer,
the records will be interleaved in the Trace display. Unless this interleaving is
required, processing one PID at a time will make it easier to follow the messages
for each stream.

Selecting records ~ Records may be selected for printing, copying, deleting, and other Edit menu
operations. To do this, they must first be selected.

A single record can be selected by clicking on it. To select a contiguous range of
streams, click the first record to be selected and then hold the Shift down and click
the last required record. Alternatively, click the first record, hold the left mouse
button down and drag the pointer to the last record.

Selected records are repainted in the highlight color scheme. By default, this is
black text on a magenta background. For example:

HMpeg_with_PER.hmr - Trace

Description

ITS 28553 Pes Packet 0:

Picture 1 decode set to
ahead=0.168):

KB Picture Header (1) moved
MB occupancy 170 bytes:
DTS 32153 Pes Packet 1:

Picture 2 decode set to 0.377
ahead=0.188):

KB Picture Header (2) moved to EB:

B a3
Edi m 1S 35753 Pes Packet 2:
e D gy i Picture 3 decode set to

Show ¥ ahead=0.207):

Delet
slete KB Picture Header (3) moved

e MB occupancy 170 bytes:
Delete Al DTS 39353 Pes Packet 3:

Picture 4 decode set to
Select Al ahead=0.208):

KB Picture Header (4) moved
MB occupancy 165 bytes:

Delete Excapt

[1748 Trace records |1 Selected 4

The selected records can be edited and viewed by using the shortcut menu option.
You can edit (cut, copy, delete) records, define the Trace (column, font, colors),
and select messages (System, Audio, Video) to be displayed in the Trace. You can
also show/hide general text, fixed, and time stamp features.
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To set the columns of information that are displayed in the Trace table, select the
Column option from the View menu.

Column Definition x|

Columns |

Column options

¥ Source
¥ Time

" Packet
[+ Type

¥ |dentity
¥ | Decoded

| ak I Cancel

A column is shown for each option that is enabled and is indicated by a check
mark. Clicking on an option toggles it between being shown and hidden.

Fonts  The font of the messages displayed in the Trace table can be changed using the
Font dialog box.

Font shyle;
Bald

Reqular

Book Antiqua [talic
() Backman Dld Style  —

M CentSchbook BT Baold Italic
ﬂ Certuny

(} Certury Gathic

B Century Schoolbaok 5.7

— Sample

AaBbYyZz

Script:
I'Western j

This font style i imitated for the display. The clozest matching stole
will be uzed for printing.
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You can select the font, font style, size, and script from this dialog box. A sample
of the selected font is displayed in the Sample display box. Click OK to see the
selected font in the Trace table.

The color scheme for each message type and for highlighting selections can be
changed using the Select Colors dialog box.

x|
— Text Colar
Highlight ~
Markers - HAEEE =
General Text
MFEG FI<ED HE . Fancel
MPEG PCR [ ]
MPEG 5Y5 B
MPEG ALD AL 1 1 Feset
MPEG ALD E
MPEG &UD TIME ~ Backgraund
FMPEG WID ME Resat Al
FMPEG VIO EB HEEEN e
wreGviDvey  -| | NI
|
HE N

To modify the color schemes, select the Colors option from the View Menu.
This opens the Select Colors dialog box.

Select the message type to be changed from the list box on the left. The current
color scheme will be displayed in the Sample under the list box. Click on the
swatch (colored square) in the Text Color and Background panels for the required
text and background colors.

Repeat the procedure for each message type that is to be changed and click OK.

The Reset button restores the selected message type to the default color scheme.
The Reset All button restores all the color schemes to their defaults.
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T-STD Buffer Analyzer — Results graphs

Common features

3-30

The axes

Zoom

The results of the analysis are plotted on a separate graph for each buffer. When a
graph is opened for a stream that is still being processed, each result is plotted as
soon as it is produced from the model.

All of the graphs have a similar format and controls.

All of the graphs plot time from the start of file on the x-axis and current space
used in the buffer on the y-axis.

When the results graph is first opened, the entire graph is shown. Even a small file
may display data points packed too closely to see the features clearly. For example,
here is just under 20 seconds of a video stream that generated several events:

& Audio Main Buffer (Bn) - Pid 36 EEE
YN mWovey WOl V0 Wwwiny e femy 1

L 2000% -+ e e L e L s

1750 FoeaafeHeddoad Qe
H \ H
0%

" 150,04
- 1260% -1
_100,0% -
i : 0:6.000, 4.0
x|
1 1.
0:0.000 0:4.000 0.2000 012000 016,000 20,000

7E0%
s0.0% |

i 0:20.000

ol

=

T 8%y

Even this small sample holds some solid bands of blue lines and green event
markers, from which only general trends can be determined.

To change the time scale (x-axis) to resolve finer detail, click on the Zoom In
button on the Toolbar:

Eﬂ@‘@il @ ?l i\l "[’E:lI-IE EB EL |

| wilzl4] RaleE

Zoom in as many times as required to achieve the desired magnification. The
magnification is doubled each time the button is clicked.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual



T-STD Buffer Analyzer — Results graphs

In this example, clicking the Zoom In button three times gave a much clearer view:

B8/ Audio Main Buffer (Bn) - Pid 36

i (| ) ] F 1

poE%
T op3ex e
= ??llzl
4 T
| esox | i ;
I 5337,:--«» G L Ec L (S (Y, -, "
| os2Ex !
o dEax !
40z

0% PP F O, | YR . I "
03634 4. 6 B34

re694

To Zoom back out, click on the Zoom Out button as many times as required:
LR 5] Sle] 8] =l ]| wizle] QIRJE| Q

Each time the Zoom Out button is clicked, the magnification is halved, until the
full graph is again displayed.

Scrolling the view  The slider at the bottom of the window indicates where the displayed area is in
relation to the rest of the file. It can be used to scroll the display through the graph
in a similar way to a window scroll bar.

Slider Control

Shows either: the center of the visible
area of the graph, or the position of the
cursor in both the file and visible area.

View Bar

Shows size and position
of visible area of the
graph within the file.

Start of file

End of file

To scroll the stream through the view:
®m  Drag the Slider Control left or right with the mouse.

m  Click the mouse pointer in the slider bar (either the clear sections or the view
bar) to the side of the Slider Control.

When a time or event is selected on the graph, the Slider Control is automatically
repositioned within the View bar. The placement of the Slider Control reflects the
position of the selected packet in the field of view.
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Event markers A graph may show one or more green triangular markers along the top. Each
marker indicates the time a particular event, listed in the PID Event Log, occurred.

B Audio Main Buffer (Bn) - Pid 36

VIAWW O IO SR T S SRR
2000 ; n i

1750 |
“saox A HAR-HE-HHA -

150t

4.601, 116,

- 1000z ¢

750% ¢

S0.0% |

250% |

0:0.000 01198 1:2293% 035904 47872 053839
053833

Only events that relate to the points plotted on the graph are displayed in that
graph. An event relating to a Video Multiplex Buffer will only be marked on the
Video Multiplex graph and not on the Elementary or Transport Buffer graphs.

Double-clicking on a marker will display a pop-up window. This shows the time
and a brief description of the event that is marked.

# Video Multiplex Buffer (MB1) - Pid 32 HE5
200.0%
Time 0:36.562
= i H MB Faied to Emply
175.0% —me- . : i Buffer MB Failed to emply within 1 second
T 1500%
1250 | e SRS R e R SR S pat s paer e e [ s S e e s R e S e
. 1000% |
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For example, selecting an event relating to the Elementary Buffer from the Event
Log of a video stream will place a cursor at the time of the event in the buffer
results graphs. Looking at the graphs, a marker of the event has been placed on
the Elementary Buffer graph, but not the Multiplex Buffer graph.

#! fish2. bmr - Event Log for PID 49

Tine | TSPacket | Event Type | Comment Al
0:12,059 15544 BME Qverflow Start  Start of MB overflow
0:12,525 161503 BMB Owverflow End  End of MB averflaw
0:12,928 166691 MB Faledto Empty  Buffer MB Failad ko ampty within 1 sacond
0:13563 174882 BJME Overflow Start  Staret of ME overflow
0:14,103 181344 B/ME Overflow End  End of ME overflow
0:14.492 186857 MB Faled to Empty  Buffer MB Failed to empty within | second ‘
0:14.634 186685 B/MB Overflow Start  Start of MB overflow =
0:14.644 166620 B/MB Overflow End  End of MB overflow |
0:15.006 L94282 B/ME Qwerflow Start  Start of MB overflow
0:15.103 194733 8/ME Overflow End  End of MB owerflow
0:15.123 195003 B/MB Owverflow Start  Start of MB averflow
0:15.355 197986 BJME Overflow End  End of MB averflow
0:15,631 201543 BJME Overflow Stark  Start of MB overflow il

H O —
\

DAY

Qo0 04188 0:8.376 012584 216752 0:20.940

- 0:20.340

_175.(]2:r~ : reeee- . R

L 1 B
= 125‘0:{5—""""""“"_E”."”""”""I""""”""."i‘”'"-”" ...... . .................
- 100.0% = ) |

MTS4000 and MTS4SAV3 Analyzer Applications User Manual 3-33



T-STD Buffer Analyzer — Results graphs

Synchronize views  Graphs of results can be open for one or more streams. For each stream, one or
more graphs can be displayed. The graphs can have their zoom, cursor position
and visible section manipulated separately or all the graphs can be synchronized.
For example, in unsynchronized operation, the open graphs might look like this:

¥ Video Elementary Buffer (EB1) - Pid 512

......................................................................................

015578

0:10.386

This pair of graphs show different periods in the file at different magnifications.
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To synchronize the views, select the Synchronize Views option from the Options
menu.

fer Analyser - h264_with_aud
=0 | Options  Process Trace e

= Drraw &ll Points

Il

e Synchron R=- Wigws

Auko Scale™s Axis

Alternatively, click on the equivalent shortcut button.

|| B o8] &% ] zefxemles | | wolz] o

Synchronise Yiews

This will apply the zoom, cursor, and visible section of the active window to all of
the other graphs. While Synchronize Views is enabled, a change to any graph is
immediately applied to all the other graphs.

® Video Elementary Buffer (FB1) - Pid 512

2000

175.0%
© 0%
- 125qu !

. 100.0%
0%
s

T moxt
- 00x!
. 0|

0:0,000 0:51893 0:10.386 015578 oz 0125.964

0:25.964

010,386 0:25.964

0:25.964
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The Trace table can also be synchronized with the other graphs by enabling the
Synchronize Views icon. While Synchronize views is enabled, a change in the
selected event of the Trace table moves the cursor position of all other graphs
accordingly. Similarly, a change in any of the graphs moves the highlighted event
of the Trace table accordingly.

final_output2.bms - Trace

0:2.407, 0.0

To separate the control of the graphs, disable synchronize views by selecting the
menu option or by clicking the shortcut button again.

Selection  The cursor can be repositioned within a graph by clicking on the required point.
This is useful when Synchronize Views is selected as a way of marking the same
time in all the graphs for ease of comparison.
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Auto scale  The scale on the y-axis of the graphs shows space used in the buffer as a
percentage of total space. By default, all of the graphs have a vertical scale that
goes from -50% to 200%. The following illustration is an example.

E'Video Elementary Buffer (EB1) - Pid 32

0:0.000 0:11.968 0:23.936 0:35.904 0:47.872 0:59.839
053.839

Selecting the Auto Scale % Axis option from the Options menu changes the
y-axis for the active graph.

[T MPEG-2/H.264 T-STD Buffer Analyser - h264
File Edit  Wiew N8l

= Draw All Points
lLE| EE| EL| -
EI&IEI Synehranize Visws —I =

AubiaScale %% Axis

Process  Trace ‘Wwindow Hel

Alternatively, select the equivalent shortcut button.

D Bl| | S{®] Ml z=|mfe el - | w8 RUGIE] Q

Autn Scale %

The y-axis is now drawn so that the full scale contains the range of values in the
graph, to the nearest 25%. For example, if the range of values was from 30% to
64%, the y-axis would go from 25% to 75%.
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3-38

Draw all points

The earlier example will be rescaled to look like the following:

#Video Elementary Buffer (EB1) - Pid 32

10000

800

BO.0%

40,00

20.0%

0.0z
(0:0.000 0:11.968 0:23.936 0:35.904 0:47.872 0:53.8339

— 0:59.839

To revert to the default scale, select the menu option or click on the shortcut
button again.

The graphs will often contain more data points than can be resolved on the screen.
By default, to avoid drawing points on top of each other, the application will plot
every nth point. This also speeds up the drawing process. How many points to
plot is determined from the available width of the graph on the screen and the
total number of points to plot.

Use the Draw All Points option to look for outlying points and to resolve the fine
detail when the display is zoomed in on the data.

Selecting the Draw All Points option from the Option menu will cause the
application to plot every point.

ST Buffer Analyser - h26

File Edit Wigw [ N Process  Trace  ‘Window

| |E| E Sﬁhronise\-‘iews L

| 4 Auko Scale %% Axis

Alternatively, select the equivalent shortcut button.

=12 7] B2 w] =elelele| - | wysl4] alal al

For larger files, this might take much longer than the default option. The option
may be disabled by clicking on the shortcut button again or deselecting the option
from the menu. This can be done even while the analyzer is still redrawing the
graphs.
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Elementary Buffer graph

B Video Elementary Buffer (EB1) - Pid 39

0:0.000 0:4.000 0:8.000 0:12.000 0:16.000 0:20.000

— 0:20.000

An Elementary Buffer graph can only be opened for Video Streams, since these
are the only type that have an elementary buffer.

Elementary Buffers are not allowed to overflow, so the graph of the results never
goes above 100%. The graph uses the scale -50% to +250% to make comparison
easy.
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Multiplex or Main Buffer graph

B Video Multiplex Buffer (MB1) - Pid 39

0:0.000 0:4.000 0:8.000 0:12.000 0:16.000 0:20.000

= 0:20.000

For Video streams this graph shows the results for modeling a Multiplex Bufter.
For Audio and System Control streams the graph shows the results for the Main
buffer. The title bar shows the stream type.

Here is an example to show the title for a graph of a System Control stream.

[ System Main Buffer (Bsys) - Pid 36 E”‘E”E

P N e RO T O R e ol R L

[:0.000 [0:4.000 00:8.000 0:12.000 0:16.000 0:20.000

— 0:20.000
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Transport Buffer graph

#'Video Transport Buffer, (TB1) - Pid 310

200.0% --nnnmmmmmmmmnmennnea T psssssssis s s .

175.0% p----m-mmmmmmmmmmomon e T T e T — :

T 1500%

-1 S R T AT EEEE R R :

_1000%

Il"- 0:0.000 0:11.968 023,936 0:35.904 047872 033833
(59 839

The Transport Buffer graph shows the results of modeling the Transport Buffer
for Video, Audio, or System Control streams. The type of stream is shown in the
title bar. In the above example, the results plotted are for a Video stream carried
in PID 305.

Here is an example of an audio stream.

¥ Audio Transport Buffer (TBn) - Pid 320

Tl et

B - mmmmmmmmm s me s T

" 1s00%

R S —— SN — e :

- 1000%
B0 fomeommnmomm sz o s e T it

I ORIV | S e E oo

i H ------- (T AR l"N"iﬂ"'ﬂ""";r'{"""""'";"'n""\""

ooz

B - S LLLITEEEERRES L SEPRRSRRSR. SO — USRS,

DD e T
0:0.000 0:11.968 0:23536 0:35.904 0:47.872 059,833

"J, 0:59.839
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ES Analyzer — Getting started

Elementary Stream (ES) Analyzer is an MPEG (Motion Pictures Expert Group)
stream analyzer that allows all MPEG-1 and MPEG-2 streams to be quickly
analyzed. Developers of MPEG compliant encoder and decoder systems, or field
application engineers (FAEs) supporting MPEG-based products will find ES
Analyzer a powerful and easy-to-use tool and debugging aid.

ES Analyzer provides the following facilities:

Analyze in detail and verify whether MPEG-1 system and MPEG-2,
video, and audio streams conform to MPEG standards. (A built-in stream
demultiplexer makes it possible to analyze elementary streams embedded in
a transport stream. All streams are checked for both syntactic and semantic
conformance. Syntactic conformance means conformance with the MPEG
language, while semantic conformance relates to the field value and range
restrictions.)

Quickly zoom from transport streams, through PES and video streams into
GOP, pictures, slices, and all the way down to the macroblock layer.

Play out audio streams to MPEG-1, MPEG-2, Layers I and 11, Japanese AAC,
and Dolby Digital (AC-3) standards.

Audio play to soundcard.
Analyze Layer I, Layer II audio data, AC-3 audio, and AAC audio.

View video output with the incorporated video player and analyze picture
data for any frame.

Produce picture quality analysis data including Quantizer Scale distribution,
motion vectors graph in a picture, and macroblock and picture size plots.

View the coded block patterns that have been extracted.

Display and analysis of DCT coefficients for each macroblock in a picture.
View interpreted and hexadecimal view of headers for all streams.

Display and analysis of DVB Teletext information.

View and analyze DVB subtitle content.

View and analyze ATSC closed caption to EIA608 and EIA708 standard.
View PID spectrum analysis for transport streams.

Analyze multiple streams in batch mode through the regression testing mode.

Quickly navigate through stream hierarchy using the powerful and easy to use
graphical interface including the Stream Properties summary window.
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m  ‘Seekback’ at all levels, allowing users to go back in a stream at all levels, thus
allow more flexibility in navigation.

B Set a level to report errors, filter them, and also store errors in log files.

NOTE. It is assumed that you are familiar with MPEG compression standards and
terminology. If you are new to MPEG and want to know about MPEG compression
standards and terminology, refer to the documents: ISO/IEC 11172 (Vol. 1, 2, 3
and 4) for MPEG-1 and ISO/IEC 13818 (Vol. 1, 2 and 3) for MPEG-2 basics.

Starting the ES Analyzer

The program can be started by selecting the ES Analyzer option from the Start >
Programs menu or by double-clicking on the ES Analyzer shortcut on the desktop.

Tektronix MTS4000
i Optionkey Wizard

Analysers 4y
]_|] Buffer Analyser ES Analyser

# Carousel Analyser

ﬂ ES Analyser
@ PES &nalyser
E\H TE Compliance Analyser

Initially an empty shell window is displayed. It is necessary to open a stream
before any screen details can be seen.
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Opening an MPEG stream

1. To open a file, select the Open... option from the File Menu or select the
corresponding icon on the toolbar.

The following dialog box appears:

open _________________ EHE

Look, i I £ viden
cact_015(1)mpg
zuzi_ 0715 mpg
zhip.mpag
File narme: Iu:-au:t_[l'l 51 ].rpag Open I
Files of type: IKnnwn Formnats j Cancel |
Open &3 |f.‘._ut.;. j [T Hex Window

ES Analyzer displays a standard windows Open dialog box with two
additional fields: Hex Window and Open As.

2. Select the file you want to open.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual 4-3



ES Analyzer — Getting started

The types of files that can be opened are as follows:
= Transport stream files

= PES stream files

= Elementary stream files

= MPEG-1 and MPEG-2 files

= Regression scripts

= Mask files

NOTE. If you want ES Analyzer to automatically detect the type of MPEG
stream the file contains, let the default Auto remain in the Open as field.

If you want to open the file as a specific type of stream and do not want ES
Analyzer to detect it, select the stream type in the Open as field.

If you open an MPEG stream as an incorrect stream type, numerous errors
may be reported and ES Analyzer may also behave unexpectedly.

If you open an ATSC stream as auto and the stream contains no PSIP service

information, the AC-3 audio may appear as (!D and not decode. Close the
file and reopen with ATSC Stream selected from the Open as field; the AC-3
audio will now decode correctly.

3. Enable or disable the hex window.

ES Analyzer parses and demultiplexes the opened MPEG stream, and displays
the packet header fields in two formats - interpreted and hexadecimal.

= If you want ES Analyzer to display the packet header fields in both the
formats, interpreted and hexadecimal, check the check box next to Hex
Window. (The hexadecimal format is displayed in a separate window.)

= If you want ES Analyzer to display the packet header fields only in the
interpreted format, let the default remain. (By default, the check box next
to Hex Window is clear.)

NOTE. If you do not enable the Hex Window when you open a stream, you
cannot enable it later when ES Analyzer is parsing the stream.

4. Click Open when you are through with this dialog box.
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Understanding the main window and icons

ES Analyzer allows you to view multiple programs and streams simultaneously.
The tree view area on the left side displays the stream hierarchy. For the currently
selected stream, the details of the header are shown on the right side. Errors, if
encountered, are logged in the error log window at the bottom. A summary of the
stream parameters is displayed in the Stream Property window. The status bar at
the bottom of the window displays the current status and stream characteristics.

' Tekironix MPEG-2 ES Analyser - [Sym2.trp]

) File Edit Yiew Window MNode Settings Help Menu Bar =18 x|
- - k3
[#|2 Gl E[" ] 8]% €06kl e A K55 | | oo
B g TPT ~ Transport Packet Head
< PROGRAM 1
g FROGRAM 2 FID 0 Packet Type [PeT  Tronspot Evorlndicator 3¢
&7 FrOGRAH 3 Transport Serambling Contiol [Not Goramble | *daRtatian Field Cntal Payload Uit Start 7
& Tree Vi iy Ganeyen 3 Adaptation Field " Payload o/ Transport Priority *®
= ree view
=& | Window - Adaptation Field
Ebg w=oruf, MPEG 2 udio
T s£s098) Adaptation Field 152 Splice Counidown A Rlandom Access Indicator %
- @2 PROGRAM 6 IFCIR B2 1A, PCR: Extension i ES Priority Indicator x
B @) PESIFID=10], MPEG 2 Video OPCR Base Ni: OPCR Estension NA Discontinuity Indicator »
- § X S
= @ VE:E[éZ;F] ~Transport Private Data Bytes Window displaying |
e s interpreted data
B {8 FES(FID=620), MPEG 2 Audio L—J
] sEs(32)
- Adaptation Field Extension
AF Extension Length Ni Splice Type: MNA LTW Difset Ni
DTS Mest Ha Fiecewiss Rale M LTW Vil Flag [
Stream Property [ Value |
« File Name 5 \Frojects\StieamshFormahl
+ FlleSize 58566 KB
~ Sueam Type Tiansport

* Video Tracks 1

= fudio| Stream Property

* Tuped "

. Type W'"° 47 40 00 33 BE 00 FF FE-FF FF FF FF FF FF FF FE-FF FF FF FF FF FF FF FF
F] F]

FF FF FF FF FF FF FF FF-FF FF

* User Dala Streams: 0 EF FF FF FE FF FF FF FE-FF FF F |\ puoo | FF-FF FE EF FE FF FE EF FF
* Totel Programs: & FF ¥F FF FF FF FF FF FF-FF FF « UISPIaY  yF_FF FF FF FF FF FF FF FF
 SenviceTyps: VB FF ¥F FF FF FF FF FF FF-FF FF window FF-FF FF FF FF FF FF FF FF
FF ¥F FF FF FF FF FF FF-FF FF Fi FF-FF FF FF FF FF FF FF FF
FF FF FF
1 Tl [ T [Len D:00] Offset
LOCATION | MESSAGE B

TPT->PESPID=410). MPEG 2 Audio->AES (195 Iritilizing AES streamn

( . ..
TPT->PESIPID=510). MPEG 2 Audio->AES(196)... Initidizing AES - -
TPT->PES[PID=620), MPEG 2 Audio>AES(192).... Intislizing 4ES| Error Log Display Window
TPT->PESIPID=H10). MPEG 2Video>VES(224)>  Initializing VES

( 0. )

TPT->PES[PID=610). MPEG 2%idea->WES(224)->  Thizis an MPEG-2 Yideo Elementary Stream -
4] | >
For Help_ press F1 [  [Psckeli47873  |PIDO packet#iO0 |Off 0+895400(8993336]

Tool bar  The Tool bar provides a means of accessing frequently used menu bar commands
quickly; each icon represents a menu bar item. Icons will display a tooltip
description when the cursor is rested over it. The tool bar illustration below does
not show all of the buttons.

= |2 Elfforan He 18| 2 @ | 0| o/l Q565

The table below lists the function of each icon and also indicates when the icon is
available. Availability refers to an icon being enabled or disabled with respect to
selected nodes in the left tree view window; disabled icons are ‘grayed out'.
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Table 4-1: Tool bar icons

You can toggle the tool bar display by selecting/deselecting the Toolbar command

on the View menu.

Availability
Icon Function (Enabled/Disabled) Menu bar equivalent
= Opens an MPEG stream, a saved Always enabled File > Open...
regression file (.REG file by default),
or dumped reports
~ Restarts analysis from the beginning Enabled for all nodes Node > Initialize
L

of the selected parent or child
stream

Extracts a PES, Audio, or Video
stream from a multiplexed stream

Enabled for all the
embedded stream
nodes (PES, VES, AES)

Node > Dump Stream

[oipaT) |

Allows navigation to the selected
TPT packets; used in conjunction
with the Next icon

Enabled for Transport
and Program

100 _,E

Enables navigation to the nth packet
at TPT node or the nth GOP at
GOP node or nth frame at AES
node. Used in conjunction with the
adjacent button

Always enabled;
disabled only for VES
node

Allows navigation to the
next/previous packet of the
selected node

Always enabled;
disabled only for VES
node, or at end of file

Next/ Previous Packet/
GOP

)

Toggles Start and Stop to run
through Test mode

Only enabled at GOP
level

Start Stop

Toggles between hexadecimal and

Always enabled

2 decimal display of data in fields
t Shows or hides the error log window  Always enabled -
k3 Shows or hides the Hex Viewer, Enabled if Hex Window -
=i which displays data in hexadecimal is checked when
opening a stream,
otherwise always
disabled
3 Enables or disables packet view Enabled only for PES -

analysis that displays the PID
spectrumal format

o

Allows zooming into any part of
data being displayed; useful when
viewing Motion Vector display in the
Slice And MB tab

Always enabled

4-6
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Availability
Icon Function (Enabled/Disabled) Menu bar equivalent
ﬁ (lefticon) Shows Frame Size Statistics for Enabled only for GOP Frame Sizes
different frames within a GOP node (Disabled if the
Picture Player tab is
selected)
—_— Shows Slice Size Statistics, i.e., Enabled only for a GOP Slice Sizes
ﬁ (ighticon) information about the sizes of the node from within the
slices within a Picture in a GOP Slice And MB tab
Allows viewing the version and Always enabled Help Topics

2

copyright information

Working with ES Analyzer
commands

When using ES Analyzer, you can issue commands in one of three ways:

m By clicking commands on the menu bar; this also includes the keyboard
shortcuts, which are shown next to the menu bar entries

B By clicking icons on the toolbar

m By clicking the right mouse button and selecting a command on the quick

menu

After you have invoked ES Analyzer, you need to select the bit stream file

you want to be analyzed by clicking Open on the File menu or by clicking the
appropriate icon on the toolbar. If the bit stream file is a valid MPEG file, ES
Analyzer displays the first packet of the top level stream. Now you can use
commands, described below, to navigate randomly to any part of the stream. You
can also run through a selected embedded stream using the Go command.

Tree view and navigation

=gk TPT

- &7 PROGRAM 1

- &2 PROGRAM 2

=) @f PROGRAM &
=] i PES(PID=610), MPEG 2 Video
B4 vES[224)
: P W Gop
= 8 PESIFID=620). MPEG 2 Audio

....... @ AES[192)

Figure 4-1: Icon function availability (enabled/disabled) Menu bar equivalent
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4-8

The tree view window displays the stream hierarchy of the currently opened
bit stream file. Each node in the tree view represents a level of hierarchy and
is displayed with:

B An associated icon (the icon varies depending on the type of stream that the
node represents; these are displayed in the following table).

B A tip that describes the kind of stream represented by the node.

m  The PID associated with the node, if applicable.

Table 4-2: Navigation icons

Icon Stream type representation
ﬁ Transport stream.
@ Program stream.

['jl r__:'-;_} System stream.
==

Packetized elementary stream (PES); PES containing a video

@ @ or audio stream, respectively.

A 5 Audio stream; an MPEG-1 and/or MPEG-2 audio stream.
il

TEXT Teletext.

Dn Dolby AC-3 audio stream.

g _’j'] E}: Video stream; an MPEG-1 and/or MPEG-2 video stream.

If Closed Caption data is detected during analysis, ‘CC' is added
to the video icon.

[:D User data stream.
" Group of pictures (GOP).
ilgli pofp (GOP)
buE DVB subtitle PES.

ET

Suffix 1 and 2 in the Tree View icons (Video and Audio Elementary Streams)
refer to MPEG-1 or MPEG-2. Note that MPEG-2 streams can contain MPEG-1
audio information.

NOTE. If packets are scrambled or if stream analysis (AAC Audio) has been
excluded by dongle, ES Analyzer does not display them.
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Navigating through ~ When an MPEG file is initially opened, ES Analyzer automatically determines the
streams  kind of MPEG stream it is. For a valid MPEG bit stream, ES Analyzer opens the

tree view with a node for the top level stream contained in the file. By default,
the stream hierarchy is expanded to only one level. You can expand/collapse a
node by clicking it. You can select the stream to be viewed at any level displayed
in the tree view window by simply clicking the left mouse button on the specific
node. Automatically, the window on the right is refreshed to display the header
and related information for the selected node.

ES Analyzer gives you full flexibility in viewing streams at any level. You can
navigate through the stream independently at each level of the stream. For
example, you may be viewing the first PES packet of a PES Stream, but in the
embedded VES stream, you may be viewing the last GOP that is not contained
in the first PES packet.

Using GoTo, Next and Previous commands. These commands are applicable to all
types of streams and assume that you have opened a valid MPEG file

Each of these commands can be executed for any node that is displayed in the
stream hierarchy tree where each node is either a GOP or a valid MPEG stream
(embedded or top level).

m  Step forward/backward to the Next/Previous packet or GOP in a video stream
for the selected node.

B Position the file pointer to the nth packet or GOP in a video stream or frame in
an audio stream for the selected video/audio node.

B Position the file pointer to the nth packet of the selected PID; this is applicable
to MPEG-1 system streams and MPEG-2 transport and program streams.

m  Position the file pointer to the first packet of the selected node.

B Save the embedded stream corresponding to the selected node in a separate
file.

m  Toggle between hexadecimal and decimal display.

B Use the Transport Stream PID drop-down list to select a PID and navigate to
the selected PID using the Next button.
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Header, extension and hex displays

Header display window

Extension displays

The header display window shows the current header and related information for
the selected node in a read-only mode. The fields are interpreted and displayed.
The header is not displayed syntactically. Wherever field codes represent specific
values, the corresponding value is shown rather than the code itself. For example,
in a video sequence, although Chroma format is a two-bit code, it is displayed
with the interpreted value of 4:2:0 or 4:2:2 or 4:4:4.

You can view field values in decimal or hexadecimal format by clicking the
appropriate icon on the toolbar. One bit fields are displayed using one of three
icons:

Table 4-3: Header icons

Icon Field value representation

v One-bit field was set to 1

%4 One-bit field was set to 0

@ One-bit field is not applicable here

Almost all MPEG headers allow stuffing bytes and have marker and unused bits
defined in their syntax. Although all these are parsed and checked for correctness,
they are not displayed since they do not provide any meaningful information.

Wherever appropriate, ES Analyzer provides visual feedback, by the use of color,
to represent different states.

Besides this generic structure, individual headers may have special displays.

For example, the video sequence header has a lot of information to be displayed
in a small area. This is achieved by using tabbed folders for all the MPEG-2
extensions (see the following illustration). The tab corresponding to an extension
is disabled if the corresponding extension does not appear in the sequence header.

When an extension appears in the video sequence, its presence is also
communicated by the changed color of text (in red) on the corresponding tab.

B OME |@CE | roe | 2rssE | Q@r7sE |BUp | macrE |

8 (16 (19 (22|26 |27 |29 |34
16 (16 |22 | 24 |27 |29 (34 | 37
19 (22 |26 | 27 |29 |34 | 34 | 38
22 (22 |26 | 27 |29 |34 | 37 | 40
22 |26 |27 (29|32 |35 | 40 | 48
26 (27 |29 |32 |35 |40 | 48 | 58
26 (27 |29 |34 |38 | 46 | 56 | 69
27 (29 |35 |36 | 46 | 56 | 69 | 83

Load Intra Quantizer Matrix

Load Non Intra Gluantizer M atris

Load Chroma Intra Quantizer Matrix

Q000

Load Chroma Mon Intra Quantizer M atrix
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Hex display window The hex display window shows a hexadecimal dump of header bytes contained in
the header being currently displayed in the header fields display window. This is
useful if you are used to viewing the headers in the hexadecimal format rather
than the interpreted format that is displayed in the header display window. Also
able to be displayed are sequence information at VES level and frame information
at GOP level (as shown below).

00 00 00 00 01 00 01 14-23 9B BG 00 00 00 OO0 00-01 BS 85 55 57 9C 00 00 EI
oo OO0 00 00 OO 00 0O 0O0-00 OO OO OO OO OO OO 0OO—-0O0 OO OO OO OO OO OO OO
00 00 00 00 D01 01 7A 14-36 24 24 22 CO 34 &1 43-E2 E0 C8 00 30 32 80 0C
75 39 CC E1 2B 00 DE C7-94& 47 27 84 A7 10 79 BA-69 60 40 08 1D 6E C2 40
3D EB AE 20 8B EB 3C F1-33 44 0A 71 87 1C 9F 43-88 C1 8C 80 3E 86 C7 BA ll

[ BN | Gyl | Offset 0:0i0) Len O=0{0)

! !

Go to field Find field

The data collection for the hex display window can sometimes be memory
intensive and can affect ES Analyzer's performance. You can turn on the hex
display or turn it off according to your requirements by checking or clearing the
check box next to Hex Window in the Open dialog box. If you have not enabled
the Hex Window option when opening a stream, you will be unable to open it
when ES Analyzer is parsing the stream. However, you can dynamically turn off

the Hex Window, whenever you want, by clicking the Show/Hide Hex Viewer
$

icon on the toolbar if you enabled it when you opened the stream (see details
in the Opening an MPEG Stream section).

The hex window displays a hyphen (-) after every eight bytes for display purposes.
The status bar in the hex window displays the current cursor position's byte offset
from the start of the header. If you select a sequence of bytes in the hex window,
the size and the byte offset from the start of the selection appears in the status bar
when you release the mouse button.

00 00 01 E0O 00 oODEEiemeiCIFEcip il BE5 DD 1F E0-01 7D 9D

[Oifset 0:5(5) [Len OxE[E]

To search for a specific byte pattern in the Hex Window:

1. Type the pattern in the Find field, on the left of the Find button, on the status
bar.

2. Click the Find button.

The specific pattern will be searched from the current cursor position. If the
pattern is found, it is highlighted in the hex window. If the pattern is not found,
you will hear a beep. The search loops back to the beginning of the file and
subsequent occurrences of a pattern can be found by clicking the Find button.
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To position the cursor to a specific byte location from the start of the packet header:

1. Type the byte position in the Goto field, on the left of the Goto button, on
the status bar.

2. Click the Goto button.

The cursor will be positioned to the corresponding byte location in the header in
the hex display window.

Summary of displayed information (Header and Hex displays). The following
table summarizes the information displayed in the hex window that corresponds
to the information displayed in the header display window.

Table 4-4: Hex Headers display

Header display window

information Hex dump in the hex display window
Transport packet header. Header data of the current packet.

PES Header. Header data of the current packet.
MPEG-2 Program stream - Pack Header data of the current packet.
Header.

MPEG-1 System Stream - Pack Header data of the current packet.
Header.

Video stream - Sequence header / All the video level information which is above the GOP level.
sequence extension.

Video stream - When viewing All the information for the currently selected picture. When the first picture is selected in the
picture at Picture or Slice level picture slider, data corresponding to the GOP header (if available) along with first picture data
display (with video analysis setting appears. For all pictures other than the first picture in the GOP, only picture data is shown. The
set to Macroblock level). subsequently read sequence header and extension data is updated in VES node.

Video stream - Hex data display Same as above.

when viewing picture at Slice level
display (with video analysis setting
set to Picture level).

Video stream - Hex data display Same as above, but with the following exception.

when viewing picture in Picture Picture data includes only picture header and extension data. No slice or macroblock level data
display form (with video analysis is shown. However, when you go down to the slice level display by clicking the Slices button,
setting set to Picture level). ES Analyzer appends slice and macroblock data in the current picture data for the hex viewer.

When you return to the Picture display dialog, ES Analyzer continues to show the complete
picture data. The pictures for which you do not step down to the slice level, you'll still be shown
picture data that includes only the picture header and extension data.

Audio Stream Both frame header and audio data is shown.
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ES Analyzer - Error testing methods and outputs

ES Analyzer can error check an entire stream in an automated manner (regression
test). Part of a stream, triggered from a node for a specific program, can be
manually checked (run though mode).

Regardless of the stream type, testing is only possible at the compression layer;
it is the task of Tektronix TS Analyzer and PES Analyzer to test at the systems
layer. However, you can still view the headers of the transport and PES packets,
but note that no tests are performed (either run-through or regression).

Both test modes will produce screen or file output error messages. Manual test
is also possible by examining the various block/slice/vector and picture display
menu screens.

Error filters can be applied to the tests, and fields selected to allow diagnostics up
to the error point to be dumped in a file for “pre error point' analysis.

Run Through Stream test mode

This is operated by highlighting the test node - usually the GOP filmstrip icon - of
the appropriate program, then clicking on the Start/Stop (green ball) in the top
toolbar.

The stream will be run though and errors reported in the error display window.

Error display window  The error display window displays information, warning and error messages
generated by the run-through test mode for a specific program node.

LOCATION | MES SAGE

TPT-»[PSl)-» Packettf 142300: Programit 9001: Beading PMT ...

TFT-»[PSl)-» Packetif 15500; Programit 9003 Reading PMT ...

TPT-»[PSl)-> Packeti 15500 Enorin PMT: coded ES_info_lenath excesds remaining valid lenath of the packet
S TPT->[PSl}-» Final CRC value = 3814643333, (should be O

TPT-»[PSl)-» Packetit 16425: Pragramit 9005 Reading PMT ...

TFT-»[PSl)-» Packetif 16485 Enorin PMT: coded ES_info_lenagth exceeds remaining valid lenagth of the packet
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Error filtering

Configuring and filtering
messages for display

For each message, the following are shown:

B An associated icon that indicates the kind of message (the icons E, I, and S
shown below indicate a syntactic error, information, and a semantic error,
respectively):

®@0s

where:

E = protocol syntax (Rules) error.

S = semantic-parameter or data range error.

I = Information only; not an error. Both E and S should be regarded as errors.

B A string that identifies the exact location in the bit stream where the error was
encountered; the format of the string is:

(STREAMTYPE) -> (STREAMTYPE, STREAMID) -> (NODE) (packetNumber)

For example, the following string identifies an error in packet number 2 of the
MPEG 1 audio stream on PID 210:

TPT->PES(PID=210), MPEG 1 Audio->AES0(2)
m  The message string associated with the message.

Double-clicking a message in the error display window lets you view more
detailed information about the message.

You can configure and filter the kinds of messages you want ES Analyzer to
report. You can turn on/off messages of any type (Information, Errors, Semantic
checks) to be reported for the entire stream, or any node in the stream hierarchy
displayed in the tree view. You can also store the displayed messages in a file
or clear the message window.

To configure messages:

1. Click the right mouse button anywhere in the error display window.

LOCATION
TPT(PacketS7043)--

5 TPT[Packett Ciurnp To File
TPT->PESIFI Elear Log windaw i Privat
TPT[Packett g

Filter Messages...
5 TPT[Facket

TPT->PES[FID=32], PES Packetz containing Privat

2. Select Filter Messages from the context menu that appears:
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The Filter Message dialog is displayed. The dialog box contains two tabbed
pages: Global and Node.

Message filtering - global. The Global Message Filter tab provides settings that
can be used to select which messages are enabled and disabled and how many
times enabled messages are to be displayed

The rules created are global; that is, they will be applied to all nodes in the active
stream. Rules to be applied to a single node (such as PSI, PES, VES) can be
added from the Node tab.

x|
| NoDE |

—Message Categony I.All 'I
& Disable Messagels) of IA|| 'I type

™~ Disable Message Mumber(s)

" Report Message Number(s) maimum of I :l, times
| g Aled Rule I | n Save Rules...l | Dq' Load Rules...l
—Rules

P RemeyERLE I
P REmuvE L] |

Cloze |

The top half of the Global tab contains:

m A drop-down list from which the category of messages can be selected to
which rules are to be applied, and

B Three options for the display of messages.

As rules are created using these fields, they should be added to the Rules text field
below by selecting the Add Rule button.
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The three options are as follows:

Disable all messages on the basis of severity, that is, Info (I), Semantic (S)
or Error (E). Enable the Disable Messages(s) of checkbox, select the type of
message to be disabled and press the Add Rule button. Note that the rule is
added in the Rules text field.

Filter Mezzage

GLOBAL | NODE |

Mesrage Categary IAII hd Ii

* Disable Mezzage]s] of &l v | fpe
Al
" Disable Meszage Humberiz) |1nfo

(5 Emartic

Errar

Rules

[izable 4l Semantic Type Mezzages

B Disable messages on the basis of message number. Each message is assigned

a unique number based on the type of streams it is related to; a tooltip will
be displayed when the cursor is passed over the message number. Enable the
Disable message Number(s) checkbox, select the message numbers to be
disabled and press the Add Rule button. The Shift and Control keys can be
used to make multiple selections. Note that the rule is added in the Rules
text field.
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Filter Meszage

GLOBAL | NODE |

—Mezzage Categomy I,.ﬁ_|| vl
" Disable Messagsls] of I vl tppe

¥ Dizable Message Mumber(s]

" Beport Message Numbers) I—{ Infoll] :Get_macroblock_twpe(l: unreco

Rule:

Diizable b eszage - #1001
Diizable Meszage : #1003

m  Report repeated messages only a specified number of times. Enable the
Report Message Number(s) checkbox and select the message numbers to be
disabled. The Shift and Control keys can be used to make multiple selections.
Select the maximum number of times that the message is to be reported and
press the Add Rule button. Note that the rule is added in the Rules text field.

L |

&+ Feport Message Humbers)

mazxirnurn of I-m YI tirmes

Rule
|V Fieport Msg #1000 kax. of 10 Times

Fieport Msg #1003 Max. of #$10 Times

Combinations of message rules can be created; they will need to be created and
added one at a time.

Rules can be removed individually (Remove Rule button) or globally (Remove
All button). Rules that are already set cannot be edited; they must be removed
and recreated.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual 4-17



ES Analyzer — Error testing methods and outputs

Rule sets can be saved and reloaded as required using the Save Rules... and Load
Rules... buttons. Message Filtering - Node.

1. Select a stream in the left scroll window and then select the types of messages
you want to be filtered out. By default, all messages are displayed for a stream.

Filter Meszage

GLOBAL

NODE |

Pleaze Select a Stream

Please Select Meszages o Filter Ouk

1]

- PESIPID-230), MPELA]

(@R PES[PID=88), MPEG

- PES[FID=E9], MPEG
(8 PES[PID=90], MPEG
- PESIPID=305], MPEI

(224]

o

FES[FID =308, MFEI
PES(FID=96), MPEG
PESIPID=97). MPEG
) PES[PID =98], MPEG
PES[PID=150], MPE!
=& vEs(229)
LAl GOP

| »

Al Messages

l:le Suntactic Errors
o General Informat

- l:l S Semantic Enors

]|

CLOSE |

If you want your message filter(s) to be applicable to all streams opened
until now, select it for the entire World. This option will apply the filter(s)
to all nodes displayed in the tree view window.

If you want your message filter to be applicable to all streams, irrespective
of whether they are opened or not, click the Set for all Streams button.

2. Click OK to accept to changes; Cancel to close the dialog box without
applying the changes.
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To store the displayed 1. Click the right mouse button anywhere in the error display window.

messages:

2. Select Dump To File from the menu that appears.

LOCATION

TRT[Packet#37048)->
S TPT[Packett Durp Ta File
TPT->PES(P! Clear Log Window ing Privat

TPT(Packett Eilter Messages...
5 TPT(Packettroeeror

TPT->PES[PID=32). PES Packets containing Privat

3. The Dump Message dialog box is displayed. Enter the name of the file in

which you want to store the messages.

b

Click the Save button when done.

To clear the windows 1. Click the right mouse button anywhere in the error display window.

i

Select Clear Log Window from the menu that appears.

LOCATION

TPT[Packet#37048]>

S TPT[Packett Curmp Ta File
TPT-=PES[PI
TPT[Packetk Filter Messages...

S TPT[Packettreeere
TPT->PES[PID=32]. PES Packets containing Privat

ing Privat

Clear Lag “Window
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Status bar

4-20

During regression and run-through mode, progress through the stream is indicated
by the status bar at the bottom of the main window. The status bar is split into
multiple fields and displays the following:

m A progress bar indicates the approximate byte position in the file for the
currently selected stream.

NOTE. Since you can view each embedded stream inside a multiplexed stream
independently, it is possible that in each embedded stream you may be viewing
packets which are far apart in the stream. In such cases, the file pointer will be at
different positions for each embedded stream and the file progress bar is updated
according to the stream being currently viewed. The byte offset in the file for the
currently displayed unit of data is also displayed in the status bar. For example,
when you are viewing a Packetized Elementary Stream (PES), the byte offset of
the first byte of the start-code of the currently viewed packet in the opened file is
displayed in the status bar. Similarly, when viewing a GOP in a Video stream
that is embedded in a Transport stream, the byte offset of the start code of the
corresponding GOP in the file is displayed in the status bar. More details are
given with the explanation of status bar with each individual stream.

B Characteristics of the stream being currently viewed. These vary with the
stream and are described in detail for each stream in subsequent chapters
in this book.

m  The state of the status bar display can be toggled by selecting/deselecting the
Status Bar command on the View menu; that is, View > Status Bar.
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Regression testing and error log files

With ES Analyzer, you can regression test MPEG streams (with errors being
saved to log files) and save data from selected fields to report files for viewing
later (see the section Reviewing a Report for details).

Regression test window  To perform a regression test, close the file, if it is open, using the File menu.
Select File > New Regression Script.... Note that disk drive icons are displayed
on the right side of the directory window; you may need to scroll right to
view/access them.

i Tektronix MPEG -2 ES Analyser - [Mask3] =l |
= File Edit Wiew window Help _ Iﬁ'lﬂ
h Message
qotream Settingz

Uptions

|Cunenl Directory: 5:%ProjectstSheamsz\Candidate‘mpeg]_ streams

B [ 100arads.m1s [ g duck.mpg [ gpromomplmpg (] mediaplaper_mpeq]
= LR =t =D =GN =k
=35

Streams Selected for Regression

Wiew Eeparts | | Start Hegras sian I Help |

Double-click on the file you require and it should appear in the lower window
Streams Selected for Regression with an orange question mark to the left of the
file name.

When regression is done, this will turn to a red or green ball, depending on the
errors found. A default log file name is entered; it can be renamed by clicking on
the double-arrow button to the right of the name. After regression testing, the log
file can be viewed by double-clicking on the log file name.

Error messages written to the log file can be controlled via the Message Settings
screen.

The button View Reports is only available to show dump/.dat files if they have
been set up beforehand (see Select Fields and Reviewing a Report sections).
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Setting up the regression You can select multiple streams for regression from the displayed list of files. (To
select multiple files, double-click a file or select it and then drag-and-drop it in the
lower window.) The streams selected for regression appear in the lower window.

Streams Selected for Rearession | Diefault Dir: C:Nw INDOYW'SSTEMP [Change ...) |
% k:\projects\Steams\Candidate'Mischdfl_cut mpg C:AuIND OWSATEMPSIA _cut_mpag.log
% k:hprojeotshStisamshCandidatesMischmntest_orig.mpa C:AwIND OWSATEMPSmintest_onig_mpa.log

For each stream, the following are displayed:
®  File name.

®  Default log file where the messages for the stream will go. You can change
this by clicking the icon displayed next to the log file name. ES Analyzer
displays a default directory where all log files are created that store the
results of the regression. You can change the directory for storing log files
by clicking the Default Dir... button.

B The stream type. Initially this is not known and is set to Unknown. Once
the regression is complete, this is updated to reflect the type of stream that
the file contains.

B An icon indicating the state of the stream. Initially, when a file is selected,
the icon appears as a question mark indicating an unknown status. After the
stream is regression tested, the icon changes to red if the regression reported
errors, or changes to green if there were no errors.

Regreszion Bunning. __ !EIE

Fie Name | File Size | File Type |
@ C-\mpegstreamsimlvhbombs_ 000, 14316364 [ideo Elementamy Stre...

| Heagression Cnmplete@i tinimize: ESAnalyser

For a regression test, you can also select embedded streams that correspond to
nodes in the tree view for a stream hierarchy. You can do this by clicking the
Streams Option button in the regression test window; see Reviewing a Report
below. This displays the settings for the current stream. By default, the tests
are enabled for all types of streams, which you can disable. Saving a regression
script also saves these settings.

4-22 MTS4000 and MTS4SAV3 Analyzer Applications User Manual



Running the regression

Viewing and saving results

Message settings

ES Analyzer — Error testing methods and outputs

Once you have set up a regression script, you can run it by clicking the Start
Regression button. A status window displays the continuous status of the
regression. If you want, you can cancel the regression anytime by clicking the
Cancel Regression button in the status window. When the regression is complete,
the state of the regression run on each stream is displayed in a dialog box through
the changed icon which is red (for failure) or green (for success), and the updated
file type. The icon remains a question mark if the file was not a valid MPEG file.

You can view the error log file created for any stream after it has been regression
tested by double-clicking the specific bit stream file in the regression test dialog
box. You will need to associate files of the type *.log with a text editor of your
choice. You may do so through the Explorer. Click View > Options to display the
Options dialog, and then click the File Types tab. By default, ES Analyzer opens
the log files with the application with which they are currently associated.

You can save the regression script and the results in a regression script. To save
the file, choose Save As from the File menu. The file is saved as a binary file and
also saves the regression results. You can reload the regression file including the
results of the last regression whenever you want. Regression can also be run on a
previously saved regression script file.

Messages sent to the log file can be controlled through the Message Settings
dialog box. Rules to be applied to messages can be created as required. The
operation of this dialog box is similar to Message Filtering. For more information
(See page 4-14, Error filtering.)

Reports and field selection

Creating a report

You can save and review reports consisting of field value dumps of specific fields
when you regression test a stream. To review a report, it must first be created by
selecting the fields to be viewed, then setting up and running the regression, and
finally selecting the View Reports button (it is also possible to select and open
multiple reports).

A regression report is packet-by-packet details listed with information fields you
can choose. A report is not an error list, although errors detected may appear in it.
A report can be used to examine run-ups to problems (pre-trigger).

Before starting a regression test, select the Stream Options button in the
Regression test window. Ensure that the Dump Fields check-box is enabled and
select the adjacent Select button. You can then add the fields to be listed in the
dump file columns (individual fields or all fields).

You can check the dump in file box and name your dat file or use the default
VES.dat or AES.dat.
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Do this for video & audio elementary streams.

To select fields.

1. Click the Stream Options button in the regression test window to display
the following screen.

i Mask2 |
— Streams to be Analyzed
Analyze Dump Fields Dump in File
Q idea Elementary Streams IMacrohIock Level vl v ¥ Select.. | IC:\TEMP'\VES.dat _I
@ Audio Elementary Sheams ¥ [ isEEEt ID\TE'\"”:"\"'B'ES":‘at J
— Durnp Olption
& Complete Stream " Part of Sheam b vty e [T IU
™ Hexadecimal Dump " Decimal Dump

2. Enable and disable the streams using the checkboxes in the Analyze column.

Deselect the streams you don't want ES Analyzer to analyze. By default,
all the streams are selected.

3. If you want to analyze Video Elementary Streams, you may either select
Macroblock Level or Picture Level from the adjacent drop-down list.

4. Select the streams for which you want to dump data by enabling the checkbox
under the Dump Fields column.

5. Click the highlighted Select button to display the Select Fields dialog box.

Select Fields

Figlds Excluded: Figlds Included:

=]|
Laner Copynght
Mode Extension Dk |

Sampling Freguency J
Bitrate Emphasis
tode

5B Limit Sdd All
Pratection Bit
Padding Bit
Frivate Bit
Original or Copy
CRLC Check
Bound

Cancel

{Delete

i

Delete &l
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6. Finalize the list of names by adding/deleting the field names in the Fields
Included list box and click OK.

= Ifyou have selected a video elementary stream, ES Analyzer also displays
options in the Select Fields dialog box.

— Dptiohz
—%ES —GOP
Add Al Delete All Aadd Al Delete All
— Dizplay Extension——— — Picture
Add Al Delete Al Add Al Delete Al

— Scalable Extension E =tension
Add All Delete Al |7 Add All [Delete All

You may click the appropriate buttons to select fields specific to these options.
This is a quick way to add/delete specific fields into the Fields Included list
box; otherwise, you will need to manually find and add fields from the Fields
Excluded list box.

For example, if you have added all the fields from the Fields Excluded list
box, and now want to delete VES-related fields from the Fields Included list
box, you may click the Delete All button in the VES section. You can also
click the Add All button under Display Extension to add related fields to
the Fields Included list box.

You may also double-click a field name displayed in the left list box to include
it in the right list box.

7. Specify the file into which you want the fields to be dumped.

You may type the filename (*.dat) or select one by using the browse button
next to the default filename.

8. Specify the dump options.

Durip Optiohs
+ Complete Stream " Park of Stream el rir Siee B¢ ID
" Hewadecimal Dumnp & Decimal Dumnp [’\X&

If you select Part of Stream, the Maximum Size (MB) field is enabled and you'll
need to specify the size of the stream from which the fields will be dumped.

Once you have specified the fields, return to the regression test window by
clicking the button next to the Stream Options button.
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Reviewing a report

A sample report looks like this:

Collecting Statistics for "C:\mpegstreams\mls\bird4.mpg"

Date 04/02/98 Time: 16:38:42

PacketNo.  SCR Fixed Flag Audio Bound
0 1 1
1083 1 1
1083 1 1
3250 1 1
4334 1 1
5417 1 1
6501 1 1
7585 1 1
8668 1 1
9752 1 1

© 00 N O O B W NN -

—_
o

NOTE. The “dump files have the default extension of . dat.

Demultiplexing transport streams to PES or elementary output files

4-26

It is possible to select a given stream node in navigation view (such as PES
video/audio) or VES audio/video (but NOT gop). The diskette icon will highlight
on top toolbar at the left when the function is available. Select the icon, name the
dump file and select it's type if required. ES Analyzer will then create a PES

or elementary stream.

This stream can be loaded back into the ES Analyzer to be checked, and then it
can be used as input to Tektronix Multiplexer application to create a transport
stream with SI/PSI to your specifications.
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ES Analyzer — Working with transport and PES streams

Using Packet view

ES Analyzer displays transport packets in a specific way that is useful for
analyzing the Transport stream and also for quickly accessing a packet at random.

== T5020804_cut. mpg - packetview =] I

— PID Number

| carpiDsy  [E0EAT

For Help. pres: F1 |PID 2191 |PACKETH 128 A

The packet view window can be displayed by clicking the Show/Hide Packet [l
view icon on the toolbar. A window appears that shows a spectrum of the packets
in the order in which they appear in the transport stream. Each PID is assigned

a color and each packet is represented using a single line of the corresponding
color. By double-clicking the spectral line for any packet, you are positioned to
the corresponding packet in the main window of ES Analyzer.

Packet view communicates with ES Analyzer's main window through OLE. You
can selectively turn on/off the display of spectral lines for any PID in the Packet
view by clicking the corresponding color index in the Packet View dialog. The
color index is also a toggle for display. You can also view distance graph between
packets of the same PID by just viewing spectral lines of the corresponding PID.
To switch back to displaying all PIDs, double-click the All index (represented by
white color).

NOTE. When you first open Packet view, it displays just the front page of the
stream, so that not all of the PID numbers present in the stream are displayed in
the button boxes below the main display. If you want to see them all, drag the
horizontal scroll bar pointer to the far right, all of the PID number buttons will
then be displayed (this could take a few seconds for large stream files).

Packet view does not operate when a program node is highlighted; it works in all
other nodes in navigation view.
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Understanding PES

Explaining the Status bar

A Packetized Elementary Stream (PES) as the name suggests is composed of

contiguous packets of an elementary stream with packet headers, as shown
in the following illustration, prepended to the packet. A PES occurs only in

MPEG-2 streams and its structure has been adapted from the packet structure of

the MPEG-1 System stream.

For more information on PES streams, refer to the ISO/IEC 13818-1 document.

—PES Header
Steam D 224 Facket Number |1 FES Extersion > > |
Stream Type IViden skream Pracket Length ID
— Optional Field:
PES Pricrity Ve Header Data Length |5 Previcuz PES Packet CRC |NA
Copyright v 4 . ESCR Base INA
Additional Copy Info INA
Original or Copy \/ ESCR E stension INA
FES Scrambling Caortrol INUt sorambled . I
[ata Alignment Indicator Ve ES Rate [bits/s] NA
PTS_DTS Flags v X s [37220887 DTS [Na.
DSM Trick Mods Field
Trick Mode Contral INA Field |d INA
Intra Slice R efresh Q
Frequency Truncetion IN-“- Field Fiep Cortral IN-“-

An embedded stream is checked when you navigate through one. For more

information, refer to Navigating through Streams. (See page 4-9, Navigating

through streams.)

For PES streams, you can:

®  Run through the stream. (See page 4-9, Navigating through streams.)

B View packet headers with their decoded fields.

®  View an embedded elementary stream.

®  View PES extension (if received).

display

ForHelp, press F

4-28

——

B Packet number, which is the number of the current packet in the PES stream.

B Byte offset in the file, which is the first byte of the Pack header being currently

The status bar, for PES streams, displays the following:

|Packet# 1

viewed in both the hexadecimal and decimal formats.
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ES Analyzer — Working with video streams

ES Analyzer performs detailed checks on MPEG Video streams. Video streams
are complex with an embedded hierarchy. Structurally, a Video stream consists
of a video sequence that has a start code, end code, sequence header, and any
number of group of pictures (GOP). Each GOP consists of a GOP header and a
group of pictures. Pictures may be of different types (I, B, or P). Pictures can
also be frame pictures that correspond to progressive video or field pictures that
correspond to interlaced video. Pictures are broken down into a slice structure
and each slice consists of macroblocks.

For more details, you may want to refer to the documents ISO/IEC 11171-2 and
ISO/IEC 13818-2 that describe the MPEG-1 and MPEG-2 video standards.

Using ES Analyzer, you can:
®m  View the sequence header along with the extensions.
B Navigate through a stream. (See page 4-9, Navigating through streams.)

B Run through a stream with the option of analyzing the stream at the picture
level or at the macroblock level.

When analyzing a group of picture, you can:
®  Randomly access any picture within the group.
B View the picture type spectrum and picture size plots.

B Zoom into any picture and see its details at the slice or macroblock levels, or
view the encoded picture. You may also use the video or picture player to play
the entire video and pause at any picture when you notice a degradation in
quality; you can then review the details of this picture down to the macroblock
level. ES Analyzer provides an easy mechanism to switch between the Picture
display and the data analysis display windows.

B Select any macroblock and examine its detailed coding.

B Perform picture quality analysis with special displays of quantizer scale
distribution, slice size distribution, macroblock-size spectrum and motion
vector plots.

m  Interpret any video descriptors received in the higher level streams and
validate them against the stream.

When analysis with the DCT option is enabled, you can:
= View 8x8 coefficients for all macroblocks within a picture.

B View coefficient tables for y, cr, cb, luma and chroma pixel data.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual 4-29



ES Analyzer — Working with video streams

Viewing the sequence header

The sequence header is interpreted and displayed as shown below.

— Sequence Header

Harizontal Size |192U Frame Rate |2EI.9?D Fiz Constrained Parann: x
Wertical Size I‘I g0 Bitrate |1 2000000 | Bitsds Load Intra Quantiser M atrix v
Aispect Ratio |9:1 E WEY Bulfer Size |1 227656 Eytes e et Eueriiees [ st v

~ Sequence Extension

Level IHigh Prafile IMain Chroma Format |4:2:|j
b 4

Liow Drelay x Eszape Bit x

Frogressive Sequence

— Sequence Display Extension

Dizplay Size

Calor Description e Yideo Format  |Unspecified Vi ’7 Horizortal [Nz Wertical N2

Color Description

Lolor Primaries [N,

Tranafer Characteristics [N&

I atrix Coefficients M
UserData

Ha

=
-]

NOTE. Placing the cursor over either Load Intro Quantizer Matrix or Load
Non-Intra Quantiser Matrix, displays the applicable quantizer matrix. The check
mark icon indicates that the matrix was received in this sequence header.

For MPEG-2 streams, an optional sequence extension and user data may also be
received. User data is displayed as a hex dump. If data is in the ASCII format, the
ASCII equivalent is displayed next to the hex dump.

For Help, press F1 mmm  |?500fps [g:2:0 [ [ [ [

The picture rate, chroma format, and the video type (NTSC/PAL/Unspecified,
etc.) appear in the status bar when the sequence headers are displayed.

The information whether the stream is an MPEG-1 or an MPEG-2 stream is
displayed in the tree view window as a single numeral (1 or 2) on the node icons.

Within a sequence, you can view the GOPs by clicking on the GOP icon in the left
side hierarchy view of the stream. The GOP node appears below the sequence
header node.
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Viewing the GOP and picture header

When displaying a GOP, ES Analyzer shows you a window with three tabs, as
shown below.

CEOTTRGTHENYTTT Slice And MB Picture Player

Briefly, the contents of each tab are explained below. For details, see the specific
sections: Displaying the GOP Header, Displaying the Slice and Macroblock, and
Using the Video Viewer for Picture Analysis.

The GOP tab displays the following:

GOP header data.

A slider for the pictures in the GOP. The slider can be used to randomly access
any picture within the GOP; the slider moves in steps of two to facilitate
working with large GOPs. The slider lists the pictures in the received
(decoding) order.

GOP position transport controls lie to the left of the slider bar

B A

Using these controls, any picture can be selected within the GOP. The controls
include Start and End GOP controls and Next and Previous I frame jump controls.
Note that the I frame controls only works in streams where multiple I frames are
present between GOP sequence headers.

Picture header display for the picture selected in the slider.
Picture extensions (applicable only to MPEG-2).
The Slice and MB tab:

Takes you inside a specific picture and provides detailed information down to
the macroblock level.

Allows you to generate picture quality plots.

Allows you to view a picture frame by frame and view macroblock level data
for a selected macroblock in the picture.
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Displaying the GOP header

4-32

The Picture Player tab allows you to play and view the video output on your
screen.

NOTE. ES Analyzer synchronizes the picture being currently displayed by the
video viewer with the picture/data that is displayed on the other tabs: GOP

And Picture and Slice And MB. For example, if you select a macroblock and
switch from the picture display to the other picture-quality analysis tabs, the same
macroblock remains selected for easy identification.

As an aid to locating a stream, you can click on any open GOP icon in the tree
view to switch picture displays in the stream multiplex.

The GOP header is an optional header and it is displayed, as shown below, when
received.

|

R

=]
=]
=]
o

R

Frame Pict

& NE N NE|

=| =
ii

The lower part of the display also shows the picture extensions that have been
received.

[ uartizer M atrix Exkengion
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Video analysis settings. Analysis of GOPs can be carried out at picture level or
macroblock level

This will affect the speed at which the ‘next GOP' is analyzed. The setting is
selected from the Video Analysis Settings dialog.

Select Menu Bar > Settings > Video Analysis. The following dialog is displayed:

Video Analysiz Settings E |

Picture level analpsiz =

Macroblock level analysis eyl |
tacroblock Shadding Scheme
Baszed on Macroblock Size [

Based on Prediction Type [

Picture level analysis provides faster analysis but error reporting at the macroblock
level is suspended. Macroblock level analysis provides error reporting but at the
cost of analysis speed.

Status bar (in GOP mode). When ES Analyzer displays the GOP and picture
headers, the status bar, as shown below, displays the:

®  Picture rate

®  Chroma format

m  Video Type (NTSC/PAL/Unspecified etc.)

B GOP number of the current GOP

B Picture number of the currently selected picture, relative to the current GOP
(the first picture is given the offset 0.)

B Picture display number, which gives the picture number in display order,
relative to the first GOP received. This represents the actual picture display
number. It is calculated by adding the temporal reference of the current
picture to the cumulative picture display number prior to the GOP.

Displaying the picture ~ The GOP header tab has a slider for selecting the picture whose details you want
header to display. The header for the selected picture is displayed below the GOP header
in the same dialog box as shown in the earlier illustration.
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Displaying the picture  For MPEG-2, several picture extensions may be received. The picture coding
extension  extension is always displayed, while the other picture extensions are displayed
on tabbed folders, as shown below. The tabs for each of these extensions are
enabled and the text on the tab appears in red, only if the corresponding extension
is received in the stream.

BOME |@ce  |@lroe | iPPssE |QPTSE |BUD | wicPE |
Load Intra Quantizer Matriz 0 E LR e e
Load Nan | izt Matii ) 16 (16 |22 |24 | 27 |29 | 34 | 37
oad Non Intra Guantizer Matris 19 |22 | 26 | 27 | 29 | 34 | 34 | 38
Load Chroma Intra Quantizer b atrix 0 22 (22|26 |27 |29 (34|37 | 40
Load Chrama Mon Intra Quantizer M atriz 0 22 |26 |27 | 29 | 32 | 35 | 40 | 48

26 (27 |29 |32 | 35| 40 | 48 | 58
26 (27 |29 |34 |38 | 46 | 56 | B9
27 (29 |35 |36 | 46 | 56 | 69 | 83

All tabs with red text represent extensions that have been received for the current
picture. The next section describes each extension and its interpretation.

NOTE. These tabs will only operate if the appropriate extensions are present
within the stream under test.

All four matrices will only display if they are downloaded with certain stream

types for example, HDTV streams. - indicates that only the default matrix
will be displayed.
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Explaining the picture extensions.

QME (Quantizer Matrix
Extension)

This allows the quantizer matrices to be downloaded for any
picture.

At most four matrices can be downloaded, namely,
intra-quantizer matrix; non-intra-quantizer matrix, chroma
intra-quantizer matrix, and chroma non-intra-quantizer matrix.

The QME tab displays through a check mark the matrices that

were downloaded. A downloaded matrix is displayed when you
move the mouse over the name of the specific matrix.

CE (Copyright Extension)

This indicates any copyrights on the video. The copyright field
is interpreted and displayed.

PDE (Picture Display
Extension)

This extension gives display extensions for MPEG-2 video.

PSSE (Picture Spatial
Scalable Extension)

This is received when the spatial scalability of MPEG-2 video is
used in the video stream.

PTSE (Picture Temporal
Scalable Extension)

This extension is received when the temporal scalability of
MPEG-2 video is used in the video stream.

UD (User Data)

This displays any user data associated with the picture in
hexadecimal format. If the data represents ASCII text, the ASCII
text is also interpreted and displayed.

CPE (Camera Picture
Extension)
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Displaying the slice and macroblock

ES Analyzer allows you to take a microscopic view of a picture by letting you
view the picture's slice and macroblock structure.

To view slice details of any 1. Select the picture by using the picture slider on the GOP And Picture tab.

PICtUre: 5 Click the Slice and MB tab.

The macroblocks for the selected picture are displayed as shown below:

GOP And Piciure e Aud M | Picture Player I
¥ FRAME Rz
ISIice Dizplay  MB Size Display | O-Scale Code Dlspla}ll Mollon\u’ectorD\sp\a}lI Picture Display

iy Toolip |

Macroblock Mumber : 2
ME Intra
DCT Type
ME Quantizer Scale
CEP

ME Size

—Wectors——

EEEEEEE

— Slice:

Priority Breakpaint IF Quantizer 5 cale IS_ Slice Extension Flag @ Intra Slice @ Picture |0 |Ma Fiow Mumber |1_
[ Macroblock.

tacrablock Intra “ Macroblock Quant x Frediction Type e | ST Code Flag x

Macroblock Pattern x Quantizer Scale IS— Iaotion Yectar Format e | ST Class IU_

tacrablock Mation Backward x DCT Type [Frame | Motion Vector Count NA— STw Code lW

Macroblock Mation Fonaard X Macroblock Size T Dkl @ Macroblock Address |2_ CBP IW

The Slice dialog box graphically displays the slices and macroblocks in the
picture and also displays the:

m  Slice header for the selected slice.
®  Macroblock details for the selected macroblock.
B Picture Quality data, which overlaps the slice display area.

B Decoded field/frame for the selected picture.
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Explaining the slice and ~ When displaying the slices, the current picture is represented by its constituent
macroblock display slices; see the above illustration. You can move the mouse to any slice and select
it using the left mouse-button. The slice header display shows the header for the
currently selected slice. MPEG-1 slices can span multiple rows and the display
shows the same.

Slice display is color coded. Intra-slices are shown in green color, while slices
that do not have this flag set are displayed in gray color.

Within a slice, the macroblocks are also shown. You can select a macroblock in
the slice using the left mouse-button. The header and information of the currently
selected macroblock is displayed below the macroblock display. Skipped
macroblocks in a slice are shown using a different color and cannot be selected.

When viewing the slice display, you can move forward to the next picture or
backward to the previous picture. You do this by clicking the picture navigation
buttons on the top right corner of the dialog box. You can also return to the
GOP display and select a specific picture. When moving backwards, you cannot
cross the GOP boundary; however, when moving forward, you can cross a GOP
boundary.

When displaying macroblocks, the status bar looks like this:

[ForHelp, press F1 m  |2500fps [420 |GOP#1 [Pic#t2z  [Display#1 |[Off5233(2417)

Viewing coded block  While in the slice and macroblock level display, you can view the coded block
patterns for a macroblock  pattern for any macroblock (except for the skipped macroblocks). This is
displayed in the last field (CBP) as shown below.

Prediction Type Dual Fri STW Code Flag x
kotion Wector Format Field ST Class a
bAotion Wectar Count 1 STW Code

Ok v kdacroblock Address I 8z CEF IDDDDDD

Depending on the chroma format, the coded block pattern is displayed as a
sequence of 6, 8, or 12 bits. From left to right, the bit pattern represents the blocks
in the macroblock as they are numbered in the standard MPEG specifications. For
more details, see the ISO/IEC 11172-3 and ISO/IEC 11318-3 documents.
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Analyzing picture quality

Viewing the macroblock
size spectrum

The Macroblock Size display provides a color-mapped two-dimensional graphical
plot of the macroblock size and type distribution in a picture; it is plotted as an
overlay on the slice display area. This plot can be viewed by clicking on the MB
Size Display button in the Slice and MB tab. The types of all macroblocks in

the picture are color-mapped; a key is shown at the right side of the display and
described below (see Macroblock Colors). Skipped macroblocks are displayed in
dark green. The macroblock size for the selected macroblock is displayed in the
macroblock field display area below it.

GOP And Picture Sl Aud M1 I Picture Player |

Slice Display I B Size Display | B-Scale Code Display | Mation Yectar Display I Picture Display | Clozed Caption Display I

-
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i~ Macroblock Colors
Field Based
Frame Based
16X BMC
Duial Prima
N,
~ Wectors——
| FF
i
Macroblock Number : 468 I BF
Motion Vectar Parameters(in units of Pixel]: e
MY Backward TopField  » -2.0,y: -15.0 FTF
MV Backward Bottom Field = 4.0,y 29.0 I e
Other P [err
ME Intra =  FalSE
DET Type - FELD | Fer
MB Quantizer Scale = 7
= 101 | B8F
B Size [Bits] = 14 l—
D.T.F.
O U O A O o o I
1 e

Friarity Breakpoint [N Quantizer Seale (13 SIiceEHlensiDnFlag@ Intra Slice ® Picture [0 |NA Raow Number |1 ‘

Macmblock
Macroblack Intra X Macroblock Quant e Prediction Type lm STw Code Flag x
Macroblock Pattern v Quantizer Scale l?_ Motioh Vectar Formatlw STW Class IU_
Macrablock Motion Backward e DCT Type Field Maotion Vector Count |2 STw Code IW
Macrablack Motion Farward x Macroblack Size [5 | DMy ¥ Macioblock Addiess ID_ CEF IW
Macroblock Escape IU_
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distribution

ES Analyzer — Working with video streams

Macroblock colors. The color-coded macroblock type represents the prediction
type employed

Field Based Predictions are made independently for each field by using data
from one or more previously decoded fields.

Frame Based Predictions are made for the frame using the data from one or
more previously decoded frames.

16 x 8 MC (16 x 8 motion compensation) In which two motion vectors are

used for each macroblock. The first motion vector is used for the
upper 16x8 region, the second for the lower 16x8 region. In the
case of a bi-directionally predicted macroblock a total of four
motion vectors will be used since there will be two for forward
prediction and two for the backward prediction. 16x8 MC is only
used with field pictures.

Dual Prima Only one motion vector is encoded (in its full format) in the bit
stream together with a small differential motion vector. In the
case of field pictures, two motion vectors are then derived from
this information. These are used to form prediction from two
reference fields (one top, one bottom) which are averaged to
form the final prediction. In the case of frame pictures, this
process is repeated for the two fields so that a total of four field
predictions are made. This mode is only used in P-pictures
where there are no B-pictures between the predicted and
reference fields or frames.

NA Not Applicable - Refers to the instances where there is no
prediction in the macroblock.

(For more detailed information, refer to ISO/IEC 13818-2 : 1996, Information
Technology - Generic coding of moving pictures and associated audio information,
Part 2 Video).

Quantizer scale distribution for the macroblocks in a picture is plotted where

the picture slice is displayed. This gives you a graphical view of the scale code
distribution and lets you visually check any obvious scale code problems. This
plot can be viewed by clicking on the Q-Scale Code Display button in the Slices
dialog box. The scale codes of 1 through 31 are mapped to shades of green with

1 being mapped to the lightest shade and 31 to the darkest (black). Skipped
macroblocks use the same scheme but are mapped in shades of gray. The value of
the scale code for the selected macroblock is displayed in the macroblock field
display area below it.
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Viewing the motion vector ~ ES Analyzer gives a detailed graphical display of motion vector for the selected
plots B or P picture. Both MPEG-1 and MPEG-2 type vectors are interpreted and
displayed.
To view motion vectors (applicable to only B or P pictures).
1. Position the cursor to the picture for which you want to see the slice size plot.

2. Move into the slice display.

3. Click the Motion Vector Display button in the slice display dialog box.

GOP And Piciure Elice Awd bl | Picture FPlayer |
BFRAME < pr
Slice Display | MB Size Display | @-Scale Code Display ”thr[)isplay PFicture Dlsplayl
|- Toaltip
¥
'» :
f I ~Wectars——
v

Macroblock Mumber : 516

tation Wector P. 1 units of Pisel]: -

-

I MY Forward Top Field w 28,930
[ MY Forward Battor Field 1.5, 3.0

FF.
B.F.
MY Backward Top Field = -1.0, 9 -3.0
M Backward Bottom Field 0.5,y -1.0
D.T.F

=

Other P 3

5 MB Intra = FaLSE
OCT Type =  HNA
MB Quantizer Scale = 10
CEBF = 000000
MB Size = 33 I
[ | o o P £ 0 s
[ R Y 53 O O | I D.B.F
T 05 Y (O
T Y Yl Y O
— Slice:
Pririty Breakpaint INA Guantizer Scale |1 1] Slice Extension Flag 3¢ IntraSlice 3 Picture 1D [ Fow Number IW 2
— Macroblack
Macroblack Intra x Macroblock Quant x Prediction Type FieldBa  S5TW Code Flag X
Macroblock Pattern X Quantizer Scale I'ID Motion Yectar Format  |Field 5T Class ID
tacrablock kMation Backward ‘/ DCT Tupe MA Mation Vector Court |2 ST Code INA
tacrablock Mation Fonward v Macrablock Size 33 Dby x Macroblock Address |51 E CEP IUUUUUU
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For each macroblock, the motion vectors corresponding to it are plotted to scale
as a directed arrow. The direction of the arrow represents motion coding for the
macroblock from the reference frame to the current frame. Different types of
vectors are plotted in different colors. You can also selectively choose to display
different motion vectors by using the buttons on the right.

FF Forward Frame BF Backward Frame

FTF Forward Top Field BTF Backward Top Field

FBF Forward Bottom BBF Backward Bottom
Field Field

DTF DMV Top Field DBF DMV Bottom Field

If a button is grayed out, the associated vector is not currently available.

The motion vectors are plotted for the luminance blocks. They are to scale (in the
resolution of full pel or half pel) according to the pel resolution fields received.
For each macroblock, multiple vectors may be received. All or some of them may
be displayed simultaneously.

When Tooltips are enabled, a summary of parameters is displayed in a popup
window.

For MPEG-1 that has only frame pictures, two kinds of motion vectors are
applicable -forward frame (for P and B pictures) and backward frame (for B
pictures).

For MPEG-2 video, additional vectors may also be coded, which are: forward
frame (for P and B pictures), backward frame (for B pictures), forward top field,
backward top field, forward bottom field, backward bottom field, dual prime top
field, dual prime bottom field.

ES Analyzer interprets all the above vectors and lets you view them graphically.
When motion vectors cross the picture boundary, an error condition occurs and
the same is reported in the error log window. In this case, the vector is drawn
until the edge of the picture display.
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Reviewing the decoded  ES Analyzer decodes and displays the selected picture when you click the Picture
picture Display button. You can view I, B, or P frames or fields (only for MPEG-2).

GOP And Picture Bliee Aud M | Picture Player I
P ERAS ME
Slice Display | MB Size Digplap | 0-Scale Cade Displayl Mation Yectar Display ” Picture Dizplay

i

Toaltip |
- I
ac_:roblock Hurnber: 1685 ) Show Grid |
e e s e
Other Parameters: Mectors——
" o N
MBE Quantizer Scale = 9
IEIBBPSize = oo |?
e
[eer
[o7r
[er
- Slics
PFriciity Breakpaint M4 Quantizer Scale l?_ Slice Exterion Flag 36 IntaSlice Y€ Picture 1D [Ma Fiow Number|4—
— Macroblock
Macroblock Intia X Macroblock Quant J Prediction Type [ha | ST Code Flag x
Macroblock Pattern e Quantizer Scale IS— Motion Yector Format Ha | ST Class IU_
Macroblock Mation Backward b 4 DCT Type Frame Mation Yector Count e ST Code IW
Macroblock b ation Fonaard b 4 Macroblock Size 6 | DMy 0 Macroblock Address IF CBF IW

ES Analyzer also allows you to view the previous and the next decoded picture
(whether frame or field) by clicking the appropriate buttons. The actual size of the
picture is displayed and if the picture is larger than the picture display area, scroll
bars will appear. For the picture being viewed, you can select a macroblock by
clicking the left mouse button anywhere in the picture display area. When you do
so, the slice and macroblock area below the picture displays the slice and MB data
for the currently selected macroblock.

If Tooltips are selected, a summary of the macroblock information is displayed in a
popup box. When you switch from the picture display to the other picture-quality
analysis tabs (e.g., MB Size Display, Q-Scale Code Display or Slice Display), the
same macroblock remains selected for easy identification.

You can also enable a macroblock grid on the displayed picture by using the Show
Grid button to easily identify and select macroblocks.
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The picture display has the following limitations:

When you navigate to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

For MPEG-2 scalable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

ES Analyzer currently displays and decodes video streams within the
following MPEG-2 profiles:

Main Profile @ High Level (MP@HL)
Main Profile @ Main Level (MP@ML)
4:2:2 Profile @ Main Level (4:2:2P@ML)

Viewing the decoded picture with motion vector plots. The decoded picture can be
further enhanced with an overlay of motion vector plots.

The interpretation of the display corresponds with the description in the previous
section - Viewing the Motion Vector Plots.

To view the vector plots for the currently displayed picture:

Select the Show MV button on the right side of the picture.

The vectors displayed will depend upon the selections made from the
remaining buttons on the right side of the screen.
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GOP And Picture Sliee fud WG | Picture Plyer |
PFRAME |
Slice Display | MB Size Display | 0-Scale Code Disp\ayl Motion Yector Dizplay ” Picture Dizplay

Toolip

croblack Mumber @ 165 g
Mation Vector Parametersfin units of Pixel): Sliery i

My Fonward Frame w 00,9 000 gpn D[:Tl

Other Parameters:

B Inta = FALSE —Vectors——
DCT Type = FRaME
ME Quantizer Scale = 3 FF.
VB 5ie Dow | TR
B.B.F.
~ Slice:
Pririty Breakpaint [MA Cuantizer Scale l?— Slice Extension Flag x Intra Slice x Picture ID IW Fow Number |4—
r— Macrablock
Macroblock Intra b 4 Macioblock Cuant ¢ Prediction Type Na | ST Code Flag X
Macroblock Pattern v Quantizer Scale IS— Iation Yector Format e | ST Class ID_
Macroblock Motion Backward % DCT Type [Frame | Mation Vector Caunt e ST Code IW
Macroblock Motion Fonward X Macroblock Size 6 | Dby Q Iacrablock Address IF CBP IW

The picture display has the following limitations:

B When navigating to a specific GOP using the toolbar icon, the picture display
may be unable to display some B pictures correctly. These pictures are those
that use a frame from the previous GOP for reference. This happens only
when you navigate to a GOP that is not a closed GOP.

B  For MPEG2 scalable streams, you will be able to display pictures only from
the base layer. Other extension layer data cannot be displayed using ES
Analyzer.

B For MPEG2 streams, ES Analyzer currently displays and decodes only
decodes MP@HL, MP@ML, and 4:2:2 video streams.

NOTE. Make sure that your monitor's display properties is set to either 24 or
32-bit true color; otherwise, you may find a distortion in the colors in the picture
being displayed.
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Displaying DCT coefficients. The Discrete Cosine Transformation matrix of each
block in a selected macroblock can be seen by selecting Settings > DCT Display
from the Menu bar

The DCT Display option is available only when viewing the details of GOP in
Video Stream Analysis. Enabling the DCT Display option will enable Show
DCT button next to the displayed picture in Slice & Macroblock Tab, Picture
View Mode.
GOP And Picture Sice Aué WL | Picture Player |
B rrRAME < >
Slice Display | M Size Display | @-Scale Code Display | Motion Vector Display | [ Ficture Display _Closed Caption Display |

g — —

—Weclors ——
Iotion Vector Parametersiin units of Pixel): I EE
MY Backwaid Top Field = -85y -1 BF.
W Backward Bottom Field » -4.5. y: 0 ek
F.TF.

e
e
[eer

e

Other Parametess:
ME Intra
DCT Type
ME Quantizer Scale

FALSE
FIELD

14
CBP 111100
ME Size (Bits) 151

514 B No:
Select Block Decoded DCT Valuas Inverse DCT Yalues

[i] 1] [1]
‘Y

Cbh

Q

[=] =1 [=1 =1 =] =1 {=] {=!
olo|la|o|a|a|o| o
o|lo|a|o|o|a|a| o
o|o|o|o|o|o|o| o

o|lo|a|o|o|o|a| o
olo|o|o|e|o|o| o
olo|o|o|o|o|o| o
o|lo|a|o|o|a|o| o
o|lo|o|o|e|o|o| =
o|lo|o|o|o|o|o| o
o|lo|a|o|a|o|o|of
olo|o|o|o|o|o| o

o|lo|o|o|o|o|o| o

o|lo|la|la|e|a|e
o|lo|lo|o|e|e|e
olo|lo|lo|la|a|le

The Show DCT button is used to toggle the DCT Coefficients display. To view
the DCT values of the a macroblock, select the macroblock; a window containing
details of coded and decoded DCT values will be displayed.

: DCT Values for Macroblock No: 642 Block No: D

Select Block Decoded DCT Valuas Invarse DCT Values
[ | [1202] 24 T 0 0 0 223 [ 223 [ 224 [ 225 | 226 [ 227 [ 228 [ 228

v [E]1]| |3 [ 0 208 | 207 | 206 | 205 | 204 | 202 | 201 | 201
71 | 16

177 | 176 | 173 | 170 | 166 | 162 | 160 | 158
160 | 159 | 156 | 152 | 148 | 145 | 142 | 140
139 | 138 | 137 | 135 | 132 | 130 | 129 | 128
115 |15 | 114 | 113 [ 113 | 112 [ 112 [ 111
110 | 110 [ 109 | 108 | 108 | 107 [ 106 | 106
103 | 103 | 102 | 100 | 99 97 | 96 | 96

olo|o(o|o|o|o|e
olo|lolo|lo|la|la|la

o|lo|o(o|o|o|o|o

o|lo|lolo|le|a|e
SEEEEEE

Sla
o
o|lo|lo|o|o|o|o

Note that the luma (y) control has four selections (0, 1, 2 and 3) which correspond
to an 8x8 pixel corner of the 16x16 pixel selected macroblock. Chroma
sub-sampling (Cb and Cr) will display matrices for the color differences between
frames.
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The picture display has the following limitations:

B When navigating to a specific GOP using the toolbar icon, the picture display
may be unable to display some B pictures correctly. These pictures are those

that use a frame from the previous GOP for reference. This happens only
when you navigate to a GOP that is not a closed GOP.

B For MPEG2 scalable streams, you will be able to display pictures only from
the base layer. Other extension layer data cannot be displayed using ES

Analyzer.

B For MPEG2 streams, ES Analyzer currently displays and decodes only
decodes MP@HL, MP@ML, and 4:2:2 video streams.

DCT Value display - version changes. The diagram also indicates the changes that

occurred between ES Analyzer, Version 1.5 (MPEG Test System, Versions 6.4
and 6.4.2) and ES Analyzer, Version 1.6 (MPEG Test System, Version 6.5). The
"windows" referred to are those in the DCT Values window.

Compressed Data Stream

A J

4
The Codad DCT values (lefi-hand window)
measurad in the stream before WLC and
RLC (entropy) decoding

WVLC Coding Table —»| VLC + RLC Decoder |

l

¥

MEEG Test System, Version 6.5

RLC {entropy) decoding,

applied, i.e. after the de-quantising .—/
process.

|

Quantization Table - De-guantizer i

|

|

|

|

|

Y I

|

Inverse DCT i

MPEG Test System, Versions B4 865 |
The data shown in the right-hand window |
—|is that after the Inverse DCT algarithmis pP—————=—=———==—=—==—=— 4

Mote the window name changes:

Inverse DCT Values - Right window (6.5}

Dacoded DCT values - Right window (6.4)

Decoded

picture

RLC - Rin Length Coding

VLG - Variable length Cading
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Configuring video analysis
settings

ES Analyzer — Working with video streams

The video analysis or picture analysis default settings can be set as required.

NOTE. The selected Video Analysis settings will not affect analysis on either the
Slice and Macroblock or the Picture Player pages. On the Slice and Macroblock
page, analysis is always at the macroblock level. On the Picture Player page,
analysis is always at the picture level.

Video analysis settings. Select Settings > Video Analysis... from the Menu bar.
The following dialog box is displayed:

Yideo Analyziz Settings E3 I

Picture level analysis &

Macroblock level analysiz Carcel |

Macroblock Shadding 5 cherme
Bazed on Macroblock Size 8

Bazed on Prediction Type is

Select Picture level analysis to view frames quickly.

Select Macroblock level analysis if pictures/frames are to be analyzed at the
macroblock level.

When Macroblock level analysis is enabled, select the shading scheme required.
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Picture display settings. A number of display and vector parameters are set from
the Picture Display Settings dialog

Select Settings > Picture Display... from the Menu bar. The following dialog
is displayed:

Picture Dizplay Settings E3 I

— Display Order of Pictures
(® Prezentation Order O Decoding Order

— Matian Yector Overlay Colowr Selection
O whibe (&} Vector Dependent
) Black (@] Background Diependent

Cancel |

Display Order of Pictures Select Presentation Order or Decoding order

Motion Vector Overlay White: All vectors will be displayed in white.
Colour Section Black: All vectors will be displayed in black.

Vector Dependent: Colors will correspond to the vector selection
button colors.

Background Dependent: Colors are combined with picture
background to provide a contrast.
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Viewing the slice size  For any picture, you can also view the slice size distribution.

distribution
To view the plot.

1. Position the cursor to the picture for which you want to see the slice size plot
on the GOP And Picture tab.

2. Move into the slices display by clicking the Slice and MB tab.

3. Click the Show Slice Size Statistics icon Iﬁl on the toolbar.

NOTE. The Show Slice Size Statistics icon [ is grayed out on all tabs except
the Slice and MB tab.

The plot appears in another window.

Slice Size Spectrum for GOP Mo. 1 Picture Mo. 2 I
1.00

0.90
0.800 -
0.70 -
0.60
0.50
0.40
0.30

s:fzﬂ

Slice Size (KBytes)

6 1 16 21 26 31 36

Slice No.

MTS4000 and MTS4SAV3 Analyzer Applications User Manual 4-49



ES Analyzer — Working with video streams

Viewing the frame size ~ You can view the picture spectrum for a GOP and the frame size plots.

spectrum
To view the plot.

1. Display the GOP for which you want to see the Frame Size Spectrum plot.

2. Click the Show Frame Size Statistics icon ]Ql on the toolbar.

The following plot is displayed. Each bar represents the frame size in kilobytes:

Frame Size Spectrum for GOP Mo. 1 E
48.0

43.3
38.5
33.9
ZB.BL
24.1 P
19.3

Frame Size (KBytes)

14.4 B B
9.7 ‘ ‘

4.9

|

9 10 11

] ok |

Selecting the Show Data Distribution button will further enhance the plot by
showing the content of each frame.

Frame Size Spectrum for GOP No. 1 E
48.0

43.3
38.5
33.9
20.8
24.1
19.3

Frame Size (KBytes)

14.4
9.7
4.9

—_—

P P
Ficture Size [Bytez) B
E E E UszeData Size [Bytes)
Motionector Size [Bytes)
[ICT Size [Bytes]
—t t —t—— t —t—— t t t
0 1 2 3 4 5

E e Emm " Frame To.

Content is color-coded as shown by the key in the bottom left corner. Details of
the content of each frame are displayed when the cursor is moved over a frame.
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Using the video viewer for picture analysis

The video viewer (or Picture Player) allows you to play a video stream and
display the decoded picture on the screen. The picture player playback speed may
vary from real time according to the ES Analyzer processor speed. You may
also notice certain pauses in the display at regular intervals. These pauses occur
at GOP boundaries. The Remote Control (described below) allows you to pause
and resume the display at any frame. You can also restart the display from the
beginning of the current GOP, or from the start of the video sequence.

The number of the current picture and the number of the last decoded picture are
displayed, as shown in the following illustration. Here is a typical sequence of
steps in which you may use the video viewer:

1. Open the video stream you want to analyze.
2. Start the video viewer.

3. Monitor the displayed picture for quality problems.

GOP And Pictwre | Slice And MB Ve Vayer |

Playing... Sym2 trp (]
youon o =

B
. o/ ’?" T |
TSAE (ot mmﬂhﬂﬁiﬁ

4. Pause the player whenever you notice a problem in a picture, such as a
degradation in quality. The player is intentionally made to play at a speed
slower than the regular play speed to allow you to stop at specific frames.
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4-52

Switch to the analysis tabs to view details of the currently displayed picture
down to the macroblock level.

Step forward or backward in decode order in the Slice And MB tab, or switch
back to the video viewer and resume play.

ES Analyzer synchronizes the picture being currently displayed by the video
viewer with the picture/data that is displayed on the other tabs: GOP And Picture
and Slice And MB. This means that:

The GOP And Picture and Slice And MB tabs always display data for the
same picture.

When you switch from the video viewer to either the GOP And Picture or the
Slice And MB tab, you are presented the data for the picture being displayed
on the Picture Player tab.

When you switch from the GOP And Picture or the Slice And MB tab to the
Picture Player tab, the video viewer presents the picture for the data being
displayed on the GOP And Picture or the Slice And MB tab.

If you select a macroblock and switch to the picture-quality analysis tabs
(such as MB Size Display, Q-Scale Code Display or Slice Display), you will
find that the same macroblock remains selected for easy identification.

The video viewer, however, has the following limitations:

When you navigate to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

For MPEG-2 scalable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

ES Analyzer currently displays and decodes video streams within the
following MPEG-2 profiles:

= Main Profile @ High Level (MP@HL)
= Main Profile (@ Main Level (MP@ML)
= 4:2:2 Profile (@ Main Level (4:2:2P(@ML)
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ES Analyzer — Working with video streams

The Remote Control is displayed whenever the Picture Player tab is selected.

Playing... Sym2 trp

=]

[ || Pld*ﬂﬂjlﬂli: :l

Play Video

Plays the video stream from where it last stopped.

Stop

Stops the video stream and allows the other analysis tabs to
be selected.

H

Next Picture

Steps forward one frame.

[

Play from GOP Start

Plays the pictures from the start of the current GOP.

o

Zoom/Restore Display

Enlarges and restores the area in which the picture appears.

Fit Best in Display

Fits picture in display area or displays picture at original size.

I:L Area/Display Picture at
True Size
ﬂ| ﬂ Left/Right Scroll Scrolls the displayed picture left and right.
| Up/Down Scroll Scrolls the displayed picture up and down.

14

Show/Hide information

Shows or hides the information panel for the displayed picture.
The following information is displayed:

GOP Number - in which the frame is present. Coded Number
- refers to the picture number within the GOP. Display Time -
in hh:mm:ss:cc; where cc is the display number in the whole
file. Display Number - refers to the display number of a picture
within the GOP.
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ES Analyzer — Working with audio streams

ES Analyzer analyzes both MPEG (-1 and -2) Audio streams and Dolby Digital
(AC-3) Audio streams.

Understanding MPEG audio streams

An MPEG audio stream consists of a sequence of audio frames. Audio data
may be received for multiple channels. Each channel is divided into sub-bands
for which data is transmitted.

ES Analyzer verifies audio streams according to the MPEG audio
recommendations. Support for both MPEG Layer I and Layer II audio is available.
MPEG-2 extensions for Layer I and II (surround and center channels, and low
frequency channels) are also interpreted and analyzed. Multi-lingual extensions in
MPEG-2 are currently not analyzed. ES Analyzer is also unable to analyze the
MPEG-2 Audio stream if the extension bit stream is present.

For a detailed discussion on the MPEG audio syntax, refer to ISO 11172-3 and
ISO 13818-3.

With ES Analyzer, you can:

B Navigate to any audio frame; see details in the Navigating through Streams
section in the Getting Started chapter.

m  View frame details, including frame header, and plots of the frame data, as
shown in the following illustration.

B [nterpret and display audio descriptors received in higher level streams and
validate them against the stream.

B Play an audio stream.

For each audio frame, data may be received for at most two channels, as shown
in the next illustration; additional channels may also be received in the MPEG-2
extension.
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ES Analyzer — Working with audio streams

The Audio Player is available on MPEG-1, MPEG-2 and Dolby AC-3 streams
(and AAC as an option). With a suitable sound card installed in the host PC,
audio streams can be played.

NOTE. The speed and quality of playout, is not high fidelity, but is sufficient to
allow an audio stream to be monitored for analysis.

WARNING. While an audio stream is playing, you cannot access any other
analyzer functions. In particular, do not close the Audio Player while an audio
stream is playing (especially in loop mode), because you will be unable to reopen
the player (and control the stream) until it has finished playing.

If more than one audio device is installed, a selection can be made from the
Device drop-down list.

Channel Select
Audio Play

Devicel Crystal Sudio Systern F'Iayl:uau:lll (}]F‘*l ll

Play Chanmelz ILeft,Hight Charinel LI

The channels to be played can be selected from the Play Channels drop-down list.
S| l| . o .
To open the Audio Player, select the player start button, which is available
on the audio stream header pages.

The Audio Player control panel is displayed:

I [H-20-50 fish2 mpg52] - k| x|
12030 v

The player controls follow the same convention as the Video Player controls:

Icon Description
Play
b
Stop
ll
[ 3 Fast forward
LT Fast rewind

(To use Fast Forward and Fast Rewind, press the required button and then stop the
action with the Stop button.)
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The Audio Player display shows the following:
B Play time

B Stream Name and Audio PID number

m  Player status (Stop/Play)

The following controls are available in addition to those described in the
preceding list.

EI Toggles continuous (or looped) playout.

it Toggles a real-time waveform display.

NOTE. Currently two channels are output to the sound card. These can be
assigned as required (as mono or stereo) from any of up to five channels in a
Stream.
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Explaining MPEG-1 audio  ES Analyzer displays data for each channel separately.

streams —

WP | (lealoe |

— Frame Header
D |1 Layer Il-a-"'e’:2 Protection Bit »
Bitrate I334kbps Sampling Frequency I‘lB-DkHZ Padding Bit b 4
Private Bt b 4 Mads IStB"30 Made Extension ID
Copuright x Emphasis INone Original or Copy x
CRC Check. |3[|33‘| Bound |2? SBlimit Izr

s ool i

i | SCFSI | Goowping | Scalefactor |  Charel Selest

Left Charinel Audio Play

DeviGEI Crystal Audio System F'Iaybaclj qr-r l|
Play Channels ILe[t_Hight Channel 'l

=
=]
)

=239

Bits/ Codeword{shi—

sh—

For the selected audio frame, ES Analyzer displays the following:
B The frame header.
B A plot of bits per code word against the sub-bands for each channel.

m  SCFSI (Scale Factor Selection Information) plotted against sub-band for each
channel.

B Grouping information plotted against sub-bands for each channel.
®  The scale factor plotted against the sub-band.

B Channel selection and playout controls.
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Explaining MPEG-2 audio

4-58

streams

For MPEG-2 Audio streams, ES Analyzer analyzes the following channels if the
data is present: Left, Right, Left Surround, Right Surround, Center and LFE.

Currently, ES Analyzer analyzes 5.1 Audio streams. When ES Analyzer detects
an MPEG-2 Audio stream, the information displayed is similar to what is shown

in the following illustration.
I RN R R RIS | MC Header | JLY% [ Cumpugite Status |
— Frame Header
D |1 Layer ILayerE Fratection Bit b4
Bitrate I334khps Sampling Frequency I‘M-1 kHz Fadding Bit o
Prriveate Bit b4 Mode IStE'ED bode Extengion ID
Copyright b 4 Emphasis INone Original or Copy v

CRLC Check. |421 53 Ecound IBD SBlimit |3[|

s ol | SCFSI

Bitsy Codevword{shi=

| Growping | Scalefactor |

o Chamel Select
Center Channel Audio Play

DeviGEI Crystal Audio System F'Iaybaclj (fjl“‘*l l|
Play Channels ILeIt.Hight Channel 'l

= Lsg  H s

ES Analyzer displays information on the following tabs: MPEG-1 Header,
MC Header (Multi-channel header), and MC Composite Status (Multi-channel

composite status).

MPEG-2 Audio streams are backward compatible with MPEG-1 streams.
Therefore, the MPEG-1 header for each frame is the same as that for an
MPEG-2 Audio stream.
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The MC Header tab displays information about the additional data present for the
multi-channel extensions, over the two stereo channels. It gives you the number
of channels that are present, the presence of the LFE channel, additional CRCs,
and other relevant fields in the MC Header, as shown.

MPEG 1 Header

Mo, of Channels
Adics Mis for Smoall Foem o

Channel | nfamnation

e

Sumound

’;Jo. of Channels |2

Lie X

Center

M Tl

- Multichannel Header Information —{ M ultichantel Headsr Infamnations |

| MC Composite Status |

I3

Copyright [0 Bit

Dematnx Procedure |2

b 4

I ultilingual Channel Infiormations

Multilingual Layer
Mo, of Channels

Sampling Frequency

x
|“_
e

Copyright 1D Start b 4

CRC wWaord [11353
MC Maode IS,F 2
Extenzion Bitstream Information

Extenziom Bitztrzam Flag x

—

Mo, of Bits in
Ancillany Data Field

The MC Composite Status tab provides the sub-band information of the channels;
and their relationship with the transmission channels, as shown.

MPEG 1 Header | MC Header WL Cocapnsive Biains |

TC Allocation ¥ alid for all Subband Groups 4 MC Prediction ON X Dynamic Crosstalk Used %

Dynamic Crosstalk LR @
TC Alloc ation 0 0 0 0 2 2 a 2 q 0 z 2
Dynamic: Crozs hode WA | N NAA | AR | WA AR AR N MR N MAA D NS
Dwanamic Crosstalk far | hA& [ RAR | BAA (| AR [ NAS || NAB | NAS || NAB | MAA || HAA | MAA || NAS
Second Steren Program

1 2 3 4 ] G 7 g 1 10 k| 12
Subband group

The lower part of the dialog box displays information specific to the channels.
You can select the channel for which you want to see the details by clicking the
appropriate graphic at right. The channel-specific data for the selected channel is
displayed at left as for MPEG-1.

Bt Wiowl | SCFSI | CGrowping | Sealefactor |

— Channel Select
Audio Flay

[B] e'viCEI Cryztal Audia Spatemn F'Ia_l,lbaclj @ (& § I|
Play Channels ILeft,Hight Channel "I

Center Chanmel

Bits' Codeword{shi=

sh—
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Explaining the Status bar

The status bar for Audio streams displays the following:

display B Frame number, which is the number of the current frame in the stream.
B Layer number, which is the number of the audio stream.
m  Byte offset in the file, which is the first byte of the Frame header being
currently viewed in both the hexadecimal and decimal formats.
|For Help. press F —— |Frame# |S{F: 48.0kHz |2Bbkbitsfs  [Layerz | |off gy

Understanding Dolby Digital (AC-3) audio streams

4-60

ES Analyzer also analyzes Dolby Digital's audio streams, which could be an
independent, stand-alone audio stream, or a multiplexed stream that is embedded
inside an MPEG-2 System stream (ATSC transport or program stream). The
Dolby Digital stream is analyzed by ES Analyzer for syntactic compliance with
Dolby Digital specifications.

For a detailed discussion on the Dolby Digital audio syntax, refer to the document
A/52 from Advance Television Systems Committee (ATSC).

ES Analyzer analyzes Dolby Digital stream frame by frame and also performs
CRC checks for each audio frame. When analyzing a Dolby Digital stream, you
may navigate to any frame and also view data specific to an audio block within it.

Automatically detecting the data format used in the Dolby Digital stream, ES
Analyzer analyzes both the little endian and the big endian formats. For ease of
debugging, ES Analyzer displays information for all the fields of any block for
any audio frame.

When errors are encountered in a stream, ES Analyzer reports the errors and
synchronizes to the next audio frame to continue the analysis.
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ES Analyzer displays the header and audio block information on specific tabs, as

shown. The Header And BSI tab displays the Dolby Digital synchronization and
bit stream information.

EECR = P
F | ode e udo Series Complte an | Ao Coding [372-Crameie L OR SLEA |

s
:

%
%
=
D
A NA

Crystal Audio System F'Ia_l,lbac:l 'l'l =TT
Left Channel =]
Right Charinel =

The audio controls are only available on the Header and BSI tab.
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Depending on the selection, the Audio Block tab displays information for the
corresponding audio block within the frame.

Header And BST Fudio Black |
[l ) : . ‘ ;
Awudio Black Number o 1 3 4 5
Dwnamic R ange P Coupling Strategy Information
Gain Range waord Exist x Gain Fange word Exist for Channel2 0 Coupling Strateqy Exists &7  Phase Flagin Use s
Gain Range 'Ward ID Gain Fange ‘Ward for Channel2 IN A Coupling in se \/ Rematrixing Strategy @
— Bit Allocation Parametric Information  Delta Bit Allocation €
—Bit Allocation Information — SMR Offset \/ Coupling Delta Bit Allacation Exists M.A
Bit Allocation Info Exists J Coarze SHR Offset 21 Coupling Delta Bit Allocation Segments M.A.
Coupling Fine SMR Offset 12 =
Slow Decay Code > ) . Law Frequency Effect \/
Fast Decay Code 1 Caupling Fast Gain Code Channel Exponent Strategy 015
Slow Gain Code 1 - Coupling Leak Initiization o ————— i A €A Ol 12
S+ Ga Channel Fast Gain Code 4
103 (e Bk Gt Gt | Faszt Leak Initilzation 0
Masking Floor Code |5 Slow Leak Irtifzation 0
‘ Skip Length Exists 3¢ Skip Length IN_A_ ‘
— Channel Select ———————————— . . 5
Caong iy Tt | Channel Fields |
Left Channel
e R r—Band Structure

B E
T T T T T e (O A B

48 T2 26 120 744 16 192 216 240

L5 B Y

The lower part of the previous illustration displays the channel-specific
information for the selected audio block, as shown in the following illustration.

o lies Tinthy | Channel Fields I

Left Channel

(=] E
L L e e e e e

— Band Structure

48 2 26 120 144 6@ 1292 =216 240

$b—
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Coupling Info Chevivie L e bl
i~ Block Switch and Dither Fage — Exponent Strategy
. Caupling E t Strat Reuse
Block Swatch Flag b4 OUPING ERponEnt Sttatedy
: Channel Exponent Shrategy FReuss
Dither Flag v Channel Banduith Code N
—Edponent——————————————— — BitAllacation Infarmnation
Gain Range Cods IF Channel Fine SMA Offzet MLA.
Channel Fast Gain Code WA
—Coupinga———  ~ DeltaBit Allazation
Coupling Co-ord Exists x Dielta Bit dillocation Ewvists WA
Master Coupling Co-ord I H.A Delta Bit Allocation seaments M4,

The Coupling information tab distinguishes between the stand-alone and coupled
data for the selected channel. The green band denotes the stand-alone information,
and the blue region denotes the coupled information. The blue region may be
further divided into bands; these appear as solid lines as opposed to the dotted
lines that denote sub-bands.

Explaining the Status bar  The status bar for Dolby Digital Audio streams displays the following:

display ®  Frame number, which is the number of the current frame in the stream.
®  Bit rate of the Dolby Digital audio stream.
®  Sampling rate.
B Frame size information.
B Byte offset in the file, which is the first byte of the Frame header being
currently viewed in both the hexadecimal and decimal formats.
||FDIHEI|3, press Fl ————— |FrameHi |BitRate 192 kbps |F#5 48 KHz |FSCOD:20 | | Offzet: 0 él
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ES Analyzer — Working with Program streams

Program streams are quite similar to MPEG1 System streams in structure. A
Program stream consists of a sequence of packs. Each pack has a header, an
optional system header, and any number of packets. If a system header is not
received in a pack, then the last received header is applicable for the pack. The
system header is sent periodically in the stream to facilitate random access. Each
pack contains any number of packets. Each packet belongs to a particular stream
and has a PID associated with it. If packets of a given PID are concatenated,
you get the embedded PES stream with this PID. The PES stream in turn has

an elementary stream embedded in it.

For more details on Program streams, refer to the ISO/IEC 13818-1 document.

—Pack

SCR Baze |1 Child Stream |D |224 bl iz Fiahe |4DDUUDD
[bits4z]
SCR Exstension |24E| Child Stream Type IPESWES]

— System Header#
Header Lenath |12 Videa Bound |1 CSPS Flag o
FivedFlag & Audio Bound |1 System Yideo Lock Flag «
Rate Bound |4uuunuu bits /s System Audio Lock Flag <
STREAM ID | STREAM TYPE | STD BUFFER SIZE

45 19 Audia Stream 4096 Bytes

@ 224 YWideo Stream 235520 Bytes

4| | ¥

ES Analyzer performs conformance and semantic checks at the program stream
packet level as per the ISO/IEC 13818-1 recommendations. An embedded stream
is checked when you navigate through one; for details, see the Navigating through
Streams section in the Getting Started chapter.
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For Program streams, you can:
B View pack and system headers, as shown in the previous illustration.

B View the program stream map; see the Viewing the program stream map
section for details.

B View an embedded stream at the PES or the elementary stream level; see the
Understanding Packetized Elementary Streams section for details.

m  Perform buffer analysis of the embedded audio/video stream using the STD
model; see the Analyzing Streams chapter for details.

B Perform PCR/PTS frequency analysis model; see the Analyzing Streams
chapter for details.

Viewing pack and system headers

When navigating through a stream, the current pack is displayed in the header
display area, as shown in the preceding illustration. The pack and system header
fields are displayed for the current packet of the Program stream. The currently
applicable system header is displayed for the packet. The receipt of a system
header in the current pack is indicated by a check mark in the system header group
box. A cross mark indicates that the system header was received earlier.

The list of streams declared in the header is displayed in the elementary stream
list box. It is possible that the stream may contain some PES streams that are not
declared in the System Header. Such streams are added in the tree view when

a packet of the same is encountered.
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Viewing the program stream map

]| The program stream map can be viewed by clicking the stream map icon
(PSMAP) in the tree view window. This pops up the stream map showing the
descriptors for the Program stream and the contained elementary streams. The
descriptors associated with each elementary stream in a program can be viewed in
one of two ways:

® By double-clicking the corresponding icon for the stream in the display

= 12 By clicking the more details icon shown for the corresponding stream in
the elementary stream listbox

— Pragram Map Table

Version Kumber IU Current Next Indicator e EI
CRC |382|3531 459 M ap Mumber |2

— Elementam Streams

| STREAM TYPE

F 197 MPEGT Audio [0513]

The form is extended (if not already extended) to add the descriptors display, as
shown in the following illustrations. All descriptors that are received for the
corresponding stream are displayed on tabbed folders. If a descriptor is not
received, its tab will not appear in the descriptor display. The illustrations below
show descriptors for the respective video and audio tabs.

[Descriptars for Stream I0:224

Video |

Multiple Frame Fiate Flag b 4 Frame Fiate ISD

x

Constrained Parameters Flag % Still Picture Flag
MPEGE

Escape Bit b 4 Profile IMain
= IMain Chrama Format IW

Frarme Rate Extension Flag x
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|Descriptars for Stream 10:192

Audio |

x

Free Farmat Flag

S

D

Layer I 2

Explaining the Status bar ~ The status bar for Program streams displays the following:

display B Pack number, which is the number of the displayed packet.

m  Packet number, which is the number of the current packet in the entire stream.

B Packet number of SID, which is the number of the current packet taking into
account only packets of the same stream ID (SID).

m At GOP level, the location of GOP header/start at PES level and Pack level is
displayed by PES packet number & Pack number respectively.

m At AES & AC3 level, the location of frame header/start at PES level and Pack
level is displayed by PES packet number and Pack number respectively.

= Byte offset in the file, which is the first byte of the Pack header being currently
viewed in both the hexadecimal and decimal formats.

“or Help, press F1 — |.+ [PESPKi 1 |Pack#13 7 T182kbits£s |Layerz |Framet;1 V |Off 0x12815(75797] = |
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ES Analyzer — Working with teletext

Teletext can be incorporated into DVB streams. ES Analyzer allows the associated
data to be analyzed and viewed.

TERT

To view the teletext data, navigate to the teletext icon in the Tree view
window.

Initially, the Page Header data will be displayed:

i#'Tektronix MPEG-2 ES Analyser - [AC3 on DVB.mpg] M= B
W Fle Edi View Window Mode Seitings Help METES]
= - k2 k2
|=|e | = JEl= «lollalsE =alaa) e
=gy TPT ]
=] @2 PROGRAM 833 Teletext Data Block In
PES(PID=255), MPEG 2/ Dataldevtiier  [16 DataUnitln |2 DetaUnit Lengtr [44
- (B PES(PID=256], MPEG 14 -
& Fest ! Line Off st 325 Field Parity Second Field Framing Code 228
(=) PES(PID=257), PES Packe
53 £5 PESIPID=32] PES contar Magazine Mumber |6 Packet Number [0 Designation Code [M.4
e el )
(&F PROGRAM 239 Tuge B |

@F PROGRAM 837
(@# PROGRAM 900 PageHeadernf

& PROGRAM 40 Subeode Valu Mational Optian Character et Bils
Magzzine Number  [6 s1 o s2 o
I I I ciz [0 oz cia i
Page Number [100 53 o g4 [0
Conlral Bit Flag
Update Indicator - 96 Interupted Sequence 9 Supress Header 36 Newsflash 9
Inbitit Display € M agazine Serial s ErasePage ¥ Sublitle x
< ] Necated 1 Hapley | Decoding Parameters |

Sheam Propert [ Value =]

~ TS 6 E4MIDVB Teletext11. 1. BEEN1 1N22 : WS
« Type of Video Mpeg2
o Typeoldudio:  Mpegl
= User Data Sheams: 1

- TotalProgiams: 5§
« Sewice Type:  DVB
< | ol |
LOCATION [ MESSAGE
TFT5PES[FID=32), PES containing Telete... Inconect Data Unit Lengih coded. Allowed value is Di2c
TPT5PES[FID=32), PES containing Telete... Inconect Data Uit Length coded. Allowed value s Di2c
(3 TPT->PES[FID=32), PES containing Telete... Inconect Data Unit Length coded. Allawed value i Dv2e
< |
For Help, press F1 [ — ] [TPTPKHED | Off 01 5 B{8598)

- -
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Using the Next button, details of the page can be viewed in the Data Packet tab.

{@'Tektronix MPEG-2 ES Analyser - [AC3 on DVB.mpg] M= B
% Fle Edt Yiew Window Hode Seltings Help 18] x|
l=zal O |E=+|0||ehadi=alH5 2
N
= & v Next Telstext Frams 1
= G)z PROGRAM 838 Teletext Data Block Inflr
FES[PID=255], MPEG 2%/ Dataldentiier  [16 Dataliitin 2 Data Unit Length  [44
PESIPID=256). MPEG 1.4
GR PESIFID-256) Line Dffset 15 FeldPaiy [t Fieid FiamingCade 228
£} PESIPID=257], PES Packs
BT (25 PESIFID-32), PES conti Magazine Number [6 Packet Number [10 Designation Code [N.4

&P PROGRAM 893
= PROGRAM 837
&P PROGRAM 900 Diata Packet Info

& PG 0 Side Parel Informations——— — Character Informations——————————
PageType  |BasicLevel 1
Left Side Panel 3 Fight Side Panel X S G0 Charscter st e
Page Coding | 7plus 1 0ad parity
Nurber of Columns inside Parel N2 Secand Mational Dption Selsction [N 4

Page Header | Color Map Table

Black Eackground Substiuion 6

Devaded Display | Decoding Parameters |

TKRuwerbefinanz. fiService; B2 40P

N — |

Stream Propet Value -

« AudoTracks: 5 —
« TypeofViden:  Mpes2

 Typeoféudic:  Mpegl J

® Llzer Data Streams: 1

« Tolsl Progiams: 5 - -
4| D 4| | »

|Ne#t Packet , GOF or Frame T |Frame#33 |PIDT023 packet [ [ 0if 0435372121 9634)

Other tab pages (Color Map Table, Decoded Display, Decoding Parameters)
provide detailed teletext encoding data. These tabs will only appear as progress is
made through the stream using the Next button and the analyzer detects them.

VBI (enhanced teletext support)

Enhanced teletext support is available (reference: ETSI EN 301-775). The
supported extensions include the following:

B VPS (Video Program System)
B WSS (Wide Screen Signaling)
®  Monochrome Data

Note that the associated information screens will only be available for display
where data of the specific type is available in the stream.

Examples of the screens are shown in the following illustrations.
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VPS (V|deo Program 18T ckiranix MPEG-2 ES Analyser - [D
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- @2 PROGRAM 1 | e
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Monochrome data
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ES Analyzer — Advanced audio compression

4-72

Elementary Stream Analyzer (ES Analyzer) performs off-line stored stream
analysis for MPEG1 Audio, MPEG2 Audio, and Dolby Digital Audio streams, as
well as MPEG1 and MPEG2 video streams. The streams can embedded inside
DVB, ATSC or MPEGI System streams.

Advanced Audio Compression (AAC) is one of the audio compression

formats defined by the MPEG-2 standard. AAC used to be called NBC
(Non-Backward-Compatible), because it is not compatible with the MPEG-1
audio formats. AAC offers a better compression ratio than MP3 (MPEG-1 Layer
3) and is the state-of-the-art in audio compression technology. It can include up
to 48 audio channels, 15 low frequency enhancement channels, 15 embedded
data streams and has multi-language capability. MPEG formal listening tests
have demonstrated that it can provide slightly better audio quality at 96 kb/s than
layer-3 at 128 kb/s or layer-2 at 192 kb/s.

Due to its high coding efficiency, AAC is a prime candidate for any digital
broadcasting system. The Japanese authorities were the first to decide to use
AAC within practically all-digital audio broadcasting schemes. Because their
first services will start in the year 2000, this decision has already triggered the
development of dedicated AAC decoder chips at a number of manufacturers. Due
to its superior performance, AAC will also play a major role for the delivery of
high-quality music via the Internet. Furthermore, AAC (with some modifications)
is the only high-quality audio-coding scheme used within the MPEG-4 standard.

The AAC bit stream is encoded in either of two formats:
B Audio Data Interchange Format (ADIF)
B Audio Data Transport Stream Frame (ADTS)
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The corresponding forms are displayed according to the format of the input bit
stream These forms display the information contained in the fields of the Header
and the Raw Data.

Hierarchy window ——

Summary window ——

Analysis window
Packel 2151 Progien 170 A P
) Packelb TG Fleadig PAT,
Error log window Packeth 13611 Pograns® 170 Roadng PMT...

Packetl 15447 Readig PAT..
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ADIF stream forms

The analyzed information regarding the input ADIF stream is displayed by means
of a property sheet containing three tabs.

The ‘ADIF Header' tab of the following figure displays the fields of the header.

SCE0,SCE1,5CE 2, SCE 3,5CE 4, 5CE 6, SCE B, CPE 0.CPE 1, CPE 2,
CPE 4, CPE 5. CPE &, CPE 7. CPE 8, CPE 3, CPE 10, CPE 11, CPE 12,

—
s
CPE 13,CPE 14, CPE 15, 5CE 7,SCE 8,SCE 9, SCE 10, SCE 11, SCE12,
A ]
M A
o
EN

Figure 4-2: ADIF header Information
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The ‘Raw Data' tab of the following figure displays the fields in each raw data
block. A slider control helps to navigate through the various raw data blocks. The
information regarding each raw data block is displayed by means of another child
property sheet containing seven tabs (for more information the fields in each tab
(See Figure 4-4.) to (See Figure 4-10.)

Figure 4-3: ADIF raw data Information

Element color coding in ~ The Element Type (below the slider bar) is color-coded; the key is given on the
the Raw Data tab  right side of the display in the Element Types box. The number displayed in the
Element Type color spot indicates the EIT (element instance tag) of that syntactic
element.

Color coding of Raw Data  The text in the Raw Data tabs is color-coded as follows:

tabs Light Blue Indicates the syntactic element is present and activated in the
raw data.
Dark Blue Indicates that the syntactic element is present, but currently
inactive in the raw data.
Dark Gray Indicates that the syntactic element is not present in the raw
data.
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4-76

Figure 4-4: Single channel element Information

LOMG_STAR
0
50

Figure 4-5: Coupling pair element information
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Figure 4-7: Low frequency element channel information
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|

7747784141

Figure 4-8: Data stream element information

Figure 4-9: Program configuration element information
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SCE | CPE | €CE | LFE | DSE | PCE ]

Fill Element

Count |0 Increment Count |255

Extension Payload

Extension Type |Bilslream filler

Figure 4-10: Fill element information

The ‘Channels' tab of the following figure displays the configuration of the coded
channels. The physical location of the speakers corresponding to the channels
coded in the stream for standard and non-standard configurations can be displayed.

ADIF Header | RawData ]

i Channels

PCE No. |0 "I
+ Audio Play
Device IElyslaI‘SoundFuswon[tm] b \E P=IT]

Left Speaker IFronl Left 1 'I
Right Speaker IFronl Right 1 - I
Implicit S peaker Mapping INUI’]'S tandard

— Speaker-Channel Mapping
Gremrarens Front Left - - Front Right - >

® s
@
@ cce
@

[7 J——

€-—— ~—or oo -
“-—— ~F¥0-D 8O- ———

------ Back Left ——> ¢~ Back Right ~——

Figure 4-11: ADIF channels (non-standard) information
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The syntactic element type corresponding to each speaker in the Speaker-Channel
Mapping is denoted by a color-code scheme, the legend for which is given in the

Ch.Element Types box. The number appearing in the color spots denotes the EIT

(element instance tag) of that syntactic element.

Gy S omont) ] 0N
|
g Swrownd

Figure 4-12: ADIF channels (standard) information
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ADTS stream forms

The analyzed information regarding the input ADTS stream is displayed by means
of a property sheet containing three tabs.

The ‘ADTS Header' tab of the following figure displays the fields of the header,
while the ‘Raw Data' tab displays the fields in each raw data block and the
‘Channels' tab displays the configuration of the coded channels. The content of
the ‘Raw Data' and ‘Channels' tabs are identical to that in the ADIF stream.

Figure 4-13: ADTS header information
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ES Analyzer - Closed caption analysis

Closed captions are captions that are hidden in the video signal, invisible without
a special decoder. The place they are hidden is called line 21 of the vertical
blanking interval (VBI).

ES Analyzer allows closed caption data to be analyzed and inspected.
The two options are:

B CCA Standalone (Player + CC-EIA608 + CC-EI708 analysis)

®  Full Elementary Stream Analyzer + CC-EIA608 + CC-EI708 analysis

NOTE. No special installation process is required. The options are dongle
protected/enabled.

The Stand-Alone option has full Closed Caption functionality, but other ES
Analyzer functions are disabled.

XDS analysis is currently disabled. Extended Data Services is a supplementary
data stream existing in Line 21, Field 2. It is used to provide additional data
(primarily content advisory information) on the program being aired (Reference:
EIA-744).

Enabling closed caption analysis

4-82

1. Open a stream containing Closed Captions.
2. Expand the navigation tree and open either a VES or a GOP node.

3. Enable Closed Caption Analysis in the Settings menu. A check mark next to
the option indicates that Closed Caption Analysis is enabled.

NOTE. By default, Closed Caption Analysis is enabled. It is recommended that
it be only enabled when required; disabling it will improve the speed of picture
analysis processing.

However, disabling and enabling the Closed Caption Analysis feature should only
be done when a stream is first opened, not during analysis. Opening the feature
during analysis may result in improper analysis.

When Closed Caption Analysis is enabled, the Closed Caption Display tab
will be visible in the Slice and MB GOP tab.

4. Ensure that the Picture Display Settings (Settings > Picture Display...) are as
shown in the following screenshot:
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Picture Dizplay Settings I

— Dizplay Order af Pictures
() Presentation Order 2} Decoding Order

— Motion Yector Owverlap Colour Selection
& White O Vector Dependent
{3 Black O Background Dependent

EE Cancel

= Display Order of Pictures > Presentation Order

= Motion Vector Overlay Colour Selection > White

Selecting closed caption analysis standard

Two primary forms of Closed Caption Analysis are offered: CC-EIA608 and
CC-EIA708. CC-EIA746 support is also supported in the EIA608 mode.

The selection of CC-EIA608 or CC-EIA708 is made from the Closed Caption
Display tab available in the Slice and MB GOP tab.

NOTE. Whichever standard is selected, no closed caption content will be
displayed until the file has been at least partially analyzed. To start analyzing the
stream, select the GOP And Picture tab and press the Go button.

A sign that closed caption content has been detected during analysis is that the
Video icon in the navigation tree changes to include a CC symbol:

2 > &

CC-EIA608 support

Celect CC
¥ E|ARD3

i EIAT03
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The following dialog box is displayed below the picture display (in the Closed
Caption Display tab) when CC-EIA608 Closed Caption Analysis is enabled:

Caption Services Test Services E sterded D ata Services
@E o @O | (@0 T @C T3 @ ¢ EDE
o

@ CC2 @& CC4 QN S

Dz Mcano -y | Roll Up | Pop On

Clozed Caption Data in Current Mode

Paint On

Row 14: IN A WILDERNESS
Row 15: TEEMING WITH LIFE.

Pen Attribute:

’7Llnderline K Coor ] Flash K ltalics K

Cursar Position

Base Fow

r~ Curment Frame ————————
Active Mode IF’op On
Background Color -
Background Opaque v

—El&-746 Data

LURL I hittp: # #vnamey dbvac) ¥ l Go |
Marne INCAM Expires INA.
Type Is Script IN.A.

At the top of the display, the LED icons indicate that closed caption data has
been received in the Field and Services sections; green indicates that data has

been received.

If data has been received for the current GOP it should be displayed in the Display
Memory tab and on the picture display:

The remaining tabs (Roll Up, Pop On and Paint On) display various parameters
defining the manner in which the captions will be displayed.

CC-EIA746 support  Associated with CC-EIA608 is CC-EIA746 which supports the transmission of
URLSs (Uniform Resource Locators) within the closed caption data.

The URLSs transmitted in the T2 closed caption service are parsed, decoded and

displayed in the EIA-746 Data view.
Ela- 746 D ata
URL | http :thwminwr. fo0.C ¥ ] Gnl

Mame |M.A | Expirez IN..-'-"-..
Type LA, Scripk IN..-'-"-..

B The attributes shown apply to the URL selected from the drop-down list.
m  The selected URL is fetched and displayed on the default Web browser

installed on the system.
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CC-EIA708 support

Select CT
" El&E03

* Ela708

The following dialog box is displayed below the picture display (in the Closed
Caption Display tab) when CC-EIA708 Closed Caption Analysis is enabled:

i~ Caption Service I Samvice 1 - I
Window Text
Service Tupe IStandard

SR Row 0: IN AWILDERNESS
- Facret Infa Row 1! TEEMING WITH LIFE.
Sequence No. |3

Packet Size I 5

:
|

—Window D efinition Parameter
Bytesteft [0 windowlD [T WindowStlelD [2
= WA
Block |.”f° . —*window Style Parameter
BlockSize |2 Justy  [LEFT Piirt Ditection  |LEFT_T0_RIGHT
Epiela ID —Pen Style Parameter
ctive Window [1 PenSize  |STANDARD | Font Style [Defaut

Details of the fields in the Closed Caption Analysis window are as follows:

Caption service  The service whose details are to be displayed can be selected from the drop-down
list.

Packet info  Sequence No. The sequence number of the packet from which the current service
block has been extracted (for example, Service 1, Service 2, etc).

Packet Size The packet size that has been coded in the packet header.

Bytes Left The number of bytes still to be received.

Block info Block size The size of the service block.

Bytes Left The number of bytes still to be received.

Active Window The Window ID which is currently the active window.
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Window identity e

w
w1

W# The buttons in red in the W# column indicated the defined windows in the
received service. The parameters to the right of this column depend on the
selection made here.

Window text The text shown in the current window.

Window definition = By placing the cursor over the more...field all the parameters related to the
parameters window definition can be viewed.

WINDOW DEﬁNITIOH PARAMETERS
PARAMETER NAME PARAMETER VALUE
1 Anchor Hovzontal 0
Anchaor Fomnt 0
Anchor Vertical 60
Column Count 32
Column Lok NO
Fen Style 10 1
Friority 0
Relaiive FPostioning NO
Row Count 3
Row Lack NO
islbis NO
Window fD 1
Window Shyie [0 2

Window D efinition Pararneter —
“wiindow (D |1 ‘window Style [D IZ w
— Windaw Stele Parameter
Justify JLEFT Print Direction ILEFT_T -

— Pen Style Parameter

Pen Size [STANDAR | Font Stle [Defaul -
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By placing the cursor over the more..

ES Analyzer — Closed caption analysis

field all the parameters related to the

window styles can be viewed.

I WINDOW STYLE PARAMETERS
* PARAMETER NAME PARAMETER VALUE
| Bordar Color <0,0,0>
Bardas Typne NONE
| Display Effect SNAP
| Effact Direchion N.A.
Effect Speed N.A.
3 Filf Codar =176,6,74>
| Fill Opaciy TRANSPARENT
Justife LEFT
Frint Direction LEFT_TO_RIGHT
! Soroll Ditection BOTTOM_TO_TOP
Word Wrap NO |
—Window D efinition Parameters
Windew 1D [T Windon Sl [Z -J

_—

Pen style parameters

— Window Style Parameters

‘ Jushify  JLEFT Pritat Dlirection ILEFT q

"F'en Style Parameters

styles can be viewed.

F'enSle!ISTAND.ﬁ.FI Font Style IDefauIl -

By placing the cursor over the more...field all the parameters related to the pen

k PEN STYLE PARAMETERS
4 PARAMETER NAME PARAMETER VALUE
| Edge Tyne NONE
Font Sivle Default
| ftalics NO
1 Cfset NORMAL
Pen Size STANDARD
Texdt Tag Dialog
- Undearing NO I3 unl 1eTON

~"window Definition Paiameters———

“Windaw 1D I Windaw Stylz D |2

— Window Styls Parameter

Justify ILEFT Print Direction ILEFT_T -
— Pen Syl Parameters

Pen Sizz [STANDAR | Font Stle [Defaul q
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Dumping closed caption statistics

Closed Caption Analysis statistics can be written to file for each standard (EIA608
and EIA708).

NOTE. Regardless of which standard is selected, no closed caption statistics can
be dumped until the file has been at least partially analyzed. To start analyzing
the stream, select the GOP And Picture tab and press the Go button.

A sign that closed caption content has been detected during analysis is that the
Video icon in the navigation tree changes to include a CC symbol:

2 > &

The sequence of actions required for a dump of statistics to be successful is as
follows:

1. The Dump CC Statistics option in the Settings menu will only become
available when analysis (or partial analysis) has established that Closed
Caption data is carried in the stream.

2. A standard must be selected from the Dump CC Statistics option sub-menu,
for example, EIA608.

3. A destination file must be specified for the statistics dump.
4. Further analysis must be carried out to provide data for the statistics dump.

The following paragraphs describe the setup required for each standard; however,
the previous steps must be adhered to for the dump to be successful.
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EIA608 closed caption 1. Select the EIA608 option from the Dump CC Statistics sub-menu.

[lucent16.mpg]

statistics dump

Settings WaEld

Video Analysis.

Picture Dizplay..

O | 8= i

DCT Display

te And BB

¥ Closed Caption Analysis ON/OFF

Dump CC Stahistic:

tdcor

l — Picture 0

2. Enable Dump Statistics.

Closed Caption EIAG08 Statistics

~ ¥ Dump Statistic:

Statistics File:
|CATEMPACCT7 dat |
— Caption Services
¥ CC1 " ccz
v CC2 [T ccd
— Dlisplay Mode
 RallUp " PopOn
% Display Mem ' Pairt On

ElA70S

Cancel |
YWiew Repart |

3. Identify a destination file in the Statistics File: field.

4. Enable the parameters to be dumped.

5. Select OK.

Existing reports (reports that you set up) can be viewed by selecting View Report.
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EIA708 closed caption 1. Select the EIA708 option from the Dump CC Statistics submenu.
statistics dump

I *
Video dmalysis. D | | Gx
| Picture Dizplay..
re And MB
DCT Dusplay
L4 GOF (S

|¥  Closed Caption &nalysis ONAOFF

DumpCCS o 3 Elag0S
l — Pictune SRR ——

2. Enable Dump Statistics.

Closed Caption EIA708 Statistics [X] I

~ ¥ Dump Statistic:
Skatistics File:

0K |
IE:\TEMP\EE?DB] Jdat L | Cancel |
- Service(s) “iew Feport |
Awallable D ump
Semice 1
Service 2 3
£ |
—Window(=]
¥ window D v Swindow 4
¥ Window 1 IV \window &
¥ window 2 ¥ \window &
¥/ tindous 3 V' window 7

3. Identify a destination file in the Statistics File: field.
4. Enable the parameters to be dumped.
5. Select OK.

Existing reports (that is, reports previously set up) can be viewed by selecting
View Report.
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ES Analyzer — DVB subtitle stream analysis

DVB Subtitling provides a means of conveying region-based bit-mapped graphics
as MPEG-2 packetized elementary streams (PES). The bit-mapped pixel images
are run-length encoded and transmitted with color look-up tables (CLUT) to

a decoder where the stream is decoded and the subtitle image rendered with the
on-screen display.

When a DVB Subtitle node is revealed and highlighted, the screen shown below
is displayed:

=gl TPT
- &7 PROGRAM 8258
- &F PROGRAM 6325
S @F PROGRAM 8384
= {8 PESIPID=2823), MPEG 2Video
 E-d@ vES(Z)
PES(PID=2824), MPEG 2 Audio
(B PES(PID=2826], MPEG 2 Audio
=1 =y PES(PID=2625). DVE Subtitis
B RO\ E G LbitlelPaeiD=2)
- <f PROGRAM 8448
- @ PROGRAM B575
- @f PROGRAM 8540

..H...H. Ii‘l_l

NOTE. Some streams may show subtitle nodes from which the Page view
(described below) cannot display any subtitles.

This is not an error, it is because the stream is too short to carry the requisite data.
If possible, record a longer section of the stream and retry the analysis.
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i@ Tektronix MPEG-2 ES Analys
&} Fie Edt Yiew Window MNode Setings Help

[chandmar2. mpg]

|& = aF A _a=«clo|als

w Q| BH | 2

Bl TPT

& PROGRAM 8258

@F PROGRAM 8325

) &f PROGRAM B384

= [ PESIFID=2823), MPEG 2 Video
= & VES(Z3)

FESIFID=2824). MPEG 2 Audio
PES[FID=282E). MPEG 2 Audio

)
- @f. PROGRAM 8448
£ @f PROGRAM 8575
7 @f PROGRAM 8540
7 @f PROGRAM 8706
P @f PROGRAM 8763

woE-E -

Steam Property | Value

 File Name CASheams\chandmarz mpg
* File Size 105463 KB

~ Stieam Type Transport

= Video Tracks 5
+ Audio Tracks 10
=+ Typeof Video Mpeg2
« Typeofdudo:  Mpeg!
= User Data Stresams: B
+ TotalPrograms: ©

DVB Sublitls Data | Page view |

~Pags Compasition Seamen

Fegion II211 -

Provider Flag x

Scgmentlength |14 | Version Mo [
Pags State [cauistion Paint Time Oul 50 = | Region Hor. Address [72
RiegionVer, Address [461
—~Region Enmpnsilinm
SegmentLength |15 Fill Flag e (Ll
e EEEEEEE Widh 612 8B Pixel Code
Height E 4B Pixel Code
ELUTID ! Depth [+BF | 2BitPiel Code
Obiect D [0 |
T | Hoizontel Fosiion [0 Foreground Pise) Cinde |2

Vettical Posiion |0 Backgiound Pirel

- ELUT Defirition 1D [ -
Gegment Length |38
Warsion No, 7

Default CLUT Table ...

CLUT Enty I[g |

Full Riange Flag

8Bic/Eniy Flag g
Defauh Color |
4 Bit/Enty Flago”
petauttCoir |
2Bit/Enty Flag 3¢
Default Color

¥ Valug

Crvae  [128
Ch¥alue [128
T Walue

Nesw Color

TR TR

[ DbjectDatalD  [20 -
Segment Length  |3843 Top Field Data Block Length [1911 Humbet of Codes N2
Version No. 3 BollomFicld Data Block  [1924
Coding Method |0 Mon-Modifying Colar » Show Object
LOCATION [ MESSARE =

1000 TPT->PESIFID=2827), MPEG 2 Video>V... Initializing ¥ES stream

1005 TPT->PESIPI
1173 TPT->PESIPI
1240 TPT-FESIFI

=2627). MPEG 2Videos... This is an MPERG-2 Video Elementary Stieam
527), MPEG 2VideosV... Naimages from previous GOP are avaiable. Playing GOP# 1 may show hazy resuits
227). MPEG 2VideosV... In the picture play mode macroblock level enors are nat flagged

4-92

1000 TPT->PESIPID=2823), MPEG 2 Video>V... IritialzingYES stream b
1] +
Far Help, press F1 s [DisplaySet#l [TPTPRH#E592 [PESPKEN |PTS/00:05107:19314538 EncPageil O 0x148448(1344564)

The working area contains two tabs: DVB Subtitle Data and Page view.
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DVB Subtitle Data tab

The DVB Subtitle Data tab displays the fields associated with the current display.
Access to two areas of detail is provided by pressing the Default CLUT Table...
and the Show Object... buttons.

Acquisition Paoint

1]

I
Il
i

2
—
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Object view  The Object view displays a decoded bitmap of the selected object rendered on
a blank screen (that is, with no underlying picture). The fields at the top of the
dialog box, provide the user with the options of changing the decoder type (2-bit,
4-bit or 8-bit), the background color, and the CLUT identity. As described in the
standard, the CLUT is attached to the region, not the object; therefore, the user
can see the bitmap using all of the available CLUTs.

The Object view is displayed by selecting the Show Object... button on the DVB
Subtitle Data tab.

DVE Subtitle : Dbject

— Setting
Decoder Tupe |d-Bit Decoder j Clut 1Ty |2 ﬂ

Backaround Colc |Black i

The Cowardly Lion from The Wizard of
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CLUT view  The Object view is displayed by selecting the Default CLUT table...button on the
DVB Subtitle Data tab.

DVYE Subtitle Default CLUT I
—Default CLUT
2 Bits CLUT 8 Bits CLUT
Y
4 Bits CLUT
-
cot [ 5 - N
s | e |
o | | oo —
| — .1 IS

NOTE. Subtitles in the UK are colored in a limited set, (ved, cyan, green,
yellow, white), one for each of four speakers/actors and white for additional
speakers/actors.
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Page view tab

On the Page view tab, the regions listed in the Page Composition Segment area of
the DVB Subtitle Data tab are rendered on a blank screen (size 720(H) x 576(W)
pixels). The regions and objects are rendered at their actual locations on the blank
screen. The user can select the Decoder Type and Background Color from the
drop-down lists.

DVE Sublite Data Page View |

Setting

Decoder Type 4-Bit Decoder | ™ B ackaground Cole M -

| wouldn't put my foot through a
Picasso painting. And I'm not going
to put my leg through...

NOTE. Background color is not carried in the broadcast. The user can select
a suitable color.
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